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Pro koho je tato uzivatelska priruCka uréena?

Tato uzivatelska prirucka bude velmi uzitecna pro kazdého, kdo si chce rychle osvojit znalosti
o LibreOffice Draw a je novackem v oblasti softwaru pro kresleni, pfipadné zna jiny kancelarsky
balik.

LibreOffice je open source kancelarsky balik obsahujici funkce pro zpracovéani textu, tabulek,
prezentaci, grafiky, databazi a Gpravu vzorcd. LibreOffice Draw je aplikace pro kresleni vektorové
grafiky v kancelarském baliku LibreOffice, ve které Ize snadno a rychle vytvaret nejrliznéjsi
grafické obrazky. Kresby Ize exportovat do nékolika format(, napfiklad PDF, HTML a mnoha

grafickych formatd.

Co je v této uzivatelské pfiruéce?

Tato uzivatelska priruCka predstavuje hlavni funkce modulu Draw, coZ je vektorovy graficky
modul LibreOffice. Tato uzivatelska prirucka je uréena uzivateldim, ktefi si cht&ji osvojit znalosti

o LibreOffice Draw a jsou novacky v oblasti softwaru pro kresleni, pfipadné znaji jiny kancelarsky
balik. Pomoci aplikace Draw Ize snadno a rychle vytvaret nejrlizn&jsi grafické obrazky. Kresby
vytvorené v aplikaci Draw Ize exportovat do nékolika format(, napfiklad do PDF, HTML

a nékolika grafickych formatd.

Tato uzivatelska pfirucka predstavuje hlavni funkce Draw. Je to pfedevSim nastroj pro kresleni
vektorové grafiky, ale Ize jej pouzit i k Gpravam rastrové grafiky (pixelll), napriklad fotografii.
Né&kolik pfikladl kreslicich funkci:

Sprava vrstey, funkce pfichyceni a systém bod0 mfizky
Zobrazeni kétovani a mérnych jednotek
Konektory pro tvorbu organiza¢nich schémat

Draw obsahuje také 3D funkce pro vytvareni 3D vykresl (s texturami a svételnymi efekty),
integrace kresby a stylu stranky, a vytvafeni Bézierovych kfivek.

Minimalni poZadavky na LibreOffice

LibreOffice 25.8 vyZaduje jeden z nasledujicich operacnich systému:
Linux x64 (deb) a Linux x64 (rpm)

Mac OS X (Aarch64/Apple Silicon)

macOS x86 64 (10.14 Mojave nebo vyssi)

Windows x86_64 (vyZadovan systéem Windows 7 nebo novéjsi)

Podrobny seznam pozadavk( a podporovanych operacénich systémi najdeme na webu
LibreOffice: https://cs.libreoffice.org/get-help/system-requirements.

Jak ziskat LibreOffice

Pocditace a notebooky

Verze LibreOffice pro Windows, Linux a macOS jsou volné dostupné a Ize je stAhnout z webu
LibreOffice na adrese https://cs.libreoffice.org/download.

v s

Pro uzivatele Linuxu je LibreOffice zdarma soucasti mnoha nejnovéjSich distribuci, napfiklad
Ubuntu. Linuxové verze LibreOffice se mohou v nékterych funkcich lisit od popist pouZzitych
v této uZivatelskeé pfirucce.

Dokumentace pro LibreOffice je dostupna na https://cs.libreoffice.org/get-help/documentation/


https://www.libreoffice.org/download
https://www.libreoffice.org/get-help/system-requirements/

LibreOffice je k dispozici také pro Windows v Microsoft Store a pro macOS v Apple App Store za
nizkou a atraktivni cenu. Tyto verze jsou svobodnym softwarem (open source), ale maly poplatek
pokryva naklady na umisténi LibreOffice v obchodech s aplikacemi. Zisky z prodeje LibreOffice
jsou investovany na podporu vyvoje projektu LibreOffice.

Tablety, iPady a Chromebooky

Chceme-li pouzivat LibreOffice na tabletech, iPadech nebo Chromeboocich, je tfeba stdhnout

a nainstalovat aplikaci zaloZenou na LibreOffice. Aplikace se jmenuje Collabora Office. VyuZiva
stejnou technologii jako LibreOffice a jeji ovladani je velmi podobné LibreOffice. DalSi informace
nalezneme na webovych strankach Collabora Office na adrese https://www.collaboraoffice.com.

Instalace LibreOffice

Informace o instalaci LibreOffice na rliznych podporovanych opera¢nich systémech jsou uvedeny
na této strance: https://cs.libreoffice.org/get-help/install-howto. Pokud je LibreOffice pofizen
prostfednictvim oficialnich obchodl s aplikacemi, postupujeme podle pokynd k instalaci
poskytnutych obchodem.

Nastaveni a pfizplisobeni LibreOffice

Po instalaci zménime vychozi nastaveni (moZnosti) LibreOffice tak, aby vyhovovalo pracovnim
pozadavkdm a preferencim. V hlavni nabidce Nastroje > MoZnosti (mac OS LibreOffice >
Predvolby) zménime nastaveni podle potieby.

Nastaveni jsou popsana v napovédeé LibreOffice a v pfiruCce Zaciname s LibreOffice. Tyto dva
zdroje poskytuji informace o tom, jak pfizpUsobit nabidky, nastrojové listy a klavesové zkratky
v aplikaci, pfidat nové nabidky a nastrojové liSty a pfifadit makra udalostem.

.- Tip

Nékterd nastaveni jsou uréena pro zkuSené uzivatele a programatory. Pokud

nerozumime tomu, co nékter4 moznost déla, doporu€ujeme ponechat ji na vychozim
nastaveni, pokud pokyny v této uzivatelské pfiru¢ce nedoporucuji zménit nastaveni.

RozSifeni a doplnky

LibreOffice mizeme rozsifit o dal$i funkce pomoci rozsiteni a dopliikd. S programem je
nainstalovano nékolik rozSifeni a dalSi rozSifeni z oficialniho Ulozisté rozsitent,
https://extensions.libreoffice.org/ nebo rliznych jinych zdrojd. Dalsi informace o instalaci rozsifeni
a doplik{ viz pfirucka Zaciname s LibreOffice.

Kde ziskat pomoc

Tato uzivatelska prirucka, systém napoveédy a systémy uzivatelské podpory pfedpokladaji, ze
uZivatelé jsou obeznameni s pocCitatem a zakladnimi funkcemi, jako je spousténi programu,
otevirani a ukladani soubord.

Systém napoveédy

LibreOffice je vybaven rozsahlym systémem napovédy a slouzi jako prvni linie podpory. UZivatelé
Windows a Linux si mohou zvolit staZeni a instalaci offline napovédy pro pouziti ve chvili, kdy
nejsou pfipojeni k internetu. Offline ndpovéda je nainstalovana s verzi LibreOffice pro MacOS.

Prirucka aplikace Draw 25.8 | 9
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Napovédu lze zobrazit stisknutim klavesy F1 nebo zvolenim polozky Napovéda > Napovéda
LibreOffice v hlavni nabidce. Pokud neni offline ndpovéda nainstalovana v pocitaci, a pocita€ je
pripojen k Internetu, otevie se dialogové okno s moznosti Cist napovédu online. Vybereme tuto
moznost a vychozi webovy prohlize€ se otevie na strankach online napovédy LibreOffice na
webu LibreOffice.

Nabidka Napovéda obsahuje odkazy na dalSi informace a podporu LibreOffice. Nabidka
Napovéda obsahuje také odkazy na dalSi informace o LibreOffice a zdroje podpory.

Cojeto?
Rychlé tipy ziskdme, kdyZz umistime ukazatel mysi nad ikonu. Zobrazi se tip ndpovédy

s kratkym popisem funkce néstroje. Podrobnéjsi vysvétleni ziskame, pokud v hlavni
nabidce zvolime Napovéda > Co je to?

v sy

Rozsifené tipy 1ze aktivovat v hlavni nabidce Nastroje > MoZnosti > LibreOffice >
Obecné (macOS LibreOffice > Pfedvolby > LibreOffice > Obecné > Napovéda)

a vybereme moznost Rozsifené tipy. RozSifené tipy poskytuji struény popis nastrojl
a prikaz(. Chceme-li rozsifeny tip zobrazit, stiskneme Shift + F1 a poté pfesuneme

kurzor na tlacitko nebo pfikaz.

Uzivatelské pfirucky
Otevie vychozi prohlize€ na strAnce Dokumentace na webu LibreOffice
https://documentation.libreoffice.org/en/english-documentation/. Tato webova stranka
poskytuje pfistup k uzivatelskym pfiruckam LibreOffice a dalSim uzite¢nym informacim,
které Ize otevfit ve vychozim prohliZzeci. UzZivatelské prirucky LibreOffice jsou k dispozici
ve forméatu PDF ke staZzeni zdarma nebo k zakoupeni v tiSténé podobé.

Zobrazit tip dne
Otevie malé okno s nahodnou radou, jak pouzivat LibreOffice.

Hledat pfikazy
Otevie okno, do kterého miizeme zadat nékolik pismen nebo nazev prikazu na
nastrojové listé a rychle tak zjistit, kde se pfikaz nachazi. Klepnuti na pfikaz ve
vysledném seznamu miZe oteviit pfislusné dialogové okno nebo mit jiné Ucinky.
Poradit se online
Otevie vychozi prohlize¢ na strance fora Ask LibreOffice, kde mizeme poloZzit Gi
zodpovédét otdzku https://ask.libreoffice.org/en/questions/cs.
Odeslat zpétnou vazbu

Otevre vychozi prohlize€ na strance zpétné vazby na webu LibreOffice
https://cs.libreoffice.org/get-help/feedback/. Na této webové strance Ize hlasit chyby,
navrhovat nové funkce a komunikovat s ostatnimi uZivateli v komunité LibreOffice.

Restartovat v nouzovém rezimu

Otevre dialogové okno s moZnosti restartovat LibreOffice a obnovit vychozi nastaveni
softwaru. Restartovani v nouzovém rezimu také poskytuje prilezitost obnovit LibreOffice
ze zalohy.

Zapojte se
Otevre vychozi prohlize€ na strance Pfipojte se k nam na webu LibreOffice,
https://cs.libreoffice.org/community/get-involved/. Zde si mizeme vybrat oblast zajmu,
v niz pomUZeme program vylepsit.

Podpo¥it LibreOffice finan€né

Otevre vychozi prohlize€ na darcovské strance LibreOffice https://donate.libreoffice.org/,
kde je moznost pfispét na podporu LibreOffice.
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Informace o licenci
Uvadi licence, pod kterymi je LibreOffice k dispozici.

Zkontrolovat aktualizace

Otevre dialogové okno a zkontroluje webové stranky LibreOffice, zda nejsou k dispozici
aktualizace verze softwaru. Dialog poskytuje pfilezitost stahnout a nainstalovat jakékoli

aktualizace LibreOffice.
O LibreOffice

Otevre dialogové okno a zobrazi informace o verzi LibreOffice a pouzitém operacnim
systému. Tyto informace jsou Casto vyZadovany, pokud komunitu poZzadame o radu nebo
pomoc se softwarem (v systému macOS se tato moznost nachazi v nabidce

LibreOffice}.

DalSi volné dostupna podpora na internetu

Komunita LibreOffice kromé vyvoje softwaru poskytuje bezplatnou

podporu od dobrovolnikd. Viz

tabulka 1 a webové stranka https:/cs.libreoffice.org/get-help/. Uplnou online podporu komunity
hledejte v konferencich a ha webové strance Ask LibreOffice: https://ask.libreoffice.org/c/czech-

and-slovak/. Bezplatné tipy a navody nabizeji i dalSi weby.

Tabulka 1: Bezplatna podpora pro uZivatele LibreOffice

Bezplatna podpora LibreOffice

Odpovédi na ¢asto kladené otazky

Caste otazky https://wiki.documentfoundation.org/Faqg.

E-mailové konference

Bezplatnou komunitni podporu poskytuje sit zkuSenych uZivatelQ
https://www.libreoffice.org/get-help/mailing-lists/.

webové adrese.

Pomoci weboveé sluzby Ask je poskytovana komunitni podpora
zdarma. Vyhledat podobna témata nebo oteviit nova miZeme na
Otazky a odpovédi strance https://ask.libreoffice.org/c/czech-and-slovak/13.

a databaze znalosti Sluzba je k dispozici v nékolika dal3ich jazycich; sta¢i nahradit /en/ za
cs-cz, de, es, fr, ja, ko, nl, pt, tr, a mnoho dalSich na vySe uvedené

https://www.libreoffice.org/community/nlc/.
Podpora v rliznych Emailové konference pro materské jazyky

Informace o socialnich sitich

Webové stranky LibreOffice v réiznych jazycich

jazycich https://wiki.documentfoundation.org/Local_Mailing_Lists.

https://wiki.documentfoundation.org/Website/Web_Sites_services.

Moznosti zpfistupnéni

Informace o dostupnych moznostech pro zlepSeni pfistupnosti
https://www.libreoffice.org/get-help/accessibility/.

Forum OpenOffice

DalSi forum, které poskytuje podporu pro LibreOffice a dalSi open
source kancelafské baliky https://forum.openoffice.org/en/forum/.

Placena podpora a Skoleni

Podpora a Skoleni je k dispozici prostfednictvim smluv o poskytovani sluzeb od prodejce nebo
poradenské firmy specializujici se na LibreOffice. Informace o certifikované profesionalni
podporfe se nachazi na webovych strankach The Document Foundation:

https://cs.libreoffice.org/get-help/professional-support/

Pro Skoly, vzdélavaci a vyzkumné instituce a velké organizace viz
https://cs.libreoffice.org/download/libreoffice-v-podnicich/.
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MozZné vzhledové odchylky

llustrace

LibreOffice funguje v operacnich systémech Windows, Linux a MacOS. Kazdy operacni systém
si mohou uZivatelé pfizpUsobit (pisma, barvy, motivy, spravci oken). llustrace v této uzivatelské
priruce byly pofizeny na réiznych pocitacich s odlisnymi operaénimi systémy. Nékteré ilustrace
se proto mohou lisit od toho, co vidime na monitoru pocitace.

Né&ktera dialogova okna se mohou lisit i diky rznym nastavenim samotného LibreOffice. UZivatel
si totiz midZe zvolit, zda chce pouZivat dialogova okna operaéniho systému (vychozi), nebo okna,
které jsou soucasti programu LibreOffice.

Zména dialogovych oken LibreOffice:

1) V hlavni nabidce zvolime Nastroje > MoZnosti > LibreOffice > Obecné (macOS
LibreOffice > Pfedvolby > LibreOffice > Obecné) a otevieme stranku pro obecné
moznosti (obrazek 1 pod).

2) Pro zobrazeni dialogll LibreOffice na displeji naseho pocitace zvolime PouZit dialogy
LibreOffice v sekci Dialogy Otev¥it/UloZit.

3) Klepnutim na OK uloZime nastaveni a okno zavieme.

Moznosti - LibreOffice - Obecné

Zadejte hledany text Napovéda
Rozsifené tipy

LibreOffice
i Upozornit, pokud neni nainstalovana lokalni napovéda

Uzivatelské (daje

. Zobrazovat pfi spusténi okno ,Tip dne”
Zobrazeni Dialogy OtevritfUloZit
Tisk Pouzit dialogy LibreOffice
- Cesty Stav dokumentu
fisms Tisk nastavi stav ,dokument zménén”
Zabezpeceni
Vzhled Rok (dvé cislice)
Zpfistupnéni Interpretovat jako roky mezi | 1930 — + |a2029
Pokrocilé
Basic IDE Pomoc pii zlepSovani LibreOffice
oOnline aktualizace Odesilat zpravy o padu The Document Foundation
- OpenCL
> Nacitani/ukladani
» Jazyky a narodni prostiedi
> LibreOffice Writer
> LibreOFffice Writer/Web
> LibreOffice Base
> Grafy
> Internet

Obrazek 1: Dialogové okno MoZnosti LibreOffice — stranka Obecné
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Moznosti - LibreOffice - Zobrazeni

Zadejte hledany text Mys Graficky vystup
Pouzit hardwarovou akceleraci

« LibreOffice Prostfednitlacitko: Vlozit obsahschranky ~
Uzivatelské udaje Powitvyhlazeni
Obecné Seznamy pisem
I Zobrazit nahled pisem
Tisk Vyhlazovani pisem na obrazovce
Cesky Y
i od: | 8 pixeld = | =k
Zabezpeceni
vzhled
Zpiistupnéni
Pokrocilé

Basic IDE
Online aktualizace
OpenCL
» Naéitanifukladani
» Jazyky a narodni prostiedi
» LibreOffice Writer
» LibreOffice Writer/Web
» LibreOffice Base
» Grafy
> Internet

Obrazek 2: Dialogové okno MoZnosti LibreOffice — Stranka Zobrazeni

Ikony

Komunita LibreOffice vytvofila nékolik sad ikon, napfiklad Breeze, Colibre a Sifr. UZivatelé
LibreOffice si mohou vybrat preferovanou sadu pisem, ktera chtéji pouzivat. Ikony pouZité pro
ilustraci nastrojd dostupnych v LibreOffice se mohou lisit od ikon pouzitych v této uzivatelské
prirucce. Ikony uzivatelské prirucky byly pfevzaty z instalace LibreOffice pomoci sady ikon
Colibre.

Sadu ikon pouzitou v instalaci LibreOffice mlizeme zménit nasledujicim zplisobem:

1) V operaCnich systémech Linux a Windows v hlavni nabidce zvolime Nastroje >
MozZnosti > LibreOffice > Zobrazeni (macOS LibreOffice > Pfedvolby > LibreOffice >
Zobrazeni), ¢imz se otevie okno pro nastaveni vzhledu (obrazek 2 nad).

2) V sekci Styl ikon vybereme pismo z moznosti dostupnych v rozeviracim seznamu.

3) Ve Velikosti ikon vybereme pozadovanou velikost pro Nastrojové listy, LiStu karet
a Postranni listu.

4) Klepnutim na OK uloZime nastaveni a okno zavieme.

ﬁ Poznamky

Nékteré operacni systémy Linux, napfiklad Ubuntu, obsahuiji LibreOffice jako soucast
instalace a nemusi obsahovat poZadovanou sadu ikon. Sady ikon Ize stAhnout
z Ulozisté softwaru pro pouzivany operacni systém Linux.

oy

Nékteré z dfive dodavanych sad ikon jsou nyni k dispozici pouze jako rozSifeni.
Pfejdeme na https://extensions.libreoffice.org/?Tags%5B%5D=49 nebo vyhledame
konkrétni. Galerie Lidé je napfiklad k dispozici na adrese
https://extensions.libreoffice.org/en/extensions/show/people-gallery.

Pouzivani LibreOffice na systému macOS

Nékteré klavesy a polozky nabidek se v pocitacich s operacnim systémem macOS [iSi od
pocitacl s operac¢nimi systémy Windows a Linux. V tabulce 2 jsou uvedeny nékteré bézné
zameény pouzivané v této uzivatelské pfiruc¢ce. DalSi informace o klavesovych zkratkach

Priru¢ka aplikace Draw 25.8 | 13


https://extensions.libreoffice.org/en/extensions/show/people-gallery
https://extensions.libreoffice.org/?Tags%5B%5D=49

nalezneme v napovédé LibreOffice a v dodatku A, Klavesové zkratky v této uZivatelské
prirucce.
Tabulka 2: Priklad klavesovych zkratek systému macOS

Windows nebo Linux Ekvivalent pro macOS Akce

Pristup k moznostem

Nastroje > MozZnosti LibreOffice > Pfedvolby nastaveni

Ctrl+klepnuti a/nebo klepnuti
Klepnuti pravym tlaCitkem pravym tlac¢itkem v zavislosti | Otevie se mistni nabidka
na nastaveni pocitace

ctrl nebo Control 3 a/nebo Cmd nebo Prikaz, |Pouziva se také s dalSimi

v zavislosti na klavesnici. klavesami.
Alt - a/nebo Alt nebo Option |Pouziva se také s dalSimi
v zavislosti na klavesnici. klavesami.
F11 F+T Otevie se postranni lista Styly.

Kdo napsal tuto uzivatelskou prirucku?

Tato pfirucka byla napséna a preloZzena dobrovolniky z komunity LibreOffice. Zisk z prodeje
tisténého vydani je pouzit ve prospéch komunity.

Casto kladené otazky

Jakou licenci LibreOffice pouziva?

v v

LibreOffice je Sifen pod licenci Mozilla Public License (MPL) schvalenou Open Source
Initiative (OSI), viz https://www.libreoffice.org/about-us/licenses/. Je zaloZen na kédu
z Apache OpenOffice, ktery je k dispozici pod licenci Apache License 2.0, ale zahrnuje
software, ktery se liSi od verze k verzi v ramci fady dalSich open source licenci. Novy kéd
je dostupny pod licenci LGPL 3.0 and MPL 2.0.

MuizZe byt LibreOffice distribuovan komukoli?

Ano.
MtZe byt LibreOffice prodavan?
Ano.

Lze LibreOffice pouzivat ve firmé?
Ano.

Na kolik poéitaci Ize LibreOffice nainstalovat?
Tolik, kolik je potreba.

Je LibreOffice k dispozici v riiznych jazycich?
LibreOffice byl pfeloZen (lokalizovén z vice nez 80 %, a to jak uZivatelské rozhrani, tak
napoveéda) do vice neZ 46 jazykd, takze pozadovany jazyk je pravdépodobné
podporovan. Lokalizace je v plném proudu pro dal$ich vice nez 30 jazyk(d (50-80 %) a pro
dalSich vice nez 50 jazyk( je pomoc vice nez vitana. Navic je k dispozici vice nez 70
slovnikd pro kontrolu pravopisu, déleni a slovniky synonym pro jazyky a jejich dialekty, do
nichz neni lokalizované uzivatelské rozhrani. Slovniky jsou k dispozici na webovych
strankéch LibreOffice na adrese: https://www.libreoffice.org/.
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Jak mtZe byt LibreOffice volné k dispozici?

LibreOffice vyvijeji a udrzuji dobrovolnici s podporou vice firem. LibreOffice se také
spoléha na dary od svych uzivatel(l. Chcete-li prispét, pfejdéte na nasledujici webovou
stréanku: https://cs.libreoffice.org/donate/.

Lze pfi vyvoji softwarové aplikace pouzit programovy kéd z LibreOffice?
Ano, ale dodrzujte parametry stanovené v MPL a/nebo LGPL. Prectéte si licenci:
https://www.mozilla.org/MPL/2.0/.

Pro€ je ke spusténi LibreOffice vyZadovana Java a pro€ je napsan v Javé?

LibreOffice neni napsan v jazyce Java, ale v jazyce C++. Java je jednim z jazykd, které
Ize pouzit k jeho rozsifovani. Béhové prostredi Java (JDK/JRE) je tfeba jen kvli
nékterym funkcim. Jednou z nich je napriklad databazovy stroj HSQLDB.

Java je dostupna bezplatné. Dalsi informace a odkazy na staZeni pfislusné edice
operacniho systému nalezneme na adrese: https://java.com/en/download/manual.jsp.

}? Poznamka

Pokud chceme pouzivat funkce LibreOffice vyZzadujici Javu, je dllezité, aby jeji
spravnd 32 bitova nebo 64 bitova verze odpovidala nainstalované verzi LibreOffice.
Pokud neni Java dostupna, Ize stéle pouZzivat témeérf viechny funkce LibreOffice.

Jak mohou uzivatelé pfispivat do LibreOffice?
UzZivatelé mohou rliznymi zplsoby poméahat s vyvojem a uzivatelskou podporou
LibreOffice, pficemz neni nutné byt programatorem. Chceme-li zacit, podivame se na tuto
webovou stranku: https://cs.libreoffice.org/community/pripojte-se-k-nam/ Interaktivni
webova stranka, ktera uzivatele vede k tomu, aby pfispéli svymi nejlepSimi dovednostmi,
je k dispozici na adrese https://whatcanidoforlibreoffice.org.

MUZe byt PDF kopie této uZivatelské prirucky distribuovana nebo vytiSténa a jeji kopie
prodavany?
Ano, pokud jsou spinény poZadavky na jednu z licenci uvedenych v prohlaseni
0 autorskych pravech na zacatku této uZivatelské prirucky. Neni tfeba Zadat o zvlastni
povoleni. LibreOffice Z&da, aby se uZivatelé podileli na projektu LibreOffice ¢asti zisku
z prodeje uzivatelskych pfirucek, a to s ohledem na veskerou préaci, kterou dobrovolnici
LibreOffice vlozili do pfipravy uzivatelskych pfirucek.

Co je nového v LibreOffice 25.8?

Poznamky k vydani LibreOffice 25.8 jsou k dispozici na tomto odkazu
https://wiki.documentfoundation.org/ReleaseNotes/25.8. Na tomto odkazu jsou k dispozici také
poznamky k vydani dfivéjSich verzi LibreOffice, které poskytuji vice informaci o funkcich
obsazenych v LibreOffice.
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Viytvareni vektorové grafiky v LibreOffice



Uvod

Draw je modul pro kresleni vektorové grafiky, ktery je k dispozici jako souc€ast kancelafské sady
LibreOffice. Program Draw slouZi k vytvareni a aktualizaci Sirokého formatu grafickych obrazkd,
véetné rastrové grafiky (pixelll). Vektorova grafika uklada a zobrazuje obrazky jako sestavy
jednoduchych geometrickych prvkd, jako jsou ¢ary, kruZnice a mnohouhelniky, nikoli jako soubor
pixeld (bodd na obrazovce), coZ umoziiuje snadné&jsi ukladani a skalovani obrazkd.

Draw je pIné integrovan do LibreOffice a zjednoduSuje vymeénu grafiky mezi vSemi moduly
LibreOffice. Pokud je obrazek vytvoren v aplikaci Draw, je jeho opétovné pouZiti v dokumentu
Writeru pomérné snadné. Kresbu miiZzeme napftiklad vybrat a zkopirovat v aplikaci Draw a poté
obrazek vlozit pfimo do dokumentu Writer. S kresbami miizeme pracovat také pfimo z programu
Writer nebo Impress pomoci sady funkci a nastrojii z programu Draw.

Funkce Draw jsou rozsahlé, ale nejsou navrzeny tak, aby se vyrovnaly Spickovym grafickym
aplikacim. Draw ma vSak vice funkci nez kreslici nastroje, které jsou k dispozici ve vétSiné
kancelarskych balikd. Nékolik pfikladd kreslicich funkci:

Sprava vrstev

Systém mfizkovych bod( s pfichytavanim

Zobrazeni kétovani a mérnych jednotek

Konektory pro tvorbu organizac¢nich schémat a dalSich diagram
3D funkce pro vytvareni malych trojrozmeérnych vykres(
Integrace kresleni a stylu stranky

Bézierovy kfivky

Uzivatelska pfiru¢ka Draw neni u€ebnici, ale referencni pfiruckou, ktera slouzi jako voditko pfi
tvorbé& grafiky a popisuje funkce spojené s Draw. Nékteré pojmy, jako je sprava soubor( nebo
zpUsob fungovani LibreOffice, jsou zminény struéné, ale podrobnéji se jimi zabyva prirucka
Zaciname s LibreOffice.

Ikona Novy zobrazena na Standardni nastrojové liSté zavisi na tom, ktery modul LibreOffice je
otevien pfi vytvafeni nového dokumentu, prezentace, tabulky nebo kreshby.

}? Poznamky
Po instalaci LibreOffice do pocitace se do systémové nabidky pfida poloZka pro
kazdy modul. Pfesny nazev a umisténi poloZek nabidky zavisi na pouzitém
operacnim systému a uZivatelském rozhrani.

Hlavni okno

Panel stranek

V aplikaci Draw Ize kresby rozdélit na nékolik stranek pomoci vicestrankovych kreseb. Tyto
vicestrankové kresby se obvykle pouzivaji v prezentacich. Podokno Stranky na levé strané
hlavniho okna poskytuje pfehled stranek vytvorenych ve vykresu. Pokud podokno Stranky neni
viditelné, vybereme v hlavni nabidce mozZnost Zobrazit > Panel stranek. Chceme-li zménit
poradi stranek, pfetdhneme jednu nebo vice strdnek zobrazenych v podokné Stranky.

Dokumentace pro LibreOffice je dostupna na https://cs.libreoffice.org/get-help/documentation/



Pracovni plocha

Uprostfed hlavniho okna (obrazek 3 pod) je Pracovni plocha, kde se vytvareji kresby, a je
obklopena nastrojovymi listami a informacnimi oblastmi. Mnozstvi a umisténi nastrojl se lisi
v zavislosti na provadéném ukolu, preferencich uzivatele a nastaveni pocitace.

Soubor  Upravy Zobrazit Wiokit Formdt Strdnka Tvar  Néstroje OQkno  Nipowdda
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Obréazek 3: Hlavni okno Draw

(1) Panel stranek (3) Postranni lista (5) Panel vrstev
(2) Pracovni plocha (4) Stavovy rfadek

Maximalni velikost stranky kresby v aplikaci Draw je omezena nastavenim pocitaCe a velikosti
stranky, kterou Ize nastavit a pouzit v tiskarné pfipojené k pocitaci.

Postranni liSta

Postranni liSta ma v programu Draw pét hlavnich karet a je podobna postranni listé v ostatnich
modulech LibreOffice. Chceme-li otevfit kartu, klepneme na jeho ikonu na pravé strané postranni
liSty nebo klepneme na ikonu Nastaveni postranni liSty v horni Casti postranni liSty a vybereme
kartu v rozeviracim seznamu. Pokud neni postranni lita viditelna, zvolime v hlavni nabidce

Zobrazit > Postranni liSta nebo pouzijeme klavesovou zkratku Ctrl + F5 (macOS 3 + F5).

Vlastnosti

Poskytuje panely postranni liSty, kde se upravuji a aktualizuji vlastnosti vybraného
objektu v kresbé. Dostupné panely zavisi na vybraném objektu, ale jsou nasleduijici:

Stranka Znak Odstavec Obrazek Oblast
Céra Efekt  Stin  Umisténi a velikost  Sloupcl
Styly

Poskytuje moznosti Gprav a pouZiti dostupnych Styl kresby na objekty ve vykresu.
Pokud styl upravime, zmény se automaticky pouZiji na vSechny prvky formatované
pomaoci tohoto stylu. V aplikaci Draw nejsou Styly prezentace k dispozici. Do kresby Ize
pfidat nové styly kresby.

Galerie

Objekty na karté Galerie se do kreshy vloZi bud jako kopie nebo jako odkaz. Do galerie
jsou pfidana nova témata. DalSi informace o pouzivani Galerie najdeme v kapitole 11,
Pokrocilé techniky kresleni. Galerie je rozdélena do nasledujicich témat:
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Sipky BPMN Odrazkovy seznam
Diagramy Vyvojovy diagram Ikony
Sit’ Tvary Zvuky

Navigator

Na karté Navigator se rychle vybiraji strAnky a objekty ve vykresu. Doporucujeme
pouzivat smysluplné nazvy stranek a objektd, které usnadiiuji identifikaci a lokalizaci pfi
pouzivani Navigatoru.

Tvar
{Jmoihuje rychly vybér nékterych polozek dostupnych na nastrojové listé Kresba. Tyto
Tvary jsou k dispozici v nasledujicich dil¢ich nastrojovych listach:
Cary a Sipky Kfivky a mnohouhelniky Spojnice Zakladni tvary
Tvary symbol Blokové Sipky Vyvojovy diagram  Bubliny
Hvézdy a cedule 3D objekty

Stavovy fadek

Stavovy fadek (obrazek 4 pod) je ve vSech modulech LibreOffice umistén ve spodni ¢asti

pracovni plochy. Stavovy fadek skryjeme v hlavni nabidce Zobrazit a zruSime vybér Stavovy
fadek.

}? Poznamka

Mérné jednotky zobrazené ve Stavovém fadku nastavime pomoci Nastroje >
Moznosti > LibreOffice Draw > Obecné (macOS LibreOffice > MoZnosti >
LibreOffice > Obecné) v hlavni nabidce. Tyto mérné jednotky se mohou liSit od
mérnych jednotek nastavenych pro pravitka zobrazend v hlavnim okné Draw.

Cislo snimku (kresby)
Zobrazi Cislo vybraného podokna kresby.

Informaéni oblast
Zobrazuje, ktera akce se provadi, nebo vybrany typ objektu.

Predloha kreshy
Oznacuje pouzivanou predlohu kresby.

Pozice kurzoru/Velikost vybraného objektu
Zobrazuje rizné informace podle toho, zda jsou objekty vybrany nebo ne.

— Pokud neni vybran Zadny objekt, €isla pozic ukazuji aktualni polohu (soufadnice X a Y)
kurzoru.

— Kdyz je objekt vybran a méni se jeho velikost, Cisla velikosti objektu zobrazuji jeho
velikost (Sitku a vysku).

— Pokud je vybran objekt, Cisla polohy zobrazuji soufadnice X a Y levého horniho rohu
a dvojice Cisel velikosti objektu zobrazuje velikost objektu. Tato Cisla se nevztahuji
k samotnému objektu, ale k obrysu vybéru, coz je nejmensi mozny obdélnik, ktery
mUZe obsahovat viditelnou ¢ast nebo ¢asti objektu. Vice informaci nalezneme
v kapitole 3, Prace s objekty a body objekt(.

— Kdyz je vybran objekt, kliknutim do kterékoli z téchto oblasti se otevie dialogové okno
Umisténi a velikost. Dalsi informace najdeme v kapitole 4, Zména atributl objektu.
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Obrazek 4: Stavovy fadek v programu Draw
(1) Cislo snimku (kresby) (5) Velikost vybraného objektu (9) Prizptsobeni kresby
(2) Informacni oblast (6) Méfitko dokumentu (10) Posuvnik méfitka zobrazeni
(3) Pfedloha kresby (7) NeuloZzené zmény (11) Mira priblizeni v procentech
(4) Pozice kurzoru (8) Elektronicky podpis

Méfitko dokumentu
Udava, jak se kresba zobrazi na displeji. Vychozi méfitko je 1:1. Chceme-li zménit

méfritko, klikneme pravym tlacitkem mySi na méritko a v oteviené mistni nabidce
vybereme méfitko.

NeuloZené zmény
Oznacuje, Ze soubor je tfeba ulozit. Zobrazena ikona zavisi na operacnim systému
a nastaveni pocitaCe. Pokud je soubor novy a dosud nebyl uloZen, kliknutim na tuto ikonu
se otevrie dialogové okno Ulozit jako. Pokud byl soubor jiz uloZen, kliknutim na tuto ikonu
se soubor po provedeni zmén automaticky uloZi.

Elektronicky podpis
Oznaduje, zda je dokument digitadlné podepsan. Ikona se zobrazi jen v pfipadé, Ze kresba
ma certifikat digitadlniho podpisu. Po uloZeni souboru se dvojklikem na tuto ikonu otevie
dialogové okno digitalnich podpisl. Dalsi informace o certifikatech digitalniho podpisu
najdeme v ndpoveédé LibreOffice.

Pfizplisobeni kresby
Zmeéni velikost vykresu tak, aby se cely vykres zobrazil v pracovni oblasti.
Posuvnik pfiblizeni | Procento pfiblizeni

Upravuje a oznaCuje zobrazené procento pfiblizeni pracovni plochy. Dvojklikem na
procento priblizeni se otevie dialogové okno Pfiblizeni a rezim zobrazeni.

Stavovy fadek Vrstvy

Vrstva je pracovni prostor, do kterého lze vkladat prvky kresby a objekty. Ve vychozim nastaveni
se Pracovni plocha sklada ze tfi vrstev, které jsou Rozvrzeni, Ovladaci prvky a Koétovaci €ary.
Ve spodni ¢asti pracovni plochy se zobrazuji karty vychozich vrstev. Vychozi vrstvy nelze
odstranit ani pfejmenovat, ale vrstvy Ize pfidavat podle potreby.

Karty pro vrstvy se objevi v liSté Vrstev ve spodni Casti pracovni plochy. Pomoci panelu Vrstvy se
mlZeme pohybovat mezi vrstvami, pfidavat vrstvy podle potfeby nebo odstrarnovat vytvorené
vrstvy. DalSi informace o vrstvach najdeme v kapitole 11, Pokrocilé techniky kresleni.

Pravitka

Pravitka jsou umisténa na horni a levé strané pracovni plochy. Pokud jsou pravitka skrytd,
zvolime v hlavni nabidce Zobrazit > Pravitka nebo pouzijeme klavesovou zkratku Ctrl +
Shift + R (macOS 3 + Shift + R). Pravitka zobrazuji velikost vybraného objektu na strance
pomoci dvojitych €ar (zvyraznéno na obrazku 5 pod).
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Obréazek 5: Priklad pravitek zobrazujicich velikost objektu
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Obréazek 6: Priklad mérnych jednotek pravitka

Na pravitkach jsou znazornény okraje stranky nachazejici se v oblasti kresby. Okraje mizeme
zménit tak, Ze je pfimo na pravitkach pretahneme kurzorem. Oblasti okrajli jsou obvykle
oznaceny Sedou oblasti na pravitkach, ale toto ozna€eni zavisi na nastaveni pocitace

a operacniho systému.

Chceme-li zménit mérné jednotky pravitka, klikneme pravym tlacitkem mysi na pravitko
a vybereme mérnou jednotku z rozeviraciho seznamu, jak je znazornéno na obrazku 6 nad pro
vodorovné pravitko. Méfici jednotky pro vodorovna a svisla pravitka mohou byt rlizné.

Nastrojové listy
Chceme-li zobrazit nebo skryt panely nastroji Draw, vybereme na v hlavni nabidce Zobrazit>
Nastrojové liSty a v podnabidce vybereme poZzadovanou nastrojovou liStu. Napfiklad ve

vychozim nastaveni jsou zobrazeny nastrojové listy Standardni a Kresba, ale nejsou zobrazeny
nastrojové listy Cara a vypli a Formatovani textu.

Vzhled ikon nastrojd na nastrojové listé zavisi na operacnim systému pocitace a vybéru stylu

a velikosti ikony v Nastroje > MoZnosti > LibreOffice > Zobrazeni (macOS LibreOffice >
MozZnosti > LibreOffice > Zobrazeni).
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Nastroje dostupné na nastrojové listé jsou oznaceny bud zvyraznénim kolem ikony nastroje,
nebo zaskrtnutim, jak ukazuje pfiklad na obrazku 7 pod. DalSi informace o praci s nastrojovymi
lisStami najdeme v dodatku B, Nastrojové liSty a v pfiru€ce Zaciname s LibreOffice.

Ctyfi hlavni néstrojové listy pouzité v Draw jsou nasledujici:
Nastrojova liSta Standardni

Nastrojova liSta Standardni (obrazek 8 pod) je podobna pro vSechny komponenty
LibreOffice a neni v této kapitole podrobné popsana. Ve vychozim nastaveni je umisténa

s w7z

v horni ¢asti hlavniho okna Draw.

Nastrojova lista Kresba

Nastrojova lista Kresba (obrazek 9 pod) obsahuje vSechny funkce nezbytné pro kresleni
rlznych geometrickych tvarli a tvari od ruky a pro jejich rozlozeni v kresbé. Ve vychozim
nastaveni je umisténa vlevo od hlavniho okna Draw. Tato nastrojova liSta je podrobné
popsana v kapitole 2, Kresleni zakladnich tvard.

Nastrojova lista Cara a vypln
Nastrojova lista Cara a vyplii (obrazek 10 pod) slouZi k Gpravé hlavnich vlastnosti objektu
kresby. Nastroje a rozeviraci seznamy se lisSi podle typu vybraného objektu. Chceme-li

napfiklad zménit styl ¢ary, klepneme na Sipku u néstroje Styl €ary a posunem nahoru
nebo dold vybereme poZadovany styl.

Funkce nastrojové listy Cara a Vyplii se pouZivaji ke zméné barvy, stylu a Sitky
nakreslené Cary, barvy a stylu vyplné a dalSich vlastnosti vybraného objektu. Pokud je
vybranym objektem textové pole, je nastrojova lista Cara a vyplii nahrazena nastrojovou
liStou Formatovani textu. Dalsi informace nalezneme v kapitole 4 Zména atributd objektu.

Zachytné body w X
N5 EEHIFE | Zichytné bady |
Viditelna tlacitka 3
Prizplsobit li5tu..,
Ukotvit listu  Ctrl+Shift+F10
Ukotvit viechny listy

VioZit zachytny bod
Vystup doleva
Wystup nahoru
Wstup doprava
Zamknout umistér Vystup dold

Zaviit listu Relativni zachytny bod

Zachytny bod vodorowné vievo
Zachytny bod vodorovné uprostied
Zachytny bod vodorovné vprave
Zachytny bod svisle nahofe
Zachytny bod svisle uprostred
Zachytny bod svisle dole
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Obrazek 7: Priklad viditelnych ikon nastrojové liSty na nastrojové listé
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Obrazek 8: Nastrojova lista Standardni
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Obrazek 9: Nastrojova lista Kresba
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Obrazek 11: Nastrojova liSta Formatovani textu

Nastrojova liSta Formatovani textu
Nastrojova liSta Formatovani textu (obrazek 11 nad) je podobny nastrojové listé Format
v aplikaci Writer. Je k dispozici pouze tehdy, kdyz je v kresbé vybran text nebo textovy
objekt, a nahrazuje nastrojovou liStu Céra a vypli. DalSi informace najdeme v kapitole 4
Zmeéna atributd objektu a Kapitola 9 Pfidavani a formatovani textu.

ﬁ Poznamky

Dalsi informace o dostupnych néastrojich, které Ize pfidat na nastrojové listy, najdeme
v dodatku B, Nastrojové liSty a v pfiruCce Zaciname s LibreOffice. Kdyz je nastroj
pfidan na nastrojovou liStu, je jeho pozice na nastrojové listé (zleva doprava) stejna
jako pozice uvedena v mistni nabidce Viditelna tlacitka.

Kdyz se ze sady nastrojll stane plovouci nastrojova lista, na misté nastroje na pevné
nastrojové listé se zobrazuje nastroj, ktery byl pouzit jako posledni. To znamena, Ze
ikona nastroje na obrazovce se mize lisit od ikony nastroje zobrazené v této
pfirucce.

Pfed pouzitim Zamknout liSty nebo Zamknout umisténi liSty se ujistime, Ze jsou
vSechny nastrojoveé listy v okné LibreOffice zakotveny na poZzadovaném misteé.
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V mistnich nabidkach neni k dispozici Zadna indikace vybéru u moznosti Zamknout
nastrojové listy. Indikace uzamceni je zndzornéna pouze Uchyty nastrojove liSty.

Pridavani a odebirani nastroji
Vychozi sadu nastrojl na nastrojové listé Ize pridat nebo odebrat pomoci Viditelna tlacitka
takto:

5) Klepneme pravym tlaCitkem do prazdné oblasti na nastrojové listé nebo na trojuhelnik v
Vv hazvu nastrojove liSty a z mistni nabidky vybereme Viditelna tla€itka, ¢imz se
dostaneme do podnabidky dostupnych nastrojt.

6) Kliknutim na nazev nastroje v podnabidce nastroj pfidame nebo odebereme.

Dostupné sady ndstrojt

Nékteré nastroje na nastrojové listé maji na pravé strané ikony nastroje trojuhelnik v, ktery
oznacuje, Ze nastroj ma dalSi nastroje dostupné na dil¢i nastrojové listé. Kliknutim na tento
trojuhelnik v se otevre paleta nebo dil¢i Nastrojova lista (obrazek 12 pod). Tuto paletu nebo dil¢i
nastrojovou listu Ize zménit na plovouci nastrojovou listu nasledujicim zplsobem:.

7 w7

1) Klikneme na prerusovanou ¢aru v horni ¢asti sady nastrojd.

2) Pfetahneme sadu nastrojl pfes obrazovku na vhodné misto a uvolnénim kurzoru
vytvofime plovouci nastrojovou listu.

3) Pokud chceme plovouci nastrojovou liStu zavfit, klepneme na X vpravo od titulku
nastrojoveé listy.

Tip

Im

Pokud bude nastroj pouzit opakované, dvakrat klikneme na vybrany nastroj. Nastroj
se aktivuje a zlistane aktivni, coz umoziiuje opakované pouziti. Chceme-li rezim
opakovaného pouziti ukoncit, stiskneme klavesu Esc nebo vybereme jiny nastro;.
Poznamka: vySe popsané nemusi fungovat u kazdého nastroje na kazdé nastrojové
liste.
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Obréazek 12: Priklad dostupnych sad nastroji
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Obréazek 13: Priklad uchyt( nastrojové listy

Odemykani a zamykani nastrojovych list
Ve vychozim nastaveni jsou pfi otevieni aplikace Draw dokované nastrojové liSty uzamceny
a predtim, nez se z nich stanou plovouci nastrojoveé listy, je tfeba je odemknout nebo pfemistit do

hlavniho okna. Stav uzamceni nastrojovych list je indikovan teCkovanymi Gchyty na levém konci
vodorovnych nastrojovych list (zvyraznéno na obrazku 13 nad). U svisle umisténych nastrojovych

liSt jsou tyto teCkované Uchyty umistény v horni ¢asti nastrojové listy.

1) Chceme-li nastrojovou liStu odemknout, klikneme pravym tlacitkem mySi do prazdné
oblasti na nastrojové listé a z mistni nabidky vybereme moZznost Zamknout umisténi
liSty. Na konci nastrojové liSty se objevi Uchyt, ktery znamena, Ze nastrojova lista je
odemcena a Ize s ni pohybovat.

2) Chceme-li nastrojovou liStu uzamknout na pozici, ukotvime ji na misto, poté klepneme

pravym tlacitkem do prazdné oblasti nastrojové liSty a v mistni nabidce vybereme
Zamknout umisténi nastrojové listy. Uchyt zmizi z konce néastrojové listy.

)? Poznamka

Pfed odemcenim nebo uzamcenim jednotlivych nastrojovych list se ujistime, Ze jsou
odem&eny VSECHNY nastrojové listy.

Odemykani a zamykani vSech nastrojovych list

VSechny nastrojové liSty dostupné v LibreOffice Ize také uzamknout, coz méa pfednost pfed
individualnim odemykanim a zamykanim nastrojovych list.

Odemknuti nastrojové listy
1) Pfed odem¢enim nebo uzamd&enim vSech nastrojovych list se ujistime, Ze jsou vSechny
dokumenty LibreOffice ulozeny.
2) Chceme-li odemknout vS8echny néastrojové listy, zvolime v hlavni nabidce Zobrazit >
Nastrojové liSty a z mistni nabidky vybereme Zamknout listy.
3) V otevieném varovném hlaSeni vybereme Restartovat nyni a vSechny nastrojoveé listy

Ize nyni jednotlivé odemknout. Uchyty nastrojové listy se zobrazuji na jednotlivych
nastrojovych listach, které NEJSOU jednotlivé uzamceny.

Uzamceni vSech nastrojovych list
1) Chceme-li uzamknout vSechny nastrojové listy, zvolime v hlavni nabidce Zobrazit >
Nastrojové liSty a z mistni nabidky vybereme Zamknout listy.
2) V otevieném varovném hlaseni vybereme Restartovat nyni a vSechny nastrojove listy
jsou nyni uzamc&eny. Uchyty néstrojové listy se jiz nezobrazuji na vSech nastrojovych
listach.
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Uvolnéni nastrojovych list

Ve vychozim nastaveni jsou pfi otevieni aplikace Draw nastrojové liSty Standardni a Kresba
ukotveny do svych pozic v hlavnim okné Draw. Tyto nastrojové liSty a jakoukoli jinou otevienou
nastrojovou listu Ize odemknout a vytvorit tak plovouci nastrojovou listu nasledujicim zplisobem:

1) Ujistime se, Ze je zobrazen Gchyt nastrojové liSty, coZ oznaluje, Ze je nastrojova lista
odemc&ena. Pokud neni zobrazen Zadny Uchyt nastrojové listy, dalSi informace nalezneme
v Céasti ,Odemykéani a zamykéani nastrojovych list* nad a ,Odemykani a zamykani vSech
nastrojovych list* Chyba: zdroj odkazu nenalezen .

2) Pfesuneme kurzor na uchyt nastrojove liSty. Kurzor v zavislosti na nastaveni pocitace
a operacnim systému zméni tvar, obvykle na symbol seviené ruky.

3) Kliknutim a taZzenim za Uchyt nastrojové listy zaCneme liStu pfesouvat, dokud se nezméni
v plovouci nastrojovou liStu. Tato funkce plovouci nastrojové liSty je spole€na pro vsechny
moduly LibreOffice.

Ukotvené nastrojové listy
Pokud chceme ukotvit plovouci nastrojovou listu, pouZijeme jednu z nasledujicich moznosti:

 Stiskneme a podrzime klavesu Ctrl (macOS ) a poté dvakrat klikneme na nazev
nastrojové listy. Nastrojova lista se pfesune do dostupného prostoru v horni ¢asti
hlavniho okna Draw.

» Klikneme na nazev nastrojové liSty a pfetdhneme nastrojovou listu do poZzadované
polohy. MiZe to byt pozice horni, dolni nebo jedna ze stran hlavniho okna Draw.

Prizplisobujeme si nastrojové listy

Nastrojové listy Draw Ize pfizplsobit pfidanim nebo odebranim pfikaz( z nastrojové listy.
Prizplsobeni také umoziiuje vytvaret nastrojové listy pro konkrétni Gcely. Prizplsobeni
nastrojovych list dopliiuje moznosti uvedené vyse v ¢asti ,Pridavani a odebirani nastroji“ na
strané 25. Dal$i informace o pfizplsobeni nastrojovych list nalezneme v dodatku B, Nastrojové
liSty nebo v pfirucce ZaCiname s LibreOffice.

Volba a definovani barev

Barevna paleta

Barevna paleta (obrazek 14 pod) je standardni sada barev, které se pouZzivaji pro objekty a text
v kresbé.

1) Barevnou paletu otevieme pomoci tlacitka Zobrazit na liSté nabidek a vybérem LiSta
barev. Paleta barev se zobrazi v hlavnim okné vedle postranni lity.

2) Vybereme objekt nebo text.

3) Barvu vyplné objektu nebo textu zmeénime tak, Zze klepneme levym tlaCitkem mySi na
poZadovanou barvu.
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Obréazek 14: LiSta barev (Barevna paleta)

4) Klikneme pravym tlacitkem mySi na poZadovanou barvu objektu nebo okraje textového
pole a zménime barvu okraje.

5) LiStu barev zavieme pomoci tlaCitka Zobrazit na liSté nabidek a zruSenim vybéru Lista
barev.

ﬁ Poznamka

Vybér X v levém dolnim rohu palety barev odpovida Zadné barvé objektu, textu nebo
ramecku.

Specializované palety barev

Kromé barevné palety ma Draw nékolik specializovanych barevnych palet, které umoznuji vybér
barev pro objekty a text; napfiklad palety grafl, obdélnik(, Sipek atd. Po vybéru objektu nebo
textu ve vykresu pouzijeme jednu z nasledujicich moznosti pro pfistup ke specializovanym
paletdm barev.

* Pro barvu oblasti nebo vypIné pouzijeme stranku Barva v dialogovém oknu Oblast,
Barva vyplné na nastrojové listé Kresba nebo Cara a vyplfi nebo Vyplr v panelu Oblast
na panelu Vlastnosti v postranni listé.

« Pro barvu ¢ary pouzijeme stranku Céra v dialogovém oknu Céra, Barva &ary na
nastrojové listé Kresba nebo Céra a vyplih nebo Barva v sekci Cara na panelu Vlastnosti
v postranni listé.

* Pro barvu textu pouzijeme nastroj Barva pisma na nastrojové listé Forméatovani textu
nebo Barva pisma na panelu Znak na bo¢nim panelu Vlastnosti v postranni liSté.

Dalsi informace o vybéru barvy a palety barev pro objekt nebo text najdeme v kapitole 4, Zména
vlastnosti objektu, v kapitole 9, Pfidavani a formatovani textu a v kapitole 11, Pokrocilé techniky
kresleni.

Vlastni barvy

V aplikaci Draw lze vytvaret vlastni barvy pomoci dialogového okna Vybér barev, hodnot CMYK
nebo RGB, aby odpovidaly pouzitym barevnym schématlim, napfiklad firemnimu barevnému

v e

RGB a HSB najdeme v kapitole 11, Pokrocilé techniky kresleni.
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Mrizka, voditka a pomocné ¢ary

MFiZka, voditka a pomocné ¢ary v aplikaci Draw slouzi jako pomdicky pro kresleni pfi pfesouvani
a umistovani objektll na vykresu. Tyto pomUcky pro kresleni Ize zapnout nebo vypnout pomoci
jedné z néasledujicich moznosti:

+ Nastrojova lista Cara a vypli kliknutim na Zobrazovat mfizku nebo Voditka pFi
pfesouvani zapneme nebo vypneme mrizku nebo voditka.

* Pro nastrojovou lista Moznosti kliknutim na Zobrazovat mfizku, Zobrazit voditka nebo
Voditka pFi pfesouvani zapneme nebo vypneme mfizku, voditka nebo pomocné Cary.

* V hlavni nabidce Zobrazit > Mfizka a voditka v podmenu zvolime nebo zruSime volbu

Zobrazovat mfizku nebo Voditka pfi pfesouvani.

* V hlavni nabidce zvolime Zobrazeni > Voditka a vybereme nebo zruSime vybér
v podnabidce Zobrazit voditka.

MFizka a voditka se zobrazuji pouze na obrazovce a nezobrazuji se na vytiSténé kreshé nebo pfi
pouziti kresby v jiném modulu LibreOffice. Barvu, rozte¢ a rozliseni bodd mrizky Ize individualné
zvolit pro kazdou osu. Aplikace Draw ma také nékolik funkci pfichyceni, které umoznuji pfesné
umisténi objektd na kresbé.

Voditka zobrazuji polohu objektu pfi pohybu a vyrazné usnadriuji umisténi objektu. Pokud je tato
funkce aktivovana, budou se pfi pohybu objektu zobrazovat dvojice svislych a vodorovnych ¢ar
obklopujicich objekt. Tyto voditka sahaji az k okrajlim oblasti kresleni.

Dalsi informace o mfiZce, voditkach, funkcich pfichyceni a pomocnych linkach nalezneme
v kapitole 3, Prace s objekty a body objekt(.
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Uvod

Program Draw se pouziva k vytvareni 2D a 3D objektll. Tato kapitola vysvétluje, jak vytvaret 2D
objekty. Vice informaci o 3D objektech najdeme v kapitole 7, Prace s 3D objekty. VSechny
obdélniky, Cary a tvary se nazyvaji objekty, coz je bézné oznaceni ve vektorovém kreslicim
softwaru.

Casto pouzivané kreslici nastroje se nachazeji na nastrojové listé Kresba (obrazek 15 pod) a
jsou obvykle umistény na levé strané hlavniho okna. Pokud nastrojova lista neni viditelnd,
pfejdeme na Zobrazeni > Nastrojové liSty v hlavni nabidce a z dostupnych mozZnosti vybereme
Kresba. Nastrojovou listu Kresba Ize odemknout a pouzivat jako plovouci nastrojovou liStu.
Nastrojovou listu Ize také konfigurovat pridanim, presunutim, skrytim nebo odstranénim nastrojd.
Informace nalezneme v kapitole 1, Uvod do aplikace Draw.

Kresleni zakladnich tvaru

Zakladni tvary, vCetné textu, jsou v programu Draw povazovany za objekty. Vychozi sada
nastroji pro kresleni zakladnich tvar(i na nastrojové listé Kresba je zobrazena na obrazku 15
pod. Informace o pfidani dalSich nastrojii na nastrojovou listu Kresba nalezneme v Dodatku B,
Nastrojové listy a v pfiruc¢ce Zac¢iname s aplikaci Draw.

Ne&které ikony nastrojii na nastrojové listé Kresba méni tvar podle posledniho pouzitého nastroje
z vybéru dostupnych nastroji. Kazdy nastroj s trojihelnickem v vedle jeho ikony informuje, Ze
jsou k dispozici dalSi nastroje. Informace o dostupnych tvarech najdeme v Casti ,Kresleni
geometrickych tvar(“ na strané 16.

PTi vytvareni tvaru, vybéru objektu k Gpravé nebo pridani textu do kresby se informacni pole ve
stavovem fadku (obrazek 16 pod) zmeéni tak, aby odrazelo provedenou nebo probihajici akci.
Informace o stavovém fadku nalezneme v kapitole 1, Uvod do programu Draw.

ﬁ Poznamka

Kdyz je nakreslen zakladni tvar nebo je vybran k Gpravam, zméni se informacni
oblast na levé strané ve Stavovém fadku tak, aby odréZela aktualni akci. Napriklad
Vytvofeny Ffadek, Vybrany textovy ramecek xxyy atd.

Kresba v X
% ﬁvﬁﬁv\[l{::‘ _’vrgvi.v
C~O~=-B-I- -~

Obrazek 15: Nastrojova lista Kresba

® ) @
P’ ;
Snimek 2 z 3 (RozvrZeni) Vybrano Obréazek s prihlednosti Vychozi -—
\—> S287/660 = 5,66 x 3,86 11 8 [ =+ 100%
A A A A A A A A
® ® OO ©® @
Obrazek 16: Stavovy radek v programu Draw
(1) Cislo snimku (kresby) (5) Velikost vybraného objektu (9) Prizptsobeni kresby
(2) Informacni oblast (6) Méfitko dokumentu (10) Posuvnik méfitka zobrazeni
(3) Predloha kresby (7) Neulozené zmény (11) Mira priblizeni v procentech

(4) Pozice kurzoru (8) Elektronicky podpis

Dokumentace pro LibreOffice je dostupna na https://cs.libreoffice.org/get-help/documentation/
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Obrazek 17: Karta Tvary na postranni listé

ﬁ Poznamky

Pokud je v hlavni nabidce zvolena moZnost Zobrazit > Voditka > Pfichytit k mfiZce,
podrZeni klavesy Ctrl (macOS ) pfi kresleni pfimé ¢ary doCasné deaktivuje

Ny

moznost Pfichytit k mfiZce.
Pokud je zvolena moznost P¥i vytvaFeni nebo pfesunu objektd v ¢asti Omezit

objekty v nabidce Nastroje > MozZnosti > LibreOffice Draw > Mfizka (macOS
LibreOffice > Pfedvolby > LibreOffice Draw > M¥izka), podrzeni klavesy Shift

doCasné deaktivuje toto omezeni.

Program Draw klasifikuje ¢ary i Sipky jako Cary a vytvari je stejnym zplisobem jako
primky. Pfejetim kurzoru nad kazdym néastrojem v dil&i nastrojové listé Cary a Sipky
(Obrazek 22 na strané 36) nebo na panelu Cary a Sipky na karté Tvary na postranni
liSté se zobrazi, jaky typ ¢ary nebo Sipky kazdy nastroj kresli. Informacni pole ve
Stavovém fadku je zobrazuje pouze jako cary.

Vytvareni Car
Pfimka je nejjednodussim prvkem nebo objektem, ktery Ize pomoci aplikace Draw vytvorit.
6) Nakreslime ji jednou z nasledujicich metod.
— Klepneme na ikonu Vlozit €aru na nastrojové listé Kresba (obrazek 15 nad).

— Na néastrojové listé Kresba klepneme na trojuhelnik v vedle ikony Cary a Sipky
(obrazek 15 nad) a z nabizenych moznosti vybereme Vlozit Caru.

— Klepneme na moznost Vlozit &aru na karté Cary a Sipky na karté Tvary v postranni
listé (obrazek 17 nad).
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Obrazek 18: Priklad pocCatec¢niho bodu Fadku
(zvyraznéno)

7) Umistime kurzor do pocatecniho bodu kresby, poté klepnutim a taZzenim kurzoru
nakreslime rovnou Caru.

8) Po dosazeni pozadované délky ¢ary uvolnime kurzor a vytvori se pfimka. Na konci
kazdého fadku se zobrazi Gchyt vybéru. Uchyt vybéru v poCatecnim bodé €ary je o néco
vetSi nez uchyt vybéru v koncovém bodé (zvyraznéno na obrazku 18 nad).

9) Pokud chceme pfichytit konce pfimky k nejblizSimu bodu mfizky, pfidrzime pfi kresleni
primky klavesu Ctr1 (macOS ). Toto je vychozi chovani klavesy Ctrl (macOS 3).

10) Pokud chceme omezit Ghel kresleni pifimky na nasobky 45 stupiiti (0, 45, 90, 135 atd.),
podrzime pfi kresleni pfimky stisknutou klavesu Shift. Toto je vychozi chovani klavesy
Shift.

11) Pokud chceme nakreslit pfimku symetricky smérem ven v obou smérech od pocatecniho
bodu, podrzime stisknutou klavesu Alt (macOS ~\2) a nakreslime pfimku od stfedu Cary.

Formatovani ¢ar
Pfi kresleni ¢ary se pouzivaji vychozi atributy stylu ¢ary, barvy ¢ary, Sitky ¢ary a prdhlednosti.
Zména nékterého z t&chto atributd podle pozadavk( na kresbu je nasledujici:
1) Klepnutim na pfimku zobrazime Uchyty pro vybér.
2) Chceme-li formatovat styl ¢ary, barvu ¢ary, Sitku ¢ary nebo prihlednost, vybereme
dostupnou moZznost pomoci jedné z nasledujicich metod:
— Klepnutim na Gchyt vybéru ¢ary a jeho pretazenim mizeme délku ¢ary zvétsit nebo
zmensit.
— Pomoci volby Format > Céra v hlavni nabidce otevieme dialogové okno Céra
(obrazek 19 pod).
— Pouzijeme nastroje Styl éary, Sirka €ary a Barva ¢ary na nastrojové list& Céara a
vypli (obrazek 20 pod).
3) Pravym tlacitkem mysi klikneme na &aru a z kontextové nabidky zvolime Céara..., &imZ
otevieme stejnojmenny dialog.
4) Otevieme panel Cara na karté Vlastnosti v postranni li§té (obrazek 21 pod).
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Cara X
Cara  Stin  Stylycar  Styly Sipek
Vlastnosti éary Styly roh( a zakoné&eni
Styl: _ Styl rohu: ‘Zakulacen{; v ‘
Barva: B Tmavé modrs 1 - Styl zakoncent: [Ploché v|
Tloustka: 0,00 cm B
Prihlednost: 0 % =
Styly Sipek
Styl zacatku: |- Z2adna - v Styl konce: - Zadna - ~
Sitka: 0,20 cm = Sitka: 0,20 cm =
Na stred Na stred
Synchronizovat zakonceni
MNapovéda Obnovit Zrudit
Obrézek 19: Dialogové okno Céra — strénka Céra
Cara a wplri v X
- ~ 0,00 cm T L~
Barva ~ | rf 0 =~ fd~ A | B =

Obrazek 20: Nastrojova lista Cara a vyplri

i Vlastnosti 2 x =

Znak Y

Odstavec =

I=| Cara M %ﬁ’
Cara: - b=
Tloustka: - @
Barva: = I ~ E@
Priihlednost: 0 % B
Styly Sipek:

Umisteéni a velikost Y

Obrézek 21: Panel Céra na karté Vlastnosti v
postranni listé
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Vytvareni Sipek
1) K vytvoreni Sipky pouZijeme jednu z nasledujicich moznosti:

a) Vybereme pozadovany typ ¢ary nebo Sipky na panelu Céry a Sipky na karté Tvary na
postranni listé (obrazek 17 na strané 33).

b) Klepneme na trojuhelnik v vedle ikony Céry a Sipky na nastrojové listé Kresba a
vybereme pozadovany typ ¢ary a Sipky z moznosti na dilCi nastrojové listé Céary a Sipky
(obrazek 22 pod).

2) Umistime kurzor do pocatecniho bodu Cary nebo Sipky, poté klepneme a prfetdhneme
kurzor. Styly Sipek jsou nakresleny na koncich €ary az po jejim dokonceni.

3) Dalsi informace o vytvareni €ar a Sipek najdeme v ¢asti ,Vytvareni ¢ar* na strance 33.

Formatovani Sipek
1) Vice informaci o formatovani ¢ary pouzité pro Sipku najdeme v ¢asti ,Forméatovani ¢ar" na
strance 34.
2) Formatovani obou koncl Sipky stejnym stylem:
a) Vybereme Sipku, zobrazi se jeji uchytky.

b) V hlavni nabidce zvolime Format > Cara nebo klepneme pravym tlagitkem mysi a tim
otevieme dialogové okno Cara (obrazek 19 na strané 35).

Cary a sipky w X

Obréazek 22: Dil¢i nastrojové listy Cary a Sipky

Cara X
Céra  Stin  Styly éar  Styly Sipek
Spravovat styly Sipek
Styl Gipky: 14
MNazev stylu:  Kratka Sipka

Pridat

Prejmenovat

Smazat

< > NN

Napovéda Obnovit Zrudit

Obréazek 23: Dialogové okno Céra — strénka Styly Sipek
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c) Klepnutim na Styly Sipek otevieme stranku Styly Sipek v dialogovém okné Cara
(obrazek 23 nad) a vybereme styl Sipky z dostupnych moznosti v rozeviracim seznamu
Styly Sipek.

d) Kliknutim na OK aplikujeme styl Sipky a zavieme dialogové okno Céra.
e) Kliknutim do prdzdného mista na vykresu zruSime vybér Sipky.
3) Formatovani koncl Sipky odliSnymi styly:
a) Vybereme Sipku, zobrazi se jeji uchytky.
b) Otevieme panel Cara na karté Vlastnosti v postranni li§t& (obrazek 21 na strané 35).
c) Na panelu Cara klepneme na Sty! Sipky a tim otevieme rozeviraci seznam styld Sipky.

d) Na nastrojové listé Cara a vyplii (obrazek 20 na strané 35) vybereme pro pocatecni
bod Sipky styl Sipky z levého seznamu styl Sipky.

e) Na néastrojové listé Cara a vyplil (obrazek 20 na strané 35) vybereme pro koncovy bod
Sipky styl Sipky z pravého seznamu styl( Sipky.

f) Kliknutim do prazdného mista na vykresu zruSime vybér Sipky.

}? Poznamka

Moznost vybéru rliznych styld Sipky na kazdem konci Sipky neni ve verzi systému
macOS k dispozici na panelu Cara na karté Vlastnosti v postrannim panelu.

Obdélniky nebo ¢tverce
1) Kresleni obdélniku nebo Etverce zaCneme jednou z nasledujicich moznosti:
— Na néstrojové listé Kresba klepneme na ikonu Obdélnik.

— Vybereme typ obdélniku nebo &tverce v panelu Zakladni tvary na karté Tvary v
postranni li5té (obrdzek 17 na strané 33).

— Klepnutim na trojuhelnik v vedle ikony Zakladni tvary na nastrojové listé Kresba
(obrazek 15 na strané 32) a ze zobrazené nabidky vybereme obdélnik nebo &tverec.

— Na néstrojové listé Dfivejsi obdélniky vybereme typ obdélniku nebo &tverce (obrazek

vvvvvv

nabidce do Zobrazeni > Nastrojové liSty a vybereme je;.

2) Umistime kurzor na pocatecni bod obdélniku nebo ¢tverce, poté klepneme a tAhneme
kurzorem, dokud nebude nakreslen obdélnik nebo ¢tverec poZadované velikosti.
Obdélnik nebo ¢Etverec se vykresluji od vychoziho levého horniho vrcholu, poloha
pravého dolniho vrcholu je urena kurzorem.

3) Pro nakresleni obdélniku nebo Ctverce pouZzijeme v pfipadé potfeby jednu z nasledujicich
moznosti:

— Pokud je vybrana kresba obdélnika a podrZime stisknutou klavesu Shift, nakreslime
Ctverec.

Diiv&jéi obdélniky v X
O[O0 = F & [

Al

Obrazek 24: Nastrojova lista Drivéjsi obdélniky
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Je-li vybrana kresba obdélnika a podrzime stisknutou klavesu Alt, budeme obdélnik
kreslit od stfedu.

Je-li vybrana kresba obdélnika a podrzime stisknuté klavesy Shift a Alt, budeme ze
stfedu kreslit Ctverec.

Pokud je vybrana kresba ¢tverce a podrzime stisknutou klavesu Shift, budeme kreslit
obdélnik.

Je-li vybrana kresba Ctverce a podrzime stisknutou kldvesu Alt, budeme &tverec
kreslit od stredu.

/? Poznamka

Pokud je vybrana moznost Pfi vytvareni nebo presunu objektll v ¢asti Omeazit
objekty v nabidce Nastroje > Moznosti > LibreOffice Draw > Mfizka (macOS
LibreOffice > MoZnosti > LibreOffice Draw > Mfizka), je funkcionalita klavesy
Shift obracena. Misto obdélniku je nakreslen &tverec. Podrzenim klavesy Shift se
vykresli obdélnik. Obraceny ucinek klavesy Shift plati také pro elipsy, kruZnice,

oblouky a usecky.

Elipsy nebo kruhy
1) K zahajeni kresleni elipsy nebo kruznice pouzijeme jednu z nasledujicich moznosti:
— Na nastrojové listé Kresba klepneme na ikonu Elipsa.

— Na karté Tvary postranni liSty vybereme typ obdélnika nebo ¢tverce v panelu Zakladni
tvary (obrazekl17 na strané 33).

— Klepneme na trojuhelnik v vedle ikony Zakladni tvary na nastrojové listé Kresba
(obrdzek 15 na strané 32) a z rozeviraciho seznamu vybereme pozZadovanou elipsu
nebo kruh.

vvvvvv

~r wrws

hlavni nabidce na Zobrazeni > Nastrojové liSty a vybereme jej.

2) Umistime kurzor do pocate€niho bodu elipsy nebo kruhu, poté klepneme a tAhneme
kurzorem, dokud nenakreslime tvar o poZadované velikosti. Elipsa nebo kruh se
vykresluji v pravouhelniku od vychoziho bodu do dolniho pravého rohu uréeného polohou
kurzoru.

3) V pripadé potfeby pouZijeme pfi kresleni elipsy nebo kruhu jednu z nasledujicich
MOoZnosti:

Podrzime-li pfi kresbé elipsy klavesu Shift, nakreslime kruh.

Podrzime-li pfi kresbé elipsy klavesu Alt budeme elipsu kreslit od stfedu.

Pokud kreslime elipsu a sou€asné stiskneme klavesy Shift a Alt, nakreslime od
stfedu kruh.

Podrzime-li pfi kresbé kruhu klavesu Shift, nakreslime elipsu.

Dfiv&jé kruhy a ovaly v X
|f_:_| I_/I |117 I-|7 |i> I_\‘m z\ |_| z]—. |L. :\> | - |

L A Ll ol e

vvvvvv

Podrzime-li pfi kresbé kruhu klavesu Alt, budeme jej kreslit od stfedu.
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Pro rychlé vloZeni objektu stiskneme a podrzime klavesu Ctrl (macOS 38) a poté
klepneme na nastroj objektu na nastrojové listé Kresba (obrazek 15 na strané 32).
Objekt standardni velikosti vybraného objektu se automaticky vykresli do stfedu
pracovni plochy. Pouzita velikost, tvar a barva jsou ve vychozim nastaveni. Tato
nastaveni Ize zménit podle pozadavkd kresby. Dalsi informace najdeme v kapitole 4,
Zmeéna atributd objektu.

Kétovaci ¢ary
Kotovaci ¢ary zobrazuji rozméry objektu v kresbé, jak ukazuje pfiklad na obrazku 26 pod.
Kotovaci ¢ara nepatii k objektu, ale je umisténa v jeho blizkosti. Objekt mdze mit tolik kétovacich

¢ar, kolik je potieba k vyznaceni rozmérd celého objektu.

3.98 cm

- b
7.5cm |
Obrazek 26: Priklad kétovacich Car objektu
Kétovaci éara X
Cara Legenda
Vzdélenost ¢ary: 0,80 cm % Umisténi textu
Previs voditka: 020 cm = @ T
Vzdalenost voditka: 0,10 cm = ®
Levé voditko: 0,00 cm = -
Pravé voditko: 0,00 cm = @ Automaticky svisle
[J Méfit pod objektem @ Automaticky vodorovné
Desetinna mista: 2 2 @ Rovnobéiné s carou
8 Zobrazit mémé jednotky
) 140,72 mm )
|
OK Zrusit

s w7z

Obréazek 27: Dialogové okno Koétovaci ¢ara

s w7z s >z

Pokud chceme formatovat zobrazeni kétovaci €ary a jejich soucasti, klepneme na kétovaci ¢aru
pravym tlaCitkem mysi a vybérem moZznosti Kétovani z mistni nabidky otevieme dialogové okno

7 w7z

Kotovaci Cara (obrazek 27 nad).
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ﬁ Poznamka
Mérné jednotky pouZzivané pro koétovaci ¢ary Ize zmeénit. V hlavni nabidce zvolime

Nastroje > MoZnosti > LibreOffice Draw > Mfizka > Obecné (macOS LibreOffice

vy

> Pfredvolby > LibreOffice Draw > Mfizka > Obecné) a vybereme mérnou jednotku
z dostupnych moznosti v rozeviracim seznamu Mérné jednotky.

Tip
Pro pfesné umisténi kétovacich €ar na objektu se doporucuje pouzivat vodorovné a

svislé vodici ¢ary. Doporucuje se také pouzit volbu Prichytit k mfiZzce pro presné
umisténi objektl a kétovacich car.

8

1) Pro zahdjeni kresleni kétovaci ¢ary pouzijeme jednu z nasledujicich metod:
— Na nastrojové listé Kresba klikneme na trojuhelnik ¥ vpravo od ikony Cary a Sipky a z

s ¥z

nabidky zvolime Kétovaci €ara.
— Klepneme na Kétovaci ¢ara na panelu Cary a Sipky na kart& Tvary v postranni listé.
2) Umistime kurzor do bodu v blizkosti objektu, abychom umistili poCatek kétovaci Cary.

3) Klepnutim a tazenim nakreslime kétovaci ¢aru. P¥i kresleni kétovaci ¢ary se kéta zobrazi
a automaticky vypocita.

4) VVybereme koétovaci Caru, klikneme na ni pravym tlacitkem mysi a z kontextové nabidky
zvolime pro zobrazeni dialogu Kétovaci ¢ara Kétovani....

5) Kétovaci ¢aru formatujeme pomoci moznosti dostupnych v dialogovém okné Koétovaci
¢ara. Vice informaci o moznostech kétovaci ¢ary najdeme v kapitole 11, Pokrocilé
techniky kresleni.

6) Kliknutim na tlacitko OK uloZime zmény a zavieme dialogové okno Kotovaci ¢ara.

7) Kliknutim do prazdného mista na vykrese zruSime vybér kétovaci Cary.

Kruhové vysece, UsecCe a oblouky
1) Pro zahajeni kresleni oblouku nebo Gsecky pouzijeme jeden z nasledujicich postupt:

— Vybereme typ oblouku nebo segmentu v panelu Kfivky a mnohouhelniky na karté
Tvary v postranni listé (obradzek 17 na strané 33).

— Klepneme na trojuhelnik v vedle ikony Zakladni tvary na nastrojové listé Kresba
(obrdzek 15 na strané 32) a z rozeviraciho seznamu vybereme pozadovany typ
oblouku nebo Usecky.

vvvvvv

vvvvvv

prejdeme v hlavni nabidce na Zobrazeni > Nastrojové liSty a vybereme jej.

2) Klepnutim a pfetaZzenim kurzoru zacneme vytvaret oblouk nebo Usecku. Tlacitko mysi
uvolnime, ma-li objekt pozadovanou velikost.

3) Pfesuneme kurzor na misto, kde oblouk nebo Usec zac¢ina a klepnutim zacneme kreslit
oblouk nebo Uset. Stavovy Fadek udavéa uhel ve stupnich.

4) Presuneme kurzor na misto, kde oblouk nebo Usec€ konci. Stavovy fadek zobrazuje thel
ve stupnich.

5) Opétovnym klepnutim dokon&ime kresleni oblouku nebo Gsece.
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KFivky
1) Vybereme pozadovany typ kfivky pomoci jedné z nasledujicich moznosti:

— Klepneme na trojuhelnik v vedle ikony Kfivky a mnohouhelniky na nastrojové listé
Kresba (obrazek 15 na strané 32) a z rozeviraciho seznamu vybereme typ kfivky.

— Vybereme typ kfivky v panelu Kfivky a mnohouhelniky na karté Tvary v postranni
listé (obrazek 17 na strané 33).

2) Kliknutim, podrZzenim a pretazenim kurzoru z pocatecniho bodu nakreslime Caru.
3) Tlac¢itko mysi uvolnime a pohybem kurzoru zakfivujeme ¢aru do poZzadovaného tvaru.
4) Klepnutim nastavime kfivku a umistime koncovy bod kfivky do kresby.

5) PokraCujeme v tazeni kurzoru a nakreslime rovné ¢ary na konci krivky. Kazdé kliknuti
nastavi rohovy bod a umozni nakreslit z kazdého rohového bodu dalSi pfimku.

6) Poklepanim ukoncime kresleni kfivky a pfimych Car.

ﬁ Poznamka

Vyplnéna kfivka a vyplnény mnohouhelnik automaticky spoji posledni bod s prvnim
bodem uzavirajicim objekt. Vybrany typ vypIné pak vypIni objekt. Kfivka nebo
mnohouhelnik bez vyplné neni na konci kresby uzavren.

Mnohouhelniky

1) Vybereme poZadovany typ mnohouhelniku pomoci jedné z nasledujicich moZnosti:

— Klepneme na trojuhelnik v vedle ikony Kfivky a mnohothelniky na nastrojové listé
Kresba (obrazek 15 na strané 32) a z rozeviraciho seznamu vybereme typ kfivky.

— Vybereme typ kfivky v panelu K¥ivky a mnohothelniky na karté Tvary v postranni
listé (obrazek 17 na strané 33).

2) Klikneme, podrzime tlaCitko mySi a kurzor pfetdhneme z prvniho do druhého vrcholu
mnohouhelnika.

3) DalSim kliknutim ukon&ime kresleni mezi prvnim a druhym vrcholem mnohouhelnika.

4) Presunutim kurzoru kreslime dalSi stranu a kliknutim vytvofime dalSi vrchol
mnohouhelnika. Kazdé kliknuti vytvari dalSi vrchol a stranu mnohouhelnika.

5) Poklepanim ukon&ime kresleni mnohouhelniku.

Mnohouhelniky 45°

Jsou stejné jako obyc&ejné mnohouhelniky vytvareny z €ar, ahly mezi Carami jsou vS8ak omezeny
na 45 nebo 90 stupnid. V pripadé potieby podrZzime pfi kresleni ¢ary stisknutou klavesu Shift a
tim zajistime, Ze je ¢ara nakreslena pod Ghlem 45 nebo 90 stupiili.

Cary od ruky

Prace s nastrojem je podobna kresleni tuzkou po papiru.

1) Klepneme, podrzime kurzor a pretahneme jej na pozadovany tvar ¢ary, poté jej uvolnime
a dokonc¢ime kresleni volné cary.

2) Pokud je vybrana moznost Cara od ruky, vyplnéna, posledni bod se automaticky spoji s
pocatecnim bodem a objekt je vyplnén vybranou vyplni.
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ﬁ Poznamka

Body v kfivkach, mnohouhelnicich a ¢arach od ruky Ize pfesouvat a upravovat. Vice
informaci najdeme v kapitole 3, Prace s objekty a v kapitole 11, Pokrocilé techniky
kresleni.

Zachytné body a spojnice

Zachytné body

VSechny objekty Draw maji zachytné body, které se normalné nezobrazuji a zviditelni se pouze
tehdy, kdyZ je na nastrojové listé Kresba vybran nastroj Spojnice nebo je vybran nastroj spojnice
na panelu Spojnice na karté Tvary na postranni liSté.

Vétsina objektll ma ¢tyfi zachytné body, jak je znazornéno na pfikladu na obrazku 28 pod. Dalsi
zachytné body Ize pridat a pfizpUsobit pomoci nastrojové listy Zachytné body (obrazek 29 pod).
V hlavni nabidce zvolime Zobrazeni > Nastrojové liSty > Zachytné body a otevieme
nastrojovou listu.

Zachytné body nejsou totéZ co tchytky vybraného objektu. Uchytky vybéru slouzi k pfesunuti
nebo zméné tvaru objektu. Zachytné body se pouzivaji k pfichyceni nebo pfilepeni spojnice k
objektu tak, aby pfi pohybu objektu zlstala spojnice k objektu pfichycena. Podrobnéjsi popis
pouziti zachytnych bod(l najdeme v kapitole 3, Prace s objekty, nebo v kapitole 8, Spojeni,
vyvojové diagramy a organizacni schémata.

Spojnice

Spojnice jsou €ary nebo Sipky, jejichZz konce se automaticky prichyti k lepenému bodu objektu.
Spojnice ale nejsou totéZ co ¢ary a Sipky. Pfi pfesouvani nebo zméné usporadani objekt(
zUstavaji spojnice prichyceny k zachytnym bodlm. Obrazek 30 pod ukazuje priklad dvou objektd
a spojnic mezi objekty.

Aplikace Draw ma nékolik réiznych spojnic a funkci spojnic. Na nastrojové listé Kresba klepneme
na trojuhelnik v vedle ikony Spojnice a vybereme typ spojnice z rozeviraciho seznamu nebo
vybereme spojnici z panelu Spojnice na karté Tvary v postranni li5t€. PodrobnéjSi popis pouziti
spojnic najdeme v kapitole 8, Spojnice, vyvojové diagramy a organizacni schémata.

Obrazek 28: Priklad zachytnych bod(i
objektu
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Zachytné body v X
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Obrazek 29: Nastrojova lista Zachytné body

i

| =

Obrazek 30: Priklad spojnic mezi objekty
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Obrazek 31: Priklad vytvoreni plovouci dil¢i nastrojové listy

Kresleni geometrickych tvari

Nastroje pro kresleni geometrickych tvar(i najdeme na nastrojové listé Kresba (obrazek 15 na
strané 32) a na karté Tvary v postranni listé (obrazek 17 na strané 33). Pouziti t&chto nastroj
pro geometrické tvary je podobné jako pouziti nastrojli pro kresleni obdélnikd a ¢tvercl nebo
elips a kruh(. Dal$i informace nalezneme v ¢asti ,Hlavni okno“ na strance 18.

Klepnutim na trojuhelnik napravo od ikony nastroje na nastrojové listé Kresba se otevie
rozeviraci seznam, ktery umoziiuje pfistup k sadé nastrojli pro dany tvar. V pfipadé potieby Ize
tento rozeviraci seznam ,odtrhnout” a vytvofit tak plovouci dil¢i nastrojovou liStu.
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* Klepneme a podrzime prerusovanou ¢aru v horni ¢asti sady nastrojd (zvyraznéna na
obrazku 31 nad), poté ji pfetAhneme pFes obrazovku na pracovni plochu a uvolnime,
¢imz vytvofime plovouci diléi nastrojovou listu.

» Pokud chceme zavfit plovouci dili nastrojovou liStu, klepneme na X vpravo od nazvu
dilci nastrojové listy.
3D objekty

Klepnutim na trojuhelnik v vpravo vedle ikony 3D Objekty na nastrojové listé Kresba otevieme
dil¢i nastrojovou listu 3D Objekty (obrdzek 32 pod). Pfipadné vybereme poZzadovany nastroj z
panelu 3D Objekty na karté Tvary v postranni listé.

Zakladni tvary

Klepnutim na trojuhelnik v vpravo vedle ikony Zakladni tvary na nastrojové listé Kresba
otevFeme d|’|é|’ néstrojovou Iiétu Zékladm’ tvary (obrézek 33 pod) Tato dilél' néstrojové liSta

nastrojové listé Kresba. Pfipadné vybereme pozadovany nastroj z panelu Zakladni tvary na
karté Tvary v postranni listé.

Blokové Sipky

Klepnutim na trojuhelnik v vpravo vedle ikony Blokové Sipky na nastrojové listé Kresba
otevieme dil¢i nastrojovou listu Blokové Sipky (obrdzek 34 pod). Pfipadné vybereme pozadovany
nastroj z panelu Blokové Sipky na karté Tvary v postranni liSté.

3D objekty v X
POoO@® & OO

Obréazek 32: Dilci nastrojova liSta 3D objekty

ﬁ Poznamka

Dil&i nastrojova lista 3D objekty je totoZzné s nastrojovou listou 3D objekty, ktera je k
dispozici v hlavni nabidce pod volbou Zobrazeni > Nastrojové listy.

Zakladni tvary v X
JO00Ovyo0scoCa
&BO’““DO 10 0,0 © N

Obrazek 33: Dil¢i nastrojova lista Zakladni tvary
Blokoveé &ipky w X
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Obrazek 34: Dil¢i nastrojova liSta Blokové Sipky
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Bubliny v X
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Obrazek 35: Dilci nastrojova lista Bubliny

Bubliny

Klepnutim na trojuhelnik ¥ vpravo vedle ikony Bubliny na nastrojové listé Kresba otevieme dilCi
nastrojovou listu Bubliny (obrazek 35 nad). Pfipadné vybereme poZadovany nastroj z panelu
Bubliny na karté Tvary v postranni liSté.

Vyvojové diagramy

Klepnutim na trojuhelnik v vpravo vedle ikony Vyvojovy diagram na nastrojové listé Kresba
otevieme dilci nastrojovou liStu Vyvojovy diagram (obrazek 36 pod) pro symboly. Pfipadné
vybereme poZadovany nastroj z panelu Vyvojovy diagram na karté Tvary v postranni listé. DalSi
informace o tvorbé vyvojovych diagramd, organizacnich schémat a podobnych planovacich
nastrojli nalezneme v kapitole 8 Spojnice, vyvojové diagramy a organizaéni schémata.

Hvézdy a cedule

Klepnutim na trojuhelnik v vpravo vedle ikony Hvézdy a cedule na nastrojoveé listé Kresba
otevieme dil€i nastrojovou liStu Hvézdy a cedule (obrdzek 37 pod). Pfipadné vybereme
pozadovany nastroj z panelu Hvézdy a cedule na karté Tvary v postranni listé.

Tvary symbolt

Klepnutim na trojuhelnik v vpravo vedle ikony Tvary symbol(i na nastrojové listé Kresba
otevieme dil¢i nastrojovou listu Tvary symbolll (obrazek 38 pod). Pfipadné vybereme
pozadovany nastroj z panelu Tvary symbolti na karté Tvary v postranni liSté.

Pridavani, vkladani a formatovani textu

V aplikaci Draw Ize text pfidavat, vkladat a formatovat v textovych polich, objektech a tvarech.
Dalsi informace o pfidavani, vkladani a formatovani textu ve vykresu najdeme v kapitole 9,
Pfidavani a formatovani textu.
Vywvojovy diagram v X
O Oleme e O00dyY
Ol ®eg X< AV UD
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Obrazek 36: Dil¢i nastrojova lista Vyvojovy diagram
Hvézdy a cedule w X
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Obréazek 37: Dil¢i nastrojova lista Hvézdy a cedule
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Obrazek 38: Dil¢i nastrojova lista Tvary symbol(i
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Uvod

V této kapitole jsou vysvétleny nastroje a funkce, které se pouzivaji k Upravé stavajicich kreseb a
k vytvoreni nebo Upravé vybraného objektu nebo skupiny vybranych objektd. Pokud je vybrano
nékolik objektl, ramecek vybéru kolem objektli odpovida nejmensimu obdélniku obsahujicimu
vSechny objekty. Tento rdmecek vybéru se také nazyva vybérovy obdélnik nebo vybérova oblast.
Uchyty pro vybér se zobrazuji v tomto obdéInikovém ramecku, ktery je zaroven dostatecné velky,
aby se do néj vesly vSechny objekty, které byly vybrany.

ﬁ Poznamka

PFi zméné vlastnosti objektu se barva a tvar Gchytl vyb&ru méni v zavislosti na
vybraném nastroji a funkci. Barva Gchyt( vybéru zavisi také na operaénim systému a
nastaveni pocitace.

Vybér objektl

Prfimy vybér
Nejjednodussi metodou vybéru je pfimé klepnuti na objekt. U objektl, které nejsou vyplnény,

klepneme na okraj objektu a vybereme jej. Vice objektd vybereme, kdyz pfi kliknuti na né drzime
stisknutou klavesu Shift. Vybeér objektu zruSime, kdyZ klikneme do prazdného mista.

Vybér oramovanim

Klepnutim a pretazenim kurzoru kolem nékolika objektl vytvofime obdélnik vybéru kolem
nékolika objektd. Vybiraji se pouze objekty, které se nachazeji uvnit tohoto vybérového
obdélniku. Ujistime se, Ze nastroj Vybrat na nastrojové listé Kresba (obrazek 39 pod) je aktivni
pfi vybéru vice objektd.

Vybér skrytych objekti

Vybirat Ize i objekty, které se nachazeji za jinymi objekty a nejsou viditelné. Kdyz je vybran skryty
objekt, zobrazi se jeho Uchyty vybéru pfes objekty, které vybrany objekt zakryvaji.

* Windows, Mac nhebo Linux — stisknutim klavesy Tabulator vybereme a prochazime
objekty v kresbé, pficemz se zastavime u skrytého objektu a vybereme jej. Pokud
chceme prochézet objekty v opatném poradi, stiskneme klavesy Shift+Tab.

* Pouze pro Windows nebo Mac — vybereme objekt pfed skrytym objektem, poté
stiskneme klavesu Alt (macOS ~\) a klepnutim vybereme skryty objekt. Pokud je
skrytych objektll vice, podrzime stisknutou klavesu Alt (macOS ~\2) a klikame, dokud
nedosahneme pozadovaného objektu. Pokud chceme prochazet objekty v opacném
poradi, podrzime stisknuté klavesy Alt+Shift (macOS +Shift) a klepneme.

Kresba w X
[ LB N O|—~+¥~"L~
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Obrazek 39: Nastrojova lista Kresba

Dokumentace pro LibreOffice je dostupna na https://cs.libreoffice.org/get-help/documentation/
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Obréazek 40: Néastrojova lista Cara a vyplri

1

Usporadani objektl

Ve slozitych kresbach mize byt nékolik objektl naskladano na sebe. Pomoci jedné z
nasledujicich metod mdzeme zménit pofadi uspofadani objektd pfesunutim objektu dopfedu
nebo dozadu:

* VVybereme obijekt, v hlavni nabidce zvolime Tvar > Uspofadat nebo klepneme pravym
tlaCitkem mysi na objekt, z mistni nabidky zvolime Uspofadat a zvolime jednu z
nasledujicich moznosti:

Pienést do popredi (Ctrl + Shift + +) (macOS #+Shift++)
Pfenést bliz (Ctrl + +) (macOS 3 + +)

Odsunout dal (Ctrl + -) (macOS 3 + -)

Odsunout do pozadi (Ctrl + Shift + -)(macOS 3 +Shift +-)
Pred objekt

Za objekt

* Vybereme objekt a poté vybereme jeden z nastrojli Usporadat na levém konci nastrojové
listy Cara a vypli (obrazek 40 nad). KdyZ najedeme kurzorem na nastroj, je zobrazena
jeho funkce.

Umisténi a zarovnani objekti

Priblizeni
Pro umisténi a Upravu objektl ma aplikace Draw funkci zvétSeni, kterd zmensuje nebo zvétSuje
zobrazeni aktualni kresby. MZeme napfiklad priblizit kresbu, abychom pFesnéji umistili objekty v

kresbé&, nebo oddalit kresbu, abychom jej vidéli cely. Priblizeni se ovlada pomoci stavového
fadku, dialogového okna Pfiblizeni a rozloZzeni zobrazeni nebo nastrojové listy Priblizeni.

ﬁ Poznamka

V operacnim systému Linux je funkce zvétSeni feSena jinak. Kreshy uloZzené s
nastavenim 100% zvétSeni v systému Windows nebo macOS se zobrazi s vétSim
pfiblizenim neZ v operacnim systému Linux.
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Stavovy radek
Ovladaci prvky priblizeni jsou umistény na pravé strané Stavového fadku (obrazek 41 pod) pro
jednoduchy pfistup pfi zvétSovani. Ke zméné miry pfiblizeni pouZzijeme jednu z nasledujicich
metod:

« Pomoci PFizplisobit stranku aktualnimu oknu prizpldsobime kresbu otevienému oknu.

» Posunutim Ovladace zvétSeni smérem ke znaménku minus (-) na posuvném ovladaci

zvétSeni snizime faktor pfiblizeni.
| = I + 76%
N N N
(1) (2) (3)

Obréazek 41: Oviladaci prvky pribliZzeni ve stavovém radku

(1) Pizpdsobeni stranky (2) Ovladani posuvniku (3) Mira priblizeni v procentech
aktualnimu oknu priblizeni

PribliZzen( a reZim zobrazeni X
Mira pfibliZeni

2) Optimalni

) Podle Eitky a vysky

) Podle sitky

2 100%

O Viastni: 65 % .

MNapovéda Zrusit

Obréazek 42: Dialogové okno PribliZzeni a
reZim zobrazeni

* Posunutim Ovladace zvétSeni smérem ke znaménku plus (+) na posuvném ovladaci
zvétSeni zvySime faktor pfiblizeni.

» Klepneme pravym tlac¢itkem mysi na Cislo Mira pfiblizeni a v oteviené mistni nabidce
vybereme moznost pfiblizeni.

Dialogové okno PribliZzeni a reZim zobrazeni
Otevieme dialogové okno Pfiblizeni a rezim zobrazeni (obrdzek 42 nad) jednim z nasledujicich
zpUsobu:
+ Klikneme na procento pribliZzeni ve Stavovém fadku.
* V hlavni nabidce zvolime Zobrazit > Pfiblizeni > Pfiblizeni.
Moznosti v dialogovém okné P¥ibliZeni a reZim zobrazeni uréuji zplisob zobrazeni kresby.
Mira pfiblizeni
Nastavi faktor zvétSeni pro zobrazeni aktualniho dokumentu a vSech nasledné
otevienych dokumentl stejného typu.
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Optimalni zobrazeni
Zméni velikost zobrazeni tak, aby odpovidalo Sifce textu v dokumentu.
Podle sirky a vysky
Zobrazi celou stranku na obrazovce.
Prizptsobit Sifce
Zobrazi celou Sifku stranky dokumentu. Horni a dolni okraj stranky nemusi byt
viditelny.
100 %
Zobrazi dokument ve skutecné velikosti.
Viastni

Do pole pro faktor pfiblizeni zadame procento, které se ma zobrazit, nebo pouzijeme
znaménka minus (-) nebo plus (+) pro zménu faktoru pfiblizeni.

Priblizeni v X
QARG D AR R D
Obrazek 43: Lista nastrojd PribliZzeni
Nastrojova lista Priblizeni
V hlavni nabidce zvolime Zobrazit > Nastrojové liSty > P¥iblizeni a otevieme nastrojovou liStu
Priblizeni (obrazek 43 nad). Zleva doprava jsou k dispozici tyto nastroje:
Priblizit
PFi kazdém vybeéru nastroje zobrazi kresbu ve dvojnasobné aktualni velikosti.
Oddalit
PFi kazdém vybeéru nastroje zobrazi vykres v polovi€ni aktualni velikosti.

100 %
Zobrazi vykres ve skutecné velikosti.
Pfedchozi pfiblizeni
Vréti zobrazeni kresby na pfedchozi pouzity faktor zvétSeni.
Nasledujici pfiblizeni
ZruSeni akce predchoziho pfikazu pro priblizeni.
Cela stranka
Zobrazi celou kresbu v pracovni oblasti.
Sitka stranky
Zobrazi celou Sitku kresby. Horni a dolni okraj strdnky nemusi byt viditelny.
Optimalni zobrazeni
Zmeni velikost zobrazeni tak, aby zahrnovalo vSechny objekty v kresbé.
Priblizit objekt
Zméni velikost zobrazeni tak, aby odpovidala vybranym objekttm.
PFiblizeni a posun
Priblizeni pfi kazdém kliknuti. Ctrl + kliknuti (macOS 3 + kliknuti) zvetsi pfi
kazdém kliknuti. Shift+klepnuti umoziuje posouvani kreshy.

Prirucka aplikace Draw 25.8 | 51



Shift
Pfesune vykres v ramci pracovniho prostoru. Umistime kurzor na vykres a tazenim
prfesuneme vykres.

Pfesun a nastaveni velikosti objektl

P¥i pfesouvani objektu nebo zméné jeho velikosti zkontrolujeme levy roh Stavového fadku v
dolni ¢asti pracovniho prostoru (obrazek 44 pod). V této oblasti se zleva doprava zobrazuje
vybrany tvar, jeho poloha v kresbé v souradnicich X/Y a rozméry objektu. Mérné jednotky se
vybiraji v Nastroje > MoZnosti > LibreOffice Draw > Obecné (macOS Preferences >
LibreOffice > LibreOffice Draw > Obecné).

Presun objekt

Pokud chceme objekt (nebo skupinu objektll) pfesunout, vybereme jej, klepneme na jeho hranice
a pretdhneme jej. BEéhem pohybu se zobrazuje obraz prihledny obraz objektu, ktery pomaha pri
zmeéne polohy, jak ukazuje pfiklad na obrazku 45 pod. Jakmile objekt dosdhne svého nového
umisténi, uvolnime jej.

300 79 28 o260 250 24 24 22

[¢ 4 » P Rozvrzeni  Oviadaciprvky | Kotovaci cary |
10 z 35 (RozvrZeni), Vybrano Tvar Wjchozi | 075 /2275 ™= 675 x 4.25

Obrazek 44: Priklad levého konce stavového fadku s vybranym tvarem

Obrazek 45: Priklad presunu vybranych objekt(
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Obrazek 46: Priklad nastaveni velikosti objektu

Nastaveni velikosti objektu

Pokud chceme zmeénit velikost vybraného objektu (nebo skupiny vybranych objekt(l), pfesuneme
kurzor na jeden z Uchytl vybéru. Kurzor zméni tvar a indikuje smér pohybu pro dany Gchyt.
Klepnutim na tchyt vybéru a jeho pretazenim zménime velikost objektu. Vysledky zavisi na tom,
jaky achyt vybéru pouZijeme, a to nasledovneé:

» Pokud chceme zménit velikost objektu v jedné ose, pouzijeme bocni, horni nebo dolni
Uchyt.

* Pokud chceme zménit velikost pomoci obou os, pouZzijeme rohovy Uchyt.

Pri zméné velikosti objektu se objevi obrys prihledného objektu, jak ukazuje pfiklad na obrazku
46 nad. Po dosazeni pozadované velikosti objektu jej uvolnime.

ﬁ Poznamka

Stisknutim a podrZenim klavesy Shift pfi zméné velikosti objektu zménime velikost
tak, aby byl zachovan pomér Sifky a vysSky. Toto chovani klavesy Shift funguje se
vSemi Uchyty vybéru.

Upravy obloukd

Velikost oblouku se mé&ni nastavenim polohy po¢ateéniho a koncového bodu oblouku. Uchyt
vybéru v poCatecnim bodé oblouku je vétsi neZ koncovy bod oblouku.

3) Vybereme oblouk, klepneme na néj pravym tlacitkem my3i a z rozeviraci nabidky
vybereme moznost Body nebo stiskneme klavesu F8. Na zaCatku a na konci oblouku se
objevi dva Uchyty, jak ukazuje pfiklad na obrazku 47 pod.

4) Klepnutim a pfetaZzenim pocCéatecniho nebo koncového tchytu zménime tvar oblouku.
5) Po dosaZeni poZzadovaného tvaru oblouku uvolnime vybrany Gchyt.

Otoceni a zeSikmeni objektu

Otoceni objekt(

Pokud chceme objekt (nebo skupinu objekt() oto€it, vybereme objekt, u kterého chceme zmeénit
rezim otaceni, nasledujicim zplsobem:

1) Vybereme objekt nebo skupinu objektd tak, aby se zobrazily Gchyty vybéru.
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2) K pfepnuti do rezimu otaceni pouzijeme jednu z nasledujicich metod. Uchyty vybéru
zmeéni tvar a barvu a ve stfedu objektu se objevi ukazatel stfedu otaceni, jak ukazuje
priklad na obrazku 48 pod.

— Znovu klepneme na vybrany objekt nebo skupinu objektd. NEKLIKAME dvakrat.
Dvojitym klepnutim se objekt pfepne do textového rezimu.

— Klepnutim na trojuhelnik v vpravo od ikony Transformace na nastrojové list& Cara a
vypln (obrazek 40 na strané 49) a z rozbalovaci nabidky vybereme Otogit.

— V hlavni nabidce zvolime Zobrazit > Nastrojové listy > Transformace, zobrazime
nastrojovou listu Transformace (obrazek 49 pod) a vybereme Otogit.

3) Presuneme kurzor nad rohovy Uchyt vybéru a kurzor zméni svij tvar, ¢imz indikuje rezim

otaceni.
o] o] (@)
Obrazek 47: Priklad Upravy oblouku Obrazek 48: Priklad reZimu rotace
Transformace e X

(S A & &85O

Obrazek 49: Nastrojova lista Transformace

4) Klepneme na rohovy Uchyt vybéru a tazenim za néj objekt otoCime. Po dosazeni
pozZzadovaného natoceni objektu uvolnime Gchyt vybéru.

ﬁ Poznamky

Stfed otaceni je obvykle umistén ve stfedu objektu. Pokud chceme zmeénit polohu
stfedu otaceni, klepneme na stfed otaCeni a pfetahneme jej na poZadovanou pozici.
Stfed otaceni lze pfemistit mimo objekt.

Otaceni funguje u 3D objekt mirné odlinym zplsobem, protoZze k nému dochazi v
trojrozmérném prostoru a ne v jedné roviné. DalSi informace najdeme v kapitole 7,
Prace s 3D objekty.

Zkoseni objekti

Osa, ktera se pouziva pro zkoseni pfedmeétu, je hrana predmétu pfimo naproti stfedovému
Uchytu, kterd se pouZziva pro zkoseni pfedmétu. Tato osa je pevné umisténa, zatimco ostatni
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strany objektu se vi¢i ni pohybuji pfi pfetahovani tchytu vybéru. Na obrazku 50 pod byla pro

zkoseni objektu pouZita rukojet vybéru ve stfedu spodni ¢asti objektu.

ﬁ Poznamka

Stisknutim a podrZenim klavesy Shift pfi otACeni nebo naklanéni objektu omezime
pohyb na 15° kroky. Toto je vychozi chovani klavesy Shift. Pokud je vSak zvolena
moznost PFi vytvaFeni nebo pfesunu objektu v nabidce Nastroje > Moznosti >
LibreOffice Draw > M¥izka (macOS LibreOffice > Pfedvolby > LibreOffice Draw >
Mf¥izka), funkce klavesy Shift je opacnéa a otaCeni nebo sklon je omezen na 15°
pohybu, pokud neni stisknuta klavesa Shift.

1) Vybereme objekt a pomoci jedné z nasledujicich moZnosti pfepneme do rezimu otaceni.
Uchyty vybéru zmeéni tvar a barvu a ve stfedu objektu se objevi ukazatel stfedu otaceni.

— Znovu klikneme na vybrany objekt.

— Klikneme na trojahelnik v napravo od Transformace na nastrojové listé Cara a vypln
a z mistni nabidky vybereme Oto¢it.

— V hlavni nabidce zvolime Zobrazit > Nastrojové listy > Transformace, abychom
otevreli nastrojovou listu Transformace, a poté vybereme Oto¢it.

2) Pfesuneme kurzor nad uchyt vybéru ve stfednim bodé horni, dolni, levé nebo pravé
strany objektu a kurzor zméni tvar, aby naznacil smér Sikmého pohybu.

Obrazek 50: Priklad zkosenych objekt(

3) Kliknutim a pretazenim uchytu vybéru objekt zkosime. Po dosazeni poZzadovaného
sklonu objektu uvolnime kurzor. Zobrazi se Sikmy obrys objektu a ve Stavovém fadku se

zobrazi aktualni Uhel zkoseni.

Pfesné nastaveni polohy, velikosti, oto€eni a zkoseni

Pouzivani kurzoru k umisténi a zméné velikosti objektd neni pfesné. Pro vétsi presnost pfi
umisténi a velikosti objektu pouzijeme dialogové okno Umisténi a velikost (obrazek 51 pod),
nebo panel Umisténi a velikost (obrazek Chyba: zdroj odkazu nenalezen Chyba: zdroj odkazu
nenalezen) na karté Vlastnosti v postranni listé.

» Pokud chceme otevfit dialogové okno Umisténi a velikost, vybereme objekt jednou z
nasledujicich moznosti:

— V hlavni nabidce vybereme Format > Umisténi a velikost.

— Klepneme pravym tlacitkem na objekt a z mistni nabidky vybereme Umisténi a
velikost.

— Stiskneme klavesu F4.
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* Pro otevieni nastrojove listy Umisténi a velikost na karté Vlastnosti v postranni listé
(obrdzek Chyba: zdroj odkazu nenalezen Chyba: zdroj odkazu nenalezen) vybereme
objekt, poté klepneme na Vlastnosti v postranni listé a klepneme na Sipku > v zahlavi
Umisténi a velikost pro otevieni panelu.

Umisténi a velikost
Umisténi
UrCuje pozici vybraného umisténi objektu na strance. Mérné jednotky pouzivané pro
soufadnice X/Y a Sitku a vysSku objektu nastavime v nabidce Nastroje > MozZnosti >
LibreOffice Draw > Obecné (v systému MacOS LibreOffice > Pfedvolby > LibreOffice
Draw > Obecné).

Umisténf a velikost X

Umisténi a velikost  Otoceni  Naklonéni a polomér rohu

Umisténi
Pozice X: 7,25 cm = ) O O
Pozice ¥: 20,50 cm = i o i
Zakladni bod:
Velikost
Sitka: 5,25 cm = ® O 0
- a ﬁ
Vyska:  3,25cm = o
L
Zakladni bod:
Zamknout Pfizplsobit
[ Umisténi Sitka podle textu
I Velikost Vyska podle textu

MNapovéda Obnovit Zrudit

Obrazek 51: Dialogové okno Umisténi a velikost
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—| Umisténi a velikost = >
Pozice X: 5,25 cm :
Pozice Y: 19,25 cm .
Sitka: 7,25 cm =i

C U@

Vyska: 3,25 cm =1
Otoceni: "% 0,00° B
Preklopit. v = b
Uspofadat: L ¥ OO &
Zarovnani: |5 & 3 00 &8 ol

+| Sloupce
+| Efekt textu

Obrazek 52: Sekce Umisténi a velikost na karté Vlastnosti na bo¢ni liSté

Pozice X

Zadame vodorovnou vzdalenost potfebnou k posunuti objektu vzhledem k z&kladnimu
bodu vybranému v mfiZce.

Pozice Y

Zadame svislou vzdalenost potfebnou k posunuti objektu vzhledem k zékladnimu bodu
vybranému v mfiZce.

Zakladni bod

Vybereme zékladni bod v mfiZce a poté do poli Pozice Y a Pozice X zaddme hodnotu
potfebnou k posunu objektu vzhledem k vybranému zakladnimu bodu. Zakladni body
odpovidaji Gchytlm vybé&ru na objektu. Tato moZnost je k dispozici pouze v dialogovém
okné Umisténi a velikost.

}? Poznamka

Vychozim umisténim polohy a velikosti zakladniho bodu je levy horni roh oblasti
kresby. Tento zakladni bod Ize doCasné zménit pro zjednoduSeni polohovani nebo
dimenzovani klepnutim na pozici odpovidajici pozadovanému umisténi zakladniho
bodu. Tato zmeéna z&kladniho bodu je platna pouze pro jedno pouZziti a po zavieni
dialogového okna Umisténi a velikost se zékladni bod vréati do vychozi polohy levého

horniho rohu.

Velikost

Zadame velikost pozadovanou pro zménu velikosti vybraného objektu vzhledem k
vybranému zakladnimu bodu.
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Sitka
Zadame Sifku vybraného objektu.
VysSka
Zadame vysku vybraného objektu.
Zachovat pomér
Zachovava proporce pfi zméné velikosti vybraného objektu.
Zéakladni bod

Vybereme zakladni bod v mfiZce a poté zadame nové rozmeéry vybraného objektu do
poli Sitka a Vyska. Tato moZnost je k dispozici pouze v dialogovém okné Umisténi a
velikost.

Zamknout
Tato moznost je k dispozici pouze v dialogovém okné Umisténi a velikost.
Umisténi
Zabrani zménam polohy nebo velikosti vybraného objektu.
Velikost
Zabranuje zméngé velikosti objektu.
Prizplsobit
Pokud je vybrana, umoziuje prizplsobit velikost textového pole a prizpUsobit ji velikosti
textu zadavaného do textového pole. Tato moznost je k dispozici pouze v dialogovém
okné Umisténi a velikost pro textova pole.
Sitka podle textu
RozSifi Sitku objektu na Sifku textu, pokud je objekt menSi nez text.
Vyska podle textu
RozSifi vysku objektu na vySku textu, pokud je objekt mensi nez text.

Otoceni objektl

Pro pfesné oto€eni objektu klepneme na zalozku Otoceni v dialogu Umisténi a velikost pro
otevieni stranky Otoc¢eni (obrazek 53 pod). MoZnosti umoznuji definovat Uhel nato¢eni a
umisténi bodu oto€eni. Alternativné pouZzijeme dostupné moznosti otaceni v panelu Umisténi a
velikost na karté Vlastnosti v postranni listé (obrdzek Chyba: zdroj odkazu nenalezen Chyba:
zdroj odkazu nenalezen).

Stied otoéeni

Vybrany objekt se otaci kolem zadaného bodu oto€eni a tato moznost je k dispozici
pouze v dialogovém okné Umisténi a velikost. Vychozi polohou bodu otoceni je stfed
objektu. Bod oto¢eni mlize byt pfesunut z vychozi polohy zménou nastaveni pro Pozice
X a/nebo Pozice Y nebo vybérem polohy v Casti Vychozi nastaveni.

Pozice X

Zadame vodorovnou vzdalenost od levého okraje stranky a zménime umisténi bodu
otoceni.

Pozice Y
Zadame svislou vzdalenost od horniho okraje stranky a zménime umisténi bodu
otoceni.

Viychozi nastaveni
Vybereme umisténi bodu otoceni. Vychozi pozice je stfed objektu. Zména oto¢ného
bodu je platnéd pouze pro jedno pouZiti a po zavieni dialogového okna Umisténi a
velikost se vrati do vychozi polohy.
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Umisténi a velikost X

Umisténi a velikost Otoceni  Naklonéni a polomér rohu
Stred otoceni
Pozice X: 14,88 cm =

»

'
L

PoziceY: 24,88 cm v ®

»
0—0—0
Lo~ b

~
L

WVychozi nastaveni:
Uhel otoéeni
Uhel: 0,00°

- -
g ! -

Wychozi nastaveni:

Obrazek 53: Dialogové okno Poloha a velikost — zaloZka OtoCeni

Umisténi a velikost X

Umisténi a velikost  Otoéeni  Naklonéni a polomér rohu

Polomér rohu Zkoseni
Polomér: Uhel: 0,00° =
Ovladaci bod 1 Ovladaci bod 2

,00 cm X 0,00 cm

)00 cm 0,00 cm

Obréazek 54: Dialogové okno Umisténi a velikost — zaloZka Naklonéni a
polomér rohu

Uhel otoéeni

Zadame pocet stupnd potfebnych k otoceni vybraného objektu. Tato moznost je k
dispozici pouze v dialogovém okné Umisténi a velikost.

Uhel
Zadame pocet stupnid, o které je tfeba vybrany objekt otodit.
Viychozi nastaveni
Kliknutim na indikator objekt otogime. Poget stupfiti oto&eni se zobrazi v poli Uhel.

Naklonéni a polomér rohu

Pro pfesné nastaveni poloméru zaobleni rohu nebo Ghlu sklonu objektu klepneme na zalozku
Naklonéni a polomér rohu v dialogovém okné Umisténi a velikost (obrazek 54 nad) a otevieme

stranku Sklon a polomér zaobleni. MoZnosti naklonéni a poloméru rohu jsou k dispozici pouze
v dialogovém okné Umisténi a velikost.

Polomér rohu
Tato moznost je k dispozici pouze pro rohy obdélnikovych nebo &tvercovych objektd,

vvvvvv

vvvvvv

obdélniky. Pokud je tato moznost zaSedl4, nelze nastavit polomér rohu.
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Obréazek 55: Priklad nastaveni rohového bodu
Polomér
Zadame polomé&r kruZnice, ktery se pouZije pro zaobleni rohl. Cim vétsi je nastavena
hodnota poloméru rohu, tim jsou zaoblené rohy viditelng;si.
Zkoseni
Nakloni vybrany objekt podél spodni hrany objektu.
Uhel
Zadame uhel $ikmé osy. Uhel zkoseni udava, do jaké miry se objekt odchyluje od své
béZné svislé polohy.
Ovladaci bod 1/ovladaci bod 2
Tyto ovladaci body jsou specialni Uchyty nebo body, které jsou k dispozici na nékterych

tvarech a slouzi ke zméné vlastnosti tvaru. Pokud jsou tyto moznosti Sedé, pak tvar nema

specialni achyt a soufadnice nelze nastavit. DalSi informace o fidicich bodech najdeme v
Casti ,Zména tvaru objektu” na strané 66.

Zadame hodnotu pro nastaveni soufadnic X a Y specialniho uchytu vzhledem k levému
hornimu rohu tvaru. PFiklad zobrazeny na obrazku 55 nad ukazuje zménu tvaru po
Upravé soufadnice X Ridiciho bodu 1 specialniho Gchytu.

Pouziti mfizky a funkce pfichyceni

Pfesné umisténi objektd pomoci funkci mrizky a pfichyceni aplikace Draw. P¥i pouZiti funkci
mfizky a pfichyceni se doporuCuje pouZzit nejvyssi praktickou hodnotu zvétSeni kresby. Souasné
Ize pouzit dvé rlizné funkce, napriklad pfichyceni k vodici ¢afe a okraji stranky. Doporucujeme
aktivovat pouze poZadované funkce pfichyceni.

MozZnosti - LibreOffice Draw - MFiZka

X
Zadejte hledany text Mriizka
LibreQffice 8 Prichytit k miizce
Nacitani/ukladani [ Viditelnd miizka
Jazyky a ndrodni prostiedi Rozlizeni Podruzné rozdéleni
= LibreOffice Draw sent ruzne roz n
Obecné Vodorovné: 1,00 cm = Vodorovné: 4 T mezery
Zobrazenl Svislé: 1,00 cm < Svislé: 4 - mezery
O Synchronizovat o
— Tisk s 7
LibreOffice Base Pichytit Omezit objekty
Grafy O K voditkim

([ Pfi vytvareni nebo presunu objektd

Internet @8 Roziifit hrany

B K okrajim stranky
0K ramecku objektu (O pii otaceni: ~ 15,00°
UK bodim objektu Redukce bod: 15,007 2

Oblast prichyceni: 5 pixeld

Obrazek 56: Dialogové okno MoZnosti LibreOffice Draw — stranka MriZka
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Obrézek 57: Néstrojové lita MoZnosti

Konfigurace mfiZzky a prichyceni
Pokud chceme nakonfigurovat funkce mfizky a pfichyceni v kresbé, zvolime v hlavni nabidce

oy

Nastroje > MozZnosti > LibreOffice Draw > Mfizka (macOS LibreOffice > Pfedvolby >
LibreOffice Draw > MFiZka) a tim zobrazime dialogové okno MozZnosti - LibreOffice Draw -
MfFiZka (obrazek 56 nad). Funkce mfizky a pfichyceni se zobrazuji a vybiraji jednim z
nasledujicich zplsob:

* Pouziti dialogového okna Moznosti - LibreOffice Draw - Mfizka.

 Klepnuti pravym tlacitkem mysi na kresbu a vybér moznosti z mistni nabidky.

« Pomoci nastrojii na nastrojové listé MozZnosti (obrazek 57 nad). Pokud neni nastrojova

liSta MoZnosti oteviena, v hlavni nabidce zvolime Zobrazit > Nastrojové listy >
MozZnosti.

Funkce mfizky a pfichyceni
Mfizka
Urcuje nastaveni konfigurovatelné mrizky kresby pro uréeni pfesné polohy objektd. Tuto
mrizku Ize také nastavit tak, aby odpovidala mfizce pfichyceni. Pokud je pfi pfesouvani
nebo vytvareni jednotlivych objektd bez prichyceni pozic aktivovana mfizka prichyceni,
drzime stisknutou klavesu Shift, abychom tuto funkci deaktivovali.
Prichyceni k mriZzce
UrCuje, zda se maji rAmce, objekty kresby a ovladaci prvky presouvat jen mezi body
mrizky. Pokud chceme zmeénit stav pfichyceni pouze pro aktualni akci, pfetahneme
objekt a zaroven podrzime stisknutou klavesu Ctr1l (macOS 3).
Viditelna miiZka
UrCuje, zda se méa zobrazit mfizka.
RozliSeni
Vodorovné
Ur€uje v dané meérné jednotce rozestupy mezi body mfizky na ose X.
Svislé
UrCuje v dané meérné jednotce rozestupy mezi body mfizky na ose Y.

Synchronizovat osy
UrCuje, zda se zmény nastaveni mrizky projevi v obou osach symetricky. RozliSeni a
podruzné rozdéleni obou os z(stava stejné.

Podruzné rozdéleni

Vodorovné
Urcuje pocet mezilehlych bodd mezi body mfizky na ose X.

Svislé
Urcéuje pocet mezilehlych bodd mezi body mfizky na ose Y.
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Prichytit

K voditkim
Pfi uvolnéni objektu pfichyti okraj pfetahovaného objektu k nejblizsi Care pfichyceni.
Toto nastaveni Ize také definovat pomoci volby PFichytit k voditk(im na nastrojové
liSté Moznosti.

K okrajim stranky
UrCuje, zda se ma obrys grafického objektu zarovnat k nejblizSimu okraji stranky.
Kurzor nebo obrysova €éara grafického objektu musi byt v dosahu zachyceni. K této
funkci Ize pristupovat také pomoci voleb PFichytit k okrajiim stranky na nastrojové
liSté MozZnosti.

K ramecku objektu
UrCuje, zda se ma obrys grafického objektu zarovnat k okraji nejblizSiho grafického
objektu. Kurzor nebo obrysova Cara grafického objektu musi byt v dosahu zachyceni. K
této funkci Ize pfistupovat také pomoci volby PFichytit k ohrani¢eni objektu na
nastrojové listé Moznosti.

K boddm objektu
Urcuje, zda se ma obrys grafického objektu zarovnat podle bodl nejblizs§iho grafického
objektu. Kurzor nebo obrysova Céara grafického objektu musi byt v dosahu zachyceni. K
této funkci lze pristupovat také pomoci volby PFichytit k bodiim objektu na nastrojové
listé Moznosti.

Oblast prichyceni
Definuje vzdalenost pfichyceni mezi kurzorem a obrysem objektu. Pfichyti se k bodu
prichyceni, pokud je kurzor blize neZ vybrana vzdalenost.

Omezit objekty

Pri vytvareni nebo presouvani objekti
PFi vytvareni nebo presunu jsou grafické objekty omezeny na pohyb svisle, vodorovné
nebo po Uhlopficce (45°). Toto nastaveni Ize doCasné deaktivovat stisknutim klavesy
Shift.

Rozsitit hrany
UrCuje, Ze Ctverec se vytvori na zakladé delsi strany obdélniku, pokud je pred
uvolnénim objektu stisknuta klavesa Shift. To plati i pro elipsu, kde se na zakladé
nejdelsiho priméru elipsy vytvori kruznice. Kdyz neni vybrana volba Rozsifit hrany,
vytvori se ¢tverec nebo kruh na zakladé kratsi strany nebo priiméru.

Pri otaceni
UrCuje, Ze grafické objekty Ize otacet pouze v rdmci vybraného Uhlu nato€eni. Chceme-
li objekt otoCit mimo definovany Uhel, stiskneme pfi otaCeni klavesu Shift. Po
dosazeni poZzadovaného Uhlu natoCeni objekt uvolnime.

Redukce bod(

Definuje Uhel pro redukci bodu. Pfi praci s mnohouhelniky je to uZitecné pro redukci
editacnich bodd.

Pfichyceni k mfizce
PouzZivame pfFichyceni k miiZzce

Prichytit k mfiZce se pouZziva pfi pfesunu objektu na bod mfizky v kresbé. Tato funkce se voli
jednim z nasledujicich zplsobl:

Vv

» Jdeme do nabidky Zobrazit > Voditka > PFichytit k mfizce.

» Klepneme pravym tlaCitkem mysi na kresbu a z mistni nabidky vybereme Voditka >
Prichytit k mfizce.
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v

» Klikneme na néstroj Pfichytit k mfiZzce na nastrojove list€ Moznosti.
Zobrazeni mrizky
Ke zobrazeni nebo skryti mfizky v kresbé pouZijeme jednu z nasledujicich metod:

* V hlavni nabidce zvolime Zobrazit > M¥izka a voditka > Zobrazovat miizku.

* Na nastrojové listé Moznosti klikneme na Zobrazovat mfizku.

Voditka

Voditka a body pfichyceni nejsou soucasti mrizky, ale vkladaji se za Gc¢elem umisténi objektu na
urcité misto kresby. Voditka — zachytné Cary — mohou byt vodorovné nebo svislé, jsou zobrazeny
¢arkované. Zachytné body se zobrazuiji jako kfizeni ¢arkovanych Car. Voditka se netisknou.

VloZeni zachytnych bodi a voditek

Pokud chceme vloZit zachytny bod nebo voditko, zvolime v hlavni nabidce VloZit > Voditko a
tim otevieme dialogové okno Nové voditko (obrazek 58 pod).

Umisténi

Nastavi polohu vybraného zachytného bodu nebo voditka vzhledem k levému hornimu
rohu stranky.

X:
Zadame velikost pozadované mezery mezi zachytnym bodem nebo voditkem a levym
okrajem stranky.

Y:
Zadame velikost poZadované mezery mezi zachytnym bodem nebo voditkem a hornim
okrajem stranky.

Typ
UrCuje typ vkladaného zachytného objektu.

Bod
VloZzi zachytny bod.

Svislé
Vlozi svislé voditko.

Vodorovné

Vlozi vodorovné voditko.

Zobrazeni zachytnych bodt a ¢ar
K zobrazeni zachytnych bod( a voditek v kresbé pouZijeme jednu z nasledujicich moZnosti:
* V hlavni nabidce zvolime Zobrazit > Voditka > Zobrazit voditka.

MNové voditko X |
Umisténi Typ
X: p,00cm * - OBod
Y. 0,00cm = 4 Dbvisly
-+ 1_) Vodorovny

MNapovéda Zrusit

Obrazek 58: Dialogové okno Nové voditko
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Upravit zachytny bod X

Umisténi
X: 691 cm =
Yoo 9,64 cm .

Mapovéda Smazat Zrusit

Obréazek 59: Dialogové okno Upravit zachytny bod
Upravit voditko X

Umisténi

X 380 cm =

Népovéda Smazat Zrusit

Obrazek 60: Dialogové okno Upravit voditko
* Na néstrojové listé Moznosti klepneme na tlaCitko Zobrazit voditka.

* Klepneme pravym tlacitkem mysi na kresbu a z mistni nabidky vybereme moznost
Voditka > Zobrazit voditka.

Uprava zéchytnych bodti

1) Klepneme pravym tlaCitkem na zachytny bod a z mistni nabidky zvolime Upravit
zachytny bod. Tim otevieme dialogové okno Upravit zachytny bod (obrazek 59 nad).

2) Zadame nové nastaveni souradnic X a Y pro zachytny bod a klepneme na OK.

3) Pripadné mizeme kliknout na zachytny bod a pfetahnout jej na nové misto na vykrese.

Uprava voditek

1) Klepneme pravym tlacitkem mysi na voditko a z mistni nabidky zvolime Upravit voditko.
Tim otevieme dialogové okno Upravit voditko (obrazek 60 nad).

2) Zadame nové nastaveni soufadnice X pro svisla voditka nebo nové nastaveni soufadnice
Y pro vodorovna voditka a klepneme na tlagitko OK.

3) Pripadné& mizeme kliknout na voditko a pfetahnout je na nové misto na vykrese.

Smazani zachytnych bodi a voditek

» Chceme-li odstranit zachytny bod, pfetahneme jej zpét na pravitko nebo na néj klepneme
pravym tlacitkem mysi a z mistni nabidky vybereme Smazat zachytny bod.

» Chceme-li odstranit voditko, pfetahneme jej zpét na pravitko nebo na néj klepneme
pravym tlaCitkem a z mistni nabidky vybereme Smazat voditko.

Nastaveni oblasti pfichyceni

Konfigurace oblasti pfichyceni, kdy se objekt pfichyti na pozici v kresbé:
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1) V hlavni nabidce zvolime Nastroje > Moznosti > LibreOffice Draw > M¥izka (macOS

vy

LibreOffice > Pfedvolby > LibreOffice Draw > MfiZka) a otevie se dialogové okno
Moznosti LibreOffice MFizka.

2) Zadame pocet pixeld a v poli Oblast prichyceni nastavime vzdalenost, kdy se objekt
prichyti na pozici. Vychozi nastaveni je 5 pixelC.

3) Kliknutim na OK ulozime novy rozsah a zavieme dialog.

Pouzivani voditek

Voditka jsou funkci aplikace Draw pro umisténi objekt(. BEhem presunu objektu se zobrazuji
voditka. Voditka sahaji od okrajli objektu k pravitkdim v horni a levé ¢asti kresby a nemaiji funkci
prichyceni (obrazek 61 pod).

1) V hlavni nabidce zvolime Nastroje > Moznosti > LibreOffice Draw > Zobrazeni
(macOS LibreOffice > Pfedvolby > LibreOffice Draw > Zobrazeni) a tim otevieme
dialogové okno MoZnosti - LibreOffice Draw - Zobrazeni (obrazek 62 pod).

2) Vybereme moznost Voditka pri presouvani nebo klepneme na Voditka pri presouvani na
nastrojové listé MoZnosti.

3) Klepnutim na OK ulozime vybér a zavieme dialogové okno.

EExEEnEEEEER R EEL

(el

-------

Obréazek 61: Priklad pouZiti voditek pri presouvani objekt(

MozZnosti - LibreOffice Draw - Zobrazeni

Zadejte hledany text
LibreOffice
Nacitani/ukladanf
Jazyky a nérodni prostredi
= LibreOffice Draw
Obecne
o |
Mrizka
Tisk
LibreOffice Base
Grafy
Internet

Zobrazeni
8 Viditelna pravitka
L% W
[ V&echny ovladaci body pfi Gpravach Bézierowych kiivek

8 Obrysy viech jednotlivich objektd

Obréazek 62: MoZnosti LibreOffice Draw, dialogové okno Zobrazeni
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Zména tvaru objektu

Pravidelné tvary

Pfi vytvareni pravidelnych tvar( v kresbé se u nékterych tvard po vybéru objektu zobrazi jeden
nebo vice kontrolnich bod( v jiné barvé nez Gchyty vybéru. KdyzZ se kurzor umisti nad jednu z
téchto teCek, zméni tvar. Klepnutim a pfetazenim ovladaciho bodu upravime tvar objektu.
Napfiklad zvétSenim poloméru rohu zaobleného obdélniku nebo ¢tverce zménime Ghly oblouku
atd. Kontrolni body maji pro kazdy tvar jinou funkci.

/? Poznamka

Po prevedeni pravidelného tvaru na kiivku nebo mnohouhelnik Ize tvar ménit a
upravovat body. Vice informaci viz ,KFfivky a mnohouhelniky“ na strance 69 a ,Upravy
bod(“ na strance 70.

Zakladni tvary

Nasledujici zakladni tvary, které jsou umistény na dilCi nastrojové listé Zakladni tvary
(obrazek 63 pod) a uvedené v tabulce 3, maji kontrolni body.

Zakladni tvary - X
OO0 UoO0OG 0O C e
ANOCOOOBa0LaON

Obréazek 63: Dil¢i nastrojova lista Zakladni tvary
Tabulka 3: Zakladni tvary s kontrolnimi body

Zakladni tvary Popis kontrolniho bodu

Zmeéni polomér kfivky, ktera nahrazuje Sikmé rohy obdélniku nebo

Zakulaceny obdélnik ||
ctverce.

. Zmeéni polomér kfivky, ktera nahrazuje Sikmé rohy obdélniku nebo
Zakulaceny Ctverec

Ctverce.
Rovnobéznik Zmeni vnitfni Ghly mezi stranami.
Lichobé&Zznik Zmeéni vnitfni ahly mezi stranami.
Kruhova vysec Zmeni velikost vyplnéného sektoru.
Oblouk Mé&ni vnitfni primér i velikost vypInéné plochy.
tl?gj\ar;]%rlimenny Zmeni tvar a typ trojuhelniku.
Sestithelnik Zméni vnitfni ahly mezi stranami.
Osmidhelnik Zmeni vnitfni Ghly mezi stranami.
Valec Méni perspektivu.
Krychle Méni perspektivu.
Ohnuty roh Zmeéni velikost slozeného rohu.
KFiz Zmeni tloustku ¢ty ramen kfize.
Ramec Zméni tloustku ramce.
Prsten Zméni vnitfni primér prstenu.
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Tvary symbolii

Nasledujici tvary symbold, které jsou umistény na dil¢i nastrojové listé Tvary symbol(
(obrazek 64 pod) a uvedené v tabulce 4, maji kontrolni body.

Tvary symbold v X
©@CV& DO 700 wMHB D
0 1 {4 {1}
Obrazek 64: Dil¢i nastrojova lista Tvary symbolti
Tabulka 4: Tvary symbolt s kontrolnimi body

Tvary symbolii Popis kontrolniho bodu

Smaijlik Zmeéni Usmév na tvafi.

Srdce Zméni tvar symbolu.

Slunce Zmeéni tvar symbolu.

Mésic Zméni tvar symbolu.

Zakaz Zmeéni tlouStku prstenu a Ghlopficky.
Zkoseny Ctverec Zméni tloustku zkoseni.

Zkoseny osmidhelnik | Zméni tloustku zkoseni.

Zkoseny kosoctverec | Zméni tloustku zkoseni.

Dvojita zavorka Zmeéni zakfiveni zavorky.
Leva zavorka Zméni zakfiveni zavorky.
Prava zavorka Zmeéni zakfiveni zavorky.

Dvojita slozena

. Zméni zakfiveni zavorky.
zavorka

Leva sloZzena zavorka |Zméni zakfiveni slozené zavorky a polohu bodu.

Prava slozena zavorka | Zméni zakfiveni slozené zavorky a polohu bodu.

Blokové Sipky

Nasledujici blokové Sipky, které jsou umistény na dilCi nastrojové listé Blokové Sipky
(obrazek 65 pod) a uvedené v tabulce 5, maji kontrolni body.

Blokoveé &ipky v X
> <= [l e §arvoeb
w2 [P alidh s dk s

Obrazek 65: Dilci nastrojové liSty Blokové Sipky
Tabulka 5: Blokové Sipky s kontrolnimi teCkami

Blokové Sipky Popis kontrolniho bodu
Sipka doprava Zmeéni tvar a tloustku Sipky.
Sipka doleva Zmeni tvar a tloustku Sipky.
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Blokové Sipky Popis kontrolniho bodu

Sipka dol Zméni tvar a tloustku Sipky.
Sipka nahoru Zmeni tvar a tloustku Sipky.
Sipka doleva a doprava Zméni tvar a tloustku Sipky.
Sipka nahoru a dol( Zmeni tvar a tloustku Sipky.
Kruhova Sipka Zméni tvar a tloustku Sipky.
Ctyfsmérova Sipka Zmeni tvar a tloustku Sipky.
Tvar V Zméni uhel mezi stranami a tvarem.
Pétiuhelnik Zméni thel mezi stranami a tvarem.
Pruhovana Sipka doprava Zméni tvar a tloustku Sipky.

Sipka nahoru, doprava a dold | Zméni tvar a tloustku Sipky.

Sipka doprava se zafezem Zméni tvar a tloustku Sipky.

Sipka nahoru a doprava Zmeni tvar a tloustku Sipky.

Sipka doprava s bublinou Zméni tvar a tloustku bubliny.
Sipka doleva s bublinou Zmeni tvar a tloustku bubliny.
Sipka dolil s bublinou Zméni tvar a tloustku bubliny.
Sipka nahoru s bublinou Zmeni tvar a tloustku bubliny.

Sipka doleva a doprava s

bublinou Zmeéni tvar a tloustku bubliny.

Sipka nahoru a dold s

bublinou Zmeni tvar a tloustku bubliny.

CtyFsmérova Sipka s bublinou | Zméni tvar a tloustku bubliny.

Sipka nahoru a doprava s

bublinou Zmeni tvar a tloustku bubliny.

Bubliny

U v8ech bublin na dilci nastrojové listé Bubliny (obrazek 66 pod) pouzijeme kontrolni body pro
zmeénu délky, umisténi a Uhlu ukazatele.

Bubliny v X
L1 & pl U
Obréazek 66: DilCi nastrojova lista Bubliny

Hvézdy a cedule

Nasledujici hvézdy a cedule, které jsou umistény na dilCi nastrojové listé Hvézdy a cedule
(obrazek 67 pod) a uvedené v tabulce 6, maji kontrolni body.

Hvézdy a cedule w X
SO E M08 0%

Obrazek 67: DilCi nastrojova lista Hvézdy a cedule
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Tabulka 6: Hvézdy a cedule s kontrolnimi body

Hvézdy a cedule

Popis kontrolniho bodu

Ctyfcipa hvézda

Zméni tloustku a tvar bodd hvézdy.

Osmicipa hvézda

Zméni tloustku a tvar bodd hvézdy.

24cipa hvézda

Zméni tloustku a tvar bodd hvézdy.

Svisla role

Zméni Sitku a tvar posuvniku.

Vodorovna role

Zmeni Sitku a tvar posuvniku.

Jmenovka

Zméni polomér vnitfniho zakfiveni rohd.

KFivky a mnohouhelniky

Bézierovy kFivky

Upravy kfivek a mnohouhelnik( zavisi na matematice Bézierovych kfivek®. UpIné vysvétleni
Bézierovych kfivek pfesahuje rdmec tohoto Privodce aplikaci Draw. Dal$i informace o kresleni a
manipulaci s Bézierovymi kfivkami najdeme v kapitole 11, Pokrocilé techniky kresleni.

Uprava Bézierovy kfivky je pohyb bodl nebo te€en prochazejicich bodem. Kazda te€na ma na
obou koncich kontrolni bod a v misté, kde se styka s kfivkou, méa spojovaci bod. Tvar kfivky
urCuje relativni ahel a vzdalenost mezi kontrolnimi body. Obrazek 68 pod zobrazuje ¢tverec a
pohyb pouze jednoho bodu na &tverci.

Prevod objekti na kfivku nebo mnohouhelnik

Pfi zméné tvaru objektu a pfed Gpravou bodi na objektu je nutné jej pfevést na kfivku nebo
mnohouhelnik. Podle toho, jaky tvar a efekt poZzadujeme, pouZzijeme k vytvoreni kfivky nebo
mnohouhelniku jednu z nasledujicich metod:

* VVybereme objekt a v hlavni nabidce zvolime Tvar > Prevést. Nasledné zvolime bud Na
kfivku nebo Na mnohouhelnik.

+ Klikneme pravym tlaCitkem na objekt a vybereme z mistni nabidky Pfevést > Na kfivku
nebo Mnohouhelnik.

1 Bézierovy kfivky vynalezl Pierre Bézier, ktery tuto techniku vyvinul v 60. letech 20. stoleti, kdyz
pracoval jako inzenyr pro automobilku Renault. Tato technologie méla usnadnit modelovani povrchu

vozidel.
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Obrazek 68: Priklad vytvareni riznych tvar( pomoci te¢nych bodu
Upravit body w X
L\AANCIAZTIEARE

Obrazek 69: Nastrojova lista Upravit body

Upravy bodt

Pfesunem bodu nebo jednoho ¢&i obou kulatych zachytnych bod( na obou koncich te¢ny Ize
vytvofit mnoho rliznych tvard, jak je znazornéno na obrazku 68 nad. Body Ize pfidavat,
odstrafiovat nebo ménit jejich typ pomoci nastroji dostupnych na nastrojové listé Upravy boddl
(obrazek 69 nad).

1) Pfevést tvar na kfivku nebo mnohouhelnik.

2) Vybereme prevadény objekt a poté zvolime rezim Upravy bodl pomoci jedné z
nésledujicich moZnosti:

— V hlavni nabidce zvolime Upravit > Body.
— Klepneme na Pfepnout rezim editace bodu na nastrojové listé Standardni.

— Klepneme pravym tlacitkem mySi na pfevedeny objekt a z mistni nabidky vybereme
moznost Pfepnout reZzim editace bodu.

— Pouzijeme klavesovou zkratku F8.

3) Kliknutim na bod objektu zménime tvar objektu. Otevre se panel nastrojl Upravit body a
néstroje se aktivuji, kdyZ je vybran bod. Te€ny se také zobrazi pfipojené k vybranému
bodu.

4) Pomoci réiznych nastrojli na nastrojové listé Upravit body miZzeme pfidavat, odstrafiovat
nebo ménit typ bodu.

5) Klepnutim a pfetazenim bodu jej mizeme presunout a zménit tvar objektu.

6) Pokud je vybranym objektem kfivka, klepneme na kulaté body na konci te¢ny a
pretdhneme je, abychom zménili tvar objektu.
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7) Pokud jsme spokojeni s tvarem, kliknutim mimo objekt zruSime reZim Gprav bodl a
zavieme nastrojovou liStu Upravit body.

Typy bodu

Dostupné nastroje na nastrojové listé Upravit body zavisi na objektu a typu vybraného bodu
objektu.
Pfesunout body
Aktivuje rezim umoznujici pohyb bodu. Klikneme a prfetahneme vybrany bod do jiného
umisténi.
Vlozit body

Aktivuje rezim vkladani pro vkladani bodl. Pfi kazdém klepnuti se na vybrany objekt vioZi
bod. Objekt také zméni tvar tak, aby se do hranice objektu dostal novy bod. VloZzené
body jsou hladkym bodem.

Smazat body

Odstrani body z vybraného objektu. Vybereme Smazat body a klepneme na bod, ktery
chceme odstranit. Chceme-li odstranit nékolik bod(, podrZzime stisknutou klavesu Shift
a poté klikneme na Smazat body.

Prevést na kfivku

Prevede kfivku na pfimku nebo pfimku na kfivku. Pokud je vybran jeden bod, pfevede se
kfivka pred timto bodem. Pokud jsou vybrany dva body, pfevede se kfivka mezi obéma
body. Pokud jsou vybrany vice nez dva body a pfi kazdém klepnuti na Pfevést na kfivku
se prevede jina Cast kfivky. V pfipadé potfeby se kulaté body pfevedou na rohové body a
rohové body se pfevedou na kulaté body.

Pokud je usek krivky pfimka, maji koncové body pfimky maximalné po jednom kontrolnim
bodu. Nelze je upravit na kulaté body, pokud pfimka neni pfevedena zpét na kfivku.
Uzavfit Beziérovu kfivku
Uzavre kfivku spojenim posledniho bodu s prvnim bodem. To je oznageno zvétSenym
Ctvercem.
Rozdélit kFivku
Vybereme bod nebo body a klepneme na Rozdélit kiivku.

Uhlovy roh
Pfevede vybrany bod nebo body na thlové body. Uhlové body maji dva pohyblivé
kontrolni body, které jsou na sobé nezavislé. Zakfivena Cara neprochazi rohovym bodem
pfimo, ale vytvafi roh.

Chceme-li vytvorit Ghlovy bod, musime nejprve viozit hladky nebo symetricky bod a poté
prevést na Uhlovy bod kliknutim na Uhlovy bod.

Plynuly pfechod

Pfrevede rohovy nebo symetricky bod na hladky bod. Oba fidici body rohového bodu jsou
vyrovnany paralelné a pohybuji se pouze souc¢asné. Kontrolni body mohou mit rliznou
délku, coZ umoznuje ménit stupen zakfiveni.

TeCny

Pfed pouzitim teCny na objektu je tfeba jej pfevést na kfivku. Te€ny se pouZzivaji pouze na
kfivkach. Pokud byl objekt pfeveden na mnohouhelnik a je pfidana te¢na, bude objekt
automaticky pfeveden na kfivku.
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ﬁ Poznamka

Uhel te¢ny se vztahuje k tvaru objektu, ktery se méni vyb&rem fidiciho bodu te¢ny na
konci te€ny a jeho posunutim. Pfi zméné Ghlu te€ny se méni tvar objektu.

Soumérny prechod

Symetricky pfechod prevede rohovy nebo hladky bod na symetricky bod. Use&ky maiji stejnou
délku a jsou zarovnany do pfimky, jak je znazornéno na obrazku 70 pod. Tangenty lze posouvat
pouze soucasné a stupei zakfiveni je v obou smérech stejny.

1) Pfevést objekt na kfivku nebo mnohouhelnik.
2) Vybereme prevedeny objekt a otevieme nastrojovou liStu Upravit body.
3) Vybereme bod, ktery chceme zmeénit na symetricky bod.

4) Na nastrojové listé Upravit body klikneme na Soumérny prechod. Pfimka na kazdé
strané soumeérného prfechodového bodu se prevede na kfivku.

5) Klepnutim a pfetaZzenim ovladaciho prvku te€ny zménime zakfiveni a tvar objektu.
Jakakoli zména jedné te€ny se pfenasi soumérné k druhé te€né.

Obrazek 70: Pfiklad soumérného prechodu

Obréazek 71: Priklad plynulého prechodu
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Plynuly prechod

Pfrevede vybrané body na rohové body. Tangenty jsou zarovnany do pfimky a pohybuji se
soucasné. Tangenty mohou mit rliznou délku, pficemz zakfiveni se fidi nejdelsi te¢nou, kterd ma
nejvétsi zakfiveni, jak je zndzornéno na obrazku 71 nad.

1) Pfevedeme objekt na kfivku nebo mnohouhelnik.
2) Vybereme prevedeny objekt a otevieme nastrojovou listu Upravit body.
3) Vybereme bod, ktery chceme zmeénit na symetricky bod.
4) Na nastrojové listé Upravit body klikneme na Plynuly pfechod.
5) Klepnutim a pfetazenim ovladaciho prvku te€ny zménime tvar objektu. Tim vznikne
asymetricka te€na s nejvétsim zakfivenim na nejdelSi strané tecny.
Uhlovy bod

Prevede vybrany bod nebo body na uhlové body. Rohové body maji dva pohyblivé kontrolni
body, které jsou na sobé nezavislé. Pomoci stfedového bodu tec¢ny jako rohového bodu lze
nezavisle ménit Uhel na kazdé strané te€ny, jak je zndzornéno na obrazku 72 pod.

L
¢

*
]
¥
¥

Obréazek 72: Priklad zmény rohového bodu

Obréazek 73: Priklad pohyblivych bod(i

Body

Presun bodt

PFi pfesouvani bodd se hranice objektu po obou stranach bodu pfizpdsobi pohybu bodu a zméni
se tvar objektu. To se také oznacuje jako deformace objekt.
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1) Pfevedeme objekt na kfivku nebo mnohouhelnik.

2) Vybereme prevedeny objekt a otevieme nastrojovou listu Upravit body.

3) Vybereme bod, ktery chceme zménit na symetricky bod.

4) Na nastrojoveé listé Upravit body klikneme na Pfesunout body.

5) Umistime kurzor na vybrany bod, klepneme na néj a pfetdhneme jej, ¢imz vytvorime
novy tvar. Obrdzek 73 nad znazorfuje, jak se z kruhu vytvofi jiny tvar pfetazenim levého
boc¢niho bodu doleva.

Vkladani bod(

Pfi kazdém klepnuti se do vybraného objektu viozi hladky bod. Klepnutim a pfetazenim
vloZeného bodu se zméni tvar objektu v novém bodg, jak je zndzornéno na obrazku 74 pod.

1) Pfevedeme objekt na kfivku nebo mnohouhelnik.
2) Vybereme prevedeny objekt a otevieme nastrojovou listu Upravit body.

3) Na nastrojové listé Upravit body klikneme na Vlozit body.

Obréazek 74: Priklad vkladani a presouvani bodi

Obrazek 75: Piiklad mazani bodd
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4) Klepnutim na okraj objektu nebo dovnitf objektu vloZime bod a poté tazenim kurzoru
pfesuneme vloZeny bod a vytvofime novy tvar.

5) Po vytvoreni poZzadovaného tvaru uvolnime vioZzeny bod.
6) V pripadé potfeby klepneme na konec te¢ny a pfetahneme ji, abychom zménili jeji Ghel.
Kazdou te€nou Ize pohybovat nezavisle a vytvaret tak ve tvaru objektu hroty a ZIabky.
Mazani bod(i

Na obrazku 75 nad je priklad toho, co se stane, kdyZ byly z kruznice odstranény tfi body vlevo.
Levy obrazek je cely kruh a pravy obrazek je misto, kde byly odstranény tfi body, které vytvareji
novy tvar.

1) Pfevedeme objekt na kfivku nebo mnohouhelnik.

2) Pfepneme vybrany objekt do rezimu Uprav bodl a otevieme nastrojovou listu Upravit
body.

3) Chceme-li odstranit jeden bod, postupujeme nasledovné:
g) Vybereme bod pro odstranéni.
h) Na nastrojové listé Upravit body klikneme na Smazat body.
4) Chceme-li vymazat nékolik bod( soucasné, postupujeme nasledovné:
a) Podrzime klavesu Shift.
b) Vybereme vSechny body k odstranéni.

c) Na nastrojove listé Upravit body klikneme na Smazat body.

Ubrani bodt

Ubrat body na nastrojove listé Upravit body funguje pouze na ¢arach s vice body. Tyto ¢ary se
vytvofi pfi pfevodu krivky na ¢aru pomoci Pfevést na kfivku. Pfiklad vytvofeni pfimky a
odstranéni bodl je uveden na obrazku 76 pod.

1) Pfevedeme kfivku na kfivku nebo mnohouhelnik.

2) Pfepneme kfivku do reZimu UGprav bod( a otevieme nastrojovou listu Upravit body.

3) Vybereme kfivku s vice body a pfevedeme ji na pfimku, viz ,,Pfevod kfivek nebo Car* pod.
4) Vybereme bod nebo body na ¢afe k ubrani. Vybrany bod je zvyraznén.

5) Na nastrojoveé listé Upravit body vybereme Ubrat body.

6) Pfesné umistime kurzor na vybrany bod, poté klikneme a pfetdhneme vybrany bod. P¥i
tazeni kurzoru se mezi sousednimi body vytvofi teCkovana Cara.

7) Jakmile se tato pferuSovana Céara jevi jako pfimka mezi sousednimi body, uvolnime
vybrany bod. Vybrany bod je vylou¢en a mezi sousednimi body nyni existuje pfimka.
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Obrazek 76: Priklad prevodu krivky na pfimku

(1) Kfivka se zobrazenymi body.
(2) Useky mezi body pfevedené na Cary.
(3) Vymazani bod( pro vytvoreni ¢arového tseku.

Prevod krivek nebo c¢ar

KFivky a Cary se prevadeji pomoci Prevést na kfivku na nastrojové listé Upravit body. Kdyz se
kfivka pfevede na pfimku, vytvorfi se pfimka mezi vybranymi body na kfivce. KdyZ se Cara
prevede na kfivku, vytvofi se kfivka mezi vybranymi body na pfimce. Pfiklad pfevodu kfivky na
pfimku je uveden na obrazku 76 nad.

1) Pfevedeme objekt na kifivku nebo mnohouhelnik.
2) Prepneme objekt do reZzimu Uprav bodi a otevieme nastrojovou listu Upravit body.
3) Vybereme body pro pfevod z kfivky na pfimku nebo z pfimky na kFivku.

4) Na nastrojové listé Upravit body klikneme na Pfevést na kfivku. Mezi vybranymi body je
kfivka pfevedena na pfimku nebo ¢éra na kfivku.

5) Odstranénim bodu na prevedené pfimce vytvofime pfimku.

Rozdéleni objekt(

1) Prevedeme objekt na kfivku nebo mnohouhelnik.
2) Pfepneme objekt do reZzimu Uprav bodi a otevieme nastrojovou listu Upravit body.

3) Vybereme bod nebo body na objektu, kde méa byt rozdélen. Pfi vybéru vice nez jednoho
bodu ponechame stisknutou klavesu Shift.

4) Chceme-li rozdélit nebo vyjmout hranici objektu ve vybraném bodé klikneme na
nastrojové listé Upravit body na Rozdélit kfivku. Pokud je objekt zapInén, vyprazdni se,
protoZe okraj objektu jiZz neni uzavien, jak je znazornéno na obrazku 77 pod.

5) ZruSime vybér objektu, poté pfetdhneme vyjimany segment a posuneme jej od
plvodniho objektu.
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}? Poznamka

Bod, kde byl objekt rozdélen, je nyni vétSi nez zbyvajici body viditeIné na objektu.

Uzavieni objektl
1) Vybereme otevieny objekt (obrazek 78 pod).

2) Pfepneme objekt do reZzimu Uprav bod( a otevieme nastrojovou listu Upravit body.

e

Obréazek 77: Priklad rozdéleni objekt(

(@

Obréazek 78: Priklad uzavieni objekt(

3) Vybereme bod, kde byl objekt rozdélen. PoCate€ni bod objektu je vétSi neZ ostatni body
viditeIné na objektu.

4) Na nastrojové listé Upravit body klikneme na Uzavfit Beziérovu kfivku a objekt
uzavieme. Pokud byl otevieny objekt plivodné uzavienym a vyplnénym objektem, vypini
plvodni barva pfi zavieni objekt.
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Formatovani car

V aplikaci Draw oznacuje pojem Cara samostatnou Gsecku (¢aru), vnéjsi hranu nebo okraj tvaru
nebo Sipku. Vlastnosti Cary, které Ize upravit, jsou styl, Sitka, barva a typ hrotu Sipky.

/? Poznamka

Dalsi informace o pouziti barvy pfi formatovani ¢ar, styll Car, Sipek a styld Sipek
najdeme v Céasti ,Prace s vyplnémi oblasti* na strané 91.

Nastrojova lista Cara a vypli
5) Vybereme Caru v kresbé.

6) V piipadé potieby zvolime v hlavni nabidce Zobrazit > Nastrojové liSty a vybereme
z rozbalovaci nabidky Cara a vyplii. Otevie se nastrojova lista Cara a vyplii
(obrazek 79 pod).

7) Klikneme na trojuhelnik v vpravo od ikony Styl €ary a v rozeviracim seznamu styl cary
vybereme.

8) Sitku ¢ary miZzeme zadat do textového pole Tloustka &ary nebo ji zmé&nit pomoci Sipek
nahoru a dolQ.

9) Klikneme na trojuhelnik ¥ vpravo od ikony Barva €ary a vyberme barvu z dostupnych
barevnych palet.

10) V pfipadé potreby pridame stin klepnutim na tlagitko Stin. Pouzity stin pouziva nastaveni
provedend na strance Stin v dialogovém okné Cara (obrazek 84 na strance 84).

11) V pripadé potfeby vybereme v rozeviracim seznamu Vyberte pocate¢ni a koncové
hroty Sipek typ hrotu Sipky pro kazdy konec ¢ary a zménime Caru na Sipku. Levy
rozeviraci seznam pfida na zaCéatek cary Sipku. Pravy rozeviraci seznam pfida na konec
cary Sipku.

12) ZruSenim vybéru Cary uloZime zmény cary.

Postranni liSta
1) Vybereme Céaru v kresbé.

2) V postranni listé klepneme na Vlastnosti a otevieme kartu Vlastnosti.
3) Kliknutim na Céara otevieme panel Cara (obrazek 80 pod).

v X
|Bar'.ra v| rf — . Q| =~ = ,.'T'«, d - m n
Cara a wplii
SHIE- 08 & O 5 — =000 cm > e~

Obréazek 79: Néastrojova lista Cara a vyplii

Dokumentace pro LibreOffice je dostupna na https://cs.libreoffice.org/get-help/documentation/



! Vlastnosti
+l Znak

-+ Odstavec
+/ Oblast
—| Cara

gl 2l el X

el
O ® @ & ml

Cara: Fadpe

Sitka:

i
4

Barva:

Pruhlednost: |0 %

4(»

Styl rohu: ‘Zal-(ulacengr

<

Styl zakonceni: ‘Ploché

<

+/ Umisténi a velikost 5

+/ Sloupce

Obrézek 80: Panel Céra na karté Vlastnosti v postranni
listé

4) V okné Céra klikneme na Vyberte poéateéni a koncové hroty Sipek pro &ary, abychom
otevieli rozeviraci seznamy typd hrotll Sipek pro jednotlivé konce ¢ary a zménili aru na
Sipku.

5) Levy rozeviraci seznam pfida na zacatek cary hrot Sipky.

6) Pravy rozeviraci seznam pfida na konec ¢ary hrot Sipky.

7) V poli Céra vybereme pozadovany typ ¢ary z rozeviraciho seznamu Styl &ary.

8) Z moznosti v poli TlouStka vybereme Sitku €ary z rozeviraciho seznamu Vyberte Sifku
¢ary nebo zadame Sifku do textového pole Vlastni tloustka ¢ary.

9) V poli Barva klikneme na trojuhelnik v vpravo od ikony Barva €ary a zvolime barvu na
jedné z dostupnych barevnych palet.

10) V pripadé potfeby zadame do pole Prihlednost procentudlni hodnotu prdhlednosti ¢ary.

11) V pfipadé potieby vyberme v poli Styl rohu z rozeviraciho seznamu styl rohu pro danou
Céru.

s w7z

12) V pfipadé potfeby vybereme v poli Styl zakonceni ¢ary z rozeviraciho seznamu styl
zakonceni pro konce cary.

13) ZruSenim vybéru ¢ary uloZzime zmény provedené na Care.
14) V pripadé potreby se kliknutim na ikonu DalSi moZnosti na pravém konci titulniho pruhu
otevie dialog Céara (obrazek 81), v némz mame vice moznosti pro formatovani Car.
Dialogové okno Cara.
1) Ujistime se, Ze je na kresbé vybrana cara.
2) Pomoci jedné z néasledujicich metod otevieme dialogové okno Céara (obrézek 81 pod):
— V hlavni nabidce zvolime Format > Cara.

— Klepneme pravym tlagitkem na ¢aru a z mistni nabidky vybereme Cara.

Prirucka aplikace Draw 25.8 | 81



— V postranni listé na karté Vlastnosti klikneme na ikonu DalSi moZnosti na pravem
konci titulniho pruhu sekce Cara.

3) Caru naformatujeme pomoci moznosti dostupnych v dialogovém okné& Céra. Nahled
v dolni ¢asti dialogu zobrazuje U€inky provadénych nastaveni Cary.

4) Klepnutim na tla€itko OK uloZime zmény a zavieme dialogové okno.

Céra Stin Styly car Styly Sipek

Vlastnosti cary Styly rohti a zakonéeni
Styl: ‘ ------------- Carkovana s deldl ‘ Styl rohu: |Zaku|acen§' ~ ‘
Barva: B Zelens - Styl zakonéent: [Ploché v]

-
Prihlednost:

Styly Sipek
Styl zacétku: | <€— Konkavni v Styl konce:
Sitka: 0,28 cm = Sitka:
[ Na stied
[ Synchronizovat zakoncenf
PN /! \
D L » PN AN
, ~ / \
s ~ /! .
Napovéda Obnovit OK Zrusit

Obréazek 81: Dialogové okno Céra — stréanka Céra

Vlastnosti ¢ary

Na strance Cara v dialogovém okné Céara se nastavuiji zakladni parametry ¢ary. Je rozdélena do
tfi nasledujicich oddild.
Vlastnosti €ary
Styl
Z rozeviraciho seznamu vybereme styl Cary.
Barva
Vybereme preddefinovanou barvu na jedné z dostupnych barevnych palet.
Tloustka
Urcuje tlouStku Cary.
Prihlednost

Nastavuje prihlednost ¢ary. Na obrazku 82 pod je pfiklad G¢ink{ riznych hodnot
prihlednosti na ¢ary umisténé nad objekt.

Styly Sipek
Tato ¢ast se vztahuje pouze na jednotlivé ¢ary a nepouZziva se pro ¢ary, které tvori
hranice objektu.
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Styl zacatku

Z rozeviraciho seznamu vybereme styl Sipky v poCatecnim bodé Cary.
Styl konce

Z rozeviraciho seznamu vybereme styl Sipky v koncovém bodé cary.

0% 25% 50% 75%

Obrazek 82: Priklad prihlednosti ¢ar

Obréazek 83: Priklad zakonceni Sipek

(1) Vychozi ukonceni (2) Vystifedéné ukonceni
Sitka
Urcuje tloustku zakonceni Sipek.
Na stred

Presune stfed Sipky do koncového bodu ¢ary. Na obrazku 83 nad je pfiklad ucink(
vybéru této moznosti.

Synchronizovat zakonceni
Zpusobi, Ze oba konce jsou stejné.
Styly rohti a zakonéeni
Urcuje, jak vypada spojeni mezi dvéma Useky ¢ary. Chceme-li zjistit rozdil mezi témito
styly, zvolime styl tlusté Cary a sledujeme, jak se zméni nahled.
Styl rohu

Vybereme tvar, ktery se pouzije v zalomeni ¢ary. U ostrych ahll je sefiznuty tvar
nahrazen tvarem zkosenym.

Styl zakonceni

Vybereme styl zakon€eni Cary. Zakon€eni je pouzito i pro vnitfni ¢arky ¢arkovanych
Car.

Stiny ¢ar

Stranka Stin dialogového okna Cara (obrazek 84 pod) poskytuje moznosti pfidani a forméatovani
stinu na vybranou ¢aru. Nastaveni na této dialogové strance se pouZivaji také pro stiny pouzité
na jiné objekty. DalSi informace nalezneme v Casti ,Prace se stiny“ na strance 108.
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Rychle pfidame care stin tak, ze klikneme na ikonu Stin na nastrojové listé Céra a vyplii. Nastroj
Stin vytvofi stin s vlastnostmi definovanymi na strance Stin v dialogu Céra.

Cara Stin Styly ¢ar Styly sipek
Vlastnosti Nahled
PouZit stin
(o]
Barva: B Cema -
Vzdalenost: |DJ4D cm E‘
Rozostfent: |D pt @‘
Prihlednost: |D % @‘

Obrézek 84: Dialogové okno Céra — stréanka Stin

Céra Stin Styly éar Styly gGipek

Vlastnosti
Styl &ary: | Teckovana (zaoblena) Pridat
Typ: |Teﬁka |Cérka Zménit
Pocet: |1 E” |3 E‘ -
Délka | : ‘ |DJ30 om E‘ Smazat

Vzdalenost: |D,2[} cm E‘

U Prizpdsobit &ifce cary

P n

H Il BN BN N BN BN BN N BN BN BN N BN BN B N B B . " ~~ ' ™
* T ) 3
Napovéda Obnovit OK Zrusit

Obrézek 85: Dialogové okno Céra — strénka Styly éar

Styly Car

PFi vytvareni nékolika Gar se stejnym formatem se pomoci styld ¢ar snizi nutnost formatovani
jednotlivych Car. LibreOffice poskytuje styly Car, které Ize pouZit v kresbé. Styly Car Ize vytvéaret,
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ukladat nebo odstrafovat. Stranka Styly &ar v dialogovém okn& Céra (obrazek 85 nad)
poskytuje moznosti pouZiti pfeddefinovanych stylli ¢ar a vytvoreni nebo zmény styll ¢ar.
Vytvareni styl( ¢ar

1) Vytvorfime Caru v kresbé.

2) Pomoci jedné z néasledujicich metod otevieme dialogové okno Céra:

3) V hlavni nabidce zvolime Format > Cara.

4) Klepneme pravym tlagitkem na ¢aru a z mistni nabidky vybereme Cara.

5) Kliknutim na Styly &ar v dialogovém okné& Céara otevieme stranku Styly é&ar.

6) V rozeviracim seznamu Styl ¢ary vybereme preddefinovany styl ¢ary, ktery chceme
pouZzit jako vychozi bod pro vytvofeni stylu €ary. Pfiklad stylu Cary se zobrazi v ramecku
v dolni C4sti dialogové stranky. Tento pfiklad se méni pfi zménach stylu Cary.

7) V rozeviracich nabidkach Typ vybereme Teéku nebo Carku.
8) Pro jeden typ Cary vybereme stejny typ v obou polich Typ.
9) Pro stiidani typd ¢ar v ramci jednoho Ffadku vybereme v kazdém poli Typ rlizné typy.

10) V polich Pocet zadame, kolikrat se maji prvky kazdého Typu opakovat. Pro rizné velké
skupiny teCek nebo Carek nastavime v kazdém poli Cislo jiny pocCet.

11) V polich Délka zaddme Délku jako procento délky Cary. Volba Délka neni pro Tecku
k dispozici.

12) V poli Vzdalenost zadame rozte€ mezi pomickami a/nebo teckami v procentech tloustky
¢ary. Moznost Vzdalenost neni k dispozici, pokud je vybrana moznost Prizplsobit Sifce
cary.

13) V pfipadé potfeby vybereme moznost Prizplsobit Sifce ¢ary, aby novy styl odpovidal
Sifce Cary pfi jejim pouziti v kreshé.

14) Pouze pro aktualni dokument vytvofime novy styl ¢ary nebo stavajici upravime
nasledujicim zptisobem:

d) Kliknutim na tlacitka Pfidat nebo Zménit otevieme dialogové okno Nazev.
e) Zadame jedineCny nazev nového nebo upraveného stylu Cary.

f) Kliknutim na OK novy nebo upraveny styl ¢ary ulozime a zavieme dialogové okno
Nazev.

15) Kliknutim na OK zavieme dialogové okno Cara a novy styl ¢ary je pouze v aktualni
kresbé pfipraven k pouZiti.

ﬁ Poznamky

Abychom mohli novy nebo upraveny styl Cary pouZit i v jinych vykresech, je tfeba na
strance Styly Car ulozit styl ¢ary kliknutim na ikonu Ulozit styly €ar.

PTi vytvafeni nebo Uprave stylu ¢ary se doporucuje pouzit pro styl Cary jedinecny
nazev. Tim se zabrani prepsani stylu ¢ar LibreOffice a vzniku problém

s formatovanim v jinych kresbach nebo dokumentech, které pouzivaji styly Car
LibreOffice.

UloZeni styld ¢ar
1) Vytvofime novy styl ary, ale nezavieme dialogové okno Cara.
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2) Kliknutim na ikonu UlozZit styly ¢ar a otevieme okno prohlizece soubor(i ve spravném
umisténi pro uloZeni styll Car.

3) Do pole Nazev zadame jedine€ny nazev souboru s pfiponou SOD pro styl Cary.

4) Kliknutim na UloZit uloZime styl ¢ary a zavieme okno prohlizece soubort. Novy styl ¢ar
je nyni k dispozici pro pouziti v novych kresbach a dokumentech.

Importovani styl( ¢ar

Styly €ar LibreOffice se instaluji béhem instalace LibreOffice. Kompatibilni styly Car Ize také
importovat a pouzivat v LibreOffice. VSechny styly ¢ar pfidané do LibreOffice musi pouzivat
pfiponu souboru SOD, aby byl styl rozpoznan v LibreOffice.

1) Vytvofime Céaru v kresbé.
2) Otevieme dialogové okno Céra a klepnutim na Styly &ar otevieme stranku Styly éar.

3) Kliknutim na ikonu Na€ist styly €ar v pravém dolnim rohu stranky Styly €ar otevieme
okno prohlizece soubor( v adreséfi se styly ¢ar.

4) Vybereme styl ze seznamu uloZenych styld v okné prohlize¢e soubor(. Pfipona souboru
pro styly ¢ar je SOD.

5) Kliknutim na Otev¥it nateme styl Car do LibreOffice. Styl ¢ary je k dispozici i pro dalSi
kresby a dokumenty LibreOffice.

6) Kliknutim na tladitko OK zavieme dialogové okno Cara a uloZime provedené zmény.
Mazani styl( ¢ar

1) Otevieme dialogové okno Céra a klepnutim na Styly &ar otevieme stranku Styly &ar.

2) Z rozeviraciho seznamu Styl ¢ary vybereme styl Cary, ktery chceme odstranit.

3) Klikneme na Smazat a v potvrzovacim dialogu dokon€ime smazani kliknutim na Ano.

4) Kliknutim na tla¢itko OK zavieme dialogové okno Céara a uloZime provedené zmény.

ﬁ Poznamka

Pfi odstranovani styl(l ¢ar by mélo platit, Ze dany styl ¢ary neni pouzit v jiném
dokumentu. Doporucuje se odstranovat pouze vytvorené nebo importované styly Car.
Nemazte styly Car LibreOffice. Tim se zabrani problémim s formatovanim v jinych
dokumentech, kde byl pouZzit styl Cary LibreOffice.

Styly Sipek

Pouzitim karty Styly Sipek (obrazek 86 pod) v dialogovém okné& Cara mdZeme vytvofit nové styly
Sipek, upravit existujici styly Sipek nebo nacist dfive uloZené styly Sipek.

Vytvareni styl( Sipek

Na Sipku miZeme pouzit kazdy tvar, ktery je prevoditelny na kfivku. Kfivka je tvar nakresleny
jednim tahem, bez zvednuti tuzky. Hvézdu Ize napfiklad pfevést na kfivku, ale smajlika nikoliv.

1) Vlyberte nebo vytvofte tvar, ktery Ize prevést na kfivku a pouZit jako novy hrot Sipky. Cést
tvaru, ktera bude hrotem Sipky, musi byt v horni ¢asti tvaru.

2) Vybereme tvar a pomoci jedné z nasledujicich metod jej pfevedeme na kfivku:

— Klikneme na tvar pravym tlacitkem mysSi a z mistni nabidky vybereme moznost Pfevést
> Na kfivku.

— V hlavni nabidce zvolime Tvar > Prevést > Na kFivku.
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3) S vybranym tvarem otevieme v dialogovém okné Céra stranku Styly Sipek.

4) Klikneme na P¥idat a v otevieném dialogovém okné Nazev zadadme jedineCny nazev
nového stylu Sipky, pak klikneme na OK. Novy styl Sipky se zobrazi v ndhledu v dolni
Casti stranky Styly Sipek a na konci rozeviraciho seznamu Styl Sipky.

Cara Stin Styly &ar Styly 3ipek
Spravovat styly Sipek
Nézev stylu: |Kratk Sipka \ Pridat
StylSipky: | 4— Krétka Sipka v| —
Prejmenovat
Smazat
1=
MNapoveda Obnovit OK Zrusit

Obréazek 86: Dialogové okno Céra — stranka Styly Sipek

5) Kliknutim na OK uloZime zmény a zavieme dialogové okno Céara. Novy styl Sipky je
k dispozici pouze v aktualnim dokumentu.

}? Poznamky

Bod vytvareného hrotu Sipky musi byt umistén v horni ¢asti tvaru. V pfipadé potfeby
tvar oto¢ime, dokud se bod nenachazi v horni ¢asti tvaru, jak je znazornéno na
obrazku 87 pod.

Nékteré tvary nelze pouzit jako hrot Sipky. To je indikovano obdélnikovymi bloky,
které se objevuji na obou koncich fadku v okné nahledu na strance Styly car
v dialogovém okné Cara.

PTi vytvareni stylu Sipky se doporucuje pouzit jedine€ny nazev stylu Sipky. Tim se
zabrani pfepsani jednoho ze styll Sipek LibreOffice, které by zplsobilo problémy

s formatovanim v jinych vykresech, které pouzivaji styly Sipek LibreOffice.

Vytvoreny novy styl Sipky je k dispozici pouze pro pouziti v aktualni kresbé. Chceme-
li novy styl Sipky pouZit v jinych kresbach, je tfeba styl Sipky uloZit pomoci moZnosti
Ulozit styly Sipek.

UloZeni styl( Sipek

1) Vytvorte novy styl Sipky podle popisu v Casti ,Vytvareni styll Sipek” na strané 86, ale
nezavieme dialogové okno Céra.
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2) Kliknutim na ikonu Ulozit styly Sipek na strance Styly Sipek otevieme okno prohliZzeCe
souborll ve spravném umisténi pro ulozeni styld Sipek.

3) Pro soubor stylu Sipky zadame jedineCny nazev s pfiponou SOE.

Obrazek 87: Priklad vytvoreni hrotu Sipky

4) Kliknutim na UloZit uloZzime styl Sipky a zavieme okno prohlizece souborl. Novy styl
Sipky je nyni k dispozici pro pouZziti v novych dokumentech.
Import stylt Sipek

LibreOffice poskytuje po instalaci do pocitaCe vychozi styly Sipek. Kompatibilni styly Sipek vSak
Ize importovat a pouZivat v LibreOffice. VSechny styly Sipek nainstalované v LibreOffice musi
pouZzivat pfiponu souboru SOE.

1) Otevieme dialogové okno +Cara a kliknutim na Styly Sipek otevieme stranku Styly
Sipek.

2) Kliknutim na ikonu Na€ist styly Sipek na strance Styly Sipek otevieme okno prohliZzeCe
soubord ve spravném umisténi pro styly Sipek.

3) Ze seznamu uloZenych styll v okné prohliZzece souborll vybereme styl Sipky.

4) Kliknutim na tlacitko Otevfit nacteme styl Sipky do kresby. Styl Sipky je k dispozici i pro
dalSi dokumenty LibreOffice.

5) Kliknutim na tlacitko OK zavieme dialogové okno Céra a uloZime provedené zmény.
Mazani styld Sipek
1) Otevieme dialogové okno +Cara a kliknutim na Styly Sipek otevieme stranku Styly
Sipek.
2) V rozeviracim seznamu Sty Sipky vybereme styl Sipky pro odstranéni.
3) Klikneme na Smazat a v potvrzovacim dialogu dokon€ime smazani kliknutim na Ano.

4) Kliknutim na tlagitko OK zavieme dialogové okno Céara a uloZime provedené zmény.

ﬁ Poznamka

Pfed smazanim stylu Sipky se ujistime, Ze dany styl neni pouzit v jinych
dokumentech. Odstraniujeme pouze vytvofené nebo importované styly Sipek.
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Abychom predesli problémidm s formatovanim pfi pouzivani styll Sipek LibreOffice,
neodstrafiujeme jeden z preddefinovanych styll Sipek LibreOffice,

Obrazek 88: Priklad typt vypini ploch

(1) Zadné (3) Pfechod (5) Vzorek
(2) Barva (4) Obrazek (6) Srafovani

Vyplné oblasti

Vypli oblasti Ize vytvofit uvnitf objektu, ktery ma nepreruSeny okraj, napfiklad obdélnik, kruh,
hvézdu, pétithelnik apod. Vypli plochy mize byt Zadna, Barva, Pfechod, Obrazek, Vzorek
nebo Srafovani, jak ukazuji pfiklady na obrazku 88 nad. Také vyplii plochy miiZze byt ¢astecné
nebo zcela prdhledna a vrhat stin.

Dialogové okno Oblast poskytuje nastroje a moznosti pro vybér a Upravu vyplni oblasti. VypIné
oblasti jsou k dispozici také v rozeviracich seznamech na panelu Oblast na karté Vlastnosti
postranni liSty a v nabidce Styl/vypln oblasti na nastrojové listé Cara a vypli, maji vSak omezené
moznosti a jiné typy vyplni.
Formatovani pomoci dialogového okna Oblast
1) Ujistime se, Ze je objekt v kresbé vybréan.
2) Pomoci jedné z nasledujicich metod otevieme dialogové okno Oblast (obrdzek 89 pod):
— V hlavni nabidce vybereme Forméat > Oblast.
— Klikneme na tla¢itko Oblast na nastrojové listé Céara a vypli.

— Klikneme pravym tlacitkem mySi na vybrany objekt a z mistni nabidky vybereme
moznost Oblast.

— Klepneme na DalSi moZnosti vpravo od ndzvu panelu Oblast v postranni listé.
3) Klepnutim Oblast otevieme stranku Oblast.

4) Z dostupnych moznosti zvolime typ vypiné (Zadna, Barva, Prechod, Obrazek, V/zorek
nebo Srafovani).

5) Vybereme pozadované moznosti vypIné oblasti, které jsou k dispozici pro kazdy vybrany
typ vyplné oblasti.
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6) Kliknutim na tlacitko OK zavieme dialogové okno Oblast a uloZime zmény vypIné oblasti.

Oblast Stin Prahlednost
Zadna Barva Prechod Obrazek Vzorek Srafovani
Barvy Aktivni Nova
Pa[eta:|standard | ) |
HEEEEEEN
EEEEEEEEEN
R (114 R |14 =
H
EEEEEEENE 6 [159 G 159 B
EEEEEEEEN B |207 B |207 =
SEEEEEEEEEN
PEEEEEEEEEEE HTML |729fcf HTML |729fcf
EEEEEEEEEEEE
ENEEEEEEEEEE Vybrat ()
Posledni barvy
EEENEE BN
Vlastni paleta
Pridat Smazat

Obrazek 89: Dialogové okno Oblast — stranka Barva oblasti

! Vlastnosti
Znak

+ Odstavec

........................

o
0
Eﬁ
ERRERREE x

Prihlednost: [Zadna

S ®F |

15{

I 0%

Cira F
Efekt

Stin

Umisténi a velikost
Sloupce

el el

Obrazek 90: Panel Oblast na karté Vlastnosti v postranni
listé
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Formatovani pomoci postranni listy
1) Ujistime se, Ze je v kresbé vybran objekt s vyplnitelnou oblasti.

2) Kliknutim na Vlastnosti na postranni listé a poté kliknutim na Sipku dold Vv v titulnim
pruhu vlevo od sekce Oblast otevieme panel Oblast (obrazek 90 nad).

3) V rozeviracim seznamu Vyplri: vybereme typ vypiné (Zadnd, Barva, Pfechod, Srafovani,
Rastr nebo Vzorek).

4) V rozeviracim seznamu Vypli: vybereme efekt vyplné z moznosti dostupnych pro
jednotlivé typy vyplni.

5) V pfipadé potfeby vybereme typ priihlednosti a procento priihlednosti z rozeviracich
seznamU Prihlednost.

6) ZruSenim vybéru objektu ulozime zmény vypIné oblasti.

ﬁ Poznamka

Typ efektu prdhlednosti vybrany pro vyplii oblasti ovliviiuje moznosti dostupné pro
prihlednost na panelu Oblast na postranni listé.

Formatovani pomoci nastrojové listy Cara a vypli

1) Pokud nastrojova lista Cara a vyplii (obrazek 79 na strané 80) neni oteviend, zvolime
v hlavni nabidce Zobrazit > Nastrojové listy > Cara a vypln.

2) VVybereme objekt, zobrazi se uchytky vybéru.

3) V rozeviracim seznamu Styl/vyplii oblasti vybereme typ vypiné (Zadna, Barva, Pfrechod,
Srafovani, Rastr nebo Vzorek).

4) V rozeviracim seznamu vybereme z moZnosti dostupnych pro jednotlivé typy vyplni efekt
vyplné. Dostupné efekty vypiné se méni pro kazdy vybrany typ vyplné.

5) ZruSenim vybéru objektu uloZzime zmény vypIné oblasti.

Prace s vyplnémi oblasti

}? Poznamka

Nasledujici pokyny pro vypIné oblasti pouzivaji dialogové okno Oblast jako hlavni
metodu vybéru a Uprav vypIné oblasti. Nastroje a moznosti dostupné na panelu
Oblast na karté Vlastnosti na postranni listé a na nastrojové listé Cara a vyplf jsou
podobné, ale maji omezené moznosti a odliSné nazvy.

Barvy vypiné
Vybér barvy vypiné

1) Ujistime se, Ze je objekt v kresbé vybran.

2) Na strance Oblast stejnojmenného dialogu (obrazek 89 na strané 90) klikneme na
tlaCitko Barva a zobrazi se moznosti nastaveni barevné vypIné.

3) V poli Barvy vybereme poZadovanou paletu z dostupnych moznosti v rozeviracim
seznamu Paleta.

4) Ve zvolené paleté klikneme na pozadovanou barvu. VSechny dostupné barevné vyplné
jsou plné barvy. Nahled s oznaCenim Aktivni obsahuje aktualni barvu vyplné vybraného
objektu. Vybrana barva vyplné se zobrazi v nahledu Nova.
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5) Barvu mizeme také vybrat jednim z nasledujicich zptsob.
— Do pfislusného textového pole zadame jednotlivé hodnoty RGB ve stupnici 0 az 255.
— Do textového pole Hex zaddme Hex Cislo barvy.

— Pokud jsme nékterou barvu uz dfive pouzili, nachazi se pod paletou v ¢asti Posledni
barvy.

6) Chceme-li se vrétit k pdvodni barvé, klikneme na Obnovit, ¢imz odstranime vSechny
provedené zmény.

7) Klepnutim na tlacitko OK zavieme dialogové okno Oblast a ulozime zmény.

Vytvareni viastnich barev pomoci dialogového okna Oblast
1) Vybereme vypInény objekt a vytvofime barvu.

2) Otevieme dialogoveé okno Oblast a klepnutim na Oblast otevieme stranku Oblast.
Nasledné klepneme na tlaCitko Barva a zobrazi se moZnosti nastaveni barevné vyplné.

3) Pomoci jedné z nasledujicich metod vytvofime vlastni barvu:
— Zadame hodnoty Cervené (R), zelené (G) a modré (B) na stupnici 0 az 255.

— Kliknutim na Vybrat otevieme dialogové okno Vyberte barvu (obrdzek 91), viz
»Vytvareni vlastnich barev pomoci dialogového okna Vyberte barvu” pod.

4) Ve Vlastni paleté klepneme na Pridat a zadame v dialogovém okné Nézev, které se
otevie, nazev barvy.

5) Kliknutim na OK zavieme dialogové okno Nazev a barva se pfida do Viastni palety.

RGB
O Cervena:
O Zelena: 207 =
O Modré:  |114 3
HTML: cicff2
HSB
® Qdstin:
' (2 Sytost:
O Jas: 81% =
b CMYK |
Azurova;
l Magenta:
Zluta:
_ Cerné: 19% =
MNapovéda QK Zrusit

Obréazek 91: Dialogové okno Vyberte barvu
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6) Klepnutim na tlacitko OK zavieme dialogové okno Oblast a uloZzime zmény. Nova vlastni
barva se zobrazi jako vyplii vybraného objektu a je k dispozici pro pouZiti v jinych
kresbach nebo dokumentech.

Vytvareni viastnich barev pomoci dialogového okna Vyberte barvu

1) Vybereme vyplnény objekt a vytvofime barvu.

2) Jednim z nasledujicich zplisobl otevieme dialogové okno Vybér barvy (obrazek 91 nad):
— Klikneme na Vybrat na strance Barva dialogového okna Oblast.

— Klikneme na trojuhelnik v vedle poloZzky Barva vyplné v ¢asti Oblast na karté
Vlastnosti na postranni listé a vybereme Viastni barvy.

— Klikneme na trojahelnik v vedle polozky Barva vyplné na nastrojové liste Cara
a vypli a vybereme moznost Viastni barva.

3) Vytvofime vlastni barvu pomoci jedné z nasledujicich metod.

— Sytou barvu vybirame na barevném pruhu, kurzorem pak na barevné ploSe volime
pozadovany odstin.

— Zadame hodnoty ¢ervené (R), zelené (G) a modré (B) slozky barvy v textovych polich
RGB.

— Pripadné zadame do textového pole Cislo Hex. Obsahuje za sebou slozky RGB
vyjadrené v Sestnactkové Ciselné soustavé.

— Mizeme také zadat hodnoty Odstinu (H), Sytosti (S) a Jasu (B) v textovych polich
HSB. Hodnoty HSB neméni barvu, ale to, jak barva vypada.

— Pripadné zaddme hodnoty azurové (C), purpurové (M), Zluté (Y) a Cerné (K) slozky
barvy v textovych polich CMYK.
)? Poznamka

Néhled vytvarené barvy se zobrazuje vlevo pod aktivni plochou, na které volime
odstin barvy. Zménou jedné sady barevnych hodnot se zméni i hodnoty barev
v ostatnich sadach barevnych hodnot.

4) Kliknutim na tlacCitko OK zavieme dialogové okno Vyberte barvu a ulozime zmény.

5) Ve Vlastni paleté klepneme na Pridat a zadame v dialogovém okné Néazev, které se
otevie, nazev barvy.

6) Kliknutim na OK zavieme dialogové okno Nazev a barva se pfida do Viastni palety.

7) Klepnutim na tlacitko OK uloZime zmény a zavieme dialogové okno Oblast. Vyplii
vybraného objektu nabude novou barvu, ta bude k dispozici i pro jiné kresby
a dokumenty.

Mazani vlastnich barev
1) Vybereme vyplnény objekt, ktery pouziva barevnou vyplii pro odstranéni.
2) Pomoci jedné z nasledujicich metod otevieme dialogové okno Oblast:
— V hlavni nabidce vybereme Format > Oblast.
— Klepneme pravym tlaCitkem na objekt a vybereme z mistni nabidky Oblast.
— Klepneme na DalSi moznosti vpravo od nazvu panelu Oblast v postranni listé.
3) Klepneme na Oblast a poté klepnutim na Barvy otevieme stranku Barvy.

4) Na strance Barvy vybereme z rozeviraciho seznamu Paleta moznost Viastni.
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5) Vybereme barvu, kterou chceme odstranit, a klikneme na tlacitko Smazat. Smazani
nevyzaduje potvrzeni.

6) Klepnutim na tlacitko OK uloZime zmény a zavieme dialogové okno Oblast.

ﬁ Poznamka

Pomaoci dialogového okna Oblast Ize odstranit pouze vlastni barvy dostupné ve
vlastni paleté. Barvy dostupné ve vychozich barevnych paletach LibreOffice nelze
odstranit.

Vypln pfechod

Pfi instalaci LibreOffice je k dispozici nékolik pfeddefinovanych pfechodd. Doporu¢ujeme vytvorit
vlastni pfechody, které odpovidaji poZadavkdm, a neupravovat zadné prechody LibreOffice.
Pfechody v LibreOffice mohly byt pouzity v jinych kresbach nebo dokumentech.

Vlastni pfechody se ukladaji s jedineénym nazvem, ktery umoziuje jejich pouziti v jinych
kresbach nebo dokumentech. V seznamu prechod( zobrazeném v poli Pfechod na strance
Pfechod dialogového okna Oblast (obrazek 92 pod) jsou vlastni pfechody umistény na konci.

Vybér vyplni s pfechody

Nasledujici postup vybéru pfechodu pro vypli oblasti pouziva dialogoveé okno Oblast. Nabidka
nastrojové listy Cara a vypli se podoba nastrojiim na panelu Plocha na karté Vlastnosti
postranni liSty, ale dostupné moznosti jsou omezené.

1) Ujistime se, Ze je objekt, ktery méa byt vyplnén, vybran v kresbé.

Oblast Stin Prihlednost

Zadna Barva Rastr Vzorek Srafovani
Prechod Moznosti Nahled
A~ Typ:
Linearni ™
Prirdstek:
Automaticky 64 =
Stred (X a Y):

EEE

I 30° =
Chraniceni:

B+ [

Qd barvy:

[ | Svétlezelena4 ~ [100%
+ | Do barmvy:

[ | Svétlecervena4 ~ | 100%

Pridat Zménit

Napovéda Qbnovit QK Zrusit

Obréazek 92: Dialogové okno Oblast — stranka Pfechod
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2) Na strdnce Oblast stejnojmenného dialogu klikneme na tlacitko Pfechod, zobrazi se
moZnosti nastaveni barevného pfechodu vypIné.

3) V okné Pfechod vybereme z nabidky néktery z pfechodd, objevi se vpravo v ¢asti

Nahled.

4) Chceme-li zménit vychozi nastaveni vybraného prechodu, zrusime vybér pole
Automaticky v ¢asti MoZnosti a poté zadame nase hodnoty do poli pro Typ, Pririistek,
Na stied, Uhel, Ohrani¢eni, Od barvy a Do barvy. P¥i jakychkoli zm&nach se zméni
i pfechod zobrazeny v Nahledu, ktery ukazuje, jak bude pfechod vypadat. DalSi
informace o nastaveni pfechodu najdeme v ,Tabulka 7: Moznosti pfechodu®.

5) Klepnutim na tlacitko OK zavieme dialogové okno Oblast a uloZime zmény. Nas pfechod

vypliiuje vybrany objekt.

}? Poznamka

Vybér a tprava pfechodu umoznuje pouziti pfechodu pouze ve vytvarené kresbeé.
Pokud ma byt upraveny pfechod pouZit v jinych kresbach nebo dokumentech,
vytvofime vlastni pfechod a uloZime jej s jedine€nym nazvem. Viz ,Vytvareni
vlastnich prechodd*“ na strané 95.

Tabulka 7: MoZnosti prechodu

Vlastnost prechodu

Vyznam

Lineé&rni pfechod

Barva pfechéazi z pocéatecni barvy do koncové barvy v pfimé linii.

Axialni pfechod

Barva pfechazi od pocatecni barvy ke koncové barvé od stfedu objektu
k jeho okrajiim ve dvou protilehlych smérech.

Radialni pfechod

Barva prechazi z pocatecni barvy do koncové barvy v kruhovém vzoru.

Ovélny prechod

Barva pfechazi z pocatecni barvy do koncové barvy eliptickym vzorem.

Krychlovy pfechod

Barva prechazi od pocatecni barvy ke koncové barvé od okrajli objektu
ke stfedu objektu ve &tyfech smérech.

Ctvercovy pfechod

Barva pfechazi od pocateéni barvy ke koncové barvé od okraji objektu
ke stfedu objektu ve Ctvercovém vzoru.

Zadame pocet krok( pro prolnuti dvou barev prechodu. Ve vychozim

Prirdstek nastaveni je tato moznost nastavena na hodnotu Automaticky.
Stied X Pro radialni, ovalné, Ctvercové a krychlové pfechody upravime tyto
hodnoty tak, abychom nastavili horizontalni posun stfedu pfechodu.
Stred Y Pro radialni, ovalné, ctvercové a krychlové prfechody upravime tyto
hodnoty tak, abychom nastavili vertikalni posun stfedu pfechodu.
Uhel U v3ech typ( pfechodu upravuje Ghel osy pfechodu.
. Pokud tuto hodnotu zvySime, bude gradient zacinat dale od okraje
Ohraniceni
tvaru.
Od barv Pocatecni barva pfechodu. Do editacniho pole zadame intenzitu barvy:
y 0 % nebo odpovida cerné barvé, 100 % piné barvé.
Koncova barva pfechodu. Do editacniho pole zadame intenzitu barvy: 0
Do barvy

% nebo odpovida ¢erné barvé, 100 % pIné barvé.

Vytvareni vlastnich prechod(i

Chceme-li pouzit v jinych vykresech nebo dokumentech upraveny pfechod, je tfeba ulozit vlastni

prechod s jedine¢nym nazvem.

1) Ujistime se, Ze je objekt v kresbé vybran.
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2) Na strance Oblast stejnojmenného dialogu klikneme na tlacitko Pfechod, zobrazi se
moZznosti nastaveni barevného pfechodu vypIné.

3) Pomoci moznosti uvedenych v Tabulka 7: MoZnosti pfechodu prechod vybereme
a upravime. Pfi provadéni zmén se méni i gradient zobrazeny v Nahledu, ktery ukazuje,
jak upraveny gradient vypada.

4) Klepnutim na Pridat otevieme dialogové okno Nazev.

5) Zadame jedineCny nazev nového prechodu a kliknutim na tlacitko OK zavieme dialogové
okno Nazev. Vlastni pfechod je posledni zobrazeny v ¢asti Pfechod a mame jej
k dispozici pro dalSi kresby a dokumenty.

6) Klepnutim na tlacitko OK zavieme dialogové okno Oblast a uloZime zmény.

Uprava viastnich pfechodti
1) Ujistime se, Ze je objekt v kresbé vybran.

2) Na strance Oblast stejnojmenného dialogu klikneme na tlacitko Pfechod, zobrazi se
moznosti nastaveni barevného pfechodu vypiné.

3) V &asti Pfechod vybereme ndas vlastni. Vlastni pfechody se zobrazi pod
pfeddefinovanymi pfechody v ¢asti Pfechod.

4) Zménime hodnoty parametrd pfechodu. Dal$i informace o moznostech prechodu
najdeme v Tabulka 7: Moznosti pfechodu . V zavislosti nha vybraném typu pfechodu
nemusi byt nékteré moznosti k dispozici.

5) Pokud je to nutné a chceme se vrétit k plivodnimu prechodu, klikneme na Obnovit
a vSechny provedené zmeény se odstrani.

6) Kliknutim na Zmeénit trvale zménime vybrany vlastni pfechod. Pfi Upravé viastniho
prechodu neni poZzadovano Zzadné potvrzeni.

7) Klepnutim na tlacitko OK zavieme dialogové okno Oblast a uloZime zmény.

ﬁ Poznamka

Pouziti moznosti Zménit na strance Pfechod v dialogovém okné Oblast trvale zméni
pfechod a nelze ji vratit zpét. DoporuCujeme upravovat pouze vlastni pfechody, nikoli
prechody LibreOffice.

Prejmenovani pfechod(
1) Vybereme objekt s pfechodem, ktery m& byt pfejmenovan.

2) Na strance Oblast stejnojmenného dialogu klikneme na tla¢itko Pfechod, zobrazi se
moznosti nastaveni barevného pfechodu vypIné.

3) Klikneme pravym tlaCitkem mysi na pfechod a z kontextové nabidky vybereme moznost
Pfejmenovat.

4) V dialogovém okné Nazev, které se otevie, zadame nazev prechodu.
5) Klepnutim na tlaitko OK uloZime zmény a zavieme dialogové okno Nazev.
6) Klepnutim na tlaitko OK uloZime zmény a zavieme dialogové okno Oblast.

Odstranéni vlastnich prechod(i
1) Vybereme obijekt, ktery pouziva vypln pfechodem.
2) V dialogovém okné Oblast otevieme stranku Oblast a klikneme na Pfechod.

3) V poli Pfechod vybereme vlastni pfechod, ktery chceme odstranit.
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4) Klikneme na prechod pravym tlacitkem mysi a z mistni nabidky vybereme moZznost
Smazat.

5) Smazani potvrdime kliknutim na Ano.
6) Klepnutim na tlaCitko OK uloZzime zmény a zavieme dialogové okno Oblast.

}? Poznamka

Doporucuje se pfejmenovat nebo odstranit pouze vytvofené vlastni pfechody.
Odstranéni nebo prejmenovani nékterého z preddefinovanych prechod(, které jsou
nainstalovany v LibreOffice, m(ze zpUsobit problémy v kresbach a dokumentech,
které néktery z pfechod(l pouzivaji.

Pokrocilé ovladaci prvky prechodii
LibreOffice poskytuje ovladaci prvky pro prechody na nastrojové listé Transformace (obrazek 93
pod).

1) Ujistime se, Ze je objekt v kresbé vybran.

2) V dialogovém okné Oblast otevieme stranku Oblast a klikneme na Pfechod.

3) V hlavni nabidce zvolime Zobrazit > Nastrojové liSty > Transformace nebo klepneme

na Transformace na nastrojové listé Transformace. Otevie se dialogové okno
Transformace.

4) Klikneme na Interaktivni nastroj pfechodu na nastrojové listé Transformace. Tim se
zobrazi pferuSovana Cara spojujici dva barevné Ctverce (obrazek 94 pod) vyplnéné
pfechodem s barvami z voleb Od barvy a Do barvy.

5) Z moznosti v rozeviracim seznamu Typ vybereme typ pfechodu pro objekt. Vlastnosti,
které Ize upravit, zavisi na vybraném typu pfechodu, jak je vysvétleno nize. Pfesouvani
¢tvercll ma rlizné Gcinky v zavislosti na typu pfechodu, viz Tabulka 8: Zména vlastnosti
pfechodu .

6) Klepnutim na tlaCitko OK uloZzime zmény a zavieme dialogové okno Oblast.

Transformace w X
A SEBETRK N

Obrazek 93: Nastrojova lista Transformace

=

Obrazek 94: Priklad pouZiti interaktivniho nastroje pro
prechod
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ﬁ Poznamka

Pfesouvani ¢tvereckd vytvari rlizné efekty v zavislosti na typu pfechodu. Napfiklad
u linearniho pfechodu prochazi spojnice obou ¢tvereckl stfedem objektu.

Tabulka 8: Zména vlastnosti pfechodu

Typ prechodu | Zména vilastnosti piechodu

PFesunutim tverce Od barvy zménime misto, kde pfechod zacina (hodnota

Linearni okraje). Pfesunutim Ctverce Do barvy zménime orientaci (hodnotu Ghlu).

PFesunutim ¢tverce Do barvy zménime Uhel i vlastnosti ohrani¢eni pfechodu.

Axialni . »
PFesunout Ize pouze Ctverec Do barvy.

Pfesunutim ¢tverce Od barvy upravime vlastnost okraje a nastavime Sirku
Radialni kruhu prechodu. Pfesunem ¢tverce Do barvy zménime bod, kde pfechod
konci (hodnoty Stfed X a Stred Y).

Pfesunutim Ctverce Z barvy upravime vlastnost ohraniceni a nastavime
Ovalny velikost ovalného prechodu. Pfesunutim ¢tverce Do barvy zménime Uhel osy
elipsoidu a samotné osy.

5 PFesunutim ¢tverce Od barvy upravime vlastnost ohrani¢eni a nastavime
Ctvercovy velikost ¢tverce nebo obdélniku pfechodu a Ghel tvaru pfechodu. PFfesunutim
Ctverce Do barvy zménime stfed prfechodu.

Pfesunutim ¢tverce Od barvy upravime vlastnost ohrani€eni a nastavime
Ctverec velikost ¢tverce nebo obdélniku pfechodu a thel tvaru prfechodu. Pfesunutim
Ctverce Do barvy zménime stfed prechodu.

Obrazkové vyplné

Pri instalaci LibreOffice do pocitace je k dispozici nékolik pfeddefinovanych obrazkd. Obsah
dodanych obrazkl nelze upravovat, ale nastaveni zobrazeni Ize ménit. Obrazky Ize také
importovat z jinych zdroju.

Vybér obrazki

Nasledujici postup vybéru obrazku pro vyplii oblasti pouziva stranku Obrazek dialogoveho okna
Oblast (obrazek 95 pod). S nastroji liSty Cara a vyplii nebo panelu Oblast karty Vlastnosti
postranni liSty se pracuje podobné, ale dostupné moznosti jsou omezené.

1) Ujistime se, Ze je objekt v kresbé vybran.
2) Otevieme dialogoveé okno Oblast a klepnutim na volbu Oblast otevieme strdnku Oblast.
Nasledné klepnutim na Obrazek otevieme moznosti dostupné pro vyplii typu obrazek.

3) V okné Obrazek vybereme pozadovany obrazek ze seznamu dostupnych obrazk
a zobrazi se v okné Nahled. Pripadné dole kliknutim na PFfidat/importovat otevieme
okno prohlizece soubor( a vybereme soubor, ktery chceme pouzit jako vypln.

4) V pfipadé potfeby zménime hodnoty v polich Styl, Velikost, Umisténi, Umisténi dlaZdic
a Odstup dlaZdic, abychom pravili obrazek. Dalsi informace o moZnostech obrazk(
nalezneme v Tabulka 9: MoZnosti obrazu.

5) Potfebujeme-li se vratit k plivodnimu obrazku, klikneme na Obnovit a vSechny
provedené zmény se odstrani.

6) Klepnutim na tlaitko OK zavieme dialogové okno Oblast a uloZime zmény. Obrazova
vyplii se pak zobrazi ve vybraném objektu.
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Oblast Stin Prihlednost

Zadna Barva Prechod Vzorek Srafovani

Rastr MoZnosti MNahled
Styl: '
Dlazdice ~]

|
Velikost: [ : : : }
Sitka: 1,00 cm |
Vyska: (1,00 cm
[ Skalovat

Umisténi:

A4

|Uprostr'ed b

Umisténi dlaZdic:
Odchylka X: |0 %
Odchylka ¥: |0 %

Odstup dlazdic:
Radek [“]lo%

e

4k

Pridat/importovat

Napovéda Obnovit OK Zrusit

Obrazek 95: Dialogové okno Oblast — stranka Rastr

Tabulka 9: MoZnosti obrazu

Nastavovana volba Vyznam
Styl — Vlastni Vybereme-li tuto moznost, Ize zadat umisténi a velikost
umisténi/velikost obrazku.

Vybereme-Ili tuto moznost, obrazek se opakuje az vyplni celou
Styl — dlazdice oblast. Velikost obrazku pouzitého pro dlazdice je urCena
nastavenim Velikost.

PFi vybéru této moznosti se obrazek roztdhne tak, aby vyplnil

Styl - roztahnute oblast objektu.

Nastavi Sifku obrazku. Napfiklad 100 % znamend, Ze Sifka
Velikost — Sifka obrazku je zménéna tak, Ze se rovna Sifce vypIné, 50 %
znamena, Ze Sitka obrazku je polovi¢ni oproti Sifce vypIné.

Nastavi vySku obrazku. Napfiklad 100 % znamena, Ze vysSka
Velikost — vySka obrazku je rovna vySce vypIné, 50 % znamena, Ze vysSka
obrazku je polovi¢ni oproti vyplni.

Pokud je vybrana, velikost obrazku je uvedena v procentech
Velikost — Skalovat pro Sitku a VySku. Pfi zruSeni vybéru je pro Sitku a Vysku
uvedena skutec¢nd velikost obrazku.

Umisténi Ur&uje polohu kotevniho bodu obrazku.

Nastavi posunuti Sitky obrazku v procentech. Posunuti o 50 %

~ 7y

znamena, Ze LibreOffice Draw umisti stfedni Cast Sirky
obrazku do kotevniho bodu a za¢ne skladat dlazdice od tohoto
bodu.

Umisténi dlazdic — odchylka X
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Nastavovana volba Vyznam

Nastavi posunuti vySky obrazku v procentech. Posun o 50 %
znamena, ze LibreOffice Draw umisti stfedni ¢ast vysky
obrazku do kotevniho bodu a zacne skladat dlaZdice od tohoto
bodu.

Posune sloupce dlazdicovych obrazk( o procento zadané
v poli tak, aby dva nasledujici sloupce nebyly zarovnany.

Umisténi dlazdic — odchylka Y

Odstup dlazdic

Upravy obrazk
1) Vybereme objekt k Gpravam, ktery obsahuje obrazek jako vyplii, nebo vioZime obrazek
do vybraného objektu.

2) Otevieme dialogoveé okno Oblast a klepnutim na volbu Oblast otevieme stranku Oblast.
Nasledné klepnutim na Obrazek otevieme moznosti dostupné pro vypli typu obrazek.

3) Z moznosti dostupnych v poli Obrazek vybereme obrazek, ktery chceme pouzit a upravit
jako vyplii. VSimneme si, Ze jsou k dispozici také importované obrazky. Vybrany obrazek
se zobrazi v poli Nahled.

4) Upravime hodnoty v polich Styl, Velikost, Umisténi, Umisténi dlaZdic a Odstup dlaZdic
podle nasich predstav. Dal$i informace o moZznostech obrazk( nalezneme v Tabulka 9:

Moznosti obrazu. Pfiklady vypIni obrazk( nebo bitmap a pouzitych vlastnosti jsou
uvedeny na obrazku 96 pod.

5) Potfebujeme-li se vratit k plivodnimu obrazku, klikneme na Obnovit a vSechny
provedené zmény se odstrani.

6) Klepnutim na tlacitko OK uloZime zmény a zavieme dialogové okno Oblast.

ﬁ Poznamka

Dodané obrazky nelze upravovat, ale nastaveni zobrazeni pro umisténi a dlazdice
Ize zménit.
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Obrazek 96: Priklady vypiné obrazkem

(1) Phvodni obrazek.
(2) Sitka/vyska je zmensena o 25 %. Kotevni bod je v levem
hornim rohu obrazku. Zadny posun.
(3) Sitka/vySka je zmenSena o 25 %. Kotevni bod je v pravém
hornim rohu. Posunuti fadku je 50 % Sitky obrazku
Import obrazki
1) Vybereme objekt, do jehoZ vyplné chceme obrazek importovat.

2) Otevieme dialogové okno Oblast a klepnutim na volbu Oblast otevieme stranku Oblast.
Nasledné klepnutim na Obrazek otevieme moznosti dostupné pro vypln typu obrazek.

3) Klikneme na PFidat/importovat a otevieme okno prohlizece soubord.
4) Prejdeme do adreséare obsahujiciho soubor obrazku, vybereme ho a klikneme na Otevfit.

5) V otevieném dialogovém okné Nazev zadame nazev nového obrazku a klepnutim na OK
zavieme dialogové okno Nazev. Importovany obrazek se zobrazi v dolni ¢asti obrazk
zobrazenych v poli Obrazek.

6) V poli Obrazek vybereme importovany obrazek.

7) Klepnutim na tlacitko OK uloZzime zmény a zavieme dialogové okno Oblast. Importovana
obrazkova vypln se zobrazi ve vybraném objektu.

Prejmenovani obrazki
1) Vybereme objekt, do jehoz vyplné chceme obrazek importovat.

2) Otevieme dialogové okno Oblast a klepnutim na volbu Oblast otevieme stranku Oblast.
Nasledné klepnutim na Obrazek otevieme moZnosti dostupné pro vypli typu obrazek.

3) Klepneme pravym tlacitkem na vybrany obrazek a z mistni nabidky vybereme
Pfejmenovat.

4) V otevieném dialogovém okné Nazev zaddme novy nazev obrazku.
5) Zménu uloZime a dialog zavieme kliknutim na OK.
6) Klepnutim na tlacitko OK uloZime zmény a zavieme dialogové okno Oblast.
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ﬁ Poznamka

Doporucuje se pfejmenovavat nebo odstrafiovat pouze obrazky, které byly vytvoreny
nebo importovany. Pfejmenovani nebo odstranéni obrazl nainstalovanych

s LibreOffice mlze zpUsobit problémy v dokumentech, které néktery z téchto obraz(
pouzivaji.

Odstranéni obrazk
1) Ujistime se, Ze je v kresbé vybran objekt obsahujici vyplii s obrazkem.
2) V dialogovém okné Oblast otevieme stranku Oblast a klikneme na tlaCitko Obrazek.

3) Klikneme pravym tlaCitkem mysi na odstrafiovany obrdzek a z mistni nabidky vybereme
moZznost Odstranit.

4) Smazani potvrdime kliknutim na Ano.

5) Klepnutim na tlacitko OK ulozime zmény a zavieme dialogové okno Oblast.

Vyplné vzorkem

Pri instalaci LibreOffice se nainstaluje nékolik vzorkovych vyplini. V LibreOffice Ize také vytvéaret
a upravovat vlastni vzory.

Vybér vzorkovych vyplni

Nasledujicim postupem vybereme vzor pro vyplii oblasti pomoci dialogového okna Oblast.
Nastroje na panelu nastrojii Cara a vyplii a panel Oblast v nabidce Vlastnosti na postranni listé
maji podobny postup, ale dostupné moznosti jsou omezené.

1) Ujistime se, Ze je objekt v kresbé vybran.
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Oblast Stin Prihlednost
Zadna Barva Prechod Rastr Srafovani

MozZnosti Nahled
~ | Editor vzorki:

(CTLEERARELLAN

B
SCCLERRARELLAN

Barva popredi:

- Cervena hd

Barva pozadi:

[ | ZIuta -
W

Pridat Zménit

Napovéda Obnovit Zrudit

Obrazek 97: Dialogové okno Oblast — stranka Vzorek oblasti

2) Otevieme dialog Oblast, klikneme na stranku Oblast a otevre se stranka Oblast. Na ni
klikneme na tlacitko Vzorek, zobrazi se moznosti dostupné pro vyplf vzorkem
(obrazek 97 nad).

3) V poli Vzorek vyberte pozadovany vzorek, zobrazi se v poli Nahled.

4) V pripadé potfeby zménite barvy popfedi a pozadi nebo samotny vzor. PFi provadéni
zmeén se méni i vzorek zobrazeny v Nahledu, vidime, jak bude vyplii vzorkem vypadat.
VeSkeré zmeény se projevi pouze u vypliovaného objektu.

5) Pokud je to nutné a chceme se vratit k pivodnimu vzorku, klikneme na Obnovit
a vSechny provedené zmény se odstrani.

6) Klepnutim na tlaCitko OK zavifeme dialogové okno Oblast a uloZime zmény. Vzorek
vypIné se pak zobrazi ve vybraném objektu.
Vytvareni vlastnich vzorki

1) Ujistime se, Ze je v kresbé vybran objekt obsahujici vzorkovou vypln, poté otevieme
dialogové okno Oblast a klikneme na Oblast. Otevie se stranka Oblast.

2) V poli Vzorek vybereme pozadovany vzorek, ktery chceme pouzit jako vychozi bod,
a vybrany vzorek se zobrazi v poli Nahled.

3) Uprostfed v bloku MoZnosti vybereme z dostupnych palet Barvu popredi a Barvu pozadi.
Vzor z{stava stejny, ale barvy se méni.

4) Novy vzorek vytvofime, kdyz v Editoru vzorks kliknutim na jednotlivé ¢tverce ménime
jejich barvu z Barvy popredi na Barvu pozadi nebo naopak.

5) V poli Nahled vidime vysledek naSeho snazeni.
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6) Klepnutim na PFidat otevieme dialogové okno Nazev.

7) Zadame jedinecny nazev nového vzorku a kliknutim na tlaCitko OK zavieme dialogové
okno Nazev. Vlastni vzorek najdeme na konci vzorkl zobrazenych v poli Vzorek a je
k dispozici pro pouZiti v dalSich vykresech a dokumentech.

8) V pripadé potfeby klikneme na Obnovit, abychom odstranili vSechny provedené zmény.

9) Klepnutim na tlacitko OK zavieme dialogové okno Oblast a ulozime zmény.

ﬁ Poznamka

Chceme-li upraveny vzorek pouzit v jinych kresbach nebo dokumentech, musi byt
vlastni vzorek uloZen s jedine¢nym nazvem. PouZiti moznosti Zménit na strance
Vzorek v dialogovém okné Oblast vzorek zméni trvale, nelze se vratit zpét.
Doporucujeme upravovat pouze vlastni vzorky, nikoli vzorky dodavané s LibreOffice.

Uprava viastnich vzorkd
1) Ujistime se, Ze je v kresbé vybran objekt obsahujici vzorkovou vypln.

2) Otevieme dialogoveé okno Oblast a kliknutim na Oblast otevieme stranku Oblast. Poté
klikneme na Vzorek.

3) Ze vzork( zobrazenych v poli Vzorek vybereme vlastni vzorek, zobrazi se v poli Nahled.
Vlastni vzorky najdeme v poli Vzorek pod vzorky pfeddefinovanymi.

4) V okné Editor vzork( klikneme na kazdy ¢tverec pro zménu barvy z Barvy popredi na
Barvu pozadi nebo z Barvy pozadi na Barvu popredi a upravime vybrany vzorek.

5) Pokud je to nutné a chceme se vratit k plvodnimu vzorku, klikneme na Obnovit
a vSechny provedené zmeény se odstrani.

6) Kliknutim na Zménit trvale zménime vybrany vlastni vzorek. Pfi Upravé vlastniho vzorku
neni poZzadovano Zadné potvrzeni.

7) Klepnutim na tlaCitko OK zavieme dialogové okno Oblast a uloZime zmény.

Prejmenovani vzorki

1) Vybereme objekt obsahujici vypli se vzorkem nebo vloZte vzorek do vyplné vybraného
objektu.

2) Otevieme dialog Oblast, klikneme na stranku Oblast a otevie se strdnka Oblast. Na ni
klikneme na tlaCitko Vzorek, zobrazi se moznosti dostupné pro vyplii vzorkem.

3) Pravym tlacitkem mysSi klikneme na vzorek pro pfejmenovéni v poli Vzorek
a z kontextové nabidky vybereme Pfejmenovat.

4) V otevieném dialogu Nazev zadame novy nazev vzorku.
5) Kliknutim na OK ulozime pfejmenovéani a zavieme dialog Nazev.
6) Klepnutim na tlacitko OK uloZzime zmény a zavieme dialogové okno Oblast.

Odstranéni viastnich vzorku

1) Vybereme objekt obsahujici vypli se vzorkem nebo vioZte vzorek do vyplné vybraného
objektu.

2) Otevieme dialog Oblast, klikneme na stranku Oblast a otevie se strdnka Oblast. Na ni
klikneme na tlacitko Vzorek, zobrazi se moznosti dostupné pro vypli vzorkem. Vybrany
vzorek se zobrazi v poli Editor vzorkd.

3) Na vzorek, ktery chceme odstranit, klikneme pravym tlaCitkem mysi v poli Vzorek
a z kontextové nabidky vybereme moZnost Smazat.
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4) Smazani potvrdime kliknutim na Ano.

5) Klepnutim na tlacitko OK uloZime zmény a zavieme dialogové okno Oblast.

ﬁ Poznamka

Upravovat, odstrafiovat nebo pfejmenovavat doporuujeme pouze vlastni vzorky.
Odstranéni nebo prejmenovani nékterého z preddefinovanych vzorkd, které jsou
nainstalovany v kancelarském baliku LibreOffice, mize zptsobit problémy v kresbach
a dokumentech, které pouzivaji néktery z vzorka.

Vypln Srafovani
Srafované vyplné jsou podobné vzorkovym vyplnim, ale misto ¢tverct pouzivaji ary. Pfi instalaci

LibreOffice do pocitace je k dispozici nékolik pfeddefinovanych Srafovacich vyplini. Lze také
vytvaret a upravovat vlastni Srafovaci vypIné.

Vybér vyplni Srafovani
Nasledujici postup vybéru Srafovani pro vyplii plochy pouziva dialogove okno Oblast. Nabidka
nastrojové listy Cara a vypli se podoba nastrojim na panelu Oblast na karté Vlastnosti
postranni liSty, ale dostupné moznosti jsou omezené.

1) Ujistime se, Ze je objekt v kresbé vybran.

2) Otevieme dialog Oblgst, klikneme na stranku Oblast, otevie se stranka Oblast a na ni
klikneme na tlacitko Srafovani. Zobrazi se moznosti dostupné pro vypli Srafovanim
(obrazek 98 pod).

3) Z moZnosti zobrazenych v poli Srafovani jedno vybereme, zobrazi se v poli Nahled.

4) V pripadé potfeby a pro navrat k pvodnimu Srafovani klikneme na tlacitko Obnovit
a vSechny provedené zmény se odstrani.

5) Klepnutim na tlacitko OK zavieme dialogové okno Oblast a uloZzime zmény. Ve vybraném
objektu se pak zobrazi Srafovani.
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Oblast Stin Prdhlednost

Zadna Barva Prechod Rastr Vzorek

Srafovéni Moznosti Nahled
Vzdalenost:

0,10 cm =
Uhel:

I o
Typ cary:

|J ednoducha ~

Barva cary:
B Cema -

[ Barva pozadi

Svétle modra 2

Pridat Zménit

MNapovéda Obnovit oK Zruit

Obrézek 98: Dialogové okno Oblast — stranka Srafovani

Vytvareni vliastnich vyplini Srafovani
1) Ujistime se, Ze je objekt v kresbé vybran.

2) Otevieme dialog Oblgst, klikneme na Oblast a tim otevieme stranku Oblast, na ni
klikneme na tlacitko Srafovani, zobrazi se moZnosti dostupné pro vypli Srafovanim.

3) Jako vychozi bod vybereme poZadované Srafovani v poli Srafovani a vybrané Srafovani
se zobrazi v poli Nahled.

4) Upravime Srafovani zmé&nou hodnot v polich Vzdalenost, Uhel, Typ ¢ary, Barva ¢ary
a Barva pozadi podle naSi pfedstavy. DalSi informace o moznostech Srafovani najdeme
v ,Tabulka 10: Moznosti vyplné Srafovanim®.

5) Klepnutim na PFidat otevieme dialogové okno Nazev.

6) Zadame jedine€ny nazev nového Srafovani a kliknutim na OK dialogové okno Nazev
zavieme. Vlastni Srafovani najdeme na konci seznamu Srafovani zobrazeného v poli
Srafovani, je k dispozici pro pouZiti v dalSich vykresech a dokumentech.

7) Klepnutim na tlaitko OK zavifeme dialogové okno Oblast a uloZime zmény. Ve vybraném
objektu se objevi novéa vyplii Srafovani.

Tabulka 10: MoZnosti vyplné Srafovanim

Moznost .
= R Vyznam
Srafovani
. Urcuje rozestup mezi dvéma fadky Srafovaci vyplné. Pfi zméné hodnoty
Vzdéalenost o .
se aktualizuje okno nahledu.
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MoZnost

« .. Vyznam
Srafovani Y

) Pomoci mini mapy pod &iselnou hodnotou mdzeme rychle nastavit Ghel
Uhel tvofeny ¢arou s nasobky 45 stupid. Pokud poZadovany uhel neni
nasobkem 45 stupiill, zadame pozadovanou hodnotu do editacniho pole.

Nastavi jednoduchou, kfizovou nebo trojitou Caru pro styl Srafovaci

Typ cary vyplné.

Barva ¢ary Pomoci seznamu vybereme barvu Car, které budou tvofit Srafovaci vypln.

Pokud je vybrana, pfida barevnou vypli za ¢ary pouzité pro Srafovaci

Barva pozadi P
vypln.

ﬁ Poznamka

PouZiti moZnosti Zménit na strance Srafovani v dialogovém okné Oblast trvale
zméni Srafovani a nelze ji vratit zpét. Doporu€ujeme upravovat pouze vlastni
Srafovani, nikoli pfeddefinované Srafovani, které bylo nainstalovano s LibreOffice.

Uprava vlastnich vyplni vyplni

1) Ujistime se, Ze je objekt v kresbé vybran.

2) Otevieme dialog Oblgst, klikneme na Oblast a tim otevieme stranku Oblast, na ni
klikneme na tlacitko Srafovani, zobrazi se moZnosti dostupné pro vypln Srafovanim.

3) V poli Srafovani vybereme vlastni Srafovani, zobrazi se v Nahledu. Vlastni Srafovani se
nachazi pod preddefinovanymi v poli Srafovani.

4) Upravime Srafovani zmé&nou hodnot v polich Vzdélenost, Uhel, Typ ¢ary, Barva ¢ary
a Barva pozadi. DalSi informace o moZnostech Srafovani najdeme v ,Tabulka 10:
Moznosti vyplné Srafovanim*.

5) V pripadé potfeby a pro navrat k ptivodnimu Srafovani klikneme na tlacitko Obnovit
a vSechny provedené zmény se odstrani.

6) Kliknutim na tlaCitko Zmeénit trvale zménime vybrané vlastni Srafovani. Pfi Gpravé vlastni
vyplné Srafovani neni pozadovano zadné potvrzeni.

7) Klepnutim na tlacitko OK zavieme dialogové okno Oblast a ulozime zmény.

Piejmenovani vyplni Srafovanim

1) Vybereme obijekt, ktery obsahuje Srafovanou vypli\, jeZ ma byt pfejmenovana.

2) Otevieme dialog Oblast, klikneme na Oblast a tim otevieme stranku Oblast, na ni
klikneme na tlacitko Srafovani, zobrazi se moznosti dostupné pro vypli Srafovanim.

3) Pravym tlagitkem mysi klikneme na 3rafovaci vyplii zobrazenou v poli Srafovani
a z kontextové nabidky vybereme moznost Pfejmenovat.

4) V otevieném dialogovém okné Nazev zadame novy nazev Srafovani.
5) Kliknutim na OK ulozime pfejmenovani a zavieme dialogové okno Nazev.
6) Klepnutim na tlacitko OK uloZime zmény a zavieme dialogové okno Oblast.

Odstranéni vlastnich vyplni Srafovani

1) Vybereme objekt, ktery pouziva Srafovaci vypln, kterou chceme odstranit.
2) V dialogovém okné Oblast otevieme stranku Oblast a klikneme na tla¢itko Srafovani.

3) V poli Srafovani vybereme vlastni Srafovani, které chceme odstranit.
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4) Klepneme pravym tlacitkem na Srafovani a z mistni nabidky vybereme Smazat. Smazani
potvrdime kliknutim na Ano.

5) Klepnutim na tlaCitko OK uloZzime zmény a zavieme dialogové okno Oblast.

ﬁ Poznamka

Upravovat, pfejmenovavat nebo odstrariovat doporuCujeme pouze vlastni vytvorené
Srafovaci vyplné. Upravy, pfejmenovani nebo odstranéni Srafovani nainstalovanych

pomoci LibreOffice mohou zptsobit problémy v dokumentech, které pouzivaji jeden
Z téchto Srafovani.

Prace se stiny

Moznosti stinovani

Stiny Ize aplikovat na objekty, jako jsou €ary, tvary a text. Pro stiny jsou k dispozici tyto moznosti:
Umisténi
Vybereme jeden z deviti bodd uréujicich smér, ve kterém je stin vrzen.
Vzdalenost nebo uhel
UrCuje vzdalenost posunu mezi objektem a stinem.

Oblast Stin Prahlednost

Vlastnosti Nahled
PouZit stin
O O O
b
! . |
Barva: |- Tmaveé zelena 2 =~ |

Vzdalenost: |0,30 cm = |

Rozostreni: | 0 pt

Prihlednost: |0 % = |

Obrazek 99: Dialogové okno Oblast — stranka Stin
Barva
Nastavi barvu pouzitou pro stin.
Rozostieni
Nastavuje, jak moc jsou okraje stinu rozmazany nebo zmék&eny.
Priihlednost
Urcéuje miru prihlednosti stinu: 0 % neprdhledny stin, 100 % prihledny stin.

ﬁ Poznamka

Chceme-li stin nastavit detailngji, pouzijeme zaloZzku Stin v dialogovych oknech
Oblast nebo Cara. Nasleduijici text popisuje pouziti stranky Stin v dialogovém okné
Oblast (obrazek 99 nad), ale Ize jej pouZit i pro stranku Stin v dialogovém okné Cara
a panel Stin na karté MoZnosti na postranni listé.
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Vychozi stinovani
Chceme-li na objekt rychle pouZzit stin, vybereme objekt a klikneme na Stin na nastrojove listé
Céra a vypln. Stin aplikovany na objekt pouziva vychozi nastaveni stinu.

Formatovani stinu

Chceme-li mit vétsi kontrolu nad pridavanim stinl k objektu, pouzijeme stranku Stin
v dialogovém okné Oblast a Cara nasledujicim zptisobem:

1) Vybereme objekt, kterému stin pfidame.

2) Otevieme dialogové okno Oblast a klepnutim na Stin otevieme stranku Stin (obrazek 99
nad).

3) Vybereme PouZit stin v bloku Vlastnosti volby stinovani se aktivuiji.
4) Vybereme jeden z deviti bodd, ktery uruje smér objektem vrzeného stinu.

5) V rozbalovacim poli Barva vybereme v rozeviracim seznamu jednu z dostupnych palet
a z té vybereme pozadovanou barvu stinu.

6) Do pole Vzdalenost zadame vzdalenost, kterou chceme nastavit mezi objektem a stinem.
7) Do pole Rozostreni zadame hodnotu pro zmékceni okrajl stinu.

8) Do pole Priihlednost zadame procento prihlednosti stinu.

9) Kliknutim na tla¢itko OK zavieme dialogové okno Oblast nebo Céra a uloZzime zmény.

Formatovani stinu z postranni listy
1) Vybereme objekt, kterému stin pfidame.
2) Klepnutim na Vlastnosti otevieme kartu Vlastnosti na postranni liste.
3) Klepnutim na Stin otevieme na karté Vlastnosti sekci Stin (obrdzek 100 pod).
4) Vybereme Povolit a volby stinovani se aktivuiji.

5) V poli Uhel vybereme v rozeviracim seznamu Ghel ur€ujici smér objektem vrzeného
stinu.

6) V rozbalovacim poli Barva vybereme v rozeviracim seznamu jednu z dostupnych palet
a z té vybereme pozadovanou barvu stinu.

7) Do pole Vzdalenost zadame vzdéalenost, kterou chceme nastavit mezi objektem a stinem.
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Vlastnosti 7 X

> Znak

» Odstavec

» Oblast

> Céra

» Efekt

» EFekt textu
~ Stin

Povolit

> Umisténi a velikost
> Sloupce
Obréazek 100: Panel stinti na karté Vlastnosti v postranni listé
8) Do pole Rozostreni zadame hodnotu pro zmékéeni okrajl stinu.

9) Prihlednost nastavujeme posuvnikem nebo do textového pole zadame v procentech
prihlednost stinu.

10) ZruSenim vybéru objektu uloZzime provedené zmény.

Prace s prtihlednosti

Prdhlednosti Ize pouZit na objekty a stiny. IV aplikaci Draw Ize na objekt aplikovat dva typy
prdhlednosti — rovhomérnou a prechodovou. Prihlednosti Ize pouZzit na vypIné ploch, pfechody,
stiny a Céry.

« Informace o prechodovych prihlednostech a pfiklad kombinace barevného prechodu s
pfechodovou prihlednosti najdeme v ¢asti ,Vypli pfechod” na strané 94.

« Dal$i informace o priihlednosti ¢ar nalezneme v ¢asti ,Co je v této uzivatelské prirucce?”
na strané 8.

« Dalsi informace o prlhlednosti stinu najdeme v ¢asti ,Prace se stiny” na strané 108.

Nasledujici ukazkovy postup aplikuje priihlednost na vypli plochy objektu pomoci dialogového
okna Oblast (obrazek 101 pod):

1) Ujistime se, Ze je objekt v kresbé vybran.

2) Otevieme dialog Oblast a kliknutim na Priihlednost otevieme stranku Prdhlednost
s jejimi volbami.
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Oblast Stin Prihlednost

ReZim prihlednosti oblasti
) Neprihledné
O Prithlednost: 50 %

Iyp:
Stfed X:
Stied Y:
Uhel: 0° =
Hranice: |0% =
Poéateéni hodnota: |0 % =
Koncova hodnota: |0 % =

Obrazek 101: Dialogové okno Oblast — stranka Prihlednost

3) Chceme-li vytvorit rovnomérnou prihlednost, vybereme Prihlednost a do textového pole
zadame procento.

4) Chceme-li vytvorit pfechodovou prihlednost, aby se oblast postupné stala prihlednou,
vybereme Prechod a v rozeviracim seznamu vybereme typ prihlednosti pfechodu:
Linearni, Axialni, Radialni, Ovalny, Krychlovy nebo Ctvercovy. Dalsi informace o typech
prechod( najdeme v ¢asti ,Vypli pfechod” na strané 94.

5) Nastavime parametry pro typ prihlednosti pfechodu vybraného vyse. Popis vlastnosti
prdhlednosti nalezneme v ,Tabulka 11: Parametry prihlednosti”. Dostupné parametry
zavisi na zvoleném typu prdhlednosti pfechodu.

6) Klepnutim na tlaCitko OK zavieme dialogové okno Oblast a uloZime zmény.
Tabulka 11: Parametry prdhlednosti

Parametry prihlednosti | Vyznam

Pro Radialni, Ovélné, Kvadratické a Ctvercové pfechody.

Stred X Hodnoty pro nastaveni vodorovného odsazeni stfedu pfechodu.

Stied Y Pro Radialni, Ovéalné, Kvadratické a Ctvercové pfechody.
Hodnoty pro nastaveni svislého posunuti stfedu pfechodu.

Uhel Pro Lineérni, Axialni, Ovélné, Kvadratické a Ctvercové prechody.
Urcuje thel osy pfechodu.

Ohraniceni Tuto hodnotu zvySime, pokud chceme, aby prechod zacinal dale

od okraje objektu.

Hodnota pro pocateéni pfechod prihlednosti. 0 % je zcela

Pocatecni hodnota neprdhledné, 100 % znamena zcela prdhledné.

Hodnota pro koncovy pfechod prihlednosti. 0 % je zcela

Koncova hodnota neprdhledné, 100 % znamena zcela prihledné.

Styly kresby

Pokud maiji byt vlastnosti vyplné oblasti, tloustky ¢ary a okraje pouzity na sadu objektd,
doporucuje se pouzit styly. Styly sniZuji riziko chyb pfi formatovani tim, Ze umoZznuji definovat
format a pouzit jej na vice objektl. Vice informaci najdeme v Prdvodci aplikaci Writer.
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= Obrézek A;
Cary B

= Tvary @

S obrysem <>

= S wyplni
Cervena wplri

Modra vyplr

Zelena wypln

Zlutd wplri

Text

Vychozi styl kresby

Obrézek 102: Karta styly na postranni listé — Styly
kresby

ﬁ Poznamka

Styly kresby, které jsou soucasti LibreOffice Draw, nelze odstranit ani pfejmenovat,
ale Ize je upravit podle naSich poZadavkd. Styly kresby Ize také skryt, pokud nejsou
v kresbhé vyzadovany.

Kategorie styl(

VSechny styly
Zobrazi vSechny dostupné styly kresby.
Pouzité styly
Zobrazi pouze styly kresby, které byly pouzity ve vybraném kreshé.

Hierarchicky

Zobrazi se hierarchicky seznamu styld kresby (vnofené styly nebo rodiGovské styly).
Chceme-li zobrazit styly v poddrovni, klikneme na trojuhelnik » nebo Sipku > vedle nazvu
stylu a zobrazi se seznam styll dostupnych v podurovni, jak je znazornéno na obrazku
102 nad.
. Tip
Hierarchické styly se pouzivaji, pokud se vice objektl lisi jednou nebo dvéma
moZznostmi, ale jsou stejné formatovany. Vytvofime nadfazeny styl pro objekty v€etné
okrajll, vyplné oblasti, pisma atd. Pak vytvofime hierarchické nebo podfizené styly,
které se liSi napfiklad barvou vyplné. Pokud je tfeba zménit velikost pisma nebo
tloustku ramecku, sta€i zménit nadfazeny styl a podle toho se zméni vSechny
podfizené styly.
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Vlastni styly
Zobrazi vSechny uZivatelem vytvorené styly kresby, které jsou k dispozici.

Skryté styly
Zobrazi vSechny styly vykresu jsou skryté, pokud je nepotfebujeme.

Vybér styl

Pouze na karté Styly a formatovani (obrazek 102 nad) v postranni listé Ize styly vybirat
a aplikovat na objekty.

1) Vybereme objekt pro aplikaci stylu.

2) Pomoci jedné z nasledujicich metod otevieme na postranni listé kartu Styly
a formatovani:

— V hlavni nabidce zvolime Zobrazit > Postranni liSta a poté klikneme na Styly na
pravé strané postranni listy.

— Klepneme na Zobrazit postranni listu Styly na nastrojové listé Cara a vypli.
— V hlavni nabidce zvolime Zobrazit > Styly.
— Pouzijeme klavesovou zkratku F11.

3) V rozeviracim seznamu v dolni ¢asti nabidky Styly vybereme kategorii styld.

4) Na karté Styly dvakrat klikneme na poZzadovany styl pro vybrany objekt.

5) V pripadé potieby vytvofime vlastni styl nebo upravime vybrany styl podle poZadavk(
kresby.

ﬁ Poznamka

Doporu€ujeme vytvaret vlastni styly, nikoli upravovat styly kresby nainstalované
v LibreOffice. Uprava styl( vykresl LibreOffice mdze zpUsobit problémy
s formatovanim, pokud byl styl pouZit v jinych kresbach.

Vytvoreni vlastnich styl
Vlastni styly jsou umistény v kategoriich VSechny styly a Vlastni styly na karté Styly postranni
listy. Pokud je na objekt aplikovan vlastni styl, zobrazi se tento styl v ¢asti Pouzité styly.
PouZivani karty Styly

1) V postranni listé pfejdeme na kartu Styly (a formatovani).

2) Klikneme pravym tlaCitkem mysi na styl, z néhoz vytvofime vlastni styl a vybérem
moznosti Novy z kontextové nabidky otevieme dialogové okno Grafické styly (obrazek
103 pod).

3) Kliknutim na Organizator otevieme stranku Organizator v dialogovém okné Grafické
styly.

4) Do textového pole Nazev zadame jedinecny nazev stylu.
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Text Animace textu Kotovani Spojnice Zarovnani Asijska typografie Tabulatory Zvyraznéni

Organizator Cara Oblast Stinovani Prihlednost Pismo Efekty pro pismo Qdsazeni a rozestupy
Styl
Mazev: |Vychozi styl kresby
Kategorie: |'J\asir.!’ styly J
‘Obsahuje

Spojitda + 0,0 cm + 0,2 cm + 0,2 cm + Nevystfedéno + Nevystfedéno + Spojita + Stin vypnuto + Barva stinovani + Odstup
stinu X 0,2 cm + Odstup stinu ¥ 0,2 cm + Vzdalenost rdmce textu vlevo 0,25 cm + Vzdédlenost rémce textu vpravo 0,25 cm +
Vzdalenost ramce textu nahore 0,12 cm + Vzdalenost ramce textu dole 0,12 cm + Vodorovné ukotveni textu PouZit celou
Sitku + » + Odsazeni vievo 0,0 cm, Odsazeni vprave 0,0 cm + Shora 0,0 cm, Zdola 0,0 cm + Jednoduché + Automaticksd +
Liberation Sans + 18 pt + normalni + Bez podtrzeni + Bez preskrinuti + Bez kurzivy + Bez obrysu + Bez stinovani + Parovy
keming + Microsoft YaHei + Arial + 18 pt + 18 pt + normalni + normalni + Bez kurzivy + Bez kurzivy + zadny + Bez reliéfu +
Bez nadtrzeni + Zadna

Obrazek 103: Dialogové okno Grafické styly — stranka Obecné

5) V textovém poli Rodicovsky vybereme z rozeviraciho seznamu moznost Zadny, pokud
novy styl kresby NEBUDE propojen. Pfi vytvafeni objektu se pouzije Vychozi styl kresby
a novy styl kresby je ve vychozim nastaveni spojen s Vychozim stylem kresby.

6) Pokud ma novy styl zdédit nastaveni z existujiciho stylu, vybereme styl z rozeviraciho
seznamu Rodicovsky.

7) K formatovani a kategorizaci nového stylu pouzijeme dostupné moznosti na riznych
strdnkach dialogového okna Grafické styly.

8) Kliknutim na OK uloZime novy styl a zavieme dialogové okno Grafické styly.

PouZiti nového stylu z vybéru

Pomoci volby Novy styl z vybéru se na objekt nejprve aplikuje veSkeré formatovani a poté se
vytvori novy styl kresleni s vyuzitim zmeén forméatovani.

1) Vybereme existujici objekt nebo vytvofime v kresbé novy objekt.

2) Objekt formatujeme pomoci nastroji a moznosti z dialogového okna Grafické styly,
dialogového okna Oblast, dialogového okna Cara, z karty Vlastnosti na postranni listé
nebo nastrojové listy Cara a vypli.

3) Ujistime se, Ze je objekt vybran, a novy styl vytvofime pomoci jedné z nasledujicich
metod:

— Otevieme kartu Styly na postranni listé a klikneme na Novy styl z vybéru v pravém
hornim rohu karty.

— V hlavni nabidce zvolime Format > Styly > Novy styl z vybéru.

4) V dialogovém okné Novy styl z vybéru zadame jedineény nazev nového stylu. Toto
dialogové okno také zobrazuje existujici vlastni styly.

5) Kliknutim na OK novy styl ulozime a zavieme dialogové okno Novy styl z vybéru.
Uprava stylt

}? Poznamka

Doporuéuje se upravovat pouze vlastni styly. Uprava nainstalovanych styl(
LibreOffice mdze zpUlsobit chyby formatovani v jinych dokumentech, které pouzivaji
styl LibreOffice.

1) Vybereme objekt v kresbé.

2) V postranni listé klikneme na ikonu Styly a formatovani a na levé strané karty otevieme
nabidku Styly kresby.
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3) Jednim z nasledujicich zplsobl otevieme dialogové okno Grafické styly:
— V hlavni nabidce zvolime Format > Styly > Upravit styl.

— Klikneme na objekt pravym tlacitkem mySi a z mistni nabidky vybereme moznost
Upravit styl.

— Pravym tlaCitkem mysi klikneme na styl zvyraznény na karté Styly a formatovani
postranni liSty, z kontextové nabidky vybereme moznost Upravit.

4) K Gprave stylu vyuzijeme moznosti na réiznych strankach dialogového okna Grafické
styly.
5) Klepnutim na OK ulozime zmény a zavieme dialogové okno Grafické styly.

Uprava hierarchickych nebo rodié¢ovskych stylil

Pokud objekt pouziva styl, ktery je propojen s hierarchickym nebo nadfazenym stylem, Ize tento
hierarchicky nebo nadfazeny styl upravovat.

1) Vybereme objekt ve vykresu, ktery pouziva propojeny styl.

2) Otevieme dialogové okno Grafické styly a kliknutim na Organizator otevieme stranku
Organizator.

3) Zkontrolujeme, zda je nazev stylu v textovém poli Rodi¢ovsky hierarchickym nebo
nadfazenym stylem, a poté pouzijeme pro Upravu stylu moznosti na réiznych strankach
dialogového okna Grafickeé styly.

4) Pokud styl hierarchicky nebo rodi¢ovsky styl NENI takovy, jak poZzadujeme:

a) Klikneme na Upravit styl napravo od textového pole Rodic¢ovsky, dokud se nezobrazi
nazev stylu.

b) K Upravé stylu pouzijte moznosti na rdznych strankach dialogového okna Grafické
styly.
5) Klepnutim na OK ulozime zmény a zavieme dialogoveé okno Graficke styly.

Aktualizace stylU

ﬁ Poznamka

Aktualizujeme pouze vytvorené vlastni styly. Aktualizace styl(l kresby LibreOffice
mUze v dokumentech vyuZivajicich styly kresby LibreOffice zplisobit chyby
formétovani.

Pouziti Aktualizovat styl umozfuje nejprve pouzit veSkeré formatovani objektu a poté
aktualizovat styl kresby pouzity pro objekt.

1) Vybereme objekt, u kterého chceme aktualizovat pouzity styl kresby.

2) Objekt formatujeme pomoci nastrojll a moznosti z dialogoveho okna Grafické styly,
dialogového okna Oblast, dialogového okna Cara, z karty Vlastnosti na postranni listé
nebo néastrojové listy Céra a vypln.

3) Pomoci jedné z nasledujicich metod aktualizujeme styl kresby. PFi aktualizaci stylu kresby
se nevyzaduje Zadné potvrzeni.

— Otevieme kartu Styly na postranni li5té a klikneme na tlaCitko Aktualizovat styl vpravo
nahofre.

— V hlavni nabidce zvolime Format > Styly > Aktualizovat vybrany styl.
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Pouzivame styly

Styly kresby se na objekt aplikuji pomoci nabidky Styly na postranni listé takto:
1) Vybereme obijekt, na ktery chceme pouZzit styl kresby.
2) Klikneme na Styly na nastrojové listé Cara a vyplii nebo na Styly na postranni listé.
3) Dvojklikem na nazev stylu pouZijeme styl kresby na vybrany objekt.

Odstranovani styl(

ﬁ Poznamka

Pfed odstranénim vlastniho stylu doporucujeme zkontrolovat, zda se styl kresby
nepouziva, a to v seznamu styld kresby v kategorii PouZité styly.

Styly kresby nainstalované v LibreOffice nelze odstranit, i kdyZ se styly kresleni nepouzivaji.
Odstranit Ize pouze vlastni styly.

1) Chceme-li oteviit seznam styl(l, pouzijeme jednu z nasledujicich metod:
— Klikneme na Styly na nastrojové list& Cara a vypli.
— Klikneme na Styly na postranni listé.

2) V rozeviracim seznamu v dolni ¢asti karty Styly na postranni listé vybereme moZnost
PouZité styly.

3) Klikneme pravym tlac¢itkem mysi na nazev stylu v seznamu stylll a z mistni nabidky
vybereme moznost Smazat.

4) Pokud je styl pouZzit na objekt, zobrazi se varovna zprava, Ze se vybrany objekt vrati
k vychozimu stylu kresby. Vybérem mozZnosti Ano potvrdime odstranéni stylu.

5) Pokud se styl nepouziva, vybérem moznosti Ano potvrdime odstranéni stylu a Zadna
potvrzovaci zprava se nezobrazi.

Specialni efekty

ﬁ Poznamka

Nastroje na nastrojové listé Transformace jsou popsany v nasledujicich kapitolach
s vyjimkou nastroje V 3D rotaénim objektu.. Tento nastroj je popséan v kapitole 7,
Prace s 3D objekty.

Na objekty v aplikaci Draw Ize pouZit specialni efekty. Na nastrojové listé Transformace je

k dispozici nékolik efektll. Pokud neni nastrojova lista Transformace (obrazek 93 na strané 97)
zobrazena, v nabidce Zobrazit > Nastrojova liSta > Transformace zobrazeni vybereme
polozku Transformace.

Otoceni objekti

)? Poznamka

Ve vychozim nastaveni je stfed otaCeni vyznacen malym kruhem ve stfedu
vybraného objektu. Chceme-Ili zménit stfed otaCeni objektu, klikneme na oto¢ny bod
a pretdhneme jej do nové polohy. Stfed otaceni miZe lezet i mimo vybrany objekt.
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Rucni otaceni
1) Vybereme objekt pro otaceni tak, aby se zobrazily Gchytky vybéru.

2) K pfepnuti vybraného objektu do rezimu otaCeni pouzijte jednu z nasledujicich metod.
V rezimu otaCeni méni uchytky vybéru tvar a barvu (obrazek 104 pod).

— Znovu klikneme na vybrany objekt.

— Klikneme na trojuhelnik ¥ vpravo od tlacitka Transformace na nastrojové listé Cara
a vypln a z mistni nabidky vybereme Otogit.

— Pokud je otevien panel nastrojd Transformace, klikneme na Otodit.

3) Pfesuneme kurzor nad jednu z rohovych Gchytek a kurzor zméni tvar. Objekt mizeme
otaCet pouze rohovymi uchytkami.

4) Kliknutim na rohovy Uchyt a jeho pfetazenim objekt oto€ime.

5) Chceme-li omezit Ghly otaeni na nasobky 15 stupiid, stiskneme a podrzime pfi otaceni
objektu klavesu Shift. To je uzite¢né pro otaceni objektd o 90 stupnid.

6) Jsme-li s Gpravou spokojeni, uvolnime tlac¢itko mysi.
Otaceni pomoci postranni liSty
1) Vybereme objekt pro otaceni tak, aby se zobrazily uchytky vybéru.

2) Otevieme panel Umisténi a velikost v nabidce Vlastnosti na postranni listé (obrazek 105
pod).

Obrazek 104: Priklad rucniho otaceni
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Obrazek 105: Panel Umisténi a velikost v nabidce Viastnosti na
postranni listé

3) Objekt oto¢ime pomoci jedné z nasledujicich moznosti:
— Klikneme na ukazatel hlu otoCeni v OtoCeni a pfetahneme jej.
— Do textového pole Vyberte thel otoCeni zadame Uhel natoCeni.

4) Po otoCeni objektu kliknutim mimo objekt zruSime jeho vybér a ulozime zmény.

Dialogové okno Umisténi a velikost
1) Vybereme objekt pro otaceni tak, aby se zobrazily dchytky vybéru.
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Obrazek 106: Dialogové okno Umisténi a velikost — zaloZka OtocCeni

2) Jednim z nasledujicich zplisobi otevieme dialogové okno Umisténi a velikost (obrazek
106 nad):

— Stiskneme klavesu F4.
— V hlavni nabidce vybereme moznost Format > Umisténi a velikost.

— Klepneme pravym tlac¢itkem na objekt a z mistni nabidky vybereme Umisténi
a velikost.

3) Kliknutim na Otoceni otevieme stranku Otoc€eni.

4) Zada-li si to kresba, zmé&nime polohu Stfedu oto&eni zadanim hodnot Pozice X a Pozice
Y. Jeho vychozi poloha je ve stfedu objektu. Také mizeme vybrat jednu z jeho deviti
poloh ve Vychozim nastaveni.

5) Uhel oto&eni miizeme urcit dvéma zplsoby:
6) Do textového pole Uhel zadame poZadované stupné otoceni.
7) Klikneme na indikator otaCeni v poli Vychozi nastaveni a otacime s nim.

8) Kliknutim na OK uloZzime zmény a zavieme dialogové okno Umisténi a velikost.
Preklapéni objekt
Rychlé preklopeni

1) Vybereme objekt, kterd chceme prevratit a zobrazi se Uchyty vybéru.
2) K preklopeni objektu na vysku nebo na Sifku pouzijeme jednu z nasledujicich metod:

Klikneme na objekt pravym tlacitkem mysi a z mistni nabidky vybereme moznost
Preklopit > Vodorovné nebo Pfeklopit > Svisle.

Na postranni listé na karté Vlastnosti a na panelu Umisténi a velikost je vybér
Preklopit (obrazek 105 na strané 118). Klikneme na Pi¥eklopit svisle nebo Preklopit
vodorovné.

Na nastrojové listé Cara a vyplii klikneme na polozku Svisle nebo Vodorovné.

V hlavni nabidce zvolime Tvar > P¥eklopit > Svisle nebo Vodorovné.
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Obrazek 107: Priklad pouZiti nastroje Preklopit
(1) Nastroj pfeklopeni je vybran (2) Posunuti osy symetrie (3) Vysledné preklopeni

Nastroj preklopeni

Nastrojem Pfeklopit na nastrojové listé Transformace (obrazek 93 na strané 97) Ize ménit
polohu a uhel pfeklopeni, coZ vidime na obrazku 107 nad.

}? Poznamka

Stisknutim a podrzenim klavesy Shift pfi pohybu osou soumérnosti Ize otaCet po 45
stupnich.

1) Vybereme objekt, ktera chceme prevratit a zobrazi se Uchyty vybéru.

2) Na nastrojove listé Transformace klikneme na P¥eklopit, arkované se zobrazi osa
soumeérnosti prochazejici sttedem objektu. Objekt je oto€en kolem této osy symetrie.

3) Kliknutim a pretazenim jednoho nebo obou koncli osy soumérnosti nastavime jeji
orientaci.

4) Umistime kurzor nad jednu z Uchytek vybéru objektu, dokud se nezméni jeho tvar.

5) Klikneme a podrzime vybér a poté pretahneme objekt na druhou stranu osy symetrie,
dokud se objekt neobjevi pfevraceny. Uhel a poloha pfevraceni zavisi na thlu a poloze
0SYy SOUmMernosti.

6) Uvolnéte Gchyt vybéru a objekt se otoci.

Zrcadlové kopie

V soucasné dobé neni v LibreOffice Draw k dispozici pfikaz zrcadleni. Zrcadleni objektu vSak Ize

napodobit zkopirovanim a preklopenim objektu nasledujicim zplsobem:

1) Vybereme objekt a zkopirujeme jej do schranky.

2) Objekt preklopime postupem popsanym v ¢asti ,Pfeklapéni objekt” na strané 119.

3) Kliknutim do prazdné oblasti na vykrese zruSime vybér objektu.

4) Vlozime kopii plivodniho objektu zpét do jeho plivodniho umisténi, ¢imz vytvorime
zrcadlovou kopii.

5V pﬁ%adé potfeby vybereme oba objekty a zarovname je pomoci jedné z nasledujicich
metod:

— V hlavni nabidce zvolime Tvar > Zarovnani objektl a pouZijeme jednu z moznosti
zarovnani.
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— Klikneme pravym tlacitkem mySi na vybrané objekty a v mistni nabidce vybereme
moznost Zarovnani objektl a poté jednu z moznosti zarovnani.

Deformace obrazku

Na nastrojové listé Transformace mame k dispozici tfi nastroje (obrazek 93 na strance 97)
umoziuijici zkresleni objektd.

» Deformovat — deformace objektu v perspektive.

* Umistit na kruZnici (zkosit) a Umistit na kruZnici (perspektivné) — oba vytvareji
pseudo 3D efekt.

ﬁ Poznamka

Pfed deformaci objektu je tfeba objekt pfevést na kfivku. Transformace objektu na
kfivku je bezpeCna operace, ale nelze ji vratit zpét. Pro zruSeni klikneme v hlavni
nabidce na Format > Zpét.

Umisténi na kruZnici (perspektivné)

Priklad zkresleni objektu pomoci nastroje Umistit na kruznici (perspektivné) je uveden na
obrazku 108 pod.

1) Vybereme objekt a klikneme na nastrojové listé Transformace na Umistit na kruznici
(perspektivné).

2) Odpoveédi Ano prevedeme objekt na kfivku. Pokud je jiz objekt kfivkou, tento dialog se
nezobrazi.

3) Kliknutim a pretazenim jedné z Uchytek vybéru ziskame pseudo 3D perspektivu,
protilehla strana zlstava na misté. V priib&hu deformace se zobrazuje poloprdhledny
nahled méniciho se tvaru objektu.

Umistit na kruZnici (zkosit)

Priklad zkresleni objektu pomoci nastroje Umistit na kruznici (zkosit) je uveden na obrazku 109
pod.

1) Vybereme objekt a na nastrojové listé Transformace klikneme na Umistit na kruznici
(zkosit).

2) Odpoveédi Ano prevedeme objekt na kfivku. Pokud je objekt jiz kfivkou, tato moznost neni
k dispozici.

(1) (2)

Obréazek 108: Priklad pouZiti nastroje Umistit na kruZnici (perspektivné))

(1) Plvodni objekt (2) Deformace Umistit na kruznici
(perspektivné)
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(1) (2)

Obrazek 109: Pfiklad pouZiti nastroje Umistit na kruZnici (zkosit)

(1) Pavodni objekt (2) Deformovano volbou Umistit na
kruznici (zkosit)

(1) (2)

(3)

Obréazek 110: Priklad pouZiti nastroje Deformovat

(1) PAvodni objekt (3) Svisla deformace
(2) Deformace ve vrcholu (4) Vodorovna deformace

3) Kliknutim a pfetazenim jedné z Uchytek vybéru ziskame pseudo 3D perspektivu,
protilehla strana zlstava na misté. V priib&hu deformace se zobrazuje poloprihledny
nahled méniciho se tvaru objektu.

Deformovat
Priklady zkresleni objektu pomoci nastroje Deformovat jsou uvedeny na obrazku 110 nad.
1) Vybereme objekt a na nastrojove listé Transformace klikneme na Deformovat.

2) Odpovédi Ano pfevedeme objekt na kfivku. Pokud je jiz objekt kfivkou, tento dialog se
nezobrazi.

3) Kliknutim a taZzenim Uchytky ve vrcholu vybéru ménime jeho polohu a deformujeme ty
strany, které jim prochazeji.

4) Kliknutim a tazenim stfedové Uchytky svislych stran je pfemistime, druha svisla strana
zUstava na misté.

5) Podobné pomoci stfedovych uchytek vodorovnych stran objektu deformujeme tvar
premisténim celé vodorovné strany.
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Dynamické prechody

Pfechody prdhlednosti se ovladaji stejnym postupem jako barevné prechody a oba typy
prechodl se pouzivaji spolecné. V priihledném pfechodu se v jeho sméru méni mira
prihlednosti barvy vyplné objektu, a to od nepriihledné po prihlednou. V barevném prechodu se
méni vyplii z jedné barvy na jinou, ale mira prdhlednosti zlstava stejna.

Dvé ikony na nastrojové listé Transformace dynamicky ovladaji prihlednost a barevné prechody.
| kdyZ objektu s barevnou vyplni neni pfifazena prihlednost, Ize ji ovladat kliknutim na
Interaktivni nastroj priihlednosti. Tim se definuje pfechod prdhlednosti a na objektu se objevi
preruSovana ¢ara spojujici dva ¢tverce. Pfesunutim dvou ¢tvercli upravime pfechod. Definujeme
smeér prechodu (svisly, vodorovny nebo pod libovolnym Ghlem) a misto, kde prihlednost zac¢ina.

Stejnym zpUsobem je definovan i pravidelny barevny pfechod. Vybereme objekt, poté vybereme
vypln oblasti pfechodem (dalSi informace nalezneme v ¢asti ,Vypli pfechod” na strané 94). Na
nastrojova listé Transformace je nyni aktivni nastroj Interaktivni nastroj pfechodu. Po kliknuti
na Interaktivni nastroj prechodu se na objektu objevi pferuSovana ¢ara spojujici dva ctverce,
stejné jako v pripadé prechodu prdhlednosti. V pfipadé pfechodu priihlednosti i vypiné
pfechodem nastavime prechod kliknutim mimo objekt.

V prikladu na obrazku 111 pod je dynamicky upravena prihlednost pfechodu. Smér priihlednosti

se méni posunutim bilého Ctverce a vzdalenost, na kterou se aplikuje, posunutim barevného
Ctverce.

Obréazek 111 Priklad pouZiti nastroje Dynamicky
pfechod

)? Poznamka

Presouvani ¢tvercd ma rizné ucinky v zavislosti na typu prechodu. Napfiklad
u linearniho pfechodu se pocatecni a koncové Ctverce pfechodu nachazeji vzdy na
obou stranach stfedového bodu objektu.
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Seskupovani objektt

Seskupovani objektl se podoba umistovani objektl do kontejneru. Objekty ve skupiné se
presouvaji spolecné jako jeden objekt a jakékoliv Upravy se aplikuji na vdechny objekty ve
skupiné. Skupinu lze rozpustit a objekty, které ji tvofily, Ize upravovat samostatné.

DocCasné seskupeni

Docasné seskupeni je situace, kdy je vybrano nékolik objektd spole¢né. Veskeré zmény
vlastnosti se projevi na vSech objektech v do¢asné skupiné. Do¢asnou skupinu objekt( Ize otodit
jednou z nasledujicich metod:

« Klikneme a pfetdhneme kurzor nad nékolik objektd, které obklopime vybérovym
obdélnikem. Vybérovy obdélnik nebo také oblast vybéru je zndzornén na obrazku 112
pod. Jakmile jsou vybrany vSechny objekty, které maji byt v docasné skupiné, uvolnime
kurzor.

» Klikneme na prvni objekt, poté drZzime stisknutou klavesu Shift a klikame na zbyvajici
objekty, které tak pfidavame do doCasné skupiny.

¢ Chceme-li zrusit do¢asnou skupinu objektd, staci kliknout mimo Gchyty vybéru zobrazené
kolem objektd.

Obréazek 112: Priklad vybérového obdélniku (oblasti vybéru)

O
Obréazek 113: Priklad seskupeni objekt(

Dokumentace pro LibreOffice je dostupna na https://cs.libreoffice.org/get-help/documentation/



Seskupeni

Pokud jsou objekty seskupeny, veSkeré Upravy provedené na skupiné se projevi na vSech
objektech ve skupiné. Kliknutim na jeden objekt ve skupiné se vybere cela skupina. Objekty ve
skupiné si zachovavaiji své individualni vlastnosti a Ize je upravovat nezavisle. DalSi informace
nalezneme v &asti ,Upravy jednotlivych objekt(i ve skuping* na strance 127.

1) Objekty tvofici skupinu vybereme pomoci jedné z nasledujicich metod. Kolem v3ech
objektll vybranych do skupiny se zobrazi Gchyty vybéru (obrazek 113 nad).

— Na kazdy objekt vytvarené skupiny klikneme a drzime pfitom stisknutou klavesu
Shift.

— Na nastrojové listé Kresba zvolime Vybrat a nakreslime obdélnik vybéru kolem objektd
nové skupiny.

— V3echny objekty snimku vybereme v nabidce Upravy > Vybrat v3e nebo pouZijeme
klavesovou zkratku Ctrl1 + A (macOS 3 + A).

2) Skupinu vybranych objektl vytvofime pomoci jedné z nasledujicich metod:

— Klikneme pravym tlacitkem mySi na néktery vybrany objekt a z kontextové nabidky
vybereme moznost Seskupit.

— V hlavni nabidce zvolime Tvar > Seskupit > Seskupit.
— Pouzijeme klavesovou zkratku Ctrl + Shift + G (macOS ¥ + Shift + G).

ZruSeni seskupeni

1) Vybereme skupinu objektd, kolem objektll ve skupiné se objevi Gchyty vybéru (obrazek
113).

2) Skupinu objektd zrusime jednou z nasledujicich metod:

— Klikneme pravym tlacitkem mySi na vybranou skupinu a v mistni nabidce vybereme
moznost Zrusit skupinu.

— V hlavni nabidce zvolime Tvar > Seskupit > Zrusit skupinu.

— Pouzijeme klavesovou zkratku Ctrl + Alt + Shift + G (macOS 3 + ~\- + Shift
+ G).

Upravy jednotlivych objektli ve skupiné

ﬁ Poznamka

Po vstupu do skupiny nelze vybrat k Gpravam Zzadné objekty mimo skupinu. Pfed
Gpravami objektd mimo skupinu nejprve odejdeme z vybrané skupiny.

Objekt ve skupiné Ize upravovat samostatné, aniz by bylo nutné skupinu zrusit.
1) Vybereme skupinu a jeji Upravy zahajime jednim z nasledujicich zpCisobu:

— Klepneme na skupinu pravym tlacitkem mySi a z mistni nabidky vybereme moZznost
Upravit skupinu.

— V hlavni nabidce zvolime Tvar > Seskupit > Upravit skupinu.
— Pouzijeme klavesovou zkratku F3.
— Poklepeme na vybranou skupinu.

2) Kliknutim na objekt jej vybereme a individualné upravime, jak je zndzornéno na obrazku
114 pod.
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3) Po upravé a uloZzeni zmén jednotlivého objektu skupiny ukoncime praci ve skupiné
jednim z néasledujicich zplsobu:

— Klikneme na skupinu pravym tlaCitkem mysi a z mistni nabidky vybereme moZnost
Opustit skupinu.

Obrazek 114: Priklad Gpravy jediného objektu ve skupiné
— V hlavni nabidce zvolime Tvar > Seskupit > Opustit skupinu.
— Pouzijeme klavesovou kombinaci Ctrl+F3 (macOS 3#+F3).

— Dvakrat klikneme mimo skupinu.

Vnorené skupiny

MdzZeme vytvorit i skupinu skupin, béZné se oznaduji jako vnofené skupiny. PTi vytvareni
vnorenych skupin zachovava Draw hierarchii jednotlivych skupin a zachovava poradi, v jakém
byly skupiny vybrany. Posledni vybrana skupina se nachézi nad vSemi ostatnimi skupinami v
ramci vnofené skupiny. ZruSeni skupiny a vstup do vnofené skupiny funguje stejné jako u
jednotlivych skupin.

_ Tip
Pokud se pfikazy seskupeni a zruSeni seskupeni nebo jiné pfikazy pouZzivaji
pravidelné, Ize na nastrojovou listu pfidat ikony téchto nastrojd. Dalsi informace o
prizpUsobeni nastrojovych list najdeme v dodatku B, Nastrojové listy a v pfiruéce
Zaciname s LibreOffice.

Kombinovani, rozdélovani, rozdélovani a spojovani

Skladani objekti

SloZeni objektll znamena jejich trvalé slouceni, pfi némz se vytvori novy objekt. Pivodni objekty
jiz nejsou k dispozici jako jednotlivé objekty a nelze je upravovat jako jednotlivé objekty.

1) Vybereme nékolik objekt(, které se vzajemné prekryvaji.
2) Vybrané objekty slozime do jednoho objektu pomoci jedné z nasledujicich metod:

— Klikneme na vybér pravym tlaCitkem mysi a z mistni nabidky vybereme moZznost Tvary
> Slozit.
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— V hlavni nabidce zvolime Tvar > Slozit.
— Pouzijte kombinaci klaves Ctr 1+Shift+K (macOS 3+Shift+K).

Vysledny sloZeny objekt nemusi byt takovy, jak o€ekavame, v nasledujicim textu je vysvétleno,
jak skladani objektl funguje.
« Atributy (napfiklad vyplii plochy) vysledného objektu jsou atributy nejnizSiho objektu ve
skupiné. Na obrazku 115 pod je obdélnik a na obrazku 116 pod je Zluty obdélnik.

» Pokud se objekty pfekryvaiji, je oblast pfekryti bud vyplnéna nebo prazdna podle toho,
zda je pocet prekryvajicich se objektl sudy nebo lichy. Obrazek 116 pod ukazuje, ze
pokud je pocet pfekryti sudy, oblast prekryti je prdzdn& a pokud je poCet prekryti lichy,
vytvori se vyplnéna oblast.

(1) (2)
Obrazek 115: Priklad vyplnéni plochy ve sloZenych objektech
(1) Prekryvani jednotlivych objektd (2) Slozené objekty
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Obréazek 116: Priklad vyplnéni plochy pii spojeni a oddéleni objektt
(1) Prekryvani jednotlivych objektd (3) Rozdéleni sloZzenych objektd
(2) Slozené objekty

Rozdéleni sloZenych objektl

Obijekt, ktery vznikl sloZzenim nékolika objekt(, Ize opét na jednotlivé objekty rozdélit. Plvodni
objekty si vSak zachovaji formatovani slozeného objektu a nevrati se ke svému plvodnimu
formatovani. Vyberte slozeny objekt a pouzijte jednu z nasledujicich metod pro jeho rozdéleni:

* V hlavni nabidce zvolime Tvar > Rozpojit.
* PouzZijeme klavesovou zkratku Ctr l+Alt+Shift+K (macOS ¥+ \-+Shift+K).

Na obrazku 116 nad maji jednotlivé plivodné prekryvajici se objekty pfi rozpojeni slozeného
objektu formatovani obdélniku 1, ktery byl plivodné nejnize.

Rozpojeni objektl

Objekt, ktery se sklada z vice nez jedné casti, Ize rozpojit na jednotlivé ¢asti takto. Napfiklad
hvézda se rozdéli na samostatné ¢ary a ztrati se vypli plochy, jak vidime uprostfed obrazku 117
pod.

1) Vybereme objekt, ktery se sklada z vice nez jedné &asti.
2) Pfevedeme objekt na kfivku nebo mnohouhelnik pomoci jedné z nasledujicich metod:
— V hlavni nabidce zvolime Tvar > Pfevést > Na kfivku nebo Na mnohouhelnik.

130 | Prirucka aplikace Draw 25.8



— Klikneme na objekt pravym tlacitkem mysi a v mistni nabidce vybereme PFevést > Na
kfivku nebo Na mnohouhelnik.

3) V hlavni nabidce zvolime Tvar > Rozpojit a objekt se rozdéli na jednotlivé Casti.

4) Jednotlivé Casti podle potfeby pfesuneme, pozménime nebo odstranime, jak vidime na
objektu vpravo na obrazku 117 pod.

Spojovaci ¢ary
Jednotlivé Casti objektu nebo jednotlivé objekty Ize propoijit takto:
1) Vybereme vSechny objekty, které budou pfipojeny.
1) V hlavni nabidce zvolime Tvar > Spojit. Jednotlivé Cary nebo Cary v ohranieni se

prevedou na kfivky a koncové body kazdé Cary se spoji.

I

(1) (2) (3)

Obrazek 117: Priklad rozpojeni objektt

(1) Plvodni objekt (2) Objekt rozpojeny (3) Uprava jednotlivych ¢asti

Uzavieni objektt
1) Vybereme objekt, ktery ma mezeru na okraji.

2) Klikneme pravym tlac¢itkem mysi na vybrany objekt a z mistni nabidky vybereme moznost
Uzavfit objekt, ¢imZ mezeru uzavieme.

3) Zformatujeme vytvorenou vyplii oblasti podle pozadavk(. Dalsi informace o praci s
vyplnémi ploch nalezneme v kapitole 4, Zména atributd objektu.

ﬁ Poznamka

Tvar, ktery vznikne spojenim jednotlivych ¢4sti nebo €ar, neni uzavieny tvar. Novy
tvar musi byt uzavieny, aby se vytvofrila vypli plochy.

Slucéovani, odecitani nebo priinik objektl

Po vybéru vice nez jednoho objektu se zpfistupni funkce slouceni, odecteni a priiniku, které
umoznuji vytvorit novy objekt s novym tvarem.

Sloucéeni

Pri sluGovani objektll se vytvori novy objekt, jehoz tvar kopiruje tvar slu¢ovanych objekt(. Vypli
plochy slou¢eného objektu je ur€ena vyplni plochy objektu, ktery je mezi slu¢ovanymi objekty
nejnize, jak je znazornéno na obrazku 118 pod.
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Po vybéru nékolika objektl pouzijeme ke slouceni objektll jednu z nasledujicich metod:

« V hlavni nabidce zvolime Tvar > Sloudit.

» Klikneme pravym tlaCitkem mySi na vybrané objekty a z mistni nabidky vybereme
moznost Tvary > Sloudit.

Obrazek 118: Priklad slu¢ovani objekt(

Obrazek 119: Priklad odecitani objektt

Obréazek 120: Priklad protinajicich se objekt(

Od¢éitani
Pfi odeditani objektll se objekty v popfedi odeditaji od objektu vzadu. Tim vznikne prazdné
misto, které odecitané objekty zabiraly a vytvofi se novy tvar, jak je zndzornéno na obrazku 119

nad. Po vybéru nékolika objektl, které se vzajemné prekryvaji, pouzijeme k odecteni objektl
jednu z nasledujicich metod:

* V hlavni nabidce zvolime Tvar > Odedcist.

* Klikneme pravym tlaCitkem mysi na vybrané objekty a z mistni nabidky vybereme
moznost Tvary > Odecist.
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Pruinik

Pfi tvorbé prlniku vznika objekt, jehoZ body jsou spole¢né véem tvarlim, z nichz priinik vznika.
Novy objekt vznika z té Casti nejnizSiho objektu, ktera je pfekryta vdemi objekty nad nim, jak
vidime na obrazku 120 nad. Po vybéru nékolika objekt(, které se vzajemné prekryvaji, pouzijeme
k jejich prlniku jednu z nasledujicich metod:

» \/ hlavni nabidce zvolime Tvar > Prinik.

* Klikneme pravym tlaCitkem mysSi na vybrané objekty a z mistni nabidky vybereme Tvary
> Pranik.

Duplikace a pfechod tvari

Duplikovani

Duplikovani vytvari kopie objektu, na duplikované kopii aplikuje fadu Uprav, napfiklad méni barvu
nebo duplikat otodi.

1) Vybereme objekt nebo skupinu objektd a pomoci jedné z nasledujicich metod otevieme
dialogové okno Duplikovat (obrazek 121 pod):

— V hlavni nabidce zvolime Upravy > Duplikovat.
— V hlavni nabidce zvolime Tvar > Duplikovat.
— Pouzijeme klavesovou zkratku Shift + F3.
2) Vybereme pocet kopii, umisténi, zvétSeni a poatecni a koncovou barvu duplikatd.

3) Klikneme na tlagitko OK a vytvofi se duplicitni kopie. Priklad duplikovani je na obrazku
122 pod. Kazdy duplicitni objekt je samostatny objekt.

Duplikovat x
Pocet kopiit 1 B @
Umisténi
Csa X 0,50 cm =
Cs=a Y: 0,50 cm =
Uhel: 0,00° =
Ivétzeni
Sitka: Q.00 cm =
Wygka: 0,00 crn =
Barvy
Zatatek: [ Svétle modra 2 v
Konec: |:| Svétle modra 2 e

MNapovéda Wychozl Lrudit

Obrazek 121: Dialogové okno Duplikovat
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Obrazek 122: Priklad duplikace

4) Chceme-li duplicitni objekty seskupit do jedné skupiny, viz ,Co je v této uZivatelské
pfirucce?" na strané 8.

5) Chceme-li spojit duplicitni objekty do jednoho objektu, viz ,Kombinovani, rozdélovani,
rozdélovani a spojovani“ na strané 128.
PTi pouziti dialogového okna Duplikovat jsou k dispozici nasledujici moznosti:
Pocet kopii
Zadame pocet pozadovanych kopii.
Umisténi
Nastavi polohu a nato¢eni duplikovanych objektl vzhledem k plivodnimu objektu.
Osa X

Zadavame vodorovnou vzdalenost mezi stfedy vybraného objektu a duplikatu. Kladné
hodnoty posunou duplikovany objekt doprava a zdporné hodnoty posunou duplikovany
objekt doleva.

OsayY

Zadavame svislou vzdalenost mezi stfedy vybraného objektu a duplikatu. Kladné
hodnoty posouvaji duplikovany objekt smérem dol(i a zaporné hodnoty smérem
nahoru.

Uhel
Zadavame Uhel (0 az 359 stupnd) otoéeni duplikatu. Kladné hodnoty otaceji

duplikované objekty ve sméru hodinovych ruciCek a zaporné hodnoty proti sméru
hodinovych rucicek.

ZvétSeni
Nastavujeme velikost duplikatu.
Sitka
Zadavame hodnotu zvétSeni nebo zmenseni Sitky duplikovanych objektd.
VysSka
Zadavame hodnotu zvétSeni nebo zmenseni vysky duplikovanych objektd.
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Barvy
Nastavujeme barvy pro vybrané objekty a duplicitni objekty. U vice nez jedné kopie tyto
barvy definuji poc¢atecni a koncovy bod barevného pfechodu.

Zacatek
Vybér barvy pro vybrany objekt.

Konec
Vybereme barvu pro duplikovany objekt. Pokud vytvafime vice nez jednu kopii, pouzije
se tato barva na posledni kopii.

Pfechod tvaru

Prechod tvarl transformuje jeden tvar objektu na jiny tvar. Vysledkem je nova skupina
jednotlivych objektl, kter4 obsahuje pocatecni a koncové objekty. Mezikroky ukazuji transformaci
z jednoho tvaru objektu na jiny tvar objektu. Pfechod tvard se provadi od prvniho vybraného
objektu k druhému vybranému objektu.

1) Vybereme dva objekty a v hlavni nabidce zvolime Tvar > Pfechod tvar(, ¢imz otevieme
dialogové okno Prechod tvar(i (obrazek 123 pod).

2) V poli Nastaveni vybereme pocet krok( transformace.
3) V pripadé potfeby vybereme v Nastaveni Atributy pfechodu tvar( a Stejny smér.

4) Kliknutim na tlaCitko OK vybrané objekty prolneme a zavieme dialogové okno Pfechod
tvar(. Na obrazku 124 pod je zobrazen priklad pfechodu tvarli se zruSenym vybérem
Stejny smér. Vytvoreny objekt je skupina objekt(.

5) Chceme-li tuto skupinu objektll zrusit a pouzivat jednotlivé objekty, viz ,Zruseni
seskupeni“ na strané 127.

V dialogovém okné PFechod tvari jsou k dispozici nasledujici moZnosti:

Prirtistky
Zadame pocet krok( pfi pfechodu mezi vybranymi objekty.
Prechod tvard *
Mastaveni
Piirdsthoy: e -

Atributy pfechodu tvard
Stejny smér

MNapovéda | CK l Zruit

Obrazek 123: Dialogové okno Prechod tvart
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Obrazek 124: Priklad pfechodu mezi tvary

Atributy pfechodu tvart

Pouzije prechod tvar(i na vlastnosti ¢ar a vypIni vybranych objektd. Pokud jsou napfiklad
vybrané objekty vyplnény riiznymi barvami, pouZije se barevny pfechod mezi obéma
barvami.

Stejny smér
PouZije plynuly pfechod mezi vybranymi objekty.

Umist'ovani objekt

Usporadani objektd
Pfi kombinovani, slu¢ovani, odecitani nebo priniku objekt se kone¢ny vysledek lisi podle toho,
ktery objekt je vpredu a ktery vzadu. Kazdy novy objekt umistény na vykres se automaticky stane

prednim objektem a vSechny ostatni objekty se posunou v pofadi umisténi dozadu. Uspofadani
objektl méni poradi ve skupiné objektd.

Chcete-li zménit usporadani objektd, vybereme jeden nebo vice objektd a pouzijeme jednu z
nasledujicich metod:

* Klikneme pravym tlaCitkem mySi na vybrané objekty a z mistni nabidky vybereme
moZznost Uspofadat a jednu z dostupnych moZzZnosti.

+ Kliknutim na trojuhelnik v vpravo od ikony Uspofadat na Standardni nastrojové listé
otevieme panel Umisténi (obrazek 125 pod) a vybereme jeden z dostupnych nastrojd.

« Klikneme na jeden z nastrojli pro usporadani na nastrojové listé Cara a vypln.

» Klikneme v hlavni nabidce na Tvar > Uspoiradat a vybereme moznost usporadani.
Umisténr v X
=1 O
= = O9 O &~ O

Obrazek 125: Dilci panel nastroji Umisténi

* PouZijeme nastroje Usporadani v ¢asti Umisténi a velikost na karté Vlastnosti na
postranni li5té.

* Pro kazdou moZznost usporadani pouzijeme klavesovou zkratku.

K dispozici jsou nasledujici moznosti usporadani:
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Pienést do popredi
Prenese vybrany objekt do popiedi skupiny objektl (Shift+Ctr 1++) (macOS ¥#+Shift+
+).

Pfenést bliz
Posune vybrany objekt o krok vpfed (Ctrl + +) (macOS & + +).

Odsunout dal
Odsune vybrany objekt o krok zpét (Ctrl + -) (macOS 3 + -).

Odsunout do pozadi
Pfesune vybrany objekt na konec skupiny objektd (Shift + Ctrl + -) (macOS & +
Shift + -).

Pfed objekt

Pfesune vybrany objekt pfed jiny vybrany objekt.
Za objekt

Pfesune vybrany objekt za jiny vybrany objekt.

Prohodit
Obrati poradi vybranych objektd. Tento nastroj je zasedly, pokud je vybran pouze jeden
objekt.

Zarovnani objektl

Aby kresba vypadala profesionalnéji, Ize objekty vzajemné zarovnat. Vybereme jeden nebo vice
objektll a pouZijeme jednu z nasledujicich metod zarovnani objekt(:

» Klikneme pravym tlaCitkem mysi na vybrané objekty a z mistni nabidky vybereme
Zarovnani objektl a jednu z dostupnych moznosti.

+ Klikneme na jeden z nastrojd pro zarovnani na nastrojové listé Cara a vypli.
* V hlavni nabidce zvolime Tvar > Zarovnat objekty a vybereme poZzadované zarovnani.

* PouZijeme nastroje Zarovnani v ¢asti Umisténi a velikost na karté Vlastnosti na
postranni listé.

* V hlavni nabidce zvolime Zobrazit > Nastrojové listy, vybereme Zarovnat objekty a
otevie se nastrojova liSta Zarovnat objekty (obrazek 126 pod).

Zarovnat objekty v X

|<§| ?ﬁ; |:|;| DTT‘ H-E% D_ll[, Ma stied stranky

Obrazek 126: Nastrojova lista Zarovnani
objektl

K dispozici jsou nasledujici nastroje pro zarovnani:

Vievo
Zarovna levé okraje vybranych objektd. Pokud je vybran pouze jeden objekt, je levy okraj
objektu zarovnan k levému okraji stranky.

Na stied

Vodorovné vystfedi vybrané objekty. Pokud je vybran pouze jeden objekt, je jeho stfed
zarovnan na vodorovny stfed stranky.
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Vpravo
Zarovna pravé okraje vybranych objektd. Pokud je vybran pouze jeden objekt, zarovna se
pravy okraj objektu k pravému okraji stranky.

Nahoru

Svisle zarovna horni okraje vybranych objektll. Pokud je vybran pouze jeden objekt,
zarovna se horni okraj objektu k hornimu okraiji stranky.

Na strfed

Svisle vystfedi vybrané objekty. Pokud je vybran pouze jeden objekt, zarovna se jeho
stfed na svisly stfed stranky.

Dolt

Svisle zarovna spodni okraje vybranych objektd. Pokud je vybran pouze jeden objekt,
zarovna se spodni okraj objektu na spodni okraj stranky.

Rozmisténi objektti

Rozmisténi objektll umoziuje rovhomérné rozmisténi tii nebo vice objektl podél vodorovné

nebo svislé osy. Nejvzdalené&jsi objekty slouzi jako zaklad pro vypocet rozestupl. Vybereme
alespon tfi objekty a poté je rozmistime pomoci jedné z nasledujicich metod:

* Klikneme pravym tlacitkem mySi na vybrané objekty a z mistni nabidky vybereme
moZnost Rozmistit vybér a jednu z dostupnych moznosti.

* V hlavni nabidce zvolime Zobrazit > Nastrojové listy, vybereme Rozmistit vybér a
otevie se nastrojova liSta Rozmistit vybér (obradzek 127 pod).

* V hlavni nabidce zvolime Tvar > Rozmistit vybér a vybereme moZnost rozmisténi.

+ Klikneme pravym tlaCitkem mySi na vybrané objekty a z mistni nabidky vybereme
moznost Rozmistit vybér a poté vybereme moznost rozdéleni.

K dispozici jsou nasledujici moznosti rozmisténi:

Vodorovné vievo
RozloZi vybrané objekty tak, aby levé okraje objektli byly od sebe stejné& vzdaleny.

Vodorovné na stied
RozloZi vybrané objekty tak, aby vodorovné stfedy objektd byly od sebe stejné vzdaleny.

Vodorovné mezery
Rozlozi vybrané objekty vodorovné tak, aby byly rovhomérné od sebe vzdaleny.
Rozmistit vybér v X

ih do @b dd = =2 & =2

Obrazek 127: Nastrojova lista Rozmistit vybér

Vodorovné vpravo
RozlozZi vybrané objekty tak, aby pravé okraje objektll byly od sebe rovnomérné vzdaleny.

Svisle nahoru
Rozlozi vybrané objekty tak, aby jejich horni okraje byly od sebe rovnomérné vzdaleny.

Svisle na stied
RozlozZi vybrané objekty tak, aby svislé stfedy objektl byly od sebe rovnomérné vzdaleny.
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Svisle mezery

Rozlozi vybrané objekty vertikalné tak, aby byly objekty rovnomérné vzdaleny od sebe.
Svisle doll

RozloZi vybrané objekty tak, aby byly jejich spodni okraje od sebe rovhomérné vzdaleny.

Prirucka aplikace Draw 25.8 | 139



j LibreOffice

The Document Foundation

Prirucka aplikace Draw 25.8

Viytvareni vektorové grafiky v LibreOffice



Uvod

V predchozich kapitolach priru¢ky Draw jsou uvedeny informace o vektorové grafice a bézné
pouzivané typy vektorové grafiky:
SVG (Scalable Vector Graphics)
Vektorovy forméat obrazk( pro dvourozmérnou grafiku zaloZzeny na rozsititelném
znackovacim jazyce (XML) s podporou interaktivity a animace.
EPS (Encapsulated PostScript)

Formét dokumentu PostScript pouZzitelny jako format grafického souboru. Soubory EPS
jsou samostatné dokumenty PostScript, které popisuji obrazek nebo kresbu a mohou byt
umistény v jiném PostScript dokumentu.

Al (Adobe lllustrator)

Proprietarni format soubor( vyvinuty spoleénosti Adobe Systems pro reprezentaci
jednostrankovych vektorovych kreseb ve formatech EPS nebo PDF.

Samozifejmé méa Draw také nékolik funkci pro préaci s rastrovou grafikou nebo bitmapami,
napriklad s fotografiemi a naskenovanymi obrazky. To zahrnuje import, export a pfevod z
jednoho grafického formatu do jiného. Program Draw dokaze oteviit vétsinu grafickych formatd a
nabizi funkce jako jiné programy pro rastrovou grafiku, napf. Gimp nebo Adobe Photoshop.
Obrazky v rastrové grafice pouzivaji nasledujici formaty:
JPGIJIPEG (Joint Photographic Experts Group)
Format JPEG je nejbéznéjSim formatem obrazk( na webovych strankach a vétsina
digitalnich fotoaparatd vytvari obrazky ve formatu JPEG.
GIF (Graphics Interchange Format)
GIF je bitmapovy obrazovy forméat, ktery je oblibeny diky své Siroké podpofe a
prenositelnosti.
PNG (Portable Network Graphics)
PNG je format rastrového obrazku, ktery podporuje bezeztratovou kompresi dat a také
prihlednost pozadi.
TIFITIFF (Tagged Image File Format)
Format TIFF je flexibilni, pfizplsobivy a umoZnuje ukladat obrazova data v
bezeztratovém formatu.
BMP (BitMaP)

Znamy také jako bitmapovy obrazovy soubor, ktery je bodovou maticovou datovou
strukturou.

Importovani grafiky a obrazku

Vkladani
Chceme-li do vykresu importovat obrazové soubory, zvolime v hlavni nabidce VloZit > Obrazek,
otevie se dialogové okno Vlozit obrazek (obrdzek 128 pod).

Aplikace Draw obsahuije importni filtry pro vétSinu grafickych forméatd. Pokud importovany soubor
pouziva graficky format, ktery neni kompatibilni s importnimi filtry LibreOffice, doporucujeme
pouZzit bezplatny program pro konverzi grafiky, ktery soubor pfevede do grafického forméatu, ktery
Draw rozpozna.

Dokumentace pro LibreOffice je dostupna na https://cs.libreoffice.org/get-help/documentation/



Pokud je vybrana moznost Nahled, zobrazi se nahled souboru na pravé strané dialogového
okna Vlozit obrazek. To usnadriuje vybér poZadovaného souboru a zajistuje, Ze Draw m(ze
importovat graficky forméat souboru.

DAIMAGES
Mista Datum zmény
=1 Dokumenty B Krokusjpg Obrazek (jpg) 723 01.05.2023, 11:06
[=1 IMAGES |2 Kyticajpg Obrazek (jpg) 76,9 kB 01.05.2023, 11:08
2 Levi 01,jpg Obrazek (jpg) 1629kB  30.04.2023, 09:53
[ Levi 02jpg Obrézek (jpg) 77,2kB  30.04.2023, 09:49
(& Levi 03,jpg Obrazek (jpg) 107,0kB  30.04.2023, 09:50
(& Levi 04,pg Obrazek (jpg) 399,0kE  30.04.2023, 09:38
i Zapad sinka 01jpg Obrazek (jpg) 355kB  30.04.2023, 10:01
[2 Zapad sinka 02jpg Obrézek (jpg) 8060kB  30.04.2023, 10:03
Nazev souboru: ||(r0kus.jpg |V ‘ | Oteviit |
Typ souboru: |ﬂ‘n.r'§echny obrazky> (*.bmp;*.dxf;*.emf;*.emz*.eps*.gif; .Jpg—| Zrusit ‘
O0Odkaz [ Nahled -
Napovéda ‘

Obrazek 128: Dialogové okno VioZit obréazek

Vkladani

VloZenim grafiky do vykresu se grafika stavéa trvalou soucasti vykresu. VeSkeré zmény vloZzené
grafiky se zobrazi pouze v kresbé LibreOffice, do které byla grafika vloZzena. Plvodni graficky
soubor neni ovlivnén. VloZeni je importovani grafiky do vykresu pomoci jedné z nasledujicich
metod:

Dialogové okno VloZzit obrazek.
Kopirovani a vlozeni.

Skenovani grafiky.

PfetaZeni mezi otevienymi soubory.

Hlavni vyhodou vloZeni grafiky do vykresu je, Ze grafika je vZdy k dispozici bez ohledu na to, v
jakém pocitaci je vykres otevien.

Hlavni nevyhodou vkladani grafiky je vytvareni velkych soubortli, coz mize zpUsobit problémy s
ukladanim, pokud je kapacita Ulozisté v pocitaci omezena. Pokud je plvodni grafika zménéna,
na vloZzené grafice se tyto zmény neprojevi.

}? Poznamka

P¥i vkladani grafiky do vykresu LibreOffice zajistime, aby v dialogovém okné VlozZit
obrazek nebyla vybrdna moznost Vlozit jako odkaz.
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Propojeni

Odkaz na plvodni grafiku nevklada grafiku do vykresu, ale vytvafi odkaz na umisténi ptivodniho
grafického souboru. Pfi kazdém otevieni vykresu LibreOffice se v ném zobrazi s nim propojena

grafika.

(1 Soubor D:\IMAGES\Krokus.jpg nebude uloZen spolu s
~ dokumentem, ale pouze jako odkaz.

Pokud se zméni umisténi nebo nazev souboru, bude obrazek nedostupny. Prejete
si namisto toho obrazek vloZit?

[IiPfi odkazovani na obrazek zobrazit dotaz:

Zachovat odkaz VloZit obrazek

Obrazek 129: Dialogové okno Potvrdit obrazek jako odkazy

Hlavni vyhodou propojeni grafickych soubort je, Ze pokud upravime pUvodni graficky soubor, v
otevieném vykresu v LibreOffice se propojena grafika automaticky aktualizuje. Také velikost
souboru vykresu LibreOffice je mensi a plivodni grafika se Iépe upravuje pomoci
specializovanych externich aplikaci.

Hlavni nevyhodou propojené grafiky je nutnost udrzovat vazbu mezi vykresem LibreOffice a
vloZenym grafickym souborem. Pokud pidvodni vykres nebo graficky soubor pfesuneme na jiné
misto v pocitaci, je tfeba aktualizovat vSechny odkazy tak, aby obsahovaly nové umisténi.

6) Otevieme dialogové okno VloZzit obrazek.
7) V dialogovém okné Vlozit obrazek vybereme Vlozit jako odkaz.

8) Vybereme pozadovany graficky soubor a kliknutim na Otevfit otevieme dialogové okno
Potvrdit obrazek jako odkaz (obrazek 129 nad).

9) Kliknutim na P¥ipojit propojime soubor a zavieme dialogové okno Potvrdit obrazek jako
odkaz.

10) V pfipadé potfeby klikneme na VloZit obrazek, abychom soubor vloZili do vykresu misto
tvorby propojeni. Tim se také zavre dialogové okno Potvrdit obrazek jako odkaz.

ﬁ Poznamka

P¥i propojeni grafického nebo obrazkového souboru v kresbé LibreOffice se format
souboru propojené grafiky nebo obrazku nezméni.

Uprava odkazti

1) V hlavni nabidce zvolime Upravy > Odkazy na externi soubory, otevie se dialogové
okno Upravit odkazy (obrazek 130 pod).

2) Podle potfeby klepneme na Upravit, Rozpojit odkaz nebo Aktualizovat.

— Upravit — umozZziiuje zmeénit vybrany odkaz mezi grafickym souborem aktualniho
vykresu a zdrojovym souborem.

— Rozpojit odkaz — pferusi vazbu mezi vybranym propojenym zdrojovym souborem a
aktualnim dokumentem. Aktualni verze zdrojového souboru se viozi do vykresu. Otevie
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se potvrzovaci dialogové okno s dotazem, zda ma byt odkaz rozpojen. Kliknutim na
Ano potvrdime rozpojeni odkazu.

— Aktualizovat — aktualizuje vybrany odkaz tak, aby se ve vykresu zobrazila nejnovéjsi
verze odkazovaného grafického souboru.

3) Kliknutim na Zavfit uloZime zmény odkazu a zavieme dialogové okno Upravit odkazy.

Zdrojovy soubor Prvek Typ Stav

file:///D:/IMAGES/Krokus.jpg Obrazek Ruéni

Zdrojovy soubor  file:///D:/IMAGES/Krokus.jpg

Prvek:
Typ: Obrazek
Aktualizace: Automaticka Rucni
MNapovéda Upravit... Rozpojit odkaz Aktualizovat Zavfit

Obréazek 130: Dialogové okno Upravit odkazy

Kopirovani a vkladani
Kopirovanim a vkladanim grafiky se do vykresu LibreOffice vlozZi také graficky nebo obrazkovy

soubor. Kopirovanou grafikou mdze byt obrazek jiz vioZeny do jiného dokumentu nebo vykresu,
také graficky soubor, napfiklad vykres, dokument nebo fotografie.

1) Po zkopirovani grafického souboru piejdeme na Upravy > VloZit jinak > VloZit jinak v
nabidce, otevie se dialogové okno VloZit jinak.

2) Vybereme poZzadovany format pro vloZeni kopirované grafiky do vykresu LibreOffice.
Dostupné formaty pro vkladani zavisi na typu kopirovaného souboru.

3) Kliknutim na OK vlozime graficky soubor a dialogové okno se zavre.

ﬁ Poznamka

Pri kopirovani a vkladani obrazkl do vykresu LibreOffice dodrzujeme autorska prava
a licenci kopirovaného souboru.
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Export obrazk

Exportovani soubor 0DG

Ve vychozim nastaveni uklada Draw vykresy ve formatu Open Document 0DG, bohuzel nékteré
programy forméat ODG neznaiji. Aby byly kresby kompatibilni s jinymi softwarovymi aplikacemi, Ize
soubor 0DG exportovat v nékolika formatech. PouZity postup exportu zavisi na nastaveni
pocitaCe a pouzitém operacnim systému. Nasledujici postup je pfikladem postupu exportu.

1) Otevieme soubor ODG, ktery chceme exportovat.

|D: ~ | Servery.. | |11« [
Mista MNazev |Typ |Ve|ikost |Datum Zmény
[owe Slozka 24.04.2023, 13:48
1 IMAGES [ DO AUTA SloZka 13.03.2023, 09:33
& D: HTML dokument (Draw) {.html;.htm) 23
XHTML (html;xhtml) m
PDF - Portable Document Format (.pdf) 15
BMP - Windows Bitmap (bmp) s
EMF - Enhanced Metafile (emf) 13
EMZ - komprimovany Enhanced Metafile (.emz) 13

EPS - Encapsulated PostScript (.eps)

GIF - Graphics Interchange Format (.gif)

JPEG - Joint Photographic Experts Group (jpg;jpeg; fif;Jif,jpe)
PNG - Portable l‘i{c\o\rmk Graphics (.png)

SVG - Scalable VEctor Graphics (.svg)

SVGZ - komprimovany Scalable Vector Graphics (.svgz)

TIFF - Tagged Image File Format (.tif; tiff)

B1

+ - WEBP - obrazek WebP (\webp)
B WMF - Windows Metafile (wmf)
Nazev souboru: ko . -

Format souboru: ble Vector Graphic:

VGZ hm rimovany Sc )
O EIRTA VG Zrusit

Automaticka piipona nézvu souboru P
= Napovéda
Vybér

Obrazek 131: Priklad dialogového okna exportu

2) V hlavni nabidce zvolime Soubor > Exportovat a otevieme dialogové okno Export.
Priklad dialogového okna pro export je na obrazku 131 nad.

3) Zadadme nazev exportovaného souboru a prejdeme do slozky, do které ma byt
exportovany soubor ulozen.

4) Z mozZnosti v rozeviracim seznamu vybereme poZadovany forméat souboru.
5) Klikneme na Exportovat a soubor se vyexportuje jako novy soubor ve zvoleném formatu.

6) V zavislosti na zvoleném formatu souboru se miiZze otev¥it dalsi dialogové okno, ve
kterém lze vybrat moZznosti forméatu exportu.

7) V zavislosti na dal$im dialogovém okné, které se mUze otevrit, klepneme na Exportovat,
Vytvofit nebo OK a soubor se vyexportuje jako novy soubor v novém formatu.

Exportovani grafiky nebo obrazki

Export jednotlivych grafickych prvkl nebo obrazkl nebo skupiny grafickych prvki nebo obrazkd z
vykresu je podobny exportu soubor(. Nasleduje priklad exportu. Skuteény postup zavisi na
operacnim systému a nastaveni pocitace.

1) Otevieme soubor 0DG, ktery obsahuje grafiku nebo obrazky uréené k exportu.

2) V souboru 0DG vybereme grafiku nebo obrazky pro export.
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3) V hlavni nabidce zvolime Soubor > Exportovat a otevieme dialogové okno Export.
Pfiklad dialogového okna pro export je na obrazku 131 nad.

4) Zadame nazev exportovaného souboru a pfejdeme do sloZzky, do které ma byt
exportovany soubor ulozZen.

5) V dialogovém okné Export klikneme na Vybér. Vybér mlize otevfit dialogové okno s
prikladem moznosti, jak je znazornéno na obrazku 132 pod.

6) V dialogovém okné moZznosti zadame poZadované moZznosti a kliknutim na tlaCitko OK
exportujeme soubor do zvolené slozky. Export neni potvrzen.

Moznosti WEBP X

Velikost
© Upravit rozméry

Sirka: 21,01 — + cm ~
Vyska: 29,71 — +

Upravit rozliseni

Rozliseni: pixelyfem  ~

Kvalita
Bezztratovy

Informace
Obrazek potiebuje asi 2612.3 kB paméti, velikost
souboru je 383.4 kB.

Napovéda Zrusit OK

Obrazek 132: Priklad dialogového okna MoZnosti

exportu
Obrazek
. —
==l = I_'_J Ll O DD ' O 7v|i}ﬂi}cm :ﬁ- Barva h —|
v X
— A - ol BT | — = [ or -7
rf I - O & ~lvyenozr [V GG 2 A LS~ @lox 1 &

Obrazek 133: Nastrojova lista Obrazek

Formatovani obrazk

Obrazky (rastrova grafika) se upravuji a formatuji pfidanim nebo zménou filtr(l, Gpravou barey,
¢ar, ploch a stinli pomoci jedné z nasledujicich metod:

» Pfejdéte do nabidky Format > Obrazek a pouzijeme nastroje v oteviené podnabidce.
» Pouzijte nastroje na nastrojové listé Obrazek (obrazek 133 nad).

* Pouzijeme nastroje dostupné na panelu Obrazek na karté Vlastnosti na postranni listé.
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» Neékteré rastrové grafiky mohou obsahovat textovy prvek. Dalsi informace o formatovani
textu najdeme v kapitole 9, Pfidavani a forméatovani textu.

ﬁ Poznamka

Zmény formatovani grafiky pomoci nastrojli LibreOffice se zobrazi pouze ve vykresu,
v némz byla grafika upravena. Plvodni graficky soubor neni ovlivnén. Rastrova
grafika obsazena ve skupiné se pfi Upravé a formatovani vlastnosti skupiny chova
jako ostatni objekty.

Pojmenovani obrazk

Aplikace Draw vyuziva poradi vkladani objektl do vykresu pfi jejich pojmenovani, napfiklad Tvar
1, Tvar 2 atd. Doporucuje se objekty pfejmenovat a uzit jedineéné nazvy. Diky nazvim jsou
objekty a obrazky snadno identifikovatelné v Navigatoru.

1) Vybereme obrazek a pomoci jedné z nasledujicich metod otevieme dialogové okno
Néazev a vytvofime pro vybrany obrazek jedine¢ny nazev:

— V hlavni nabidce zvolime Format > Nazev.

— Klikneme na obrazek pravym tlacitkem mySi a z mistni nabidky vybereme mozZnost
Nazev.

2) V otevieném dialogovém okné Nazev zadame nazev do textového pole Nazev a
klikneme na OK.

Nastrojova lista Obrazek

Nastrojova lista Obrazek (obrazek 133 nad) se zobrazi, kdyZ je vybran obrdzek nebo rastrovy
graficky objekt. DalSi informace o Nastrojové listé Obrazek a dostupnych nastrojich nalezneme v
dodatku B, Nastrojové listy. Nize uvedené nastroje na nastrojové listé Obrazek jsou pouze
prikladem.

Umisténi a velikost (F4)
Otevre dialogové okno Umisténi a velikost. DalSi informace nalezneme v kapitole 3,
Prace s objekty.

Zarovnat objekty
Otevre dil¢i nastrojovou listu, kterd umoziiuje pfistup k nastrojlim pro zarovnani
vybranych objektl vici sobé. Vice informaci nalezneme v kapitole 5, Kombinace vice
objektd.

Pfenést do popredi
Presune vybrany objekt ve skupiné objektll nejvyse (Ctr1+Shift++) (macOS $+Shift+
+).

Pfenést bliz
Posune vybrany objekt pfed objekt, za kterym byl(Ctrl + +) (macOS & + +).

Odsunout dal
Odsune vybrany objekt za objekt pod nim (Ctrl + -) (macOS 3 + -).

Odsunout do pozadi
Ve skupiné objektll bude tento poslednim (Ctr 1+Shift+-) (macOS +Shift+-).

Pred objekt
Pfesune vybrany objekt pfed jiny vybrany objekt.
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Za objekt
Pfesune vybrany objekt za jiny vybrany objekt.

Prohodit
Obrati pofadi vybranych objekt(l. Tento nastroj je zasedly, pokud je vybran pouze jeden
objekt.

Styl ¢ary
Otevie rozeviraci seznam s rliznymi styly ¢ar pouzitymi pro obrys ramce. Dalsi informace
najdeme v kapitole 4, Zména atributd objektu.

Sitka gary
Slouzi ke zméné Sitky ¢ary. Dal3i informace najdeme v kapitole 4, Zména atribut(
objektu.

Barva Cary
Slouzi ke zméné barvy ¢ary. Dal$i informace najdeme v kapitole 4, Zména atribut(
objektu.

Styl | vypli oblasti
SlouZi ke zméné typu vypIné pouZité ve tvaru. DalSi informace najdeme v kapitole 4,
Zména atributl objektu.

Stin
Nastavi vychozi efekt stinu kolem obrazku. Vlastnosti stinu upravime pomoci panelu Stin
na karté Vlastnosti v postranni listé€. DalSi informace nalezneme v kapitole 4, Zména
atributll objektu.

Filtr
Otevie nastrojovou listu Filtry obrazk(, je popsana v ¢asti ,Filtry obrazku“ na strané 155.

ReZim obrazku
Zmeéni zobrazeni obrazku z barevného na ¢ernobilé, ve stupnich Sedi nebo na vodoznak.
Toto nastaveni ovlivni pouze zobrazeni a tisk obrazku; plivodni obrazovy soubor zlstava
nezménén. Nastaveni reZimu obrazku Ize zménit také ve volbé Barevny reZim na panelu
Obrazek na karté Vlastnosti v postranni liSté (obrazek 134 pod).
Viychozi
Obrazek se zobrazi v nezménénych barvach.
Stupné Sedi
Obraz se zobrazuje ve 256 odstinech Sedé.
Cerné/bila
Obrazek je zobrazen Cernobile.
Vodoznak

Zmensi se hodnoty barev, jasu, kontrastu a gamy, aby bylo moZné obrazek pouzit jako
vodoznak v pozadi. Vychozi nastaveni pro Vodoznak lze upravit pomoci nastrojové
liSty Barva (obrazek 135 pod).
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Obrazek 134: Panel Obrazek na karté Vlastnosti v
postranni listé
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Obrazek 135: Nastrojova lista Barva

Ofiznout obrazek

Ofiznuti obrazku. PFi pouziti tohoto nastroje se kolem obrazku zobrazi ofezové znacky.
PfetaZenim jedné nebo vice téchto znacek ofizneme obrazek na poZadovanou velikost.

o

DalSi informace o ofezani najdeme v Céasti ,,Ofiznuti obrazku“. pod.

Svisle
Preklopi vybrany objekt svisle. Dal$i informace najdeme v kapitole 4, Zména atribut(
objektu.

Vodorovné
Preklopi vybrany objekt vodorovné. Dalsi informace najdeme v kapitole 4, Zména atributd
objektu.

Transformace

Otevie nastrojovou liStu Transformace. DalSi informace najdeme v kapitole 4, Zména
atribut(l objektu.
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Priihlednost
Upravuje prihlednost obrazku v rozmezi 0 % (neprlihledny) az 100 % (zcela prdhledny).
Nastaveni prihlednosti Ize upravit také pomoci panelu Obrazek na karté Vlastnosti
postranni liSty.

Barva

Otevrie nastrojovou listu Barva (obrazek 135 nad), kde Ize upravit hodnoty slozek RGB,
jasu, kontrastu a gamy. Tyto Upravy nemaji vliv na pdvodni obrazek, hodnoty jsou
ulozeny v LibreOffice Draw jako samostatna sada forméatovani. Nastaveni barev Ize
upravit také pomoci panelu Obrazek na karté Vlastnosti postranni liSty.

Cervena, zelena, modra
Volime hodnoty od —100 % (Zadna barva) do +100 % (pln& intenzita); 0 % pfedstavuje
plvodni hodnotu barvy obrazku.

Jas

Zvolime hodnotu mezi —100 % (zcela ¢ernd) a +100 % (zcela bila).
Kontrast

Zvolime hodnotu mezi —100 % (minimum) a +100 % (maximum).
Gama

Ovliviiuje jas stfednich barevnych ton(. Zvolime hodnotu v rozmezi 0,10 (minimum) aZ
10 (maximum). Pokud zména jasu nebo kontrastu nepfinese pozadovany vysledek, Ize
tuto hodnotu upravit.

Ofiznuti obrazkd

Ofiznuti je metoda skryvani neZzadoucich oblasti obrazku nebo zmény velikosti obrazku v kresbé.
Zmeény provedené ofezanim obrazku méni pouze zobrazeni obrazku ve vykresu, nikoliv plvodni
soubor obrazku.

Obrazek 136: Priklad obrazku v rezimu ofezani

Rychlé ofiznuti

Po vybéru obrazku jej Ize rychle ofiznout nékterou z nasledujicich metod:
* Na néstrojove listé Standardni nebo Obrazek klepneme na Ofiznout obrazek.
* V hlavni nabidce zvolime Format > Obrazek > Ofiznout.

* Klikneme pravym tlaCitkem mysi na obrazek a z mistni nabidky vybereme moznost
Ofiznout.
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Kolem vybraného obrazku se zobrazi Uchyty vybéru, jak ukazuje pfiklad na obrazku 136 nad.
Obréazek ofizneme takto:

* Horni, dolni, levy a pravy Uchyt vybéru ofizne obrazek pouze v jednom sméru.
+ Uchyty pro vybé&r roh( ofiznou obréazek vertikalné a horizontalné ve dvou smérech.

» Chceme-li zachovat pomér mezi svislymi a vodorovnymi rozmeéry, podrzime pfi
presouvani Uchytu vybéru klavesu Shift.

Dialogové okno Ofiznout

Pro detailnéjSi ovladani a pfesnost funkci ofezu doporucujeme pouzit dialogové okno Ofiznout
(obrazek 137 pod). Vybereme obrazek a pfejdeme do nabidky Format > Obrazek > Dialogové
okno Ofiznout, ¢imz dialogové okno Ofiznout otevieme.

Ofiznout
Vybrany obrazek ofizneme nebo zmensime, miiZzeme pridat bilé misto kolem obrazku.

Zachovat méritko
Zachovava se zvétseni plivodniho obrazku, ofezanim jeho ¢asti se méni rozméry.

Zachovat velikost obrazku
P¥i ofezavani zachovava plvodni velikost obrazku, takze se méni zvétSeni ofezané
¢asti. Chcete-li zmensit zvétSeni obrazku, vybereme tuto moznost a do poli pro ofez
zadame zaporné hodnoty. Jak jiz bylo feCeno, zadanim kladnych hodnot se zvétSeni
zvysuje.

Vilevo a vpravo
Vybereme-li moznost Zachovat méritko, zadanim kladné hodnoty ofizneme levy nebo
pravy okraj snimku, zapornou hodnotou pfidame bilé misto vlevo nebo vpravo od
snimku. Pokud vybereme moznost Zachovat velikost obrazku, zadanim kladné hodnoty
zvySime vodorovné zvétSeni obrazu, zapornou hodnotou zvétSeni ve vodorovném
smeéru snizime.
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Oriznout

I @ 7achovat méfitko ]

(1) Zachovat velikost obrazku

Vlevo: (0,00 cm = |

Vpravo: :U.ﬂ{} cm

4k

Nahore: (0,00 cm

Dole: 0,00 cm

4k

6,77 cm=4,50 cm (300 pixeld na palec)

800x531 px ey
Méfithko Velikost obrazku
Sitka:  50% 2 Sifka:  [339em +]
Viska: (S0 % 2 Viska: 225 cm H
Napovéda oK Zrusit

Obréazek 137: Dialogové okno Oriznout

Nahore a dole

Pokud vybereme moznost Zachovat méfitko, zadanim kladné hodnoty ofizneme horni
nebo dolni ¢asti obrazku, zapornou hodnotou pfidame bilé misto nad nebo pod
obrazkem. VVybereme-li Zachovat velikost obrézku, zadanim kladné hodnoty zvétSime
svislé zvétSeni obrazu, zapornou hodnotou zvétSeni ve svislém sméru zmensSime.

Méfitko
Slouzi ke zméné zvétSeni obrazku na vykrese.
Sitka
Zménu Sifky obrazku zadavame v procentech.
VysSka
Zmeénu vysky obrazku zadavame v procentech.
Velikost obrazku
Slouzi ke zméné velikosti obrazku.
Sitka
Zadavame Sifku obrazku.
Vyska
Zadavame vysku obrazku.
Pavodni velikost

PUvodni velikost obrazku se zobrazuje nad touto moznosti. Kliknutim na tuto volbu a
naslednym kliknutim na OK obnovime plvodni velikost obrazku.

)? Poznamka

V dialogovém okné Ofiznout jsou Udaje Sitka a Vyska povazovany za nezavislé
hodnoty. Zména jednoho bez druhého mdze vést k vyraznému zkresleni obrazu a to
nemusi byt to, co je poZadovano.
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Export ofiznutych snimku
Chceme-li ofiznuty obrazek pouzit i v jiném vykresu, pouZzijeme po vybéru ofiznutého obrazku
jeden z nasledujicich krokd.
PouZziti dialogového okna Exportovat
1) Vybereme ofiznuty obrazek.

2) V hlavni nabidce zvolime Soubor > Exportovat, ¢imZ otevieme dialogové okno
EXxportovat.

3) Prejdeme do cilové slozky a zadame nazev souboru.
4) Klikneme na Vybér a poté na Export. DalSi informace nalezneme v ¢asti ,Export
obrazk{“ na strané 146.
Pouziti funkce UloZit
1) Vybereme ofiznuty obrazek.

2) Prejdeme do nabidky Format > Obrazek > UloZit nebo klikneme pravym tlacitkem mysi
na ofiznuty obrazek a z kontextové nabidky vybereme moznost UloZit.

3) Kliknutim na Ano otevieme dialogové okno Export obrazku.

4) Vybereme pozadovany formét souboru, pfejdeme do cilové slozky a zadame nazev
souboru.

5) Kliknutim na Ulozit ofiznuty obrazek ulozime.

Komprese obrazk

Pokud je do kresby vlozen velky obrazek a jeho velikost je zménéna tak, aby se veSel do
rozvrzeni kresby, je v souboru kresby ulozen cely pdvodni obrazek v pIné velikosti. Tim se
zachova plvodni obrazek, ale mize se vytvorit velky soubor, ktery je tfeba ulozit nebo odeslat
postou.

Pokud Ize akceptovat urcitou ztratu kvality obrazu, Ize obraz komprimovat nasledujicim
postupem. Tim se snizi objem dat a zaroven se zachova kvalita obrazku v rozvrzeni stranky.
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Komprese Rozligeni

) Kvalita JPEG L] Zmensit rozliseni obrazkid na:

5 s Sirka: (798 2| px
[ ® Komprese PNG ] Vyska: 531 = px
| |5 & Rozligeni: |300 ~| om
Interpolace: |Lam:zus T‘

Informace o obrazku

Typ: Obrazek IPEG

Skutefné rozmény: 16,93 cm = 11,24 cm (800 = 531 px)

Zdanlivé rozmeéry: 6,77 cm = 4,49 cm pfi 300 DPI

Velikost obrazku: T2 KiB

Vypoditat novou velikost: | 77
Napovéda OK Zrusit

Obréazek 138: Dialogové okno Komprimovat obrézek

1) Dialogové okno Komprimovat obrazek (obrazek 138 nad) otevieme jednim z
nasledujicich zptsob:

* Klikneme na obrazek pravym tlacitkem my3i a z mistni nabidky vybereme mozZnost
Komprimovat.

* V hlavni nabidce zvolime Format > Obrazek > Komprimovat.
2) Vybereme typ komprese a poZzadované rozliSeni.

3) Kliknutim na tlacitko Vypod&itat novou velikost aktualizujeme informace o obrazku po
zméné nastaveni Komprese a RozliSeni.

4) Pokud jsme s novym nastavenim spokojeni, kliknutim na tlacitko OK nastaveni
pouzijeme.

5) Pokud vysledny obrazek neni pfijatelny, pouzijeme jednu z nasledujicich metod pro
zruSeni zmén a vybereme jiné nastaveni komprese.

Filtry obrazku

Draw ma jedendct filtr(l, které Ize pouzit na zvoleny obrazek a uginky filtrd Ize kombinovat. Filtry
vZzdy pUsobi na cely obrazek, neni mozné pouzit filtry pouze na ¢ast obrazku.

}? Poznamky

Pokud je obrazek vlozen do vykresu, veSkeré filtry obrazku se aplikuji jen na vlozeny
obrazek, plvodni soubor obrazku se nezméni. UloZenim vykresu zachovame
vSechny efekty filtru pouzité na viozeny obrazek.

Po uloZeni a zavieni kresby se G¢inky obrazovych filtr(i stanou trvalymi. Pokud jsou
efekty obrazovych filtrd nevyhovujici, pouzijeme nabidku Upravit > Zpét pro zruseni
efektd filtrd PRED uloZenim vykresu.

Prirucka aplikace Draw 25.8 | 155



Pfi pouziti obrazovych filtrli na obrazek je tfeba vzit v Gvahu velikost souboru
obrazku. U velkych soubord dochazi k Casové prodlevé mezi aplikaci filtru a
projevenim se efektu na obrazku.

Pouziti obrazovych filtr(i
1) Vybérem obrazku otevieme nastrojovou liStu Obrazek.
2) Pomaci jedné z nasledujicich metod pouzijeme filtr obrazku:

— Kliknutim na Filtr otevieme dili nastrojovou liStu Filtr obrazku (obrazek 139 pod) a
vybereme filtr obrazku, ktery chceme pouzit.

— V hlavni nabidce zvolime Format > Obrazek > Filtr a z mistni nabidky vybereme filtr
obrazku.

Filtry obrazku
Zadny filtr
Na obrazku 140 pod je pfiklad obrazku bez pouzitych obrazovych filtrd.

Filtr obrazku v X

OAF abEE /B R

Obréazek 139: DIl¢i nastrojova lista Filtr obrazkd

Obréazek 141: Pfiklad pouZiti inverzniho filtru
Obrazek 140: Priklad bez pouZiti filtru Prevréatit
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Parametry

Rozsah vyhlazeni:

Napovéda QK Zrusit

Obréazek 142: Priklad pouZiti filtru Viyhladit ~ Obrézek 143: Dialogové okno filtru Viyhladit

Filtr Prevratit

Prevraci hodnoty barev obrazku (podobné jako na barevnému negativu), nebo hodnoty jasu na
obrazku ve stupnich 3edi. Op&tovnym pouZitim filtru se vratime k plivodnimu zobrazeni (obrazek
141 nad).

Filtr Vyhladit

Zjemni nebo rozmaze obrazek pomoci low pass filtru. Tim se sniZzi kontrast mezi sousednimi
pixely a obraz se stane neostrym, takze vypada hladsi. U¢inek vyhlazovaciho filtru mize byt
velmi jemny. Obrdzek 142 nad ukazuje ucinek na obrazek pfi pouziti poloméru vyhlazeni 15.

Vybérem tohoto filtru se otevfe dialogové okno Vyhladit (obrazek 143 nad), kde nastavujeme
polomér vyhlazeni. Nahled v dialogovém okné Vyhladit ukazuje efekt pouZiti filtru Vyhladit na
obrazek.

Filtr Zaostrit

Zaostfuje obraz pouzitim vysokofrekvencniho filtru a upravuje kontrast mezi sousednimi pixely.
Efekt se zvysi, pokud je filtr aplikovan nékolikrat, takze barvy vypadaji vybledlé, jak ukazuje
priklad na obrazku 144 pod.

Obrazek 144: Priklad pouZiti filtru Zaostrit Obrazek 145: Priklad pouZiti filtru Odstranit Sum
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Parametry

Hodnota prahu:

50 % -+

Prevratit

Napovéda OK Zrusit

Obrazek 147: Dialogové okno filtru
Obrazek 146: Priklad pouZiti filtru Solarizace Solarizace

Filtr Odstranit Sum

Odstrariuje Sum pouzitim medianoveého filtru, ktery porovnava kazdy pixel s jeho sousedem.
Nahradi jakykoli pixel s extrémnimi hodnotami, které se barevné zna¢né odchyluji od stfedni
hodnoty, pixelem se stfedni hodnotou barvy. MnoZstvi obrazovych informaci se pfi kazdém
pouziti filtru nezvySuje. Dochazi vSak k menSim zménam kontrastu, coZ ma za nasledek, ze
obraz vypadé hladsi a efekt je velmi jemny (obrdzek 145 nad).

Filtr Solarizace

Solarizace je efekt, ktery vznika osvétlenim fotografii béhem vyvolavéani, barvy se ¢astecné
prevraceji. Tmavé oblasti se jevi jako svétlé nebo svétlé oblasti jako tmavé. V digitdlnim svété

fotografie vytvari solarizace zménu nebo obraceni barev, podobné jako obrazovy filtr Pfevratit.
Obrazek 146 nad zobrazuje efekt filtru Solarizace za pouZiti Hodnoty prahu 50%.

Vybérem Solarizace se otevie dialogové okno Solarizace (obrdzek 147 nad), kde Ize zadat
stupen solarizace (Hodnota prahu). Zadanim Hodnoty prahu nad 70 % se inverzni efekt na barvy
obrati. Moznost Prevratit pfevraci efekt filtru Solarizace, jak je ukazano v okné nahledu na

obrazku 147 nad.

Parametry

Stupefi ztmavnuti:

10 % B

Napovéda oK Zrusit

Obréazek 148: Priklad pouZiti filtru Ztmavnuti  Obrézek 149: Dialogové okno Ztmavnuti
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Parametry

Barvy posterizace:

16 K

Napovéda 0K Zrusit

Obréazek 150: Priklad pouZiti filtru Posterizovat ~ Obrézek 151: Dialog filtru Posterizovat

Filtr Ztmavnuti

Filtr Ztmavnuti vytvafi vzhled, ktery pfipomina fotografie vyvolané v pocétcich fotografie
(obrazek 148 nad). VSechny pixely jsou nastaveny na své Sedé hodnoty. Zeleny a modry barevny
kanal se pak snizi o hodnotu zadanou v dialogovém okné Ztmavnuti v poli Stuperi ztmavnuti.
Kanal Cervené barvy se nezméni. Vybérem filtru Ztmavnuti se otevie dialogové okno Ztmavnuti
(obrazek 149 nad), kde Ize definovat Stupern ztmavnuti a vytvofit vzhled pfipominajici stary
obrazek.

Filtr Posterizovat

Posterizace sniZzuje pocet barev v obrazku. Napfiklad fotografie bude pravdépodobné vypadat
jako malba, kdyZ snizime pocet barev (obrazek 150 nad). Vybérem filtru Posterizovat se otevie
dialogové okno Posterizovat (obrazek 151 nad), kde Ize pro dosazeni pozadovaného efektu
definovat pocet Barev posterizace.

Filtr Pop Art

Zmeéni barvy obrazku pfevedenim obrazku do forméatu pop-art (obrazek 152 pod).

Filtr Kresba uhlem

Zobrazi obrazek jako naértek uhlem. Obrysy obrazu jsou vykresleny ¢erné a plvodni barvy jsou
potlaeny (obrazek 153 pod).

Obrazek 152: Priklad pouZiti filtru Pop art  Obrazek 153: Priklad pouZiti filtru Kresba uhlem
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Parametry

Zdroj svétla:

5 5
o 0
oO—>0—®

Napovéda 0K Zrusit

Obrazek 154: Priklad pouZiti filtru Reliéf Obrazek 155: Dialogové okno filtru Reliéf

Parametry
Sitka:

‘6 pixeld E“
Vygka:
‘4 pixeld E|

Vylepiit hrany

Napovéda oK Zrudit

Obréazek 156: Priklad pouZiti filtru Mozaika  Obrazek 157: Dialogové okno filtru Mozaika

Filtr Reliéf:

Vypocitava hrany reliéfniho obrazu, jako by byl obraz osvétlen svételnym zdrojem (obrazek 154
nad). Vybérem filtru Reliéf se otevie dialogové okno Reliéf (obrdzek 155 nad), ve kterém se
vybere poloha Zdroje svétla a vytvori se stiny, které se liSi smérem a velikosti.

Filtr Mozaika

Filtr Mozaika vytvafri skupiny pixejl‘] v jednobarevnych obdélnicich, €imz vznika obraz vypadajici
jako mozaika obrazek 156 nad). Cim vétsi jsou jednotlivé vytvorené obdélniky, tim méné detaill
je v mozaice.

Vybérem tohoto filtru se otevie dialogoveé okno Mozaika (obrazek 157 nad), kde se nastavi pocet
pixelll pro Sitku a Vysku dlazdic. Vybérem moznosti ViylepsSit hrany zvyraznime okraje
jednotlivych dlaZdic, jsou patrnéjsi.

Nahrada barev

Pfikaz Nahrada barev slouZzi k nahrazeni nebo zmeéné barvy ve vloZzeném obrazku za jinou
barvu nebo ke zprdhlednéni barvy. Soucasné Ize nahradit nebo zménit az ¢tyfi barvy. K Gpravam
nelze vybrat ¢asti obrazku, protoZze Nahrada barev funguje pouze na cely obrazek.
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Nahradni barvy Ize vybirat pouze z barev dostupnych na barevnych paletach v LibreOffice.
Vlastni barvy nelze definovat v Nahradé barev, ale miizeme je vytvorit pfed pouzitim nastroje
Néahrada barev. Dalsi informace o vytvareni vlastnich barev nalezneme v kapitole 11, Pokrocilé

techniky kresleni.

ﬁ Poznamka

Nastroj Nahrada barev Ize pouzit pouze u vloZzenych obrazkd. Pokud je nastroj
Nahrada barev pouzit na propojeném obrazku, zobrazi se nasledujici chybova
zprava , Tento obrazek je propojen s dokumentem. Chcete zrusit propojeni obrazku,
abyste jej mohli upravit?,. Kliknutim na tlaCitko Ano zruSime propojeni a vloZzime

grafiku.

Dialogové okno Nahrada barev

Kapatko
Zapne vybér barvy, kdyZ je vybrana.

Nahradit
Nahradi vybrané zdrojové barvy ve vybraném obrazku barvami zadanymi v polich
Nahradit za.

Barvy
Zobrazuje plvodni barvy a barvy pro nahrazeni.

Pavodni barva
Zaskrtnutim tohoto pole nahradime aktualni Pdvodni barvu barvou, kterou uréime v
poli Nahradit za.

Tolerance
Nastavujeme toleranci pro nahrazeni zdrojové barvy ve zdrojovém obrazku. Chceme-li
nahradit barvy, které jsou podobné vybrané barvé, zadame nizkou hodnotu. Chceme-li
nahradit SirSi rozsah barev, zadame vySSi hodnotu.

Nahradit za
Zobrazuje seznam dostupnych barevnych palet a nahradnich barev.

Priihlednost
Nahradi priihledné oblasti ve vybraném obrazku vybranou barvou.

Prirucka aplikace Draw 25.8 | 161



Barvy
Pivodni barva  Tolerance Nahradit za...
10 % : - Purpurova =
10% - | [ | Svétle #luta 1 -
10% - | [_|svétle #lutozelena 1 A
10% | [0 Tmavé #luta 2 A
[ Prihlednost Cerna

Obrazek 158: Dialogové okno Nahrada barev

Nahrada barev

ﬁ Poznamka

Pouzitim Nahrady barev nahradime vSechny vyskyty Pdvodni barva, které jsou ve
vybraném obrazku. Vychozi vybér Prihledné v polich Nahradit za odstrani z obrazku
vybranou barvu a vytvoii v ném prihledné oblasti.

1) Vyberte vloZzeny obrazek.

2) Jdeme do nabidky Nastroje > Nahrada barev, v niz otevieme dialog Nahrada barev
(obrazek 158 nad).

3) Kliknutim na Kapatko v horni ¢asti dialogu aktivujeme rezim vybéru barvy.
4) Pfesuneme kurzor na barvu, ktera ma byt ve vybraném obrazku nahrazena.
5) Klikneme na barvu a pokracujeme. V obrazku Ize vybrat maximalné Ctyfi barvy.

— Nahled vybrané barvy se zobrazi v rAmecku vedle Kapatko pfi kazdém kliknuti na
barvu.

— Kazda vybrana barva se zobrazi v nahledovém poli Pdvodni barva se zaskrtnutim.

6) Do poli Tolerance zadame velikost tolerance poZadované pro nahrazeni kazdé vybrané
barvy. Ve vychozim nastaveni je tolerance 10 %.

7) Do poli Nahradit za pro kazdou vybranou barvu vybereme z rozeviraciho seznamu paletu
barev a z ni poté vybereme poZadovanou barvu. Ve vychozim nastaveni je zadano
Priihledné.

8) Po vybéru az Ctyf barev pro nadhradu klikneme na tla¢itko Nahradit, aby doSlo k nahradé
barev vybraného obrazku. Pfiklady plvodniho obrazku a obrazku po nahrazeni barev
jsou uvedeny na obrazcich 159 pod a 160 pod.

9) V dialogu neni nahled efektu. Pokud nés vysledek neuspokoji, jdeme do nabidky Upravit
> ZrusSit: Obrazek s priihlednosti Nahrada barev a zopakujeme cely postup nahrazeni
barev.
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Obréazek 159: Priklad pred nahrazenim barev ~ Obrazek 160: Priklad po nahrazeni barev

Nahrada prihlednych oblasti
1) V hlavni nabidce zvolime Nastroje > Nahrada barev, ¢imzZ otevieme dialogové okno

Nahrada barev.

2) Vybereme obrazek s prihlednymi oblastmi.

3) V dialogovém okné Nahrada barev vybereme moznost Priihlednost, takze se vedle

polozky Prlihlednost objevi zaskrtavaci pole.

4) V rozeviracim seznamu vedle polozky Prihlednost vybereme paletu barev a poté

vybereme z vybrané palety barvu.

5) Klikneme na tlacitko Nahradit a priihledné oblasti se vypIni vybranou barvou.

6) V dialogu neni nahled efektu. Pokud nas vysledek zklame, jdeme do nabidky Upravit >

Zrusit: Obrazek s prlihlednosti Nahrazeni barev a zopakujeme postup nahrazeni
prdhlednosti.

Prevod

Prevod obrysi

PFred provedenim prevodu obrysu objektu zvazme nasleduijici:

Prevod obrysu prevede vybrany objekt na mnohouhelnik nebo skupinu mnohouhelnikd
se Ctyfmi rohovymi body.

PTi pfevodu obrazku na obrys se prevedeny obrazek nastavi jako grafika na pozadi.
Pokud pfevod vytvari skupinu mnohouhelnikd (napfiklad obrysovy prevod textového
objektu). Pfed vybérem jednotlivého polygonu zadame skupinu polygont, ze které

vybirdme. DalSi informace o praci se skupinami nalezneme v kapitole 5, Kombinovani
vice objektl.

Po prevedeni obrazku na obrys jiz nelze objekt normalné upravovat. Pfevedeny obrazek
je tfeba upravit pomoci Upravy > Body v hlavni nabidce, aby se upravil jeho tvar. DalSi
informace o Gpravach bodl najdeme v kapitole 3, Prace s objekty.

Veskeré Upravy objektu musi byt dokonéeny pred provedenim prevodu obryst, protoze
dalSi upravy prevedeného objektu nejsou mozné.

PTi pfevodu na obrys se nezobrazi potvrzovaci dialog.

Prevod obryst se provadi takto:
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1) Pfed pfevedenim na obrys provedeme vSechny potfebné Upravy objektu.
2) Zkontrolujeme, zda je objekt vybran.
3) Pomaci jedné z nasledujicich metod prevedeme objekt na obrys:

— V hlavni nabidce zvolime Tvar > Pfevést > Na obrys.

— Pravym tlaCitkem mysi klikneme na objekt a z kontextové nabidky vybereme Prevést >
Na obrys.

Pfevod mnohouhelnikt

Konverze mnohouhelnikl slouzi k pfevodu vybraného obrazku na skupinu mnohouhelnikd
vyplnénych barvou. Obrazek je také preveden na vektorovou grafiku a Ize ménit jeho velikost bez
ztraty kvality obrazu nebo zkresleni textu. Po prevodu Ize grafiku rozdélit na skupiny
mnohouhelnik(l a poté na jednotlivé mnohouhelniky. Rozpojeni a déleni umoziiuje upravovat
nebo odstranovat jednotlivé barvy v ramci grafiky.

MozZnosti prevodu a ovladani

Pocet barev
Zadame pocet barev, které se maji zobrazit v prevedeném obrazku. LibreOffice generuje
mnohouhelnik pro kazdy vyskyt barvy v obrazku. Rozsah poc&tu barev je 8 az 32.
Redukce bodi
Odstrani barevné mnohouhelniky, které jsou mensi nez zadana hodnota pixelu. Rozsah
zmenseni bodu je 0 az 32 pixeld.
Zaplnit mezery
Vyplni prazdné oblasti, které mohou vzniknout pfi pouziti redukce bodd.
Velikost dlazdice
Zadame velikost obdélniku pro vypli pozadi. Velikost dlazdic se pohybuje mezi 8 a 128
pixely.
Zdrojovy obrazek
Nahled originalu.
Vektorovy obrazek
Néahled prevedeného obrazku.

Nahled
Vytvori ndhled prevedeného obrazku ve vektorovém formatu bez jakychkoli zmén.

OK
Prevede obrazek na vektorovou grafiku sloZzenou z mnohouhelnikd. Vysledkem je
metasoubor ve formatu SVM (Star View Metafile), ktery pouziva kancelarsky balik
LibreOffice a ktery umoZiiuje pfenos prevedeného obrazku do jinych dokumentd
LibreOffice.
Prevod
1) Vybereme v kresbé obrazek.

2) Obrazek pfevedeme na mnohouhelnik pomoci jedné z nasledujicich metod, otevie se
dialogové okno Prevést na mnohouhelnik (obrazek 161 pod).

— V hlavni nabidce zvolime Tvar > Prevést > Na mnohothelnik.

— Pravym tlaCitkem mysSi klikneme na obrazek a z kontextové nabidky vybereme Pfevést
> Na mnohouhelnik.
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3) Vybereme Pocet barev a Redukce bodt, které se maji pouzit pfi pfevodu.

4) Chceme-li zabranit tomu, aby se v pfevedeném obrézku objevily prazdné oblasti,
vybereme moznost Zaplnit mezery.

Poéet barev: ‘18 = |
Redukce bodd: ‘4 pixeld = |
[ Zaplnit mezery:

Velikost dlazdice: |100 pixeld S

Zdrojovy obrazek: Vektorowy obrazek:

Napovéda Mahled QK Zrusit

Obrazek 161: Dialogové okno Prevést na mnohouhelnik
5) Zadame pocet pixeld, které se maji pouzit pro Velikost dlaZdice.
6) Kliknutim na Nahled zkontrolujeme, jak bude pfevedena grafika vypadat.
7) Provedeme potfebné zmény nastaveni a znovu zkontrolujeme néhled.

8) Pokud prevedeny obrazek spliiuje oCekavané pozadavky, kliknutim na tladitko OK
prevedeme obrazek na mnohouhelnik a zavieme dialogové okno Prevést na
mnohouhelnik.

Rozpojeni

Po pfevodu obrdzku na mnohouhelniky Ize vektorizovany obrazek rozdélit na skupiny
mnohouhelnikd. Kazda skupina mnohouhelnikd je jednobarevna a stava se objektem, ktery Ize
pouzit v jiném vykresu.

1) Prevést obrdzek na mnohouhelniky.

2) Ujistime se, Ze je vybran pfevedeny obrazek, a poté pouZzijeme jednu z nasledujicich
metod pro rozdéleni obrazku na skupiny mnohouhelniku:

— V hlavni nabidce zvolime Tvar > Rozpojit.

— Klikneme pravym tlacitkem mySi na obrazek a z mistni nabidky vybereme mozZnost
Rozpoijit.
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3) Klikneme na barvu v obrazku a pretazenim skupiny mnohothelnik{ vypinénych touto
barvou z obrazku vytvofime novy obrazek.

4) Pripadné stiskneme Odstranit a barvu z obrazku vymazeme.

Rozdélovani

Po prevedeni obrazku na mnohouhelniky a rozdéleni obrazku na skupiny mnohouhelnik( Ize tyto
skupiny rozdélit na jednotlivé mnohouhelniky.

1) Prevést obrdzek na mnohouhelniky.
2) Rozdélime obrazek na skupiny mnohouhelnik.

3) Vybereme obrazek a poté pouzijeme jednu z nasledujicich metod pro rozdéleni skupin
mnohouhelnikl na jednotlivé mnohothelniky:

— V hlavni nabidce zvolime Tvar > Rozpojit.

— Klikneme pravym tlacitkem mySi na obrazek a z mistni nabidky vybereme moZnost
Tvary > Rozpojit.
— Pouzijeme klavesovou zkratku Ctr I+Alt+Shift+K (macOS &+\_+Shift+K).

4) Vybereme jednotlivy mnohouhelnik (nebo nékolik mnohothelnikd) v obrazku a
pretazenim mnohouhelniku z obrazku vytvofime v kresbé novy obrazek.

5) Pripadné stisknutim tlaCitka Odstranit odstranime vybrané mnohouhelniky z obrazku.

Konverze rastri

VSechny objekty kresby, umisténé do vykresu LibreOffice, jsou vektorovou grafikou a tuto
vektorovou grafiku Ize prevést na bitmapu (rastrovou grafiku) ve formatu PNG. Veskeré
prihledné oblasti z plvodni vektorové grafiky se pfi pfevodu ztrati, pfestoze format PNG
pouzivany programem Draw prihlednost podporuje. K pfevodu vektorové grafiky na bitmapu
pouZzijeme jednu z nasledujicich metod. Pfi pfevodu bitmapy neni k dispozici Zadné potvrzovaci
dialogové okno.

« V hlavni nabidce zvolime Tvar > Prevést > Na rastr.

+ Klikneme na grafiku pravym tlaCitkem mysi a z mistni nabidky vybereme moznost
Konvertovat > Na rastr.
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Uvod

LibreOffice Draw nema k dispozici stejné funkce jako jiné programy pro kresleni nebo Upravu
obrazkd, ale dokaze vytvaret a upravovat 3D kresby. Pomoci programu Draw se vytvareji a
upravuji 3D scény a plastické 3D tvary. V zavislosti na zvoleném typu 3D jsou k dispozici
moznosti dalSich Uprav objektl (rotace, osvétleni, perspektiva atd.).

* Plastické 3D tvary se vytvareji a upravuji jednoduseji.

3D scény umoznuji vétsi prizplsobeni.

Typy 3D objektt

3D scény

3D scény se vytvareji z objektd pomoci rozmérl pro soufadnice x, y a z a obsahuji typy objektd,
jako je krychle, koule, plasticky objekt nebo rota¢ni objekt. Tyto typy objektd neexistuji mimo 3D
scénu.

Stavovy fadek zobrazuje Viybréano 3D scéna (Obrazek 162 pod), kdyZ je vybrana a byla
vytvorena z 2D objektu pomoci otaCeni téla nebo konverze. Pfipadné se jedna o hotovy 3D
objekt, ktery byl vioZzen do kresby.

3D scéna je podobna skupiné. Stejné jako do skupiny se i do 3D scény vstupuje za Ucelem Uprav
jednotlivych objektd v rdmci 3D scény a po dokoncéeni Gprav ji opustit. Dalsi informace o
zadavani, Upravach a opousténi skupin nalezneme v kapitole 5, Kombinace vice objekt(.

Pfi vytvareni 3D scény z vybéru nékolika 2D objektd se automaticky vytvori skupina jako jedna
3D scéna. Vstoupime do této 3D scény, abychom mohli ménit, upravovat a otacet jednotlivé
objekty v ramci 3D scény.

ﬁ Poznamky

Pokud byla 3D scéna vytvorena z vybranych 2D objekt(, nelze jednotlivé objekty
seskupit.

PFepnout plasti€énost se pouzije pouze tehdy, kdyz je v kresbé vybran 2D tvar nebo
3D objekt, ktery byl vytlacen z 2D tvaru, nebo objekt z Galerie pisem. Pfepnout
plasti€énost nelze pouZzit pro text, Cary, Sipky, kfivky a mnohouhelniky.

‘ Snimek 4 z 25 (RozvrZzeni) Vybrano 3D scéna Vyichozi 9340/ 260 =230 % 2,30

Obrazek 162: Stavovy rfadek — informace s vybranou 3D scénou

‘ Snimek 4 z 25 (Rozvrieni) Vybrano Tvar Vychozi = 1,90 / 8,60 = 2,10 x 1,80

Obrazek 163: Stavovy fadek — informace s vybranym 3D tvarem

3D tvary

2D tvary jsou ploché a maji pouze rozméry na Sitku a vysku, ale 3D tvary jsou pevné objekty,
které maji hloubku, Sitku a vySku. 3D tvar se vytvori, kdyZ se 2D tvar nebo objekt z Galerie
pisem pfevede na 3D pomoci funkce Pfepnout plastiénost. Pri vybéru tohoto typu 3D objektu

Dokumentace pro LibreOffice je dostupna na https://cs.libreoffice.org/get-help/documentation/



se ve Stavovém fadku zobrazi Vybrano Tvar (obrazek 163 nad). 3D tvary Ize prohlizet a
upravovat v rezimu 3D nebo 2D. Pokud chceme provadét Upravy v rezimu 2D, vypneme
plasti€nost, provedeme Upravy a poté se pfepneme zpét do rezimu 3D pomoci funkce Pfepnout
plasti¢nost.

Vytvareni prostorovych (3D) objektl

ﬁ Poznamky

Pred vytvorenim 3D objektd v kresbé se doporucuije pridat 3D nastroje na
nastrojovou liStu Kresba (Na 3D objekt; Na 3D rotacni objekt; Pfepnout
plasti¢énost) pomoci volby Viditelna tla¢itka nebo dialogového okna PfizpUsobit.
Dalsi informace o pouzivani Viditelna tlaéitka a dialogového okna PrizpUsobit
najdeme v Dodatku B, Nastrojove liSty a v pfirucce Za¢iname s LibreOffice.

Po instalaci 3D nastrojli na nastrojovou listu Kresba jsou tyto nastroje k dispozici
pouze tehdy, kdyZ je v kreshé vybran 2D objekt.

Hotové 3D objekty Ize pfemistovat, ménit jejich velikost a upravovat je stejné jako 2D
objekty. DalSi informace nalezneme v kapitole 3, Prace s objekty.

Pfipravené 3D objekty

Hotové 3D objekty jsou 3D scény vioZené do kresby jednou z nasledujicich moznosti. Vybér a
kresleni 3D objektl je u vdech metod vkladani hotového 3D objektu stejné.

* Klepneme na trojuhelnik ¥ vpravo od ikony 3D objekty na nastrojové listé Kresba
(obrazek 164 pod) a vybereme 3D objekt z dil¢i nastrojové liSty, ktera se otevre.

* V hlavni nabidce zvolime Zobrazit > Nastrojové liSty > 3D objekty a tim otevieme
nastrojovou listu 3D objekty (obrazek 165 pod). Tato nastrojova liSta ma k dispozici stejné
mozZnosti jako dil€i nastrojova liSta 3D objekty na nastrojové listé Kresba.

* Pfejdeme na Tvary > Vlozit > 3D objekty v hlavni nabidce a v podnabidce vybereme 3D
objekt.

* Na panelu 3D objekty na karté Tvary v postranni listé (obrdzek 166 pod) a vybereme 3D
objekt.

Kresba v W
3 LB N OO —=+¥~1L~
Tk;j?;l - = - - * 5 7w -
& od v 0 v vy

Obrazek 164: Nastrojova lista Kresba

=

3D objekty v X
PORL&IHLOCO®

Obrazek 165: Nastrojova lista 3D objekty
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Obrézek 166: Karta Tvary na postranni liSté

Pfevod 2D objekt
Nastroje pro pfevod 2D objektu na 3D objekt jsou k dispozici nasledujici:
* Na néstrojoveé listé Kresba.
* Na néstrojové listé Transformace.
» Klepnuti pravym tlaCitkem my3i na objekt a vybér z mistni nabidky.

* V hlavni nabidce zvolime Tvar a z mistni nabidky vybereme Transformace nebo
Prevést.

» Pouziti dialogového okna 3D efekty.
Pokud chceme prevést 2D objekt na 3D objekt, pouzijeme jeden z nasledujicich nastroju.

Na 3D objekt
Vytvofi 3D scénu obsahujici plasticky objekt (obrazek 167 pod).

Na 3D rotaéni objekt
Vytvofi 3D scénu s pouzitim vychozi osy ota€eni. Polohu vychozi osy nelze upravit
(obrazek 168 pod).

V 3D rota€¢nim objektu

Vytvofi 3D scénu pomoci osy otaceni. Polohu osy otaceni Ize upravit tak, aby bylo mozné
vytvorit rizné 3D objekty (obrazek 169 pod).
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Obrazek 167: Priklad pouZiti prevodu do 3D

Obréazek 168: Priklad pouZiti pfevodu na 3D rotaCni objekt

TS
Obrazek 169: Priklad pouZiti prevodu na 3D rotacni objekt

Obrazek 170: Priklad pouZiti Pfepnout plasti¢nost
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PFepnout plasti€nost

Vytvori 3D tvar vytlacenim 2D objektu do 3D. Pouze 3D tvary, které byly vytlaceny, Ize
pfevést zpét na 2D objekt (obrdzek 170 nad).

Pfevést na rotac¢ni objekt
K dispozici v dialogovém okné 3D efekty. Pfevede vybrany 2D objekt na 3D objekt s
rotaci. Vybér nékolika neseskupenych 2D objektl Ize také prevést na jeden 3D rotacni
objekt. DalSi informace nalezneme v ¢asti 3D efekty” na strance 175.

Plasticnost

Plasti¢nost pfevede 2D objekt na 3D scénu tak, Ze 2D objekt vytlaci smérem k pozorovateli.
Scéna je otoena o 20 stupill kolem vodorovné osy, aby byl 3D efekt Iépe viditelny. Po vybéru
2D objektu jej pfevedeme na 3D scénu pomoci jedné z nasledujicich metod:

» Klepneme pravym tlac¢itkem mysi na 2D objekt a z mistni nabidky vybereme moznost
Prevést > Na 3D objekt.

* Na nastrojoveé listé Kresba klepneme na Na 3D objekt.
* V hlavni nabidce zvolime Tvar > Pfevést > Na 3D objekt.

 V dialogovém okné 3D efekty klepneme na Prevést na 3D. Dalsi informace nalezneme v
¢asti ,3D efekty” na strance 175.

Otoceni

Na 3D rotacni objekt nebo Prevést na rota¢ni objekt prevede 2D objekt na 3D scénu otocenim
objektu za pouZiti levého okraje ohranicujiciho rdmecku kolem objektu jako osy otaceni. Priklady
3D prevodu pomoci nékterého z téchto rota¢nich nastrojli jsou uvedeny na obrazku 168.

Skutecné vytvofena 3D scéna zavisi na Uhlu a tvaru otaCeného objektu. Po vybéru 2D objektu v
kresbé jej pfevedeme na 3D scénu pomoci rotace jednou z nasledujicich moznosti:

» Klepneme pravym tlaCitkem mysi na 2D objekt a v mistni nabidce vybereme mozZnost
Prevést > Na 3D rotacni objekt.

» Klepneme na Na 3D rotacni objekt na nastrojové listé Kresba. Ve vychozim nastaveni
neni ikona Na 3D rotacni objekt na nastrojové listé Kresba nainstalovana, ale je k
dispozici pro instalaci v ¢asti Viditelna tlac¢itka pro nastrojovou liStu Kresba.

* V hlavni nabidce zvolime Tvar > Pfevést > Na 3D rotac¢ni objekt.

+ V dialogovém okné 3D efekty klepneme na Pfevést na rota€ni objekt. DalSi informace
nalezneme v ¢asti ,3D efekty” na strance 175.

* V hlavni nabidce zvolime Tvar > Prevést > V 3D rotacnim objektu.

Prepinani plasti¢nosti

Plasti¢nost je proces, pfi kterém se paralelni plochy posouvaji a vytvareji 3D tvar. V aplikaci
Draw se 2D plocha posune dopfedu mimo aroven kresby. Soucasné je objekt mirné naklonén a
je zapnuta centrélni projekce, coZ vytvari dojem 3D tvaru. Draw pouZziva vychozi hodnotu pro
tuto plasti€nost (hloubku téla) na zakladé velikosti 2D objektu. Hodnotu Ize zménit po vytvoreni
plasticity, viz ,Uprava 3D objektd“ na strané 173.

PFepocet plastiCnosti se provadi pomoci Pfepnout plasti€nost. Plasticnost je moZné pouzit
pouze na Zakladni tvary, Tvary symboli, Blokové Sipky, Vyvojovy diagram, Bubliny,
Hvézdy a cedule a Pismomalba. Ty jsou soucasti vychozi sady nastroji na nastrojové listé
Kresba nebo na karté Tvary v postranni listé.

6) Vybereme v kresbé 2D objekt vytvofeny ze Zakladnich tvard, TvarG symbolQ,
Blokovych Sipek, Vyvojovych diagramti, Bublin, Hvézd a ceduli nebo Pismomalby.
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7) Kliknutim na Pfepnout plasti€nost na nastrojové listé Kresba prfevedeme 2D objekt na
3D tvar.

8) Chceme-li provést 3D prevod zpét na 2D objekt, vybereme 3D objekt a klikneme na
PFepnout plasti€nost na nastrojové listé Kresba.

ﬁ Poznamka

Plasti¢nost nelze pouzit na textové objekty vytvofené pomoci Vlozit textové pole
nebo Vlozit svisly text.

Uprava 3D objektti

ﬁ Poznamka

Pokud jsou 3D scény vytvofeny z vice nez jednoho 2D objektu, automaticky se
vytvori skupina 3D scén. Tuto skupinu 3D scén nelze rozdélit do skupin a veskeré
provedené Upravy se tykaji vdech 3D objektll ve skupin&. Chceme-li upravit jednotlivy
3D objekt v rdmci této skupiny 3D scén, vstoupime do skupiny. DalSi informace o
praci se skupinami nalezneme v kapitole 5, Kombinovani vice objektd.

Umisténi, velikost a otoceni

Uprava polohy, velikosti a natoceni 3D objektl je podobna jako u 2D objektdl. Dalsi informace
nalezneme v kapitole 3, Prace s objekty.

3D nastaveni

V hlavni nabidce zvolime Zobrazit > Nastrojové liSty > 3D nastaveni a otevieme nastrojovou
liStu 3D moznosti (obrazek 171 pod). Nastrojova lista 3D nastaveni se aktivuje, kdyZ je vybran
3D tvar vytvoreny z 2D objektu pomoci ,Pfepinani plasti¢nosti“ na strané 172.

Veskeré zmény provedené pomoci nastroji pro Upravy na nastrojové listé 3D nastaveni se
okamzité aplikuji na vybrany 3D tvar a zobrazi 3D efekt. Obradzek 172 pod ukazuje pfiklad
naklonéni doleva, zvétSeni hloubky protlaceni a zmény 3D barvy pomoci nastrojové listy 3D
nastaveni.

30 nastaveni o
:Fl. w (—I-_I 1_) Eﬂ - ﬁa ¥ e Y ii TI‘@I v

Obrazek 171: Nastrojova lista 3D nastaveni
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Obrazek 172: Priklad zmény 3D nastaveni

K Gpravam 3D tvard jsou k dispozici nasledujici nastroje.

Naklonit dolt
Nakloni objekt smérem dol( (otoeni vodorovné osy) o 5 stupnid pfi kazdém pouZiti
nastroje.

Naklonit nahoru
Nakloni objekt smérem nahoru (oto¢eni vodorovné osy) o 5 stupiili pfi kazdém pouziti
nastroje.

Naklonit doleva
Nakloni objekt doleva (otoceni svislé osy) o 5 stupiill pfi kazdém pouZiti nastroje.

Naklonit doprava
Nakloni vybrany objekt doprava (otogeni svislé osy) o 5 stupiill pfi kazdém pouziti
nastroje.

Hloubka
Otevie vyskakovaci nabidku, ve které Ize nastavit hloubku vytlacovani z objektu pevnou
nebo vlastni hodnotou.

Smér
Otevie mistni nabidku, ve které Ize nastavit smér pohledu pro vytvorfeni plasti¢nosti v
perspektivni nebo rovnobézné projekci.

Osvétleni
Otevrie vyskakovaci nabidku, ve které Ize pfi vytvareni plastiCnosti nastavit smér a
intenzitu osvétleni.

Povrch
Otevre vyskakovaci nabidku, ve které Ize nastavit zobrazeni povrchu objektu jako
Dratovy model, Matny, Plasticky nebo Kovovy.

Barva 3D

Otevre vyskakovaci nabidku, ve které Ize nastavit barvu pouzitou pro vytlaCovani. Tato
barva nemusi byt stejna jako barva pouzita pro plvodni 2D objekt.
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3D efekty

Dialogové okno 3D efekty nabizi moZnosti Uprav hotovych 3D objektl nebo 3D scén. Toto
dialogové okno slouzi také k pfevodu 2D objektu na 3D pomoci nastrojd v levém dolnim rohu
dialogového okna. Dialogové okno 3D efekty otevieme jednim z nasledujicich zplsob(:

+ Klepneme na 3D efekty nastrojové listé Standardni nebo Céary a vypIn&, pokud byl tento
panel pfidan do nastrojove listy.

* V hlavni nabidce zvolime Format > 3D efekty.

Veskeré 3D efekty pouzité na 3D scénu se provedou az po vybéru moznosti PFidat v pravém
hornim rohu dialogového okna 3D efekty. To umoZiiuje provést vSsechny zmény 3D efektll pred
jejich pouzitim na 3D scéné.

ﬁ Poznamky

Dialogové okno 3D efekty nelze pouzit pro 3D tvary vytvofené pomoci Pfepnout
plastiénost, protoZe nebude dosaZeno spravnych vysledkl formatovani. Pokud je
dialogové okno 3D efekty pouZzito chybné, odstranime nespravné formatovani tak, ze
prejdeme do Format > Vychozi formatovani v hlavni nabidce.

Pro vybrany objekt nelze pouzit zadné moznosti, které jsou na strankach v
dialogovém okné 3D efekty Sedé.

3D prevod

V levém dolnim rohu dialogového okna 3D efekty (obrazek 173 pod) se nachazeji nastroje pro
prevod 2D objektu na 3D scénu a zménu projekce pouzité ve 3D scéné.
Pievést na 3D
Pfrevede vybrany objekt na 3D scénu. Tento nastroj funguje stejné jako nastroj
,Plasticnost* na strané 172.
Pfevést na rotacni objekt
Pfevede 2D objekt na 3D scénu pomoci rotace télesa. Tento nastroj funguje stejné jako
nastroj ,OtoCeni“ na strané 172.
Zapnutilvypnuti perspektivy

Zapne nebo vypne perspektivni projekci pro 3D scénu. Perspektivni projekce je technika
pro vytvoreni linearni iluze hloubky. Jak se objekty vzdaluji od divaka, zmensuje se
perspektivni kresba konstantnim pomérem.

ﬁ Poznamka

Dialogové okno 3D efekty ma pét stranek, které poskytuji moznosti pro Geometrii,
Stinovani, Osvétleni, Textury a Material. Nastroje pro zménu stranek pro rlizné
typy 3D efektd se nachazeji v horni ¢asti dialogového okna 3D efekty.
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3D efekty ﬂ

ot me @~

Geometrie
Zacblené hrany 10% =
Skalovana hloubka 100 % S
Uhel otoeni 360,07 =
Hloubka 1,00 cm =
Casti
Vodorovné 24 =
Svislé 24 =
MNormaly
F N
5 g
% &

Obrazek 173: Dialogové okno 3D efekty — stranka
Geometrie

(1) (2) (3)

Obrazek 174: Priklad zaoblenych hran

(1) Pavodni objekt (2) 10% zaoblené (3) 75 % zaoblené
hrany hrany
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Obrazek 175: Pfiklad Skalovani hloubky

(1) PAvodni objekt (3) 100% Skélované hloubka
(2) 50% Skalované hloubky (4) 150% Skalované hloubky

3D efekty — Geometrie

Klepnutim na ikonu Geometrie v dialogovém okné 3D efekty (obrazek 173 nad) otevie moZnosti
dostupné na strance Geometrie a upravime geometrii 3D objektu.
Geometrie
Definuje vlastnosti objektu ve 3D scéné.

Zaoblené hrany

Zadame mnoZstvi potfebné k zaobleni rohtl 3D tvaru, jak ukazuje pfiklad na obrazku
174 nad. Vychozi nastaveni pro Zaoblené hrany je 10 %.

Skélovana hloubka
Zadame hodnotu pozadovanou ke zvétSeni nebo zmen3eni Celni plochy vybraného 3D
objektu. Obrazek 175 nad ukazuje priklad, kde byla Skalovana hloubka nejprve
snizena na 50%a nasledné zvySena na 150%. Vychozi nastaveni pro Skalovanou
hloubkou je 100 %.

Uhel natoceni
Zadame Uhel ve stupnich pro otoCeni 2D objektu, ktery byl pfeveden do 3D pomoci
funkce Na 3D rotacni objekt. Obrazek 176 pod ukazuje priklad 2D kruznice, u které je
Uhel rotace zménény na 180 stupnd.

Hloubka

Zadame hloubku plasti¢nosti pro vybrany 2D objekt po jeho pfevedeni do 3D.
Obrazek 177 pod ukazuje pfiklad originalniho objektu pfevedeného na 3D pomoci
nastroje Na 3D objekt a nasledné zvySeni Hloubky na 3cm.

(1) (2) (3)

Obrazek 176: Priklad uhlu oto¢eni

(1) Plvodni objekt (3) Uhel nato&eni zménén na 180 stupiili
(2) Prevedeno pomoci nastroje Na 3D
rotacni objekt
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(1) (2) (3)
Obréazek 177: Pfiklad zvétSujici se hloubky

(1) Plvodni objekt (3) Hloubka se zvySila na 3 cm
(2) Pfevedeno pomoci nastroje
Na 3D objekt

) 2)

Obréazek 178: Priklad pouZiti segment(
(1) 12 segmentd (2) 24 segmentdi

Segmenty
Zméni pocet segmentd, které LibreOffice Draw pouZiva ke kresleni 3D objektu. Cim vy33i
je pocet segment, tim hladsi je povrch objektu. Vysoky pocet segmentli vsak mize
prodlouZzit dobu potfebnou k vygenerovani 3D objektu na displeji. Obrazek 178 nad
ukazuije rozdil na 3D kouli pfi zvétSeni segmentll z 12 na 24 vodorovné a svisle.
Vodorovné
Zadame pocet vodorovnych segmentd pouzitych ve vybraném 3D objektu.
Svislé
Zadame pocet svislych segment( pouzitych ve vybraném 3D objektu.

(1) 3)

Obréazek 179: Priklady specifickych, plosnych a sférickych efekt( objekti
(1) Specifické pro objekty (2) Ploché (3) Sférické
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(1) (2) (3) (4)

Obrazek 180: Priklady prevracenych normal a oboustranného osvétleni

(1) Pfevracené normaly vypnuty, Oboustranné (3) Pfevracené normaly vypnuty, oboustranné
osvétleni vypnuto osvétleni zapnuto
(2) Prevracené normaly zapnuty, Oboustranné (4) Prevracené normaly zapnuty, Oboustranné
osvétleni vypnuto osvétleni zapnuto
Normaly
Upravi styl vykreslovani 3D povrchu.
Specifické pro objekt
Vykresli 3D povrch podle tvaru objektu (obrdzek 179 nad).
Ploché
Viykresli 3D povrch jako polygony (obrazek 179 nad).
Sférické

Vykresli hladky 3D povrch bez ohledu na tvar objektu (obrazek 179 nad).
Prevrétit normaly

Pfevracena normala je normala, kterd smeéfuje Spatnym smérem (obrazek 180 nad). To
pocitai fika, Ze vnéjsi strana je ve skutecnosti vnitfni strana, i kdyZ tomu tak neni.
Pokud se jedna o dutinovou konstrukci, Ize uvést obracenou normalu, protoze obé
plochy sméfujici dovnitf a ven jsou ve stejném modelu.

Oboustranné osvétleni
Osvétluje vnéjsi a vnitfni stranu objektu (obrazek 180 nad). To ma vliv pouze v pfipadé,
Ze je vnitfek vlbec vykreslen, viz Oboustranny. Jedna se o nastaveni pro celou 3D
scénu, nikoli pro jednotlivy objekt ve scéné.

Oboustranny
3D objekt méa vnéjsi (pfedni) a vnitini (zadni) stranu (obrazek 180 nad). Pfi vypnuté
funkci Oboustranny se vykresli pouze vnéjsi strana objektu. Pfi pohledu zvenci se
jedna o pevny objekt, ale pfi pohledu zevnitf je ¢elni strana prihledna. Pokud neni
vidét na vnitfni stranu, normalni pro plasticky 3D objekt s pevnou texturou, méla by byt
moznost Oboustranny vypnuta, aby se zlepsil vykon pfi vykreslovani. Jakykoliv 3D

objekt vytvofeny pomoci rotace ¢asto umoznuje vnitfni pohled a doporucuje se zapnout
moznost Oboustranny.

3D efekty — stinovani

Na strance Stinovani dialogového okna 3D efekty (obrazek 181 pod) jsou k dispozici moznosti
nastaveni stinovani, stinu a efektdl kamery na vybraném 3D objektu.

Stinovani
Urcuje rezim stinovani aplikovany na 3D objekt (obrazek 182 pod).
Gouraudovo

Rezim stinovani Gouraudovo se pouziva k simulaci rozdilnych G¢ink( svétla a barvy na
povrchu objektu. Dosahuje plynulého osvétleni na plochach s nizkym poétem
mnohouhelnikl bez velkych vypocetnich narokl na vypocet osvétleni pro kazdy pixel.
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3D efekty ﬂ
Js] ¢ M| e v

Stinovani

Redim |C-|::-uraudovo V|

Stin

] Sklon povrchu  0O°

Kamera
Vzdalenost 0.10cm =
Ohniskova vzdalenost 10,00 cm =

% | & (7]

Obrazek 181: Dialogové okno 3D efekty — stranka
Stinovani

(1) (2) (3)

Obrazek 182: Priklady reZimu stinovani
(1) Gouraudovo (2) Phongovo (3) Ploché
Phongovo

ReZim stinovani Phongovo je interpolani technika pro stinovani povrchu, ktera pocitéa
normalu bodu v mnohouhelniku interpolaci normal vrcholl. Uhel mezi normalou a

s w7

smérem osvétleni uruje, jak velka Cast osvétleni se pouZije k obarveni pixelu.
Ploché
Rezim stinovani Plochy se tyka vnimani hloubky v 3D modelech nebo ilustracich

pomoci zmény Urovné tmavosti. Pfifazuje jednu barvu stinovani jednomu segmentu na
povrchu objektu.
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Stin
PFida nebo odstrani stin z vybraného 3D objektu (obrazek 183 pod). Stin se vytvari
pouze z prvniho zdroje svétla. Zadame Sklon povrchu od zdroje svétla k povrchu v
rozmezi 0 az 90 stupnill pro vrzeni stinu.

Kamera

Nastavi moznosti kamery pro vybranou 3D scénu, jako kdyby byla kamera pouzita k
pofizeni zabéru (obrazek 184 pod). Nastaveni ovliviiuje pouze centralni perspektivu,
nikoli rovnobé&znou projekci.

(1)

Obréazek 183: Priklady thlu povrchu stinu

(2)

(1) O stupid stinu (2) 50 stupiil stinu

(1)

Obrazek 184: Priklad pouZiti GhlG kamery

(2)

(1) Vychozi nastaveni — (2) Vzdalenost 10 cm; ohniskova
vzdalenost 2,6 cm; ohniskova vzdalenost 100 cm
vzdalenost 10 cm

Vzdéalenost

Zadame vzdalenost, kterou chceme ponechat mezi kamerou a stfedem vybrané 3D
scény. Vychozi nastaveni vzdalenosti je 2,6 cm.

Ohniskova vzdalenost
Zadame ohniskovou vzdalenost objektivu kamery. Mala hodnota odpovida objektivu
typu rybi oko a velka hodnota teleobjektivu. Vychozi nastaveni ohniskové vzdalenosti
je 10 cm.
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3D efekty — osvétleni

Na strance Osvétleni v dialogovém okné 3D efekty (obrazek 185 pod) jsou k dispozici moznosti
osvétleni 3D scény. Nastaveni osvétleni se aplikuje na vSechny 3D objekty ve scéné. Pro 3D
scénu se zadava smér, barva a okolni svétlo zdroje svétla. Ve vychozim nastaveni je pfi otevieni
stranky Osvétleni jiz vybran jeden zdroj svétla. Lze pouzit maximalné osm zdrojli a kazdy zdroj
svétla mlze mit jinou barvu.

Umisténi a barva svételného zdroje jsou zobrazeny v pravém dolnim rohu stranky Osvétleni.
Svisly posuvnik nastavuje Uhel osvétleni a vodorovny posuvnik otaci svétlo kolem objektu.
Pfipadné klepneme na svételny bod a pretahneme zdroj svétla na pozadované misto.

Chceme-li zménit nahled z koule na krychli, klepneme na maly ¢tvere€ek napravo od
vodorovného posuvniku a pod svislym posuvnikem. Kazdy vybrany zdroj svétla se zobrazi jako
mala barevna koule v zadané barvé. VétSi barevna koule oznacuje aktivni zdroj svétla.

slo/Emliel (@]~

Osvétleni
Zdroj svétla 0 0 0
R e e 9@
[ R:204 G:204 B:204 - &
Ambientni osvétleni [l Tmavé teds 1 vy @

Obrazek 185: Dialogové okno 3D efekty — stranka
Osvétleni

Vybér zdroje svétla a nastaveni efektl osvétleni je nasledujici:
2) Opétovnym kliknutim na vybrany zdroj svétla upravime barvu zdroje svétla.

3) Vybereme barvu svétla z jedné z barevnych palet v rozeviracim seznamu Zdroj svétla.
Pro kaZzdy zvoleny zdroj svétla Ize pouZzit jinou barvu.
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4) Vybérem barvy z jedné z barevnych palet v rozeviracim seznamu Okolni svétlo
nastavime barvu okolniho svétla.

5) Chceme-li zrusit vybér zdroje svétla, vybereme jiz vybrany zdroj svétla a znovu na ngj
klepneme.

3D efekty — textury

Na strance Textury v dialogovém okné 3D efekty (obrazek 186 pod) je mozné nastavit vlastnosti
textury povrchu pro vybrany 3D objekt. Nastaveni na strance Textury jsou dostupné pouze po
nastaveni vypiné plochy 3D objektu Prechod, Obrazek, VVzorek nebo Srafovani. Dalsi informace
0 zméné vyplné oblasti nalezneme v kapitole 4, Zména atribut(l objektu.

Typ
Nastavi barevné vlastnosti textury.
Cernobila
Prevede texturu na ¢ernobilou.
Barva
Pfevede texturu na barvu.
3D efekty n
HIEE & v
Textury
Ty
Redir
Projekce
Projekce
[trovani
Obrazek 186: Dialogové okno 3D efekty — stranka
Textury
Rezim

Zobrazi nebo skryje stinovani.

Pouze textura
Aplikuje texturu bez stinovani.
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Textura a stinovani
Aplikuje texturu se stinovanim pro zesvétleni nebo ztmaveni osvétleni.
Projekce X
Nastavuje moznosti zobrazeni textury podél osy X. Lze vybrat pouze jednu z
nasledujicich tfi moznosti.
Specifické pro objekt
Automaticky upravi texturu tak, aby co nejlépe odpovidala tvaru a velikosti objektu.
Toto je vychozi nastaveni s vyjimkou plastickych objektd.
Rovnobézné

Aplikuje texturu rovnobézné s vodorovnou osou a zrcadli se na zadni strané objektu.
Jedné se o vychozi nastaveni pro plastické objekty.

Kruhova
Obtaci vodorovnou osu vzoru textury kolem objektu.
Projekce Y
Nastavuje moznosti zobrazeni textury podél osy Y. Lze vybrat pouze jednu z
nésledujicich tfi moznosti.
Specifické pro objekt
Automaticky upravi texturu tak, aby co nejlépe odpovidala tvaru a velikosti objektu.
Toto je vychozi nastaveni s vyjimkou plastickych objektd.
Rovnobézné

Aplikuje texturu rovnobézné se svislou osou a zrcadli se na zadni strané objektu.
Jednd se o vychozi nastaveni pro plastické objekty.

Kruhova

Obtaci svislou osu vzoru textury kolem objektu.
Filtrovani

Odfiltruje Sum, ktery mize vzniknout pfi aplikaci textury na 3D objekt.
Zapnuti/vypnuti filtrovani

Aplikuje filtr jemného zaostreni, ktery mirné rozostfi texturu a odstrani nezadouci
skvrny.

3D efekty — Material

Nastaveni na strance Material dialogového okna 3D efekty (obrazek 187 pod) zménime vzhled
3D objektu tak, aby reprezentoval rlizné materialy. Materialy a Textury Ize vzajemné
kombinovat, aby bylo dosaZzeno poZzadovaného vysledku.

Material

Pfifadi barvu z palety barev. DalSi informace o vytvareni vlastnich barev nalezneme v
kapitole 11, Pokrocilé techniky kresleni.

Oblibené

V rozeviracim seznamu Oblibené vybereme typ materialu pro vybrany objekt.
Barva objektu

V rozeviracim seznamu Barva objektu vybereme barvu z jedné z barevnych palet,
kterou chceme na objekt pouZit.
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3D efekty

T || O C
Material
Chlibené |Definn:-vané uZivatelem L |
Barva objektu |:| Svétlemodra 2 ™ %,
Barva osvétleni - Cerna x> %;'
Odraz
Barva |:| Bila e %;
Intenzita 15% =

Obréazek 187: Dialogové okno 3D efekty — stranka
Materialy
Barva osvétleni

Vybereme barvu z jedné z barevnych palet v rozeviracim seznamu Barva osvétleni.
Tim se objekt osvétli a ¢asti objektu, které jsou ve stinu, se rozjasni, takZze se objekt
zda byt vice osvétleny.

Odraz
Nastavi vlastnosti odrazu svétla pro vybrany objekt simulujici odrazivost povrchu. Poloha
osvétleného bodu je ur€ena nastavenim prvniho svételného zdroje.
Barva

V rozeviracim seznamu Barva vybereme barvu, ktera se ma od objektu odrazit, z jedné
Z barevnych palet.

Intenzita
Zadame intenzitu zrcadlového efektu v procentech.
Dialogové okno Barvy

Otevre dialogové okno Vybrat barvu, ve kterém se definuji vlastni barvy pomoci 2D
grafiky a Ciselného grafu gradientu. VSechny vytvorené barvy jsou uloZzeny ve vlastni
paleté. DalSi informace o vytvareni vlastnich barev najdeme v kapitole 11, Pokrocilé
techniky kresleni.
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ﬁ Poznamka

Kovové a sklenéné povrchy nelze dobre simulovat, protoZe vzhled téchto materiall je
vytvaren pomoci odrazu.

. Tip

Nepouzivejte pro jednotlivé barvy pfili§ vysokou hodnotu jasu. Barvy se skladaji a
snadno se miZe stat, Ze barevna plocha bude bila.

Skladani objektt

Vice 3D objektli nelze kombinovat pomoci Tvar > SloZit v hlavni nabidce nebo pomoci
klavesové zkratky Ctrl + Shift + K (macOS & + Shift + K). Nejprve je tfeba vytvofit vice
2D objekt( a poté jeden 3D objekt (vice informaci o skladani objekt(i nalezneme v kapitole 5,
Skladani vice objektd):

1) Vytvorime vice 2D objektll a provedeme vSechny potifebné Upravy.
2) Ujistime se, Ze jsou vybrany vSechny 2D objekty, abychom vytvofili jeden 3D objekt.

3) Vytvorime jeden 3D objekt kombinaci vybranych 2D objektli pomoci jedné z nasledujicich
moznosti (pfiklady vytvofeni 3D objektd jsou uvedeny na obrazku 188 pod):

— Klepneme na Na 3D objekt nebo Na 3D rotaéni objekt na nastrojové listé Kresba.

— Klepneme pravym tlacitkem mySi na vybrané vicenasobné 2D objekty a z mistni
nabidky vybereme moznost Pfevést > Na 3D objekt nebo Na 3D rotacni objekt.

— V hlavni nabidce zvolime Tvar > Pievést > Na 3D objekt nebo Na 3D rotac¢ni objekt.

Skladani 3D objektl

3D objekty, z nichZ kazdy tvori samostatnou 3D scénu, Ize kombinovat nebo skladat do jedné 3D
scény. Priklad postupu sestavovani 3D objektl je nasledujici a je zndzornén na obrazku 189
pod:

(1) (2) (3)
Obréazek 188: Priklad vytvoreni 3D objektu z vice 2D objektt
(1) Kombinace vice 2D objekt( (3) 3D objekt vytvoreny pomoci nastroje
(2) 3D objekt vytvofeny pomoci nastroje Na 3D rota¢ni objekt

Na 3D objekt
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Obréazek 189: Priklad sestaveni 3D objekti

1) Vybereme 3D objekt (napfiklad krychli) z 3D objekty na nastrojoveé listé Kresba nebo na
karté Tvary v postranni li5té a umistime jej do kresby.

2) Vybereme druhy 3D objekt (napfiklad kouli) z 3D objekty na nastrojové listé Kresba nebo
na karté Tvary v postranni listé a umistime jej do kresby.

3) V pripadé potfeby nastavime vyplni oblasti na Nic a ¢ary na Souvislé, abychom vytvorili
objekty draténého ramecku. To usnadiiuje umisténi obou objektll do sestavené 3D scény.

4) Vybereme druhy 3D objekt (kouli) a pfejdeme na Upravit > Vyjmout v hlavni nabidce
nebo klepneme na objekt pravym tlaCitkem mysi a z mistni nabidky vybereme Vyjmout.

5) Dvakrat klepneme na prvni 3D objekt (krychli), abychom vstoupili do skupiny nebo
pfejdeme na Tvar > Skupina > Upravit skupinu v hlavni nabidce.

6) Pfejdeme na Upravit > Vlozit v hlavni nabidce nebo klepneme pravym tlacitkem mysSi na
prvni 3D objekt a z mistni nabidky vybereme VloZit. Koule se objevi uvnitf krychle a je
soucasti skupiny.

7) V pripadé potfeby upravime jednotlivé objekty nebo zménime jejich pozici ve skupiné.
8) Upravu skupiny ukon&ime dvojklikem mimo sestavenou 3D scénu nebo v hlavni nabidce
zvolime Tvar > Skupina > Opustit skupinu.

ﬁ Poznamka

Po provedeni VloZit se druhy objekt objevi na svém plvodnim misté. Tento objekt
NENI soucasti sestavené 3D scény a v pfipadé potfeby jej Ize odstranit.
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Spojnice a zachytné body

Spojnice jsou €ary nebo Sipky, jejichz konce se automaticky pripoji ke spojnici nebo zachytnému
bodu na okraji objektu. Spojovaci ¢ary mezi objekty zlstanou s objekty spojeny, i kdyZ jsou
objekty pfesunuty nebo pfeskupeny. Pokud je objekt s pfipojenou spojnici pfesunut nebo je
zménéna jeho velikost, pfizplsobi spojnice automaticky svdj tvar t¢tmto zménam. Naptiklad pfi
vytvareni vyvojového diagramu nebo organiza¢niho diagramu pomoci spojnic namisto
jednoduchych €ar odpada nutnost pfekreslovat Cary mezi objekty pfi provadéni zmén

v diagramu.

PTi vytvareni nebo vybéru spojnice se Uchyty pro vybér lisi od béznych tchytd pro vybér, které se
pouzivaji u ¢ar nebo objektll. Koncové body spojnice jsou kulaté v pocate¢nim a koncovém bodé
spojnice a Ctvercove ve stfedu Car, které tvori spojnici, jak ukazuje priklad pfimé spojnice na
obrazku 190 pod. Ctvercové chyty pro vybér na vybrané spojnici slouzi ke zméné smérovani
spojnice.

Spojnice

Draw obsahuje vybér spojnic pro pouziti ve vyvojovém diagramu nebo organizaénim schématu.
K vychozi sadé& spojnic se pfistupuje jednim z nasledujicich zptsobu:

» Klepnutim na trojuhelnik v vpravo od Spojnice na nastrojoveé listé Kresba otevieme
vyskakovaci nastrojovou listu. Ikona Spojnice méni tvar v zavislosti na posledni pouzité
spojnici.

* VWybereme spojnici z moZnosti dostupnych na panelu Spojnice na karté Tvary
v postranni liSté.

Diléi nastrojova lista Spojnice
V pripadé potfeby Ize spojnice zobrazit jako dil¢i nastrojovou liStu Spojnice takto:

9) Klepnutim na trojuhelnik v vpravo od Spojnice na nastrojové listé Kresba otevieme
vyskakovaci nastrojovou listu.

10) Klepneme na Céaru v horni ¢asti vyskakovaci nastrojové listy a prfetdhneme ji na pracovni
plochu.

11) Uvolnime nastrojovou listu a vytvorfime dil¢i nastrojovou liStu Spojnice (obrazek 191 pod).

Dokumentace pro LibreOffice je dostupna na https://cs.libreoffice.org/get-help/documentation/



Stores

Obréazek 190: Priklad spojnic mezi objekty

Spojnice

LNa VLN ZENYLNa N\

v X

Obrazek 191: Dil¢i nastrojova liSta Spojnice

(1) Spojnice konci Sipkou

(2) Pfimé spojnice konci Sipkou

(3) Zakrivena spojnice zakoncena Sipkou

(4) Cérova spojnice koné&i Sipkou

(5) Spojnice

(6) PFima spojnice

(7) Zakrivena spojnice

(8) Carova spojnice

(9) Spojnice zacina Sipkou
(10) PFfima spojnice za€ina Sipkou
(11) Zakfivenéa spojnice zacina Sipkou
(12) Céarova spojnice zagina Sipkou

Typy spojnic a skupiny

(13) Spojnice kon¢i kruznici

(14) Pfima spojnice kon¢i kruznici
(15) Zakfivena spojnice kon¢i kruznici
(16) Cérova spojnice konéi kruznici
(17) Spojnice zacina kruznici

(18) Pfima spojnice zacina kruznici
(19) Zakrivena spojnice zacina kruznici
(20) Cérova spojnice zac¢ina kruznici
(21) Spojnice s kruznicemi

(22) Pfima spojnice s kruznici

(23) Zakfivend spojnice s kruznici
(24) Céarova spojnice s kruznici

Kompletni nabidku dostupnych spojnic Ize zobrazit klepnutim na trojuhelnik ¥ vpravo na dil¢i
nastrojové listé Spojnice a vybérem Viditelna tla€itka z mistni nabidky. V zavislosti na pouzitém
pocitaCovém systému jsou jiz nainstalované spojnice na dilCi nastrojové li5té Spojnice oznaceny
bud zaSkrtnutim u nazvu, nebo je zvyraznéna ikona spojnice.

Spojnice jsou rozdéleny do Ctyf hlavnich skupin:

Spojnice

Standardni spojnice zaginaji Spojnice. Carové segmenty jdou svisle a vodorovng.
Vytvofi spojnici s jednim nebo vice ohyby pod Ghlem 90 stupiid.

Carovy

Spojnice &ar zacinaji Cara. Sklada se z Usecky se dvéma mensimi iseckami na koncich
a kresli spojnici, ktera se ohyba v blizkosti zachytného bodu. Chceme-li upravit délku
usecky mezi bodem ohybu a zachytnym bodem, klepneme na spojnici a pfetahneme bod

ohybu.
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Piima
Primé spojnice zacinaji slovem P¥fimé. Je tvofena Useckou.

Zakfivena
Zakfivené spojnice za€inaji slovem Zakfivené. Na zakladé Bézierovych kfivek se
nakresli zakfivena spojnice, ktera se ohyba kolem objekt(.

Spojnice se instaluji na dil¢i nastrojovou liStu Spojnice ve stejném poradi, v jakém se zobrazuji
v rozeviracim seznamu Viditelna tlacitka.

Pridavani spojnic k objektim
1) Klepnutim na trojuhelnik ¥ vpravo od poloZky Spojnice na nastrojové listé Kresba
otevieme moznosti vybéru spojnic.

2) Vybereme poZadovany typ spojnice a pfesuneme kurzor na prvni objekt. Kdyz
pfesuneme kurzor nad jeden z pfipojovanych objektt, kolem okrajd objektu se objevi
malé krizky nahrazujici achyty pro vybér objektu, jak ukazuje pfiklad na obrazku 192 pod.

3) Umistime kurzor nad z&chytny bod, klikneme a pfetahneme kurzor smérem k jinému
objektu, €¢imz vytvofime spojnic. KdyZ kurzor doséhne cilového objektu, zobrazi se kolem
okrajd objektu malé k¥izky oznadujici zachytné body.

Obréazek 192: Priklad zachytnych bodd objektu

4) Pfesuneme kurzor nad pozadovany zachytny bod na cilovém objektu a uvolnime kurzor
a spojnice se vykresli. Kulaté uchyty pro vybér na obou koncich spojnice jsou pfipojeny
k zachytnym boddim na kazdém objektu.

5) V pripadé potfeby upravime trasu spojnice pomoci ¢tvercovych ovladacich tchytd, které
se objevi na spojnici, tak, aby nezakryvala zadny jiny objekt v trase spojnice. Dalsi
informace nalezneme v €asti ,Uprava spojnic” na strance 193.

)? Poznamky

Pocatecni a koncovy bod spojnice nelze zaménit. Chceme-li vymeénit koncové body
spojnice, je tfeba spojnici odstranit a nakreslit novou spojnici v opaném smeéru.
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Koncovy bod spojnice je mozné umistit do prdzdné Casti kresby. Tento koncovy bod
pak Ize v pfipadé potfeby pfesunout a pfipojit k objektu.

Uprava spojnic
Spojnice Ize upravit jednim z nasledujicich zplsobU:
* Chceme-li spojnici odpojit nebo zménit jeji polohu, klepneme a pfetahneme jeden
z kulatych tchytovych bodd linie spojnice na jiné misto.

» Chceme-Ili zménit trasu spojnice mezi objekty tak, aby spojnice nepfekryvala Zadné
objekty na trase, klepneme na jeden ze ¢tvercovych Uchytovych bodl na linii spojnice
a pfetdhneme jej na nové misto.

» Chceme-Ili zménit spojnici, klikneme na ni pravym tlaCitkem mysi a z mistni nabidky
zvolime Spojnice, aby se otevfel stejnojmenny dialog (obrazek 193 pod). V tomto
dialogovém okné mdzeme zménit typ spojnice a jeji vlastnosti.

V dialogovém okné Spojnice jsou k dispozici nasledujici moznosti:

Typ
V rozeviracim seznamu vybereme skupinu typu spojnice. DalSi informace nalezneme
v Casti ,, Typy spojnic a skupiny“ na strance 191.

Typ: |Béiné spojnice A |
Zkoseni ary
Céra 1: 0,00 cm = |
Cara 2: -
Cara 3: =
Vzdalenost car
Vodorovny pocatek:  |0,50 cm = |
Vodorovny konec: 0,50 cm = |
Svisly potatek 0,50 cm =]
Svisly konec: 0,50 cm = |
Napovéda = Zrusit

Obréazek 193: Dialogové okno Spojnice
Zkoseni €ary
Definuje zkoseni spojnice. V nahledu tohoto dialogového okna je zobrazen vysledek
jakychkoliv zmeén.
Proklad mezi fadky
Nastavi rozestupy kolem spojnice.

Vodorovny pocatek
Zadame velikost vodorovného prostoru poZzadovaného na zacatku spojnice.
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Vodorovny konec
Zadame velikost vodorovného prostoru pozadovaného na konci spojnice.
Svisly pocatek
Zadame velikost svislé mezery poZzadované na zaCatku spojnice.
Svisly konec
Zadame velikost svislého prostoru pozadovaného na konci spojnice.
Okno nahledu
Zobrazi nahled vybrané spojnice a objektl, ke kterym je spojnice pfipojena. Nahled se
méni podle toho, jak jsou provadény zmeény vybrané spojnice pomoci dialogového okna
Spojnice. Klepnutim levym tlaCitkem mysi v oblasti nahledu si nahled pfiblizime;
klepnutim pravym tlaCitkem mysi v oblasti ndhledu si ho oddalime.

Zachytné body

Zachytné body nejsou totéz co uchyty pro vybér objektu, které slouzi k pfesouvani nebo zméné
tvaru objektu (dalsi informace nalezneme v kapitole 3, Prace s objekty). Zachytné body se
pouzivaji k pfichyceni nebo pfilepeni spojnice k objektu tak, aby pfi pohybu objektu zlstala
spojnice k objektu pfichycena.

VSechny objekty maji zachytné body, jak ukazuje pfiklad na obrazku 192 na strané 192.

Zachytné body se na objektu bézné nezobrazuji a zviditelni se az po vybéru spojnice pomoci
jedné z nasledujicich metod.

Zachytné body v X
| 7y W e >
<] &1 X e [

Obrazek 194: Nastrojova lista Zachytné body

* Na nastrojové listé Kresba vybereme Spojnice. Ikona Spojnice zobrazena na nastrojové
listé Kresba je typ spojnice, ktery byl naposledy pouzit.

* VWybereme typ spojnice na nastrojové listé Spojnice na panelu Tvary na postranni liSté.

Chceme-li pfidat, upravit nebo odstranit zachytné body, pfejdéme na Zobrazeni > Nastrojové
liSty > Zachytné body v hlavni nabidce a aktivujeme nastrojovou liStu Zachytné body (obrazek
194 nad). Tato nastrojova liSta se zobrazi pouze po pouZiti jedné z nasledujicich moznosti:

* Na néstrojové listé Kresba vybereme Zobrazit funkce zachytnych bodd.

* V hlavni nabidce vybereme moZnost Upravit > Zachytné body.

ﬁ Poznamky

Zobrazit funkce zachytnych bodU na nastrojové listé Kresba neni soucasti vychozi
sady nastrojl nastrojové listy Kresba. Chceme-li na nastrojovou listu Kresba pridat
ikonu Zobrazit funkce zachytnych bod, klikneme pravym tla¢itkem mysi do
prazdné oblasti na nastrojové listé Kresba a z mistni nabidky vybereme moZznost
Viditelna tlaCitka > Zachytné body.

Kazdy zachytny bod pridany k objektu mdize mit pouze jednu vodorovnou a jednu
svislou polohu. Proto mizeme vybrat vzdy jen jeden horizontalni a jeden vertikalni
nastroj.
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Typy zachytnych bod(i
Po otevieni nastrojové listy Zachytné body je aktivnich pouze pét nastrojl vlevo od nastroje
Relativni zachytny bod. Zbyvajicich Sest nastrojli na pravé strané nastrojové listy se aktivuje
pouze tehdy, kdyZ je zruSen vybér polozky Relativni zachytny bod.
Vlozit Zachytny bod
Po klepnuti na tlacitko se vloZi do objektu na pozici kurzoru zachytny bod.
Vystup doleva
Spojnice se pripoji k levému okraji vybraného zachytného bodu.
Vystup nahoru
Spojnice se pripoji k hornimu okraji vybraného zachytného bodu.
Vystup doprava
Spojnice se pripoji k pravému okraji vybraného zachytného bodu.
Vystup doli
Spojnice se pripoji ke spodnimu okraji vybraného zachytného bodu.
Relativni zachytny bod

Pokud je vybran, pohybuje se zachytny bod pfi zméné velikosti objektu a zachovava si
svou polohu vzhledem k hranicim objektu. Pokud je vybér zruSen, Ize po zméné velikosti
objektu zménit polohu zachytného bodu. Tento néstroj je ve vychozim nastaveni vybran
pfi otevieni nastrojové listy Zachytné body
Nasledujicich Sest nastrojll je aktivnich pouze tehdy, kdyZ je zruSen vybér polozky Relativni
zachytny bod.

Zachytny bod vodorovné vievo
Pri zméné velikosti objektu zlstane vybrany zachytny bod pevné umistén na levém okraji
objektu.

Zachytny bod vodorovné uprostied
Pfi zméné velikosti objektu zlstane vybrany zachytny bod pevné umistén ve stiedu
objektu.

Zachytny bod vodorovné vpravo
Pfi zméné velikosti objektu zlstane vybrany zachytny bod pevné umistén na pravém
okraji objektu.

Zachytny bod svisle nahore
Pri zméné velikosti objektu zlstane vybrany zachytny bod pevné umistén na hornim
okraji objektu.

Zachytny bod svisle uprostred
Pfi zmé&né velikosti objektu zlstane vybrany zachytny bod pevné umistén ve svislém
stfedu objektu.

Zachytny bod svisle dole
Pfi zméné velikosti objektu zlstane vybrany zachytny bod pevné umistén na spodnim

okraji objektu.
Pridani zachytnych bodu

Ve vychozim nastaveni maji objekty ¢tyfi zachytné body, jak ukazuje pfiklad na obrazku 192 na
strané 192. Dal3i zachytné body se k objektu pfidavaji nasledujicim zplsobem:

1) Pfejdeme na Zobrazeni > Nastrojové liSty > Zachytné body v hlavni nabidce
a aktivujeme nastrojovou liStu Zachytné body.
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2) Ujistime se, Ze nejsou vybrany zadné objekty a jednim z nasledujicich zplsobi
zobrazime nastrojovou listu Zachytné body:

— Na nastrojové listé Kresba vybereme Zobrazit funkce zachytnych bodi.
— V hlavni nabidce vybereme mozZnost Upravit > Zachytné body.
3) Vybereme objekt a klepneme na VloZzit zachytny bod na nastrojové listé Zachytné body.

4) Pfesuneme kurzor na pozadované misto na vybraném objektu a kurzor zmeéni tvar.
Obvykle se jedna o kfiz, ale skuteCny tvar zavisi na nastaveni pocitace.

5) Jednim klepnutim pfidame zachytny bod. Chceme-li pfidat dalsi zachytné body,
presuneme kurzor na nové misto a klepneme na né;.

6) Po pridani zachytnych bod( presuneme kurzor mimo vybrany objekt a klepnutim do
prazdného mista vybér objektu zruSime.

7) Pfipadné klepneme pravym tlacitkem mysi na dfive pfidany lepici bod k objektu
a z mistni nabidky vybereme Vlozit zachytny bod, poté klepneme a pretahneme novy
zachytny bod na poZzadované misto.

8) Z moznosti dostupnych na nastrojové listé Zachytné body vybereme pozadovany typ
zachytného bodu. Dal$i informace nalezneme v &asti , Typy zachytnych bodd“ na strance
195.

ﬁ Poznamka
Pro objekty bez vypiné Ize zachytny bod pfidat k okraji prazdného objektu.

.- Tip
PFi pfidavani, presouvani nebo pfizplsobovani zachytnych bodd se doporucuje
pouzivat funkci zvétSeni, ktera usnadnuje praci se zachytnymi body. DalSi informace
nalezneme v kapitole 3, Prace s objekty. Zachytné body se také pfichytavaji k mfizce,

coz usnadnuje umisténi zachytného bodu.

Prizplisobeni sméru vystupu zachytného bodu
Prizplsobime smér vystupu pro zachytny bod pfidany k objektu nasledujicim zplsobem:

1) Pfejdeme na Zobrazeni > Nastrojové liSty > Zachytné body v hlavni nabidce, abychom
aktivovali a otevreli nastrojovou liStu Zachytné body.

2) Dvojitym klepnutim na zachytny bod pfidany k objektu vybereme zachytny bod pro
prizplsobeni.

3) Vybereme pozadovany smér vystupu pro konektor pripojeny k zachytnému bodu pomaoci
jedné z nésledujicich metod:

— Vybereme smér vystupu na nastrojove listé Zachytné body.
— Klepneme pravym tlacitkem mySi na zachytny bod a z mistni nabidky vybereme smér
vystupu.

Prizp(isobeni polohy zachytného bodu

ﬁ Poznamka

Prizplsobit Ize pouze zachytné body, které byly ptidany k objektu. Vychozi zachytné
body (pfiklad na obrazku 192 a strané 192) , které jsou soucasti objektu, nelze
prizplsobit ani odstranit.
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Pfizplisobime vodorovné a svislé umisténi zachytného bodu pfidaného k objektu takto:

1) Pfejdeme na Zobrazeni > Nastrojové liSty > Zachytné body v hlavni nabidce, abychom
aktivovali a otevreli nastrojovou liStu Zachytné body.

2) Dvojitym klepnutim na zachytny bod pfidany k objektu vybereme zachytny bod pro
prizplsobeni.
3) Klepnutim na Relativni zachytny bod na nastrojové listé Lepené body zruSime vybér

nastroje nebo klepneme pravym tlaCitkem mysi na zachytny bod a z mistni nabidky
vybereme Relativni zachytny bod.

4) Zvolime vodorovné a svislé nastroje umisténi pozadované pro zachytny bod pomoci
jedné z nasledujicich metod. V jednom okamziku lze pouzit pouze jeden nastroj pro
vodorovné umisténi a jeden nastroj pro svislé umisténi:

— Klepneme a vybereme poZadovany nastroj pro vodorovné nebo svislé umisténi na
nastrojové listé Zachytné body.

— Klepneme pravym tlaCitkem mySi na zachytny bod a z mistni nabidky vybereme
poZzadované vodorovné a svislé umisténi.
Odstranéni zachytnych bod(
1) Vybereme zachytny bod, ktery byl do objektu pfidan dfive, a odstranime jej.

2) Stiskneme klavesu De lete nebo Backspace nebo prejdeme do Upravy > Vyjmout
v hlavni nabidce.

Text spojnice

Do spojnic Ize snadno pfidavat a formatovat text, aby bylo mozné Iépe sledovat vyvojovy
diagram nebo organizacni schéma. DalSi informace o praci s textem najdeme v kapitole 9,
Pfidavani a formatovani textu.

Pridani textu
1) Vybereme spojnici a ovladaci body se stanou aktivnimi.

2) Do textového rezimu vstoupime jednim z nasledujicich zplsobU. V blizkosti spojnice se
zobrazi blikajici textovy kurzor a otevie se nastrojova lista Formatovani textu
(obrazek 195 pod).

Formatovani textu
Liberation Sans v| |18pt | ¥ | Aa B I U5 ¥ x; § A A é - _‘

i -
> - e | - Ty

» . =20 =0 (A3 1A |9 @

= — 5 | ke

Obrazek 195: Nastrojova lista Formatovani textu

— Klepneme na Vlozit textové pole nebo Vlozit svisly text (pokud je pfidan) na
nastrojové listé Kresba

— Pomoci klavesové zkratky F2 vytvofime vodorovny text na vybrané spojnici.
3) NapiSeme pozadovany text pro tuto spojnici.

4) V pfipadé potfeby naformatujeme text spojnice. DalSi informace o forméatovani a
Upravach textu najdeme v Casti “Formatovani textu” na strané 198.
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5) Po dokong&eni pridavani a formatovani textu pfesuneme kurzor od textu a spojnice
a klepnutim ukoncime textovy rezim. Tim také zavieme néstrojovou listu Formatovani
textu.

ﬁ Poznamka

Ve vychozi instalaci LibreOffice nemusi byt na nastrojové listé Kresba nainstalovany
nastroje Vlozit textové pole a Vlozit svisly text. Chceme-li pfidat na nastrojovou
liStu Kresba textové nastroje, klikneme pravym tlacitkem do prazdné oblasti na
nastrojové listé Kresba a z mistni nabidky zvolime Viditelna tla€itka, a poté z mistni
nabidky vybereme Textové pole a/nebo Svisly text.

Formatovani textu

1) Vybereme spojnici s pfidanym textem a aktivujeme kontrolni body pro vstup do textového
rezimu. DalSi informace o pfidavani textu ke spojnici najdeme v casti ,Pridani textu“ na
strance 197.

2) K formatovani textu pouzijeme nastroje dostupné na nastrojové listé Formatovani textu
nebo moznosti dostupné v nabidce Format > Text v hlavni nabidce. Ve vychozim
nastaveni je text spojnice naformatovan s vodorovnym stfedovym zarovnanim a svislym
stfedovym umisténim odstavce textu spojnice.

3) Klepneme pravym tlacitkem mysi na text spojnice a vybé&rem moZznosti Atributy textu
z mistni nabidky otevieme dialogové okno Text (obrdzek 196 pod) a naformatujeme text
spojnice pomoci moznosti dostupnych v dialogovém okné.

4) Klepnutim na OK uloZzime zmény textu a zavieme dialogové okno Text.

5) Pfesuneme kurzor pry€ od textu a spojnice a klepnutim ukonc¢ime textovy rezim. Tim také
zavieme nastrojovou listu Formatovani textu.

ﬁ Poznamky

Moznosti dostupné pro animaci textu se hedoporucuji pro text spojnice, pokud se
kresba nebude zobrazovat jako soucdast prezentace. DalSi informace o animaci textu
nalezneme v Prirucce aplikace Impress.

Moznosti dostupné pro textové sloupce se nedoporucuji pro text spojnic. Textové
sloupce se obvykle pouZivaji pro text, ktery je umistén do textového pole pfi
pridavani informaci do kresby nebo do objektu, jako je obdélnik nebo kruh. DalSi
informace o textovych sloupcich najdeme v kapitole 9, Pfidavani a formatovani textu.
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Text Animace textu Textové sloupce

Text viastniho tvaru
[ Zalomit text podle tvaru
[ Upravit velikost tvaru podle textu

Vzdalenost k ohraniceni Ukotveni textu
Vlevo: |D,25 cm = | o O 0
Vpravo: |D,25 cm = | i @® (L
Mahofe: |D,13 cm - | l - l
Dole: |D,13 cm - | PIna ditka
MNépovéda Obnovit oK Zrusit

Obrazek 196: Dialogové okno Text — stranka Text
V dialogovém okné Text jsou k dispozici ndsledujici moznosti:

Text objektu kresby
Velikost podle ramce
Zméni velikost textu tak, aby se veSel do celé plochy obdélniku nebo ramecku
spojnice.
Prizplsobit obrysu
PrizpUsobi tok textu tak, aby odpovidal obrysim vybrané spojnice.
Vzdalenost k ohraniceni
Zadame velikost mezery, ktera ma byt ponechana mezi spojnici a okraji textu.

Ukotveni textu
Vybereme jednu z deviti pozic pro ukotveni textu v obdélniku spojnice.

PIna Sifka
Ukotvi text na celou Sifku obdélniku spojnice. Pokud je tato moZnost vybrana, Ize
k ukotveni textu pouZit pouze horni, stfedni a dolni stfedovou pozici.

Vyvojové diagramy

Priklad vyvojového diagramu je uveden na obrazku 197 pod a pfi jeho vytvareni se pouzivaji
nasledujici zakladni kroky:

« Informace potifebné pro pridavani objektl nebo tvarl vyvojového diagramu do
vyvojového diagramu nalezneme v kapitole 2, Kresleni zakladnich tvar(, tam se nachazi
informace o kresleni a zméné velikosti tvar(i objektd.

* Ke kazdému tvaru vyvojového diagramu pfidame text, abychom objekt vyvojového
diagramu snadno identifikovali. DalSi informace nalezneme v kapitole 2, Kresleni
zakladnich tvar(, a v kapitole 11, Pokrocilé techniky kresleni.
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* Ve vyvojovych diagramech pouzivame spojnice. To umoZziiuje pfemistovani objektd ve
vyvojovém diagramu pfi zachovani vazeb na ostatni objekty. DalSi informace nalezneme
v Casti ,Co je v této uzivatelské pfirucce?" na strance 8.

Obrazek 197: Priklad vyvojového diagramu

« PFi umistovani objektll ve vyvojovém diagramu ndm pomohou funkce priblizeni, mrizky
a prichyceni. Vice informaci nalezneme v kapitole 3, Prace s objekty a body objektU.

» Pomoci funkci zarovnani a rozdéleni dodame vyvojovému diagramu profesionalnéjsi
vzhled. Vice informaci nalezneme v kapitole 5, Kombinace vice objekt.

» K vytvoreni vyvojového diagramu pouzijeme dilci nastrojovou liStu Vyvojovy diagram
(obrazek 198 pod) a jeji Sirokou nabidku nastrojli vyvojového diagramu. Kliknutim na
Vyvojovy diagram na nastrojové listé Kresba otevieme dilCi nastrojovou liStu Vyvojovy
diagram.
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Vyvojovy diagram
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Obréazek 198:

Dil¢i nastrojova liSta vyvojového diagramu

(1) Vyvojovy diagram: Proces (10) Vyvojovy diagram: Pfiprava  (21) Vyvojovy diagram: Extrakce
(2) Vyvojovy diagram: (11) Vyvojovy diagram: Manualni  (22) Vyvojovy diagram: Spojeni
Alternativni proces vstup (23) Vyvojovy diagram: Ulozena
(3) Vyvojovy diagram: (12) Vyvojovy diagram: Manualni data
Rozhodnuti operace (24) Vyvojovy diagram: Zpozdéni
(4) Vyvojovy diagram: Data (13) Vyvojovy diagram: Konektor  (25) Vyvojovy diagram:
(5) Vyvojovy diagram: Pfedem (14) Vyvojovy diagram: Vnéjsi Sekvencni pfistup
definovany proces konektor (26) Vyvojovy diagram:
(6) Vyvojovy diagram: Interni (15) Vyvojovy diagram: Karta Magneticky disk
tlozisté (16) Vyvojovy diagram: Dérovany (27) Vyvojovy diagram: Primy
(7) Vyvojovy diagram: typ pristup
Dokument (17) Vyvojovy diagram: (28) Vyvojovy diagram:
(8) Vyvojovy diagram: Sjednoceni Zobrazeni
Multidokument (18) Vyvojovy diagram: Nebo
(9) Vyvojovy diagram: (19) Vyvojovy diagram: Sbér
Terminator (20) Vyvojovy diagram: Razeni
Vyvoj
Hardware Software -

Obréazek 199: Priklad organizacniho schématu

Organiza€ni schémata

Aplikace Draw nema specificky nastroj pro vytvafeni organizacnich schémat, ale Ize je snadno
vytvaret pomoci zakladnich tvard, tvard vyvojovych diagramd a spojnic. Hierarchie v organizaci
se snadno vyznacuje pomoci stinovani a/nebo barvy. PFi pouZziti stinovani a barvy

v organizanim schématu se ujistime, Zze vybér poskytuje dobry kontrast mezi textem
a stinovanim, pfip. barvou. Diky tomu je graf snadno Citelny na displeji pocitace nebo v tisténém
dokumentu. Pfiklad organizacniho schématu je uveden na obrazku 199 nad.
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« Informace potiebné pro pridavani objektd do schématu nalezneme v kapitole 2, Kresleni
zakladnich tvar(, zde jsou dostupné informace o kresleni a zméné velikost tvar( objekt.

» Pfidanim textu ke kazdému objektu organizacniho schématu usnadnime identifikaci
objektu ve schématu. Vice informaci nalezneme v kapitole 2, Kresleni zakladnich tvar(
a v kapitole 11, Pokrocilé techniky kresleni.

* V organiza¢nim schématu pouZzijeme spojnice. Ty umozni zménit polohu objektu ve
schématu pfi zachovani spojeni s ostatnimi objekty. DalSi informace nalezneme v Casti
,CO je v této uzivatelské pfirucce?" na strance 8.

PFi umistovani objektl do schématu nam pomohou funkce priblizeni, mfizky
a prichyceni. Vice informaci nalezneme v kapitole 3, Prace s objekty a body objektd.

Pomoci funkci zarovnani a rozdéleni dodame organizanimu schématu profesionalnéjsi
vzhled. Vice informaci nalezneme v kapitole 5, Kombinace vice objekt.

Pokud potfebujeme vice objektll stejného tvaru a velikost, tak objekty duplikujeme. Vice
informaci nalezneme v kapitole 5, Kombinace vice objektd.
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Uvod

Text pouzity v kresbach je umistén uvnitf objektu nebo textového pole. Tato kapitola obsahuje
informace o vytvareni, formatovani, pouzivani a odstrarfiovani textu a informace o rliznych typech
textu, které Ize vkladat do kresby. Déle jsou zde uvedeny informace o vkladani specialnich forem
textu, jako jsou usporadané nebo neusporadané seznamy, tabulky, pole, hypertextové odkazy,
sloupce a prace s pismem.

ﬁ Poznamka

PTi vybéru textovych nastrojli pro pfidani textu do kresby se Draw automaticky
prepne do textového rezimu. Automaticky se take otevre nastrojova lista Formatovani
textu (obrazek 200 pod), ktera nahradi nastrojovou listu Céara a vypln v horni ¢asti

kresby.

Textovy rezim

Aktivace textového rezimu
Pred vlozenim textu do kresby je tfeba jednim z nasledujicich zplsobU aktivovat textovy rezim.

» Pouze pro vodorovny text zvolime v hlavni nabidce Vlozit > Textové pole nebo
pouzijeme kldvesovou zkratku F2.

» Klepneme na VloZit textové pole pro vodorovny text nebo VloZit svisly text na
nastrojové listé Kresba (obrazek 201 pod) nebo nastrojové listé Text (obrazek 202 pod).

Pfidani svislého textu
Pokud nastroj Vlozit svisly text neni na nastrojové listé kresba viditelny (obrazek 201 pod), Ize
jej na nastrojovou listu pfidat nasledujicim zplsobem:
6) Volbou Nastroje > MoZnosti > Jazykova nastaveni > Jazyky (macOS LibreOffice >
Predvolby > Jazykova nastaveni > Jazyky) v hlavni nabidce otevieme stranku Jazyky
v dialogovém okné MoZzZnosti.

¥ X

Formatovani textu

Liberation Sans ~ 18pt v AT A‘J’ B I u - ‘S’

X2 X | § A A 0~

= 4 == 1= _ =t =t

i = === Y oy =1
Obréazek 200: Néstrojova lista Formatovani textu

Kresba v X

& Z-B AN OO0 —~¥-"1L~
O~Oveo-ImB- B~

Obréazek 201: Nastrojova lista Kresba

Dokumentace pro LibreOffice je dostupna na https://cs.libreoffice.org/get-help/documentation/
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Obrazek 202: Nastrojova lista
Text

7) V Casti Vychozi jazyky pro dokumenty vybereme moznost Asijské a pfijmeme
zobrazeny vychozi jazyk.

8) Klepnutim na OK zavieme dialogové okno MoZnosti a zmény uloZime.

9) Klepneme pravym tlacitkem mysi do prazdné oblasti na nastrojove listé Kresba nebo na
trojuhelnik smérem dolll ¥ a z mistni nabidky vybereme moznost Viditelna tladitka.

10) Vybérem moznosti Svisly text z rozeviraciho seznamu moznosti pfidame na nastrojovou
liStu Kresba moznost Vlozit svisly text.

Nastrojova lista Text

Pfi praci s textem se doporucuje mit v aplikaci Draw k dispozici nastrojovou liStu Text (obrazek
202 nad). Pokud néstrojova lista Text neni k dispozici, pfejdeme na Zobrazit > Nastrojové listy
v hlavni nabidce a vybereme z mistni nabidky poloZku Text, abychom ji pfidali mezi dostupné
nastrojové listy.

Textova pole

Vytvareni textovych poli

PTi pridavani textu do vykresu se automaticky vytvofi textové pole. Ve vychozim nastaveni se
textové pole rozsifi bud vodorovné, aby se do néj veSel jeden fadek vodorovného textu, nebo
svisle, aby se do néj veSel jeden Fadek svislého textu.

}? Poznamka

Textova pole jsou ur€ena pouze pro text a nemohou obsahovat ilustrace, vioZzené
obrazky, vzorce, tabulky ani objekty.

1) Aktivace vodorovného nebo svislého textového rezim, viz ,Aktivace textového rezimu“ na
strané 204. Automaticky se otevfe nastrojova liSta Formatovani textu, ktera nahradi
nastrojovou listu Cara a vypln.

2) Klepnutim na pfiblizné misto v kresbé vlozime textove pole. Vytvori se textové pole s
blikajicim textovym kurzorem v zavislosti na pouzitém pocitaovém systému a nastaveni.

3) Do textového pole napiSeme nebo viozime text a textové pole se rozSifi bud vodorovné
nebo svisle tak, aby se do néj veSel jeden Ffadek textu. V levém rohu stavového fadku je
také zobrazen indikator reZzimu Uprav textu a pozice textového kurzoru (obrazek 203
pod).

4)
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Obrazek 203: Priklad textovych informaci na stavovém radku

5) Pokud chceme v textovém poli vytvorit vice fadkd, pouZijeme jednu z nasledujicich
MOoZnosti:

— Pomoci klavesy Enter vytvofime uvnitf textového pole jednofadkové odstavce.
Textové pole se rozsifi tak, aby se do néj veslo vice fadkd textu.

— Pro vodorovny text klikneme na textovy kurzor a pfetahneme jej vodorovné, ¢imz
vytvofime textové pole o pfiblizné pozadované Sifce. Po dosaZeni hranic textového
pole se text automaticky zabali dovnitf textového pole a s pfibyvajicimi Fadky textu se
zvétSuje vySka textového pole.

— Pro svisly text klikneme na textovy kurzor a pfetdhneme jej svisle, ¢imz vytvofime
textové pole o pfiblizné poZzadované vySce. Po dosazeni hranic textového pole se text
automaticky zabali dovnitf textového pole a s pfibyvajicimi fadky textu se zvétSuje
Sifka textového pole.

6) Textové pole mizeme podle potieby pfesouvat, ménit jeho velikost, otacet nebo
formatovat. DalSi informace nalezneme v nasledujicich ¢astech a v kapitole 3, Prace s
objekty.

7) Text naforméatujeme pomoci riiznych nastrojli na nastrojové listé Formatovani textu. Dalsi
informace o formatovani textu najdeme v €asti ,Formatovani textu" na strané 215.

8) Po dokonceni vkladani a formatovani textu klepnutim mimo textové pole zmény uloZzime
a zruSime vybér textového pole.

OhranicCeni textového pole

Ve vychozim nastaveni se pfi vytvoreni textového pole jeho okraje zobrazi pouze tehdy, kdyz je
textové pole vybrano. V pripadé potfeby vytvofime kolem textového pole viditelny rAmecek
nékterou z nasledujicich metod.

Néstrojova lista Cdra a vyplri
1) Klepnutim na textové pole jej vybereme tak, aby se zobrazil ramecCek oznacuijici, ze
textové pole je v rezimu Uprav.

2) Pokud nastrojova lista Céra a vyplii neni viditelna, pfejdeme na Zobrazeni > Nastrojové
liSty > Céara a vypli v hlavni nabidce.

3) V poli Styl &ary na néastrojové listé Cara a vyplii (obrazek 204 pod) vybereme z
rozeviraciho seznamu styl cary.
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4) Do pole Sitka &ary na nastrojové listé Cara a vyplii zadame $itku stylu Gary pro
ohraniceni textového pole.

5) V okné Barva &ary na nastrojové listé Cary a vyplné vybereme barvu z jedné z
dostupnych palet barev nebo vytvofime vlastni barvu.

6) Klepnutim mimo textové pole ukonime rezim Gprav a uloZzime zmény.

Cara a vyplf * X
IEETOH&FO 4

« 0,00cm = -ﬁ:’ -
| |

S WRE
Obrazek 204: Nastrojova lista Cara a vyplri
Céra | *

Cara  Stin  Stylycar  Styly gipek

Viastnosti Eary Styly rohi a zakonéeni
Styl: . Styl rohu: |Zaku|an:n2n}'r ~ |
Barva: B zelens - Styl zakonéenti: |F'|Dché ~ |
Tloutka: 0,21 cm =
Prihlednost: 0% =

Styly ipek
Styl zacdtku: |- Zadna - ~ Styl konce: - Zadna - ~
Siflca: 0,52 cm = Sifka: 0,52 cm =

Na stfed Na stred

Synchronizovat zakonden|

—_— N\

Mapovéda Obnovit Zruiit

Obrézek 205: Dialogové okno Cara — Stranka Céra — Ohrani¢eni textového
pole

Dialogové okno Céra.

1) Klepnutim na textové pole jej vybereme tak, aby se zobrazil ramecek oznacuijici, Ze
textové pole je v reZimu Uprav.

2) Jednim z nasledujicich zplsobl otevieme dialogové okno Céara (obrazek 205 nad):

— Klepneme pravym tlacitkem mysi na okraj textoveho pole a z mistni nabidky vybereme
mozZnost Cara.
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— V hlavni nabidce zvolime Format > Cara.
3) Klepnutim na Cara otevieme stranku Cara.
4) Klepnutim na Cara otevieme stranku Cara.

5) V poli Styl vybereme z rozeviraciho seznamu styl ¢ary, ktery chceme pouzit jako
ohraniCeni textového pole.

6) V okné Barva vybereme barvu pro styl ¢ary z jedné z dostupnych barevnych palet nebo
vytvorime vlastni barvu.

7) Do pole TlouStka zadame Sitku vybraného stylu Cary.
8) Do pole Priihlednost, v pfipadé potfeby zadame procentudlni hodnotu pro styl ¢ary.
9) V poli Styl rohu vybereme z rozeviraciho seznamu styl rohu.

10) Kliknutim na tla¢itko OK uloZzime zmé&ny a zavieme dialogové okno Céra, poté kliknutim
mimo textové pole ukonime reZzim Gprav.

ﬁ Poznamka

Aby byl rohovy styl v ramecku textového pole jasné viditelny, doporuCujeme nastavit
Sifku Cary na tloustku nad 0,35 cm, jak ukazuje pfiklad na obrazku 206 pod.

Lorem ipsum dolor
Sit amet,

consectetur
adipiscing elit

Obrazek 206: Priklad pouZiti zaoblenych rohi v textovém poli
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! Vlastnosti A —
+ Inak [
+ Seznamy My
+ Odstavec [ ’e’?
+ Oblast = &
- Cara [ @
Cara: —_— .
Tloustka: —_— E::S
Barva: = I ~
Priklednost 0% =
+ Efekt
+ Efekt textu
+ Stin =

[

+ Umisténi a velikost
+ Sloupce

Obrézek 207: Panel Céra na karté Vlastnosti v postranni list& pro
textové pole

Panel ¢ar v postranni listé

1) Klepnutim na textové pole jej vybereme tak, aby se zobrazil ramecek oznacujici, Ze
textové pole je v reZzimu Uprav.

2) V postranni liste klepnutim na Vlastnosti otevieme kartu Vlastnosti v postranni listé, po
té klepnutim na Céra otevieme panel Cara (obrazek 207 nad).

3) V poli Céra vybereme z rozeviraciho seznamu styl ¢ary, ktery chceme pouZit jako
ohraniceni textového pole.

~ sy

4) Do pole Tloustka zadame Sifku vybraného stylu Cary.

5) V okné Barva vybereme barvu pro styl ¢ary z jedné z dostupnych barevnych palet nebo
vytvofime vlastni barvu.

6) Do pole Prihlednost, v pfipadé potieby zadame procentualni hodnotu pro styl ¢ary.
7) Klepnutim mimo textové pole ukoncime rezim Uprav.

Pfesouvani textovych poli

1) Kliknutim na textové pole jej vybereme. Zobrazi se ramecek oznacuijici, ze textoveé pole je
v rezimu Uprav.

2) Pfesuneme kurzor na ramecek. Kurzor zméni tvar na symbol pfesunuti podle nastaveni
pocitaCe (napriklad seviena ruka).

3) Klepneme na ohrani¢eni a pfetdhneme textové pole na nové umisténi v kresbé. Stin
obrysu textového pole ukazuje, kde bude umisténo (obrazek 208 pod).

4) Jakmile je textové pole na poZzadovaném misté, uvolnime jej.
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5) Chceme-li pfesné umistit textové pole, pouzijeme dialogové okno Umisténi a velikost
nebo panel Umisténi a velikost na karté Vlastnosti na postranni listé. DalSi informace
nalezneme v kapitole 3, Prace s objekty.

6) KdyZ je textové pole v poZzadované poloze, klepnutim mimo textové pole uloZzime zmeény
a zruSime vybeér textového pole.

Zmeéna velikosti textovych poli

1) Klepnutim na textové pole jej vybereme tak, aby se zobrazil ramecek oznacujici, Ze
textové pole je v rezimu Uprav.

2) Umistime kurzor na jeden z Gchytd vybéru. Kurzor zmeni tvar na symbol zmény velikosti
podle nastaveni pocitaCe (napfiklad oboustrannd Sipka). Uchytky vybraného textového
pole méni jeho rozmeéry takto:

3) Rohové uchytky méni sou€asné Sitku i vySku textového pole.
4) Horni a dolni stfedové uchytky méni vySku textového pole.
5) Prava a leva Uchytka slouZi ke zméné Sifky textového pole.

6) Klepnutim a pfetaZzenim ramecku do nového umisténi zménime velikost textového pole.
PFi zméné velikosti textového pole se zobrazi jeho obrys (obrazek 209 pod).

Lorem ipsumedolars
sit amet, sit amet,
consectetunnsectet

adipiscingeelibiscing

Lorem ipsum dolor
gitamet,
donseatetur
adipiscing elit

-
adipiscing
elit

Obrazek 209: Priklad zmény velikosti textového
pole

7) Jakmile textové pole dosahne pozadované velikosti, uvolnime jej.

8) Chceme-li pfesné zménit velikost textového pole, pouZijeme dialogové okno Umisténi a
velikost nebo panel Umisténi a velikost na karté Vlastnosti v postranni listé. DalSi
informace nalezneme v kapitole 3, Prace s objekty.

9) Jakmile ma textové pole poZadovanou velikost, klepnutim mimo textové pole uloZzime
zmeény a zruSime vybér textového pole.

210 | Prirucka aplikace Draw 25.8



ﬁ Poznamka

Pfi zméné velikosti textového pole stiskneme a podrZzime klavesu Shift, abychom
zachovali proporce textového pole, a poté kliknutim a pfetazenim Uchytu vybéru
zménime velikost. Pfed uvolnénim klavesy Shift uvolnime kurzor.

Otaceni textovych poli

1) Klepnutim na textové pole jej vybereme tak, aby se zobrazil ramecek oznacujici, Ze
textové pole je v reZimu Uprav.

2) Znovu klepneme na ohrani€eni textu a Uchyty vybéru zméni tvar a velikost, ¢imz se
nastavi rezim otaceni. Uprostfed textového pole se také zobrazi stfed otaceni.

3) Klepneme na Uchyt vybéru v rohu a tazenim textové pole otoCime. Zobrazi se obrys
otaCeného textového pole a ve stavovém fadku se zobrazi aktualni uhel otoCeni (obrazek
210 pod).

4) V pripadé potfeby miZzeme kliknout na stfed otaceni a premistit jej do jiné polohy a
zmeénit Ghel natoCeni textového pole. Stied otaceni mize leZet i vné textového pole.
5) Jakmile je textové pole v pozadovaném Ghlu nato€eni, uvolnime jej.

6) Chceme-li pfesné otocit textové pole, pouzijeme zélozku Otoc€eni v dialogu Umisténi a
velikost nebo panel Umisténi a velikost na karté Vlastnosti na postranni listé. DalSi
informace nalezneme v kapitole 3, Prace s objekty.

/? Poznamka

PFi otaceni textového pole jsou viditelné horni, dolni a bo¢ni Gchyty pro vybér, ale
nejsou k dispozici pro otaceni textového pole. Textova pole nelze naklanét, zkosit ani
prevracet vertikalné/horizontalné.

Obréazek 210: Priklad otaceni textového pole
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Text X

Text  Animacetextu  Textové sloupce

Text objektu kreshy
(] Sitka podle textu
Wika podle textu
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Vzdalenost k ohranifeni Ukotwveni textu
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L
)
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Mapovéda Obnovit Zrusit

Obrazek 211: Dialogové okno Text — stranka Text — Objekt
kresby

Formatovani textovych poli

MozZnosti formatovani dostupné pro vypli oblasti a okraje rameck( textovych poli jsou stejné jako
u ostatnich objektll v kresb&. Po naforméatovani textového pole jsou atributy textu naformatovany
tak, aby se text v textovém poli zobrazil spravné. DalSi informace o formatovani vyplné oblasti
nebo okrajll textového pole najdeme v kapitole 3, Prace s objekty.

1) Vybereme textové pole a jednim z nasledujicich zplsob( otevieme dialogové okno Text
(obrazek 211 nad).

— Klepneme pravym tlaCitkem mysi na textové pole a z mistni nabidky vybereme
Atributy textu.

— V hlavni nabidce zvolime Format > Atributy textu.

2) Klepnutim na Text v dialogovém okné Text otevieme stranku Text a ziskame pristup k
moznostem formatovani.

3) V prfipadé potieby klepneme na Animace textu a otevieme stranku Animace textu, kde
ziskédme pfistup k moznostem animace textu. DalSi informace o pouZiti animace textu v
kresbé najdeme v &asti ,Animace textu“ na strané 226.

4) V pfipadé potfeby klepnutim na Textové sloupce otevieme stranku Textové sloupce a
ziskame pristup k moznostem vytvareni sloupcl v textovém poli. Dal$i informace o
pouziti textovych sloupct v kresbé najdeme v ¢asti , Textové sloupce* na strané 224.

5) Klepnutim na OK uloZime zmény atributll textu a zavieme dialogové okno Text.

6) Kliknutim do prdzdného mista zruSime vybér textového pole a ukoncime rezim Uprav
textu.
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MozZnosti formatovani textového pole

Text objektu kresby
Sitka podle textu

RozSifi nebo zmensi Sitku textového pole tak, aby odpovidala délce textu, pokud je
textové pole mensi nebo veétsi nez text. Lze pouzit s VySka podle textu k
automatickému pfizplsobeni Sitky a vysky textového pole textu.

Vyska podle textu

Rozsifi nebo zmensi vysku textoveho pole tak, aby odpovidala vysce textu, pokud je
textové pole mensi nebo vétsi nez text. Lze pouzit s Sitka podle textu k automatickému

7 Moy

prizplsobeni Sitky a vysky textového pole textu.
Velikost podle ramce

Zméni Sifku a vySku textu tak, aby byla vyuZzita cela plocha textového pole, aniz by se
zmeénila Sitka nebo vyska textového pole. Tato moznost neni k dispozici, pokud jsou
vybrany moznosti Sitka podle textu a/nebo Vyska podle textu.

Vzdalenost k ohraniceni
Zadame velikost prostoru pro vytvoreni okrajli mezi textem a okraji textového pole.

Ukotveni textu
Ukotvi text na jednu z deviti pozic v textovém poli. Levou a pravou pozici kotvy Ize vybrat
pouze tehdy, pokud neni vybrana moznost Cela Sifka. Textova kotva ur€uje pouze pozici
textu v textovém poli a nemeéni zarovnani odstavce textu uvnitf textového pole.

PIna Sifka

Po vybéru se Sitka textového pole rozsifi tak, aby se do néj veSel nejdelSi odstavec textu
jako jeden Ffadek. Pokud je tato moZnost vybrana, Ize pro ukotveni textu uvnitf textového
pole pouZit pouze horni, stfedni nebo dolni stfedovou pozici v poli Ukotveni textu.

Mazani textovych poli

1) Klepneme na textové pole tak, aby byly viditelné Gchyty pro vybér, coz znamena, Ze
textové pole je v rezimu Uprav.

2) Zméackneme klavesu Delete nebo Backspace. Textové pole se odstranéni bez
jakéhokoliv upozornéni.

Text v objektech

Ve vychozim nastaveni neni objekt pfi prvnim vytvoreni v aplikaci Draw dynamicky a nechova se
jako textové pole. Zadny text umistény uvnitf objektu Draw se nezalamuje.

Chceme-li text udrzet v mezich objektu, musime pouZzit odstavce, zalomeni fadku nebo mensi
velikost textu, zvétsit velikost objektu nebo zkombinovat vSechny zplisoby. Dostupna metoda
zavisi na typu vybraného objektu.

}? Poznamka

Text Ize pridat k vétSiné objektl. Text vSak nelze pridavat do 3D objektl ani do
ovladacich prvkd, jako jsou tlacitka.

Pridavani textu k objektim

Priklad pfidani textu do objektu je uveden na obrazku 212 pod. Na horni objekt neni pouzita
volba obtékani textu a na spodni objekt je pouzita volba obtékani textu.

1) Vytvorfime objekt ve vykresu a ujistime se, Ze je objekt vybran.
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2) Do textového reZzimu vybraného objektu vstoupime pomoci jedné z nasledujicich
MOoZnosti:

— Klepneme na Vlozit textové pole pro vodorovny text nebo Vlozit svisly text pro svisly
text na nastrojové listé Kresba nebo Text.

— V pripadé vodorovného textu klepneme dvakréat na vybrany objekt.

— Pro vodorovny text pouzijeme klavesovou zkratku F2.

Lorem ipsum dol@r sit amet, consect@tur adipiscing elit

Lorem ipsum

dolor sit amet,
consectetur
adipiscing elit

Obrazek 212: Priklad obtékani textu uvnitf objektu
3) Zadame nebo vloZime text do vybraného objektu.

4) Text formatujeme pomoci rdiznych nastrojli na nastrojové listé Formatovani textu, panell
na karté Vlastnosti v postranni liSsté nebo moznosti v nabidce Format v hlavni nabidce.
DalSi informace o formatovani textu najdeme v €asti ,Formatovani textu“ na strance 215.

5) Pokud text pfesahuje hranice objektu, dostaneme se k moznostem formatovani textu pro
objekt Draw takto:

c¢) Dvoijitym klepnutim na text uvnitf vybraného objektu oznaCime text.

d) Klikneme pravym tlaCitkem mysi na vybrany text a zvolime Atributy textu. Otevie se
dialogové okno Text (obrazek 211 na strané 212).

e) Pomoci dostupnych mozZnosti forméatujeme text. DalSi informace nalezneme v Casti
"MozZnosti textu pro objekty" na strané 215.

6) V pripadé potfeby kliknutim na Animace textu otevieme stranku Animace textu a
ziskame pfistup k moznostem animace textu. DalSi informace o pouziti animace textu v
kresbé najdeme v &asti ,Animace textu“ na strané 226.

7) V pripadé potfeby kliknutim na Textové sloupce otevieme stranku Textové sloupce a
ziskate pfistup k moznostem vytvareni sloupcl uvnitf objektu. Dalsi informace o pouZziti
textovych sloupct v kresbé najdeme v ¢asti , Textové sloupce” na strané 224.

/? Poznamka

Dialogové okno Text pro Text vlastniho tvaru (obradzek 213 pod) je pouZit pro pridani
textu k objektlim a je podobny dialogovému oknu Text (obrazek 211 na strané 212).
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MozZnosti textu pro objekty

Text vlastniho tvaru
Zalomit text podle tvaru

Zalomi text tak, aby se veSel do objektu. Pokud se napfiklad zméni Sifka objektu,
vySka objektu se bud zvétsi, nebo zmensi, aby se pfizplsobila zvétSeni nebo
zmenseni poctu radkul textu.

Upravit velikost tvaru podle textu

Zméni velikost objektu tak, aby odpovidal textu, ktery je do objektu zadavan. Napfiklad
pokud objekt jiz obsahuje jeden vicefadkovy odstavec textu a je vybrana tato moznost,
Sifka objektu se zvétsi a vyska zmensi, dokud text nebude tvofit jeden Ffadek textu.

Text X

Text  Animacetextu  Textové sloupce

Text vlastniho tvaru

B Zzlomit text podle tyaru!

[ Upravit velikest tvaru podle textu

Vzdilenost k ohraniCeni Ukotveni textu

Vievo: 0,25 cm = O O

e
S

PIna &ifka

Vpravo: 0,25cm

O —) 'S

MNahore: 0,13 cm

Dole: 013 cm

Napovéda Obnovit Jruiit

Obrézek 213: Dialogové okno Text — stranka Text

Vzdalenost k ohrani¢eni
UrCime, jak velky prostor ma byt ponechan mezi textem a okraji objektu.

Ukotveni textu

Ukotvi text na jednu z deviti pozic v textovém poli. Levou a pravou pozici kotvy Ize vybrat
pouze tehdy, pokud neni vybrdna moznost Cela Sitka. Textova kotva ur€uje pouze pozici
textu v textovém poli a neméni zarovnani odstavce textu uvnitf objektu.

PIna Sirka

Po vybéru se Sitka objektu rozsifi tak, aby se do néj veSel nejdelSi odstavec textu jako
jeden fadek. Pokud je tato moznost vybrana, Ize pro ukotveni textu uvnitf textového pole
pouzit pouze horni, stfedni nebo dolni stfedovou pozici v poli Ukotveni textu.

Formatovani textu

Formatovani textu vytvari profesionalnéjsi kresbu bez rusivych prvkd. Nastroje pro formatovani
textu jsou k dispozici na nastrojové listé Formatovani textu a v rozeviracich nabidkach Format v
hlavni nabidce. Vice informaci o formatovani textu najdeme v pfiruéce Privodce programem
Writer.
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Pokud je v kresbé nékolik textovych poli a/nebo objektd, které vyzaduiji stejné formatovani textu,
doporucujeme pouzit styly kresby. Vice informaci o pouzivani a tvorbé stylli najdeme v kapitole
4, Zména atributll objektu.

ﬁ Poznamka

Pomoci volby v hlavni nabidce Upravy > VloZit nebo klavesové zkratce Ctrl + V
(macOS ¥ + V) se vlozi zkopirovany text pfimo do kresby a vytvori se OLE objekt a
NEvytvofi se objekt Draw. P¥i vytvareni textovych poli nebo pfidavani textu do
objektd Draw se doporucuje vkladat text do objektd Draw jako neformatovany text.

Vkladani textu

PTi vkladani zkopirovaného textu z jiného objektu, kresby nebo dokumentu do textového pole
nebo objektu si zkopirovany text zachova formatovani ze zdrojové kresby nebo dokumentu.
Tento zkopirovany text nemusi odpovidat jiz pouzitému formatovani textu. Doporucuje se vlozit
text do kresby jako neformatovany text a poté pouzit formatovani, které odpovida formatovani
textu jiz pouzitému v cilové kresbé.

1) Text zkopirujeme a vloZime jako neforméatovany text do kresby nebo objektu Draw
pomoci jedné z nasledujicich metod:

— V hlavni nabidce zvolime Upravy > VloZit jinak > VloZit neformatovany text.

— V hlavni nabidce zvolime Upravy > VloZit jinak > VloZit jinak a otevfe se dialogové
okno Vlozit jinak. Vybereme Neformatovany text a klepnutim na OK dialogové okno
zavieme.

— Pouzijeme klavesovou zkratku Ctrl + Shift + V (macOS ¥# + Shift + V)a
otevie se dialogové okno Vlozit jinak. Vybereme Neformatovany text a klepnutim na
OK dialogové okno zavieme.

— Klepneme na trojuhelnik ¥ vpravo od polozky Vlozit na Standardni nastrojové listé a z
mistni nabidky vybereme Neformatovany text.

2) Vlozeny text naforméatujeme podle poZzadavkl kresby nebo pouZijeme styl kresby.
Neformatovany text se vloZi do textového pole na pozici kurzoru nebo uvnitf vybraného
objektu a naformatuje se podle vychoziho stylu kresby.

Rychla zména velikosti pisma

Po vybéru textu Ize velikost pisma rychle zvétsit nebo zmensit pomoci nastrojii Zvétsit velikost
pisma (Ctrl + ]) (macOS ¥ + ])a ZmensSit velikost pisma (Ctrl + [) (macOS & + [),

které najdeme na nastrojové listé Formatovani textu.

ﬁ Poznamka

PTi pouZziti rychlé zmény velikosti pisma zavisi kazda zména velikosti pisma na
standardnich velikostech pisma, které jsou k dispozici pro pismo pouZité v cilovém
objektu kreshy.

Vybér textu

Text, ktery chceme formatovat, musi byt pred Upravou vybran jednim z nasledujicich zplsobd.
V8echny zmeény formatovani se vztahuji pouze na vybrany text.

» Pokud chceme naformatovat vSechen text v textovém poli nebo objektu, klepneme
jednou na okraj textového pole nebo objektu a zobrazime Uchyty pro vybér. Zmény
formatovani se pak vztahuji na veskery text v textovém poli nebo objektu.
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» Abychom upravili forméat jen Casti textu pole, vybereme jej jednou z nasledujicich metod:
— Klikneme do textu a taZzenim kurzoru vybereme text.

— Dvojitym kliknutim na text vybereme celé slovo nebo trojitym kliknutim vybereme
odstavec.

— Klikneme do textu, pak stiskneme a podrzime klavesu Shift a pouzijeme klavesy se
Sipkami.
Formatovani odstavcu
PFimé formatovani
Pfimé nebo ruéni formatovani odstavcl se aplikuje pfimo na vybrané odstavce. Toto pfimé nebo

rucni formatovani potlaci formatovani, které bylo pouzito pomoci formatovani odstavce a styll
kresleni.

1) Vybereme text (viz ,Vybér textu“ na strané& 216) a jednim z nasledujicich zpUsobl jej
naformatujeme:

— Pomoci rliznych nastroji formatovani na nastrojové listé Formatovani textu.

— Pomoaoci volby Format v hlavni nabidce a vybérem moZznosti formatovani z rozeviraci
nabidky. Vyb&rem mozZnosti forméatovani se otevie kontextova nabidka nebo dialogové
okno s dalSimi moznostmi forméatovani, které Ize pouZzit na vybrany text.

— Pouzijeme moZznosti dostupné v dialogovych oknech Odstavec a Znak.

— PouZijte moznosti dostupné v panelech Odstavec a Znak na karté Vlastnosti v
postranni listé.

2) Kliknutim mimo textové pole nebo objekt zruSime vybér rezimu Uprav textu.

Dialogové okno Odstavec
1) Klikneme kamkoli do formatovaného odstavce.
2) jednim z nasledujicich zplsob( otevieme dialogové okno Odstavec (obrazek 214 pod).

— Klepneme pravym tlacitkem mySi na vybrany text a z mistni nabidky vybereme
Odstavec.

— Jdeme do nabidky Format > Odstavec.
3) K formatovani textu pouzijeme rlizné moznosti na kartach dialogového okna Odstavec.
4) Klepnutim na OK uloZime zmény a zavieme dialogové okno Odstavec.

5) Kliknutim mimo textové pole nebo objekt zruSime vybér textu.

/? Poznamka

Informace o rliznych moznostech formatovani textu, které jsou k dispozici na
strdnkach dialogového okna Odstavec, nalezneme v prirucce aplikace Writer.
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Odstavec *

Odsazeni a rozestupy  Tabuldtory  Zarowvndni

Odsazeni
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[Tl Mevkladat mezeru mezi odstavee stejného stylu

Radkovani

Jednoduché

Napovéda Cbnovit Zrugit

Obrazek 214: Dialogové okno Odstavec — stranka Odsazeni a rozestupy
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Obrazek 215: Panel Odstavec na karté Vlastnosti v postranni
listé
Panel odstavci v postranni listé

Pro formatovani odstavcil pouZijeme panel Odstavec (obrazek 215 nad) na karté Vlastnosti v
postranni listé. MoZnosti formatovani jsou omezené, ale maji podobné pouZiti jako moznosti
formatovani dostupné v dialogovém okné Odstavec. Jakékoli formatovani pouzité na odstavec
pomoci panelu Odstavec je okamZité.

1) Klikneme kamkoli do formétovaného odstavce.
2) V postranni listé klikneme na ikonu Vlastnosti, otevie se stejnojmenna karta.
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3) V pripadé potfeby klepneme na symbol rozSifeni vlevo od titulkového pruhu Odstavec a
otevieme panel Odstavec.

4) Text formatujeme pomoci rliznych moZnosti dostupnych v panelu Odstavec.

5) Je-li to nutné, klikneme na ikonu Dal$i moznosti na pravém okraji titulniho pruhu, ¢imz
otevieme dialog Odstavec se vSemi moznostmi formatovani textu.

ﬁ Poznamka

Informace o rliznych mozZnostech formatovani textu na panelu Odstavec v postranni
li5sté nalezneme v prirucce aplikace Writer.

Formatovani znaku
PFimé formatovani
Pfimé nebo ru¢ni formatovani znakd se aplikuje pfimo na vybrané znaky. Toto pfimé nebo ru¢ni

formatovani potlaci formatovani, které bylo pouZito pomoci formatovani znakll nebo odstavcl a
styl(l kresby.

1) Vybereme znaky pro formatovéani, dalSi informace nalezneme v ¢asti ,Vybér textu” na
strané 216.

2) Znaky formatujeme jednou z nasledujicich metod.

— RUzné formatovaci nastroje na nastrojové listé Formatovani textu. Formatovani pouZzité
na znaky je okamzité.

Jdeme do nabidky Format. Vybérem moznosti formatovani se otevie mistni nabidka
nebo dialogové okno, kde Ize vybrat dalSi mozZnosti formatovani.

PouZijeme moZznosti dialogu Znak. Klepnutim na OK v dialogovém okné pouzZijeme
zmény formatovani.

Pouzijeme moZnosti dostupné v panelu Znak na karté Vlastnosti v postranni listé.
Formétovani pouzité na znaky je okamZzité.

3) Kliknutim mimo textové pole nebo objekt zruSime vybér textu.

Dialog Znak

1) Vybereme znaky pro formatovani a otevieme dialogové okno Znak (obrazek 216 pod)
jednim z nasledujicich zplsob:

— Pravym tlaCitkem mysi klepneme na znaky a z mistni nabidky vybereme Znak.

— V hlavni nabidce zvolime Format > Znak.
2) Vybrané znaky formatujeme vyuzitim moznosti na strankach dialogového okna Znak.
3) Klepnutim na OK aplikujeme zmény formatovani a zavieme dialogové okno.

4) Kliknutim mimo textové pole nebo objekt zruSime vybér textu.
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Obréazek 216: Dialogové okno Znak — strénka Pisma
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Obrazek 217: Panel Znak na karté Vlastnosti v postranni listé

ﬁ Poznamky

Informace o rliznych moznostech formatovani dostupnych pro znaky na strankach
dialogového okna Znak nalezneme v PFirucce aplikace Writer.

Informace o rliznych moZnostech formatovani, které nabizi panel Znak na postranni
li5sté, nalezneme v Prirucce aplikace Writer.
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Panel Znak v postranni listé

Panel Znak (obrazek 217 nad) v postranni listé slouzi k formatovani znak(. MozZnosti
forméatovani jsou omezené, ale podobné moznostem formatovani, které poskytuje dialogové
okno Znak. Jakékoliv formatovani prostfednictvim panelu Znak je okamzité. K formatovani znak
je také ur€ena nastrojova liSta Formatovani textu.

1) Vybereme textové pole nebo objekt tak, aby se na okraji zobrazily Uchyty pro vybér.
2) V postranni listé klikneme na ikonu Vlastnosti, otevie se stejnojmenna karta.

s

3) Klepnutim na symbol rozSifeni na levé strané titulkového pruhu Znak otevieme panel
Znak.

4) Formatujeme text pomoci nastrojli na panelu Znak.

5) V pripadé potfeby klikneme v titulnim pruhu napravo na ikonu DalSi moznosti, ktera
otevie dialog Znak.

Neusporadané nebo usporfadané seznamy

V textovych polich a objektech Ize vytvaret neusporadané (s odrazkami) a uspofadané
(Cislované) seznamy. Objekty Draw nejsou dynamické a pfi vytvareni seznamu v nich se jejich
velikost automaticky nezvétSuje. Tvorba neuspofadanych nebo usporadanych seznam( v
aplikaci Draw se podoba praci v aplikaci Writer. DalSi informace o neuspofadanych nebo
usporadanych seznamech nalezneme v Prirucce aplikace Writer.

Vytvareni seznamll

Neusporadané nebo uspofadané seznamy vytvofime v textovych polich nebo v objektech Draw
takto:

1) Vyberte text, ktery bude tvofit seznam.

2) Seznam vytvofime pomoci jedné z nasledujicich moznosti a vychozich nastaveni
seznamU:

— Na nastrojové listé Forméatovani textu klepneme na Pfepnout nesefazeny seznam
nebo Pfepnout sefazeny seznam.

— Klepnutim na Pfepnout nesefazeny seznam nebo Pfepnout sefazeny seznam na
panelu Seznamy na karté Vlastnosti v postranni listé (obrazek 218 pod).

— Prejdeme do nabidky Format > Seznamy > Nesefazeny seznam nebo Sefazeny
seznam.
3) Chceme-li zménit format seznamu, klepneme na trojuhelnik ¥ vpravo od ikon seznamu a

vybereme styl seznamu z moznosti dostupnych ve vyskakovacim dialogovém okné Dalsi
odrazky (obrazky 219 pod) nebo Dalsi €islovani (obrazek 220 pod).

Uprava lirovné a pozice polozky seznamu

Uroven kazdé polozky v neuspofadaném nebo uspofadaném seznamu v rdmci seznamu snizime
nebo zvysime, nebo poloZzku v pofadi seznamu posuneme nahoru nebo dolll nasledujicim
zpUsobem:

1) Klikneme na polozku seznamu, jejiz aroven chceme zménit nebo chceme zmeénit jeji
poradi v seznamu.
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Obrazek 218: Panel Seznamy na karté Vlastnosti v postranni
listé

Knihovna odraZek

o Prizplsobit..

Obrazek 219: Dialogové okno Knihovna odrazek pro
nesefazené seznamy

1) 1 (1) .
22 @ I.
35— 3 G —T}
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0 J (c) i

& Pfizpdsobit..,
Obrazek 220: Dialogové okno Dalsi ¢isla pro Cislované
seznamy
2) Uroveri polozky o jednu sniZime jednou z nasledujicich metod:
— PouZijeme klavesu Tab.
— V hlavni nabidce zvolime Format > Seznamy > O Uroven niz.
— PouZijeme O droven niz v panelu Seznamy na karté Vlastnosti v postranni listé.
3) Urovefi polozky o jednu zvysime n&kterym z nasledujicich postupd:
— Pouzijeme kombinaci klaves Shift + Tab.

— V hlavni nabidce zvolime Format > Seznamy > O Uroven vys.
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— Pouzijeme O urovei vys v panelu Seznamy na karté Vlastnosti v postranni listé.
4) Pozici polozky v seznamu zménime jednou z nasledujicich metod:

— Pfejdeme na Format > Seznamy > Pfesunout nahoru nebo Pfesunout doldi v hlavni
nabidce.

— PouZijeme Pfesunout nahoru nebo Pfesunout dolii na panelu Seznamy na karté
Vlastnosti v postranni listé.

Dialogové okno Odrazky a €islovani

DetailngjSiho formatovani seznamu dosdhneme uzitim dialogu Odrazky a Cislovani
(obrazek 221 pod). Vybereme text v textovém poli nebo objektu a otevieme dialogové okno
pomoci jedné z nasledujicich moZnosti:

* Jdeme do nabidky Format > Odrazky a Cislovani.
* Klepneme pravym tlacitkem mysSi na vybrany text a z mistni nabidky zvolime Odrazky a

Cislovani.

Odrazky a &islovani ey
Uroveii  Vlastnosti Nahled
T Typ: |Odrézka | —
2

3 Znak: Wybrat... .

4

5 Barva: [ | Automaticka = .

6 Velikost .

S

3 Rel, velikost: 433 = .

g Umisténi

L ]

10 a

Cd=azeni: 0.00cm

1-10 . = .
Sirka: 0.60cm =
[ Relativni .
Zarovnani; = =
[ ]
Rozsah
O Strénka *
O vyber

Mapovéda Obnovit Zrudit

Obréazek 221: Dialogové okno OdraZky a Cislovani

» Klepneme na Dal$i moZnosti na pravé strané titulkového pruhu panelu Seznamy na
karté Vlastnosti v postranni listé.

vs ws

+ Klepnutim na DalSi odrazky nebo DalSi €islovani po klepnuti na trojuhelnik v vpravo
vedle Pfepnout nesefazeny seznam nebo Pfepnout sefazeny seznam na nastrojové
liSté Formatovani textu nebo na panelu Seznamy na karté Vlastnosti v postranni liste.
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ﬁ Poznamka

Dalsi informace o moznostech dostupnych v dialogovém okné odrazky a Cislovani
pro neusporadané nebo usporadané seznamy nalezneme v Pfirucce aplikace Writer.

Textové sloupce

V textovych polich a uvnitt objektd Ize text formatovat do sloupcl . Sloupce nelze pouZzit jen na
¢ast textu. Pro sloupce musi byt pouZito celé textové pole nebo objekt. Priklad textovych sloupcl
uvnitf objektu aplikace Draw je uveden na obrazku 222 pod.

V aplikace Draw text mezi sloupci pretéka. Kdyz dosahne spodni ¢ast sloupce, dalsi pfidany text
se automaticky pfelije do dalSiho sloupce.

Textova pole

1) Klepnutim na okraj textového pole jej vybereme tak, aby se zobrazily dchyty pro vybér,
C0Z znamena, Ze textové pole je v rezimu Gprav.

2) Moznosti textovych sloupcll otevieme jednim z nasledujicich zplsobd:

— Pravym tlaCitkem mysi klepneme do textového pole a z mistni nabidky vybereme
Atributy textu. Tim otevieme dialogové okno Text a poté klepnutim na kartu Sloupce
textu otevieme stranku Sloupce textu (obrazek 223 pod),

— Klepnutim na Sloupce na karté Vlastnosti postranni liSty otevieme panel Sloupce
(obrazek 224 pod).

Lorem ipsum Senectus et  Ridiculus mus
dolor sit amet, netus et mauris vitae
consectetur malesuada. ultricies leo
adipiscing elit, Quis ipsum integer

sed do suspendisse malesuada
eiusmod ultrices nunc.

tempor gravida A erat nam at
incididunt ut  dictum fusce. lectus urna
labore et Enim nec dui duis convallis
dolore magna nunc mattis  convallis
aliqua. enim. tellus.

Obrazek 222: Priklad textovych sloupcl v objektu aplikace Draw
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Text b4
Text  Animacetextu  Textové sloupce

Potetsloupc: B -

Rozestup: 021 cm S

Obrazek 223: Dialogové okno Text — stranka Sloupce textu

! Vlastnosti Pox =

+ Inak

7
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+l Seznamy

+ Qdstavec

il
g

+ QOblast
+ Cara

el

B ® g

=l

+ Efekt
+ Efekt textu

+ Stin

il

+ Umisténi a velikost [

Poéet sloupcd: 3

Rozestup: 021 cm

Obrazek 224: Panel Sloupce na karté Vlastnosti v postranni
listé
3) V poli Pocet sloupcti nastavime poZadovany pocet sloupct a v poli Rozestup
pozadovanou vzdalenost mezi sloupci.
4) Ulozime zmény a zrusime vybér textového pole jednim z nasledujicich zptsob:

— V dialogovém okné Text klepnutim na OK ulozime zmény a zavifeme dialogové okno,
poté klepnutim mimo textové pole zruSime jeho vybeér.

— U panelu Sloupce na karté Vlastnosti v postranni listé klepnutim mimo textové pole
zruSime jeho oznaceni a ulozime zmény.

ﬁ Poznamka

Jakykoli text uvnitf textového pole nebo objektu kresby se po uloZzeni zmén
automaticky pfevede do formatu sloupce.

Objekty kreshy

1) Klepnutim na objekt jej vybereme tak, aby se zobrazily Gchyty vybéru, které indikuji, Ze je
objekt v reZimu Uprav.

2) Dvojitym klepnutim na vybrany objekt zapneme reZim Uprav textu.
3) Moznosti textovych sloupcl otevieme jednim z nasledujicich zplsobd:

— Pravym tlacitkem mySi klepneme do textového pole a z mistni nabidky vybereme
Atributy textu. Tim otevieme dialogové okno Text a poté klepnutim na kartu Sloupce
textu otevieme stranku Sloupce textu (obrazek 223 nad),
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— Klepnutim na Sloupce na karté Vlastnosti postranni liSty otevieme panel Sloupce
(obrazek 224 nad).

4) V poli Pocet sloupcl nastavime pozadovany pocet sloupcll a v poli Rozestup
poZadovanou vzdalenost mezi sloupci.

5) UloZime zmény a zruSime vybér objektu pomoci jedné z nasledujicich metod:

— V dialogovém okné Text klepnutim na OK ulozime zmény a zavifeme dialogové okno,
poté klepnutim mimo objekt zruSime jeho vybér.

— U panelu Sloupce na karté Vlastnosti v postranni listé klepnutim mimo objekt zruSime
jeho vybér a ulozime zmény.

6) Opétovnym poklepanim na objekt zapneme rezim Uprav textu.

7) NapiSeme nas text nebo pouzijeme funkci kopirovat a vloZzit. VeSkery text je formatovan
do sloupce.

8) V pripadé potieby naformatujeme text podle poZzadavk( kresby.

9) Klepnutim mimo objekt zruSime jeho vybér a uloZzime zmény.

Animace textu

ﬁ Poznamka

Animace textu se v kresbé nedoporucuje, pokud se kresba nebude zobrazovat jako
soucast prezentace. DalSi informace o animaci textu nalezneme v Prirucce aplikace
Impress.

Text *

Text Animacefextu  Textové sloupce

Efekt
1
Smér: =
+
Vlastnosti
() Zaéit uvnitf
(] viditelny text pfi ukondeni
Cykly animace: @ spojite =
Ffirdstek: @ Pixely 1 B

Prodleva: 8 Automaticka

Mapovéda Obnovit Zrusit

Obrazek 225: Dialogové okno Text — stranka Animace textu
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Vytvofeni animace textu

1) Klepneme pravym tlaCitkem mySi na text v textovém poli nebo na objekt kresby a
vyb&rem moznosti Atributy textu z mistni nabidky otevieme dialogové okno Text.

2) V dialogovém okné Text klepnutim na Animace textu otevieme stranku Animace textu
(obrazek 225 nad).

3) V poli Efekt vybereme, jak se text zobrazi béhem animace.
4) V poli Smér vybereme, ze kterého sméru se bude text pohybovat.

5) V sekci Vlastnosti vybereme Zacit uvnitf, aby byl text pfi animaci viditelny a uvnitf
objektu kresleni.

6) V sekci Vlastnosti vybereme moznost Viditelny text pfi ukonceni, aby text z(stal viditelny
i po dokoncCeni animace.

7) V poli Cykly animace vybereme moznost Spojité nebo zadame pocet animacnich cykll
pro animovany text.

8) V poli Prirlistek vybereme hodnotu pfirlistku v poli Pixely pro posouvani textu.

9) V poli Prodleva zadame Automaticky nebo zaddme Casovou prodlevu, kterou chceme
pockat pred opakovanim animacniho efektu.

10) Klepnutim na OK ulozim zmény a zavieme dialogové okno Text.

MozZnosti animace textu

Akce
V rozeviracim seznamu vybereme animacni efekt, ktery se ma pouzit na text ve
vybraném objektu kresby. Chceme-li odstranit animacni efekt, vybereme moznost Bez
efektu.
Smér
Vybereme smér posouvani animovaného textu.
Vlastnosti
Zacit uvnitr
Bé&hem animace je text viditelny a je uvnitf objektu kresby.
Viditelny text pfi ukonceni
Text zUstane viditelny i po skonéené animaci.
Cykly animace
Nastaveni moznosti smycky pro efekt animace.
Spojité
Prehrava animacni efekt nepretrzité. Chceme-li zadat poCet pfehrani animacniho
efektu, zruSime zaskrtnuti tohoto policka a zadame pocet cyklli do pole Spojité.
Prirtstek
Urcéuje hodnotu pfirdstku v poli Pixely pro posouvani textu.
Prodleva
Urcuje pauzu pfed dalSim opakovanim animace.

Automaticky
LibreOffice automaticky nastavi pauzu pfed opakovanim animace. Chceme-li délku
pauzy zadat ru¢né, zruSime zaSkrtnuti tohoto policka a zadame jeji ¢as do pole
Automatické.
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Obrazek 226: Priklady horizontalniho a vertikalniho pohybu
textu

Textové bubliny

Textova bublina je kratky text se spojnici, kterd zvyrazriuje nebo upozorfiuje na néjaky prvek v
ilustraci nebo vykresu. Dostupné jsou dva typy textovych bublin (obrazek 226 nad) — Bubliny pro

LibreOffice, najdeme je na nastrojové listé Text (obrazek 202 na strané 205).

ﬁ Poznamka

Jiné bubliny najdeme na nastrojové listé Kresba pod nastrojem Tvary bublin nebo v
panelu Bubliny na karté Tvary v postranni listé. Tvary bublin maji stejny Gcel jako
textové bubliny, ale jsou u nich k dispozici rlizné moznosti.

Vytvareni textovych bublin

1) Na nastrojové listé Text klepneme na Bubliny pro vodorovny text nebo Svislé bubliny
pro svisly text (obrazek 202 na strané 205).

2) Klepneme do kresby a pfetdhneme kurzor, abychom vytvofili bublinu.
3) Dvojitym klepnutim do pole bubliny pfejdeme do textového rezimu.

4) Zaddme pozadovany text a klepneme na prazdné misto v kresbé. Pole bubliny upravi
svou velikost vodorovné a/nebo svisle tak, aby se text veSel do pole bubliny.

5) Vybereme bublinu a klepneme na Gchyt vybéru na konci spojovaci ¢ary a pretdhneme

konec spojovaci ¢ary na pozadované misto.
6) Kdyz je bublina stale vybrana, klepneme na ni a pfetdhneme ji na pozadované misto.

7) Pokud potfebujeme zménit Sitku a vySku bubliny, vybereme ji a zménime Sifku a vysku
ramecCku bubliny.

8) Klepnutim do prazdného mista v kresbé zruSime vybér textové bubliny a zmény ulozime.
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ﬁ Poznamka

ZaloZka Bublina v dialogovém okné Umisténi a velikost je k dispozici pouze v
pfipadé, Ze je vybrana textova bublina. Neni k dispozici pro Tvary bublin na
nastrojové listé Kresba, ani pro panel Bubliny na karté Tvary v postranni listé.

Uprava textovych bublin

1) Dvojitym klepnutim do pole bubliny prejdeme do textového rezimu, v ném mdZeme text
upravovat a forméatovat. DalSi informace o formatovani textu najdeme v ¢asti
»=Formatovani textu“ na strance 215.

2) Kliknutim do prazdného mista na vykresu zmény textu ulozime.
3) Vybereme pouze textovou bublinu, zobrazi se Gchyty pro vybeér.
4) Ujistime se, Ze text v bubliné NENI vybran.

5) Kliknutim pravym tlaCitkem mysi na text a vybé&rem moznosti z kontextové nabidky
mUzete zménit atributy pozice, velikosti, Fadku a oblasti textu. Dal$i informace nalezneme
v kapitole 3, Prace s objekty, a v kapitole 4, Zména atribut(i objekt(.

6) Klepnutim na Gchyt vybé&ru na konci spojovaci ¢ary a jeho pretazenim mdzeme zménit
polohu konce ¢ary nebo délku spojovaci cary.

7) Vybereme textovou bublinu a dialogové okno Umisténi a velikost (obrazek 227 pod)
otevieme jednim z nasledujicich zplsobu:

— Klepneme pravym tlaCitkem mySi na vybranou bublinu a z mistni nabidky vybereme
moznost Umisténi a velikost.

— V hlavni nabidce vybereme Format > Umisténi a velikost.

— Stiskneme klavesu F4.

8) Kliknutim na stranku Bublina otevieme mozZnosti formatovani dostupné pro textové
bubliny.

9) Styl textové bubliny vybereme z moznosti Pfimka, Kfivka nebo Zak¥ivena spojnice

10) Do pole Vzdalenost zadame velikost poZzadované mezery mezi koncem Cary bubliny a
rdmeckem bubliny.

11) V poli Rozsifeni z dostupnych moZnosti vybirame zpUsob, jakym spojnice bubliny
vychazi z pole textu.

Urmnisténi a velikost X

Umisténi a velikest  Bublina

i ]

Zakfivena spojnice

VWzdilenost: 0,00 mm

Roziifent: Vodorovné V| Urnistént: |Upru:::5tFEu:| w

élka 0,00 mm Optimalni

Obrazek 227: Dialogové okno Umisténi a velikost — stranka Bublina
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12) Pokud vybereme Shora nebo Zleva z rozeviraciho seznamu RozSifeni a zadame
vzdalenost v poli O:, vytvofime mezeru mezi pocate¢nim bodem spojnice a rameckem
bubliny.

13) Pokud vybereme Vodorovné nebo Svisle z rozeviraciho seznamu RozSifeni, zadame
nastaveni umisténi z rozeviraciho seznamu Umisténi a nastavime umisténi, kde bude
¢ara spojnice pfipoje k ramecku bubliny.

14) Do pole Délka zadame délku spojnice mezi vychozim bodem a bodem ohybu.

15) Vybérem mozZnosti Optimalni se zalomeni spojnice vytvofi v optimélni vzdalenosti od
textového pole bubliny.

16) Klepnutim do prazdného mista v kresbé zruSime vybér textové bubliny a zmény ulozime.

MozZnosti textovych bublin
Styly bublin
Z dostupnych moznosti vybereme pozadovany styl bubliny.

Vzdalenost
Zadame velikost pozadované mezery mezi koncem fadku bubliny a rameckem bubliny.

Rozsifeni
Zvolime, kam a jak bude fadek bubliny vystupovat z ramecku bubliny.

Délka
Zadame délku ¢ary bubliny, ktera se tAhne od ramecku bubliny k inflexnimu bodu Cary.

Optimalni zobrazeni
Tuto mozZnost vybereme, chceme-li zobrazit jeden fadek v optimalnim umisténi.

ﬁ Poznamka

Moznost Délka je dostupna pouze tehdy, kdyz je vybrana volba Zak¥ivena spojnice
jako styl bubliny a neni ozna¢ena volba Optimalni.

Tabulky v aplikaci Draw

Tabulky jsou, pokud jsou v kresbé pouzity, Gé¢innym nastrojem pro rychlé predani strukturovanych
informaci. Tabulky Ize do vykresu pfidavat pfimo, ¢imz odpada nutnost vkladat tabulku z aplikaci
Calc nebo Writer. Doporucujeme vSak tabulku z Calcu do vykresu vloZit, pokud je v tabulce
vyzadovana vétSi funkcionalita. Tabulky poskytované nastroji aplikace Draw ji maji omezenou.

ﬁ Poznamky

Tabulky jsou umistény uprostied kresby a nelze je umistit do objekt(i nebo tvari. Na
rozdil od textovych poli a jinych objektll nelze tabulky otacet, ale Ize je pfemistovat.

PFi vkladani tabulek do kresby se tabulka vytvofi pomoci vychoziho stylu s jiz
pouzitym nastavenim. V soucasné dobé jsou tyto vychozi hodnoty v LibreOffice
pevné zakédovany. Tabulku Ize po vloZeni naforméatovat podle pozadavki kresby.

Pokud néstrojovou liStu Tabulka nevidime, pfejdeme do nabidky Zobrazeni >
Nastrojové listy > Tabulka. Nastrojova lista Tabulka se obvykle nachazi v dolni ¢asti
okna Draw.
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Vkladani tabulek

Dialogové okno Tabulka

1) V hlavni nabidce zvolime Vlozit > Tabulku, otevie se dialogové okno Vlozit tabulku
(obrazek 228 pod).

2) Zadame pozadovany pocet fadkl a sloupcd.
3) Klepnutim na OK vloZime tabulku do stfedu kresby a zavieme dialogové okno.

4) Tabulku pfesuneme na misto klepnutim na jeji ohraniCeni a jejim pfetazenim do nového

umisténi.
Viozit tabulku >
Poéet sloupcd: 5 -
Podet fadki: 2 =
MNapovéda Zrugit
Obréazek 228: Dialogové okno VioZit tabulku
Tabulka v X

Ev Ev@v HHv|Bawa v|ﬂﬁ_7
BT+ = | F e R | BB

Obrazek 229: Nastrojova lista Tabulka

Tabulka

Dal&i moZnosti...

Obréazek 230: MriZka tabulky
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Obrazek 231: Panel navrhu tabulky na karté Vlastnosti v
postranni liSté
M¥iZka navrhu tabulky

1) Klepnutim na Tabulka na Standardni nastrojové listé (obrdzek 229 nad) otevieme mfizku
navrhu tabulky (obrazek 230 nad).

2) Klepneme a tdhneme kurzor, dokud neni vybran pozadovany pocet sloupct a Fadkd,
3) DalSim klepnutim vioZime tabulku do stfedu kresby a zavieme mfizku tabulky.

4) V pripadé potfeby klepnutim na DalSi moZnosti otevieme dialogové okno VloZit tabulku,
kde vybereme pozadovany pocet fadkd a sloupci.

5) Tabulku pfesuneme na misto klepnutim na jeji ohranieni a jejim pfetazenim do nového
umisténi.
Panel Navrh tabulky

V panelu Navrh tabulky na karté Vlastnosti v postranni listé je k dispozici nékolik
preddefinovanych navrhi tabulek (obrazek 231 nad). Panel Navrh tabulky je k dispozici tehdy,
mame-li tabulku vybranou.
Vkladani navrhd tabulky

1) Vlozeni tabulky do kresby nebo vybér tabulky v kresbé.

2) Kliknutim na Navrh tabulky na karté Vlastnosti postranni liSty otevieme panel Navrh
tabulky a zobrazime dostupné vzory.

3) Z dostupnych navrhli vzhledu tabulky jeden vybereme.
4) Radky a sloupce tabulky se formatuji podle vybrané pfedlohy panelu Navrh tabulky.

5) Pripadné klikneme pravym tlacitkem mysi v postranni listé na vybrany navrh tabulky a v
kontextové nabidce vybereme moZznosti formatovani radkl a sloupcd.
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Vytvareni navrhi tabulky
1) Do vykresu vloZime novou tabulku a vybereme ji.

2) Klepnutim na Navrh tabulky na karté Vlastnosti v postranni li5té otevieme panel Navrh
tabulky nebo klepneme na Navrh tabulky na nastrojové listé Tabulka.

Obrazek 232: Priklad tabulky s pruhy v radcich i sloupcich
3) Kliknutim na znaménko plus v panelu Navrh tabulky vytvofime novy navrh.

4) Ujistime se, Ze je vybran novy navrh, a poté naformatujeme fadky a sloupce z
dostupnych moznosti uvedenych pod panelem Navrh tabulky.

5) Pfipadné klikneme pravym tlacitkem mysi v postranni listé na novy navrh tabulky a v
kontextové nabidce vybereme moznosti formatovani fadkl a sloupcd.

MozZnosti navrhu tabulky
Radek zahlavi
Vybrano ve vychozim nastaveni. Prvni Fadek je obvykle radek zahlavi a ma obvykle
odlisné pozadi od zbytku tabulky.

Radek souétu
Pokud je vybrana, zméni pozadi posledniho fadku, aby se odliil od ostatnich rfadkd.

Pruhované radky

Vybrano ve vychozim nastaveni. Stfidavé radky maji odliSné pozadi, coz usnadruje Cteni
dat v fadcich, jak ukazuje pfiklad na obrazku 232 nad.

Prvni sloupec

Pokud je volba vybrana, zvyrazni se prvni sloupec tabulky tmavsim pozadim.
Posledni sloupec

Pokud je volba vybrana, zvyrazni posledni sloupec tabulky tmavSim pozadim.
Pruhované sloupce

Po vybéru jsou sloupce stfidavé zvyraznény tmavou a svétlou barvou pozadi.

Formatovani tabulky

Vybranou tabulku formatujeme pomoci nastrojli a mozZnosti dostupnych na nastrojové listé
Tabulka, pomoci pfikazu nabidky Format > Tabulka nebo pomoci moZnosti dostupnych v
dialogovém okné Vlastnosti tabulky.

Nastrojova lista Tabulka

PTi vybéru tabulky se automaticky otevie nastrojova lista Tabulka (obrazek 229 na strané 231),
ktera obsahuje nastroje pro vytvareni a forméatovani tabulky. Vychozi pozice ukotveni nastrojovée
liSty je v dolni Casti pracovni plochy LibreOffice Draw.
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Tabulka

VloZi novou tabulku do kresby pomoci dialogového okna VlozZit tabulku nebo mfizky
navrhu tabulky. DalSi informace o vkladani tabulek najdeme v ¢asti ,,Vkladani tabulek na
strance 231.

Styl ohrani€eni

Zméni styl ¢ar na okrajich vybranych bunék. Kliknutim na trojuhelnik v vedle Styl
ohraniéeni otevieme rozeviraci seznam a vybereme si z fady preddefinovanych styld.

Barva ohraniceni

Zmeéni barvu okrajd vybranych bunék. Kliknutim na trojahelnik v vedle Barva ohraniéeni
ziskédme pfistup k dostupnym barevnym paletdm LibreOffice. Vybereme barvu z fady
preddefinovanych palet nebo vytvofime vlastni barvu.

Karta Ohranic¢eni

Vybereme preddefinovanou konfiguraci ramecku pro vybranou tabulku nebo buriky.
Kliknutim na trojuhelnik v vedle Ohrani€eni otevieme rozeviraci seznam pro volbu
konfigurace ohraniceni.

Styl | vyplh oblasti

Vybereme buriky, které maji mit vyplii a poté vybereme typ vypiné z rozeviraciho
seznamu: Zadna, Barva, Pfechod, Srafovani, Rastr, VVzorek, PouZit pozadi snimku.

Barva vyplné

V rozeviraci nabidce vybereme moznost vyplné. Moznosti vyplné se zméni a zobrazi
vypIné dostupné pro kazdy typ Stylivypli oblasti.

Slougdit bunky

Slouci vybrané burky do jedné. VSimneme si, Ze obsah slou¢enych bunék je také
sloucen. Pfipadné klepneme pravym tlaCitkem mysi na vybrané buriky a z mistni nabidky
vybereme moznost Slouéit bunky.

Rozdélit bunky

Rozdéli vybranou buriku na vice bunék ve vodorovném nebo svislém sméru. Ujistime se,
Ze je kurzor umistén na burice, a klepnutim na Rozdélit buniky otevieme dialogové okno
Rozdélit buniky (obradzek 233 pod).

V Rozdélit buriku na vybereme pozadovany pocet bunék pfi rozdéleni bunky a zda
chceme bunku rozdélit Vodorovné nebo Svisle. V pfipadé potfeby pfi horizontalnim
déleni vybereme moznost Do stejného poméru, aby vznikly stejné velké bunky. Obsah
rozdélené buriky zUstava v plvodni burice — levé nebo horni.

Optimalizovat

Rovnomérné rozdéli vybrané fadky a sloupce v tabulce bud vodorovné, nebo svisle.
Klepnutim na Optimalizovat se otevie vyskakovaci nastrojova lista, ktera obsahuje
nasledujici nastroje:

Minimalni vyska radku
Ur€uje minimalni vySku fadku pro vybrané fadky. Minimalni vyska fadku zavisi na
velikosti pisma nejvétsiho znaku v fadku.

s oy

Minimalni Sifka sloupce

7 sy 7 sy

Definuje minimalni $ifku vybranych sloupct. Minimalni Sitku sloupce uréuje nejdelsi
polozka ve sloupci.
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Rozdélit buriky *

Rozdélit
Rozdélit bufiku na: P :
Smér
E O Vodorovné
(] Ma stejné &asti
[T]O svisle

MNapovéda oK l Lrudit

Obréazek 233: Dialog Rozdélit buriky
Optimalni vyska radku
Urci optimalni vySku radku pro vybrané fadky. Optimalni vyska fadku zavisi na velikosti
pisma nejvétSiho znaku v fadku.
Optimalni Sirka sloupce
Definuje optimalni Sitku sloupce pro vybrané sloupce. Optimalni Sifka sloupce zavisi
na nejdelSi poloZce ve sloupci.
Rovnomeérné rozdéleni radka
Upravi vysku vybranych fadk( tak, aby odpovidala vy3ce nejvyssiho fadku ve vybéru.
Rovnomérné rozdéleni sloupct

.....

Celkova Sitka tabulky nesmi pfesahnout Sifku stranky.
Zarovnat nahoru, Svisle na stfed, Zarovnat dolt
Nastavi svislé zarovnani textu ve vybranych burikéch.

Vlozit Fradek nahofe, vilozit fadek dole

Klepnutim do buriky nebo bunék vybereme fadky a pomoci téchto dvou nastrojl vioZime
fadek nebo radky nad nebo pod vybrané fadky. Pfipadné klepneme pravym tlaitkem
mysi na vybrané radky a vybereme VloZit > VloZzit Fadek nad nebo VloZit fadek pod.

Vlozit sloupec pred, vlozit sloupec za

Klepnutim do buriky nebo bunék vybereme sloupce a pomoci téchto dvou nastroji
vloZime sloupec nebo sloupce pred nebo za vybrané sloupce. Pfipadné klepneme
pravym tlac¢itkem mysi na vybrané sloupce a vybereme Vlozit > Vlozit sloupec pred
nebo Vlozit sloupec za.

Odstranit fadek, Odstranit sloupec, Odstranit tabulku

Klepnutim do buriky nebo bunék vybereme radky nebo sloupce a poté klepnutim na
néastroj vybrané fadky nebo sloupce odstranime. Chceme-li odstranit celou tabulku,
umistime kurzor do burky a vybereme Smazat tabulku. Pfipadné klepneme pravym
tlacitkem mysi do vybranych bunék a z mistni nabidky vybereme Smazat > Smazat
fadek nebo Smazat sloupec nebo Smazat tabulku.

Vybrat tabulku, Vybrat sloupec, Vybrat fadek

Vybereme tabulku, sloupec nebo fadek, pokud maji byt stejné atributy pouZzity na tabulku,
sloupec nebo Fadek.
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Navrh tabulky
Kliknutim na tento nastroj otevieme panel Navrh tabulky na karté Vlastnosti v postranni
listé. DalSi informace naleznete v Casti ,Panel Navrh tabulky” na strance 232.

Vlastnosti tabulky

Kliknutim na tento nastroj otevieme dialogové okno Vlastnosti tabulky. Pfipadné
klepneme pravym tlaCitkem mysSi na tabulku a z mistni nabidky vybereme moznost
Vlastnosti tabulky.

Hlavni nabidka
Pfejdeme do nabidky Format > Tabulka a v podnabidce vybereme moznost forméatovani.
Minimalni vySka rfadku
Ur€uje minimalni vysku fadku pro vybrané fadky. Minimalni vySka fadku zavisi na
velikosti pisma nejvétsiho znaku v fadku.
Optimalni vyska fadku
Ur¢i optimalni vySku radku pro vybrané radky. Optimalni vySka radku zavisi na velikosti
pisma nejvétSiho znaku v fadku.

Rovnomeérné rozdéleni sloupcti

Celkova Sitka tabulky nesmi pfesahnout Sifku stranky.
Vybrat fadek

Vybere fadek nebo fadky, ve kterych byly v tabulce vybrany buriky.
Vlozit fadku

Vlozi fadky do tabulky, kde byly vybrany buriky v tabulce.

Smazat fadek
Odstrani Fadky tabulky, ve kterych byly vybrany buriky tabulky.

7 M v

Minimalni Sifka sloupce

Definuje minimalni $ifku vybranych sloupct. Minimalni Sitku sloupce uréuje nejdelsi
polozka ve sloupci.

7 vy

Optimalni Sifka sloupce

7 sy N

Definuje optimalni Sitku sloupce pro vybrané sloupce. Optimalni Sifka sloupce zavisi na
nejdelSi poloZce ve sloupci.

Rovnomérné rozdéleni sloupci

s s

v 7y

Celkové Sitka tabulky nesmi pfesahnout Sifku stranky.

Vybrat sloupec
Vybere sloupec nebo sloupce, ve kterych byly vybrany buriky v tabulce.

Vlozit sloupce
Vlozi sloupce do tabulky, kde byly vybrany bunky v tabulce.

Smazat sloupec
Odstrani sloupce tabulky, ve kterych byly vybrany burky tabulky.

Slougdit bunky
Slouci vybrané buriky do jedné. Obsah slou¢enych bunék se rovnéz slouci. Pfipadné
klepneme pravym tlaCitkem mysi na vybrané buiiky a z mistni nabidky vybereme
moZznost Sloucit burnky.
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Rozdélit bunky

Rozdéli vybranou buriku na vice bunék ve vodorovném nebo svislém sméru. Ujistime se,
Ze je kurzor umistén na burice, a klepnutim na Rozdélit buriky otevieme dialogové okno
Rozdélit buriky (obradzek 233 na strance 235). V Rozdélit buriku na vybereme
poZadovany pocet bunék pfi rozdéleni burky a zda chceme buriku rozdélit Vodorovné
nebo Svisle. V pfipadé potieby pfi horizontalnim déleni vybereme Na stejné casti, aby
vznikly bunky stejné velikosti. Obsah rozdélené buriky zlstava v pdvodni burice — levé
nebo horni.

Smazat tabulku

Chceme-li odstranit celou tabulku, umistime kurzor do buiky a vybereme moZznost
Smazat tabulku. Pfipadné klikneme pravym tlacitkem mysSi na vybrané burnky a z
kontextové nabidky vybereme moZnost Odstranit tabulku.

Vybrat...
Vybere celou tabulku.

Vlastnosti...
Otevrie dialogové okno Vlastnosti tabulky.
Dialog Vlastnosti tabulky

Dialogové okno Vlastnosti tabulky obsahuje pét karet, které poskytuji moZnosti formatovani pro
Pismo, Efekty pisma, Ohraniceni, Pozadi a Stin. Dialogové okno Vlastnosti tabulky otevieme
jednim z nasledujicich zplsobu:

+ Klikneme pravym tlaCitkem mysi do tabulky a z mistni nabidky vybereme Vlastnosti
tabulky.

* Jdeme do nabidky Forméat > Tabulka > Vlastnosti.
* Na nastrojové listé Tabulka klikneme na ikonu Vlastnosti tabulky.

Wlastnosti tabulky X
Pismo  Efekty propismo  Ohranifeni  Pozadi  Stin
Zapadni Asijske
Pismo:  Liberation Sans Pismo:  Microsoft YaHei

Liberation Sans
Liberation Sans Marrow

Liberation Serif

Linux Biclinum G

Linux Libertine Display G
Linux Libertine G

Lucida Bright

Lurida Callinranhar

Microsoft YaHei
Microsoft YaHei Light
Microsoft YaHei Ul
Microsoft YaHei Ul Light
Microsoft Yi Baiti
MingLiU-ExtB
MingLiU_HKSCS-ExtB
Minal il MSCS-FvtR

Styl: Béiné i Styl:
Velikost: 18 pt &5 Velikost: 18 pt
Jazylk: Cettina & Vlastnosti... Jazylk: Cinttina (zjedn.) & Vlastnosti
Stejné pismo bude pouZito na tiskarné i na cbrazovce, Stejné pismo bude pouZito na tiskarné i na cbrazovee,
i i =
Lorem ipsum AZ#] MAE
Napovéda Obnovit Zrusit

Obrazek 234: Dialogové okno Vlastnosti tabulky — stranka Pismo
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Vlastnosti tabulky X

Pismo  Efekty pro pismo  Ohrani¢eni  Pozadi  Stin

Barva pisma

Barva plsma: I 5vitle cervena 1 ¥ | Prihlednost 0% -
Dekorace textu

Madtrieni: Tuéné ~ ‘ I:l Automaticka "7

Pretkrinuti:

Podtrieni: (Zadng) - ‘ Automaticka

[ Jednatliva slova

Efekty

Velikost; |iZadne) ~]

Relief: |Eia'dn)'f]| — | Oobrys [ stin

Znacka zvyraznéni: |[ia'dna']l e |

Umisténi:

Lorem ipsum A< HEAS

Napovéda Obnovit ZFrudit

Obrazek 235: Dialogové okno Vlastnosti tabulky — stranka Efekty pisma

MozZnosti formétovani na kazdé strance dialogového okna jsou néasledujici:

Pismo

Na obrazku 234 nad vybereme poZadované Pismo, Styl, Velikost a Jazyk pro text v
tabulce. V nahledu se zobrazuje ukazka vybraného pisma. Dal3i informace o pismech
nalezneme v PriruCce aplikace Writer.

Efekty pro pismo

Na obrazku 235 nad vybirame Barvu pisma, Dekoraci textu a Efekty pro text v tabulce.
V poli nahledu se zobrazuje ukazka zvolenych efektd pisma. Dalsi informace o efektech
pisma naleznete v Priru¢ce aplikace Writer.

Vlastnosti tabulky X

Pismo  Efekty propismo  Ohraniceni  Pozadi  Stin
Usporadani &ar Okraj
Predlchy: B HIH H Wlevo: 0,10cm

Definované uZivatelem: Vpravo: 0,10cm

Mahore: 0,10 cm

Cole: 010cm
a Synchronizovat

Cara
Styl —— -
Barva: - Zelena =

Tloustka: |Velmi tlusta (4.5pt) ~

Obrazek 236: Dialogové okno Vlastnosti tabulky — stranka OhraniCeni
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Vlastnosti tabulky X

Pismo  Efekty pro pisme  Chranigeni  Pozadl  Stin

Tadna Prechod Obrazek Vzorek Srafovani
Barvy Alctivni MNova
EEEEEN
EEEEEEEE R
R 114 R 114 =
EEE G 159 G 159 =
EEEEEEEN B 207 B 207 z
EEEEEEEEEN m———
AEEEEEEEEEN HTML  729fcf HTML 72%cf
EEEEEEEEEEEE
EEEEEEEEEEEE -
Posledni banry
EEEEN
Vlastni paleta
Pridat Smazat
MNapovéda Obnovit oK Fruit

Obréazek 237: Dialogové okno Vlastnosti tabulky — stranka Pozadi

Vlastnosti tabulky X

Pismo  Efekty propismo  OChrani¢eni  Pozadi  Stin

Viastnosti Nahled
B Pousit stin

0

.
A

Barva: - Cervens S
Vzdalenost  0.70cm -

Rozostfeni:  [fali

H— N

0

Prihlednost: 0%

Obrazek 238: Dialogové okno Vlastnosti tabulky — stranka Stin

Karta Ohraniéeni
Na karté - obrazek 236 nad vybirame Usporadani &ar, Caru a Okraj pro ohrani¢eni
tabulky a bunék. Tyto moZnosti jsou podobné nastrojim Styl ohrani¢eni, Barva
ohrani€eni a Ohranic¢eni na nastrojové listé Tabulka. Vice informaci o pouziti €ar pro
ohrani¢eni tabulky a buriky najdeme v kapitole 4, Zména atributd objektu.

Pozadi
Na karté - obrdzek 237 nad vybirdme pozadi jako vyplf oblasti tabulky a/nebo vybranych
bunék. Tato karta dialogového okna nabizi stejné funkce jako nastroj Styllvypli oblasti
na nastrojové listé Tabulka. DalSi informace o stylu oblasti a vyplni pouzivané pro pozadi
tabulek a bunék najdeme v kapitole 4, Zména atribut(i objektu.

Stin
Karta - obradzek 238 nad umozZziiuje tabulce pfidat stin. MoZnosti upravuji vzhled a polohu
stinu. Vice informaci o stinech tabulky najdeme v kapitole 4, Zména atributd objektu.
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Umisténi a velikost tabulky

Tabulky jsou pfi vytvareni umistény do ramcd. To umoziiuje forméatovat tabulky stejné jako
objekty Draw. Po vybéru tabulky zménime jeji polohu a velikost nékterou z nasledujicich metod.
Dalsi informace o umisténi a zméné velikosti najdeme v €asti , Textova pole“ na strané 205 a v
kapitole 3, Prace s objekty.

» Klepneme na okraj tabulky a pfetdhneme ji na nové misto.
 Kliknutim a pfetazenim uchytu vybéru zménime velikost tabulky.

» Otevieme dialogové okno Umisténi a velikost a pouZijeme moZznosti dostupné na strance
Umisténi a velikost (obrazek 239 pod). Pro tabulku nelze pouZzit mozZnosti dostupné na
strankach Otoceni, a Naklonéni a polomér rohu.

Po vybéru tabulky otevieme dialogové okno Umisténi a velikost jednim z nasledujicich zplsobd:

» Klepneme pravym tlaCitkem mySi na tabulku a z mistni nabidky vybereme Umisténi a
velikost.

* Prejdeme do nabidky Format > Umisténi a velikost.

» Stiskneme klavesu F4.

ﬁ Poznamka

Kdyz se zmeéni velikost ramce tabulky, zvétSi se nebo zmenSi také obsah tabulky a
bunék tak, aby odpovidal velikosti rAmce tabulky.

Urnisténi a velikost >

Umisténi a velikost  Otofeni  Maklonéni a polomér rohu

Umisténi
Pozice X: - @ O O
Pozice: 2.80cm = (L O J‘
Lol
Lakladni bod:
Velikost
Sifka: 14,10 em = @ » .
. 9a (L ﬁ
Vytka: 2,79 cm =1 J O
Lo
ZLakladni bod:
Zamknout Prizpisobit
i () Umisténi Sitka podle texty
(] Velikost \Viyika podle textu

Mapovéda Obnovit frugit

Obrazek 239: Dialogové okno Umisténi a velikost
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Odstranéni tabulky
Cela tabulka

Ujistime se, Ze je tabulka vybrana a Uchyty vybéru jsou viditelné na okraji tabulky. Poté tabulku
odstranime nékterou z nasledujicich moznosti:

» Pfejdeme na Format > Tabulka > Smazat tabulku v hlavni nabidce.
* Na nastrojové listé Tabulka vybereme Smazat tabulku.

* Klepneme pravym tlaCitkem mysi na tabulku a z mistni nabidky vybereme moznost
Smazat > Smazat tabulku.

Rédek nebo sloupec

Kliknutim na buriku tabulky odstranime fadek nebo sloupec tabulky jednim z nasledujicich
zpUlsobi. Zkontrolujeme, Ze Gchyty vybéru tabulky NEJSOU zobrazeny.

» Pfejdeme do nabidky Format > Tabulka > Smazat fadek nebo Smazat sloupec.
* Na nastrojové listé Tabulka vybereme Smazat fadek nebo Smazat sloupec.

* Klepneme pravym tlacitkem mysi a z mistni nabidky vybereme moznost Smazat >
Smazat fadek nebo Smazat sloupec.

Obsah bunky

Obsah bunék v tabulce odstranime nasledujicim zplsobem:
1) Vybereme burku nebo buriky.
2) Stiskneme klavesu De lete nebo Zpét na klavesnici.

Pouzivani poli

Pole umoZznuji automatické vkladani textu do vykresu a pouzivaji se pfi vytvafeni Sablon a
predloh vykres(. Vice informaci o $ablonach a predlohach kresby najdeme v kapitole 11,
Pokrocilé techniky kresleni.

Vkladani poli
P¥i vytvareni pole se textové pole pole vilozi do stfedu vykresu a Ize jej pfemistovat stejné jako
jakékoli jiné textové pole. Vice informaci najdeme v ¢éasti ,Textova pole" na strané 205.

1) Pfejdeme do nabidky Vlozit > Pole a vybereme pozadovany typ pole.

2) V pripadé potfeby zménime polohu a velikost textového pole.

3) V pfipadé potfeby naformatujeme text pole. Vice informaci viz ,Formatovani textu“ na
strané 215.

Typy poli

Datum (neménné)

Vlozi aktuélni datum do kresby jako pevné pole. Datum se neaktualizuje. Dostupné
formaty data zavisi na nastaveni jazyka v Nastroje > MozZnosti > Jazykova nastaveni >
Jazyk (macOS LibreOffice > Pfedvolby > Jazykova nastaveni > Jazyk). Klepneme
pravym tlaCitkem mysi na pole data a z mistni nabidky vybereme poZadovany format
data.
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Datum (proménnad)

VloZzi aktualni datum do kresby jako proménné pole. Datum se automaticky aktualizuje pfi
kaZzdém otevieni souboru. Dostupné formaty data zavisi na nastaveni jazyka v Nastroje
> Moznosti > Jazykova nastaveni > Jazyk (macOS LibreOffice > Pfedvolby >
Jazykova nastaveni > Jazyk). Klepneme pravym tlaCitkem mysi na pole data a z mistni
nabidky vybereme pozadovany format data.

Cas (neménny)
Vlozi aktuélni ¢as do kresby jako pevné pole. Cas se neaktualizuje. Dostupné ¢asové
formaty zavisi na nastaveni jazyka v Nastroje > Moznosti > Jazykova nastaveni >
Jazyk (macOS LibreOffice > Pfedvolby > Jazykova nastaveni > Jazyk). Klepneme
pravym tlacitkem mysi na pole s €asem a z mistni nabidky vybereme pozadovany format
casu.

Cas (proménna)
Vlozi aktuélni ¢as do kresby jako proménné pole. Cas se automaticky aktualizuje pfi
kazdém otevieni souboru. Dostupné Casové formaty zavisi na nastaveni jazyka v
Nastroje > Moznosti > Jazykova nastaveni > Jazyk (macOS LibreOffice > Predvolby
> Jazykova nastaveni > Jazyk). Klepneme pravym tlaCitkem mysSi na pole s Casem a z
mistni nabidky vybereme pozadovany format ¢asu.

Autor

VloZi jméno a pfijmeni autora kresby. Informace se prebira z uzivatelskych Gdajl
uloZenych v LibreOffice. Chceme-li tyto informace upravit, pfejdeme do Nastroje >
MozZnosti > LibreOffice > UZivatelské tdaje (macOS LibreOffice > Pfedvolby >
LibreOffice > UZivatelské udaje).

Cislo stranky

Vlozi &islo stranky do aktudlni kresby. Pfipadné prejdeme na Vlozit > Cislo stranky v
hlavni nabidce. Pokud ma byt ke kazdé strance kresby pfidano Cislo stranky, pfejdeme
na Zobrazit > Pfedloha v hlavni nabidce a vloZime pole s Cislem stranky.

Nazev stranky
VlozZi nazev stranky. Pokud stranka nebyla pfejmenovana, je vychozi nazev Stranka #.

Pocet stranek
Vlozi celkovy pocet stranek kreshy.

Nazev souboru
Vlozi nazev souboru pouzitého pro kresbu. Nazev souboru se zobrazi az po jeho ulozeni.

Hypertextové odkazy

PTi vkladani textu, ktery lze pouzit jako hypertextovy odkaz (napfiklad adresu webové stranky
nebo URL), jej Draw automaticky zformatuje a vytvori hypertextovy odkaz a pouZije barvu a
podtrzeni. Existuji ¢tyfi typy hypertextovych odkaz( a kazdy typ vyzaduje jiny postup pfi vkladani
hypertextového odkazu.

/? Poznamka

Chceme-li LibreOffice zabranit v automatickém pfevadéni webovych adres nebo
adres URL na hypertextové odkazy, pfejdeme do nabidky Nastroje > Nastaveni
automatickych oprav > MoZnosti a zruSime vybér moznosti Rozpoznavéani URL.
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Tip

Im

Barvu hypertextovych odkaz( zménime v nabidce Nastroje > MoZnosti >
LibreOffice > Barvy aplikaci, pfejdeme na Nenavstivené odkazy a/nebo Navstivené
odkazy, zaskrtneme policka, vybereme z barevné palety nové barvy odkazl a
klikneme na OK. Je tfeba si uvédomit, Ze tato zména barvy zméni barvu vSech
hypertextovych odkaz( ve viech modulech LibreOffice.

Internetovy hypertextovy odkaz
1) Klepneme na textové pole na poZadované misto, kam chceme vloZzit hypertextovy odkaz.

2) V hlavni nabidce vybereme Vlozit > Hypertextovy odkaz nebo pouzijeme klavesovou
zkratku Ctrl + K (macOS 3# + K) a otevieme dialogové okno Hypertextovy odkaz

3) V dialogovém okné Hypertextovy odkaz vybereme Internet a otevieme stranku Internet
(obrazek 240 pod).

4) V &asti Protokol vyberme bud Web nebo FTP.
5) Do textového pole URL zadame pozadovanou webovou adresu hypertextového odkazu.
6) Do pole Text zadame nazev hypertextového odkazu.

7) V pfipadé potfeby zadame Udaje poZzadované pro DalSi nastaveni. DalSi informace
nalezneme v ¢asti ,DalSi nastaveni“ na strané 247.

8) Klepnutim na Pouzit viozime hypertextovy odkaz a ulozime vybér. Pokud vytvafime
nékolik hypertextovych odkazl, klepneme po vioZeni kazdého z nich na PoutZit.

9) Klepnutim na OK zavieme dialogové okno Hypertextovy odkaz.

Hypertextovy odkaz Mail
1) Klepneme na textové pole na pozadované misto, kam chceme vlozit hypertextovy odkaz.

2) V hlavni nabidce vybereme Vlozit > Hypertextovy odkaz nebo pouzijeme klavesovou
zkratku Ctrl + K (macOS 3# + K) a otevieme dialogové okno Hypertextovy odkaz
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Hypertextovy odkaz

Mastaveni hypertextového odkazu
G
URL: | v
Internet
Text:
Dalsi nastaveni
Posit
= Podoba: ‘Text 4
MNazew:
Dokument

]

MNowvy dokument

Napovéda Obnovit PouZit Zavrit
Obrazek 240: Dialogové okno Hypertextovy odkaz — stranka Internet
Hypertextovy odkaz >
Poita
(5] .
Internet Piijemce: 4
Predmét:
- Dali nastaveni
Poita
Podoba: (Text 4
[
= Text:
Dokument MNazev:
Movy dokument
MNapovéda Obnovit PouZit

Zavfit

Obréazek 241: Dialogové okno Hypertextovy odkaz — stranka Posta
3) V dialogovém okné Hypertextovy odkaz vybereme PosSta a otevieme stranku PoSta
(obrazek 241 nad).

4) Do textového pole Prijemce zadame e-mailovou adresu pfijemce.
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5) Do textového pole Predmét zadame pfedmét zpravy.

6) V pripadé potieby kliknutim na Zdroje dat otevieme prohlize¢ zdroji dat a poté
pretahneme datové pole prijemce e-mailu z prohliZzece zdrojli dat do textového pole
Prijemce.

7) V pfipadé potfeby zadame Udaje poZzadované pro DalSi nastaveni. DalSi informace
nalezneme v ¢asti ,DalSi nastaveni“ na strané 247.

8) Klepnutim na Pouzit viozime hypertextovy odkaz a ulozime vybér. Pokud vytvafime
nékolik hypertextovych odkazl, klepneme po vloZeni kazdého z nich na PoutZit.

9) Klepnutim na OK zavieme dialogové okno Hypertextovy odkaz.

Hypertextovy odkaz na dokument

Vytvori hypertextovy odkaz na jiny dokument nebo na jiné misto v dokumentu, bézné
oznacCovany jako zalozka.

1) Klepneme na textové pole na poZadované misto, kam chceme vloZzit hypertextovy odkaz.

2) V hlavni nabidce vybereme Vlozit > Hypertextovy odkaz nebo pouzijeme klavesovou
zkratku Ctrl + K (macOS 3 + K) a otevieme dialogové okno Hypertextovy odkaz

3) V dialogovém okné Hypertextovy odkaz vybereme Dokument a otevieme stranku
Dokument (obrazek 242 pod).

ﬁ Poznamka
Pole Cesta ponechame prazdné, pokud odkaz sméfuje na cil ve stejné kresbé.

4) Do textového pole Cesta zadame cestu k souboru dokumentu.

5) Pripadné klepnutim na Otev¥it soubor otevieme prohlize¢ soubor( a vybereme soubor
jako cil hypertextového odkazu.

6) Chceme-li volitelné zadat cil v konkrétni kresbé, klepnutim na Cil v dokumentu otevieme
dialogové okno pro vybér cile. Pokud je vSak nazev cile znam, zadame jej do textového
pole Cil.
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Hypertextowy odkaz
ﬁﬁi} Dokument
Intemnet Cesta: w
Cil v dokumentu
Cil: -:E}
Poita
URL:
T
L)g Dal3i nastaveni
Dokument Formulaf:  [Text ~
Text:

\j MNazew:

Novy dekument

Obnovit

Napovéda Pouzit Zavfit

Obrazek 242: Dialogové okno Hypertextovy odkaz — stranka
Dokument

7) V pfipadé potfeby zadame Udaje pozadované pro DalSi nastaveni. DalSi informace

nalezneme v &asti ,DalSi nastaveni“ na strané 247.
8) Klepnutim na Pouzit vlozime hypertextovy odkaz a uloZzime vybér. Pokud vytvarime
nékolik hypertextovych odkazd, klepneme po vioZeni kazdého z nich na PouZit.

9) Klepnutim na OK zavieme dialogové okno Hypertextovy odkaz.

Hypertextovy odkaz Novy dokument

Vytvofi novy dokument a hypertextovy odkaz na novy dokument.
1) Klepneme na textové pole na pozadované misto, kam chceme vlozit hypertextovy odkaz.

2) V hlavni nabidce vybereme Vlozit > Hypertextovy odkaz nebo pouzijeme klavesovou
zkratku Ctrl + K (macOS 3 + K) a otevieme dialogové okno Hypertextovy odkaz

3) Pomaci volby Novy dokument otevieme stranku Novy dokument v dialogovém okné

Hypertextovy odkaz (obrazek 243 pod).
4) Na strance Novy dokument vybereme Upravit nyni pro okamzitou Upravu nové
vytvofeného dokumentu nebo Upravit pozdéji pro vytvoreni hypertextového odkazu bez

Upravy vytvofeného dokumentu.
5) V rozeviracim seznamu Typ souboru vybereme typ dokumentu, ktery chceme vytvofit.

6) Klepnutim na volbu Vybrat cestu otevieme prohlize¢ soubor(l a pfejdeme do slozky, kam

bude novy dokument uloZen.
7) Vybereme slozku a klepneme na Otevifit. Vybrana slozka se zobrazi v textovém poli

Soubor.
8) V pfipadé potfeby zadame Udaje pozadované pro DalSi nastaveni. DalSi informace

nalezneme v ¢asti ,DalSi nastaveni“ na strané 247.
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9) Klepnutim na Pouzit vioZime hypertextovy odkaz a uloZime vybér. Pokud vytvafime
nékolik hypertextovych odkazl, klepneme po vioZeni kazdého z nich na PoutZit.

10) Klepnutim na OK zavieme dialogové okno Hypertextovy odkaz.

Hypertextovy odkaz
ﬁﬂ: Novy dokument
GO O Upravit myni O Upravit pozdéji
Internet
Soubor: ~ D
Typ souboru:
Posta Setit |
Prezentace
Kresba
L,:_ Vzorec
Dokument
Dalsi nastaveni
A"

ﬂ Formulaf  (Text

Nowvy dokument Text:

Nazev:

Obnowit Pouzit Zavfit

Obrazek 243: Dialogové okno Hypertextovy odkaz — stranka Novy
dokument

Mapovéda

DalSi nastaveni
Cast Dalsi nastaveni v dialogovém okné Hypertextovy odkaz je spole&na pro viechny typy

hypertextovych odkazl, ackoli nékteré moznosti se tykaji spiSe konkrétnich typd odkazd.

Ramec
Do textového pole Ramec zadame nazev ramce, ve kterém se propojeny soubor otevie,
nebo vybereme preddefinovany ramec ze seznamu. Pokud je textové pole Ramec

prazdné, otevie se odkazovany soubor v aktualnim okné prohlizece.

Formular
UrCuje, zda se hypertextovy odkaz vloZzi jako text nebo jako tlacgitko.

Text
UrCuje viditelny text nebo titulek tlaCitka hypertextového odkazu.

Néazev
Plati pro dokumenty HTML. Ur€uje text pfidany jako atribut NAME v kodu HTML za
hypertextovym odkazem.

Uprava textll hypertextovych odkazti

1) Vybereme hypertextovy odkaz.
2) Klepnutim pravym tlacitkem mySi na hypertextovy odkaz a vybérem moznosti Upravit

hypertextovy odkaz z mistni nabidky otevfeme dialogové okno Hypertextovy odkaz.

3) Provedeme zmeény Uprav pomoci dostupnych moznosti.
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4) Klepnutim na PouZit vloZime hypertextovy odkaz a ulozime vybér. Pokud vytvafime
nékolik hypertextovych odkazl, klepneme po vioZeni kazdého z nich na Poutzit.

5) Klepnutim na OK uloZzime zmény a zavieme dialogové okno Hypertextovy odkaz.

/? Poznamka

P¥i apravach nebo formatovani hypertextovych odkazd NEKLIKAME pfimo na
text hypertextového odkazu. Klepnutim na text hypertextového odkazu se
hypertextovy odkaz otevfe.

Formatovani hypertextovych odkaz(

Do stfedu aktualniho snimku se vloZi hypertextovy odkaz. Chceme-li upravit text, velikost pole s
hypertextovym odkazem nebo jej pfesunout na snimek:

1) Klepnutim a pfetazenim vybérového pole nad text hypertextového odkazu zobrazime
ramecek textového pole a Uchyty pro vybér.

2) Klepneme pravym tlacitkem mySi na vybrany hypertextovy odkaz a z moznosti
dostupnych v mistni nabidce vybereme pozadovany typ formatovani.

3) Chceme-li zménit polohu hypertextového odkazu, klepneme na okraj textu a prfetahneme
jej na snimku.

4) Z mistni nabidky vybereme Umisténi a velikost nebo pomoci klavesy F4 otevieme
dialogové okno Umisténi a velikost. Lze vybrat moZnosti pro pfesun hypertextového
odkazu nebo zménu velikosti textového pole.

Obrazkové mapy

Obrazkova mapa definuje oblasti pouZzivané jako aktivni oblasti na obrazcich, které jsou spojeny
s adresou URL (webova adresa nebo soubor v pocitaci). Aktivni oblasti jsou grafické ekvivalenty
hypertextovych odkaz(. V aplikaci Draw se klepnutim na sledovany bod otevie odkazovana
stranka v prislusném programu (napfiklad vychozi prohlize¢ pro stranky HTML; Writer pro
soubory ODT; prohlize¢ PDF pro soubory PDF).
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Editor obrazkowjich map *

= B zavin |3 OO0 A B

Adresza:

Alternativni text: Ramec:

100%: 50,79 cmx 22,22 cm

Obréazek 244: Dialogové okno Editor obrazkovych map

Aktivni oblasti Ize vytvaret v rliznych tvarech, napriklad obdélniky, elipsy a mnohouhelniky. Do
jednoho obrazku lze zahrnout nékolik aktivnich oblasti. Po klepnuti na aktivni oblast se adresa
URL otevie v zadaném okné nebo rdmu prohlizece. Text Ize zadat také jako nazev aktivni
oblasti, ktery se zobrazi, kdyZz kurzor najede na aktivni oblast.

Vytvareni obrazkovych map
1) V kresbé vybereme obrazek, které chceme pouzit jako aktivni oblast.

2) V hlavni nabidce zvolime Nastroje > Obrazkova mapa a tim otevieme dialogové okno
Editor obrazkovych map (obrazek 244 nad). Hlavni Cast dialogu zobrazuje vybrany
obrazek, v némz budou definovany aktivni oblasti.

3) Z ikon v horni &asti dialogového okna Editor obrazkovych map vybereme pozadovany typ
aktivni oblasti z moZnosti Obdélnik, Elipsa, Mnohouhelnik nebo Mnohouhelnik od
ruky.

4) Ve vybraném obrazku nakreslime aktivni oblast.

5) Do textového pole Adresa zadame adresu hypertextového odkazu pro aktivni oblast ve
forméatu adresy: file:///<cesta>/nazev_dokumentu#nazev_kotvy.

6) Kliknutim na ikonu Pouzit nastaveni aplikujeme.
7) Klepnutim na UloZzit ulozime obrazkovou mapu do souboru.
8) Klepneme na Zavfit v dialogovém okné Editor obrdzkovych map.
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Nastroje obrazkovych map
Pouzit
Aplikuje zmény.
Oteviit

Nacte existujici obrdzkovou mapu ve formatu MAP-CERN, MAP-NCSA nebo SIP
StarView.

Ulozit

UloZi obrazkovou mapu ve formatu MAP-CERN, MAP-NCSA nebo SIP StarView.
Vybrat

Vybere sledované misto na mapé obrazku k Gpravam.
Obdélnik, elipsa, mnohothelnik, mnohouhelnik od ruky

Vytvori aktivni oblast na vybraném obrazku ve vybraném tvaru.
Upravit body

Upravou kotevnich bodd mGZzeme zménit tvar vybraného kotevniho bodu.
Pfesunout body

Pfesune jednotlivé kotevni body vybrané aktivni oblasti.
Vlozit body

PFida kotevni bod ve vybraném bodé na obrysu aktivni oblasti.
Smazat body

Odstrani vybrany kotevni bod.
Zpét

ZruSi predchozi akci.
Znovu

Znovu pouZije pfedchozi zrusenou akci.
Aktivni

Prepina stav vybrané aktivni oblasti mezi aktivnim a neaktivnim.
Makro

Prifazeni makra, které se spusti po klepnuti na aktivni oblast.
Vlastnosti

Definujeme vlastnosti vybraného sledovaného bodu.

Adresa
Zadame adresu URL souboru, ktery se otevie po klepnuti na vybranou aktivni oblast.
Format adresy, ktery se ma pouZit:
file:///<cesta>/nazev_dokumentu#nazev_kotvy.

Text
Zadame text, ktery se zobrazi, kdyZ kurzor najede na aktivni oblast. Pokud neni zadan
Zadny text, zobrazi se Adresa.

Ramec
Zadame nazev cilového ramce pro aktivni oblast. Z rozeviraciho seznamu Ize vybrat
standardni nazvy ramcl a pouZit je.

_blank
Otevie se v novém okné prohlizecCe.
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_self
Vychozi vybér a otevie se v aktualnim okné.

_top
Soubor se otevie v nejvy3Sim ramci v hierarchii.

_parent
Soubor se otevie v nadfazeném rdmu aktuélniho ramce. Pokud neni Zadny nadfazeny
ramec, pouzije se aktualni.

Grafické zobrazeni
Zobrazi obrazovou mapu, aby bylo moZné vybrat a upravit aktivni oblasti.

)? Poznamka

Hodnota _self pro cilovy snimek funguje ve vétsiné pfipadd. Nedoporucuje se
pouzivat ostatni hodnoty, pokud to neni nezbytné nutné.

Pismomalba

Pismomalba slouzi k vytvoreni grafického textu jako objektu v kresbé. Pro Pismomalbu jsou k
dispozici rizna nastaveni (Cara, plocha, pozice, velikost a dalsi), ktera odpovidaji poZadavkim
kresby. Pismomalba je k dispozici také v modulech Writer, Calc a Impress v LibreOffice. Existuji
vSak drobné rozdily ve zplsobu, jakym jednotlivé moduly LibreOffice Pismomalbu zobrazuiji.

Vytvareni pismomalby

1) V hlavni nabidce zvolime Vlozit > Pismomalba a tim otevieme dialogové okno Galerie
pismomalby (obrazek 245 pod) a vybereme styl pismomalby.

2) Dvakrat klepneme na vybrany styl Pismomalby nebo zvolime OK. Tim se zavfe dialogové
okno Galerie pismomalby a vybrané pismo se zobrazi uprostfed kresby.
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Galerie plsmomalby x

Vyberte styl pismomalby

Style Spow Jtuna blue Snadow
Open (uding Favarie

MNapovéda Zrugit

Obrazek 245: Dialogové okno Galerie pismomalby

calne 2 Favite
sz u,nrmg@@e
raw

Obréazek 246: Priklad vytvoreni textu Pismomalby

Pizmomalba * X
F > vAa| = - & [

Obrazek 247: Nastrojova lista Pismomalba

3) Dvakrat klepneme na objekt Pismomalby a zapneme rezim Uprav. Ukazka textu
Pismomalby se v rezimu Uprav textu zobrazi uprostfed obrazku, jak ukazuje pfiklad na
obrazku 246 nad.

4) V rezimu Uprav zvyraznime cely text, abychom jej vybrali, a poté zadame pozadovany
text, kterym zvyraznény text nahradime.
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5) Stisknutim klavesy Esc nebo klepnutim mimo vybranou oblast aplikujeme novy text, ktery
se zobrazi jako objekt Pismomalby ve stfedu kresby.

6) V pripadé potfeby zménime umisténi a velikost objektu Pismomalby podle poZzadavk(
kresby. Dalsi informace nalezneme v kapitole 3, Prace s objekty, a v kapitole 4, Zména
atributd objektd.

Nastrojova lista Pismomalba

Po vybéru objektu Pismomalby se na pracovni ploSe otevie nastrojova lista Pismomalba
(obrazek 247 nad). Pokud neni nastrojova lista viditelna, zvolime v hlavni nabidce moZznost
Zobrazit > Nastrojové listy > Pismomalba.

Pro Upravu objektu Pismomalby jsou k dispozici nasledujici nastroje.

VloZeni textu Pismomalby
Otevre dialogové okno Galerie pisem.

Tvar pismomalby
Zméni tvar vybraného objektu Pismomalby. Klepnutim na trojuhelnik v vedle Tvar
pismomalby na nastrojové listé Pismomalba otevieme dil€i nastrojovou liStu
Pismomalba. Z dostupnych moZnosti vybereme tvar pisma. Tvary pismomalby jsou k
dispozici také v dilCi nastrojové listé Tvar pismomalby (obrazek 248 pod).

Stejna vysSka pismen pismomalby
Zméni vysku znakl ve vybraném objektu Pismomalby. Pfepina mezi normalnim pismem
s rliznou vyskou znak( a reZimem stejné vysky vSech znaka.

Zarovnani pismomalby
Urcuje zarovnani textu v ramci ramecku. MozZnaosti zarovnani jsou Zarovnani doleva, Na

Stfed, Zarovnani doprava, Do bloku a Roztahnout.

Twar pismomalby v X
D0 O0OdDAVDdAY
CDOrNQNUeo ¢ ) 38e

_ A Dy T
il v () £
Ir: :1' ":_;l‘ ] L+ N (]

Obrazek 248: Dil¢i nastrojova lista Tvar pismomalby

Rozestup znaki pismomalby
Vybira rozestupy mezi znaky a ur€uje, zda se maji pouZzit kerningové pary. Dostupné
moznosti jsou Velmi tésné, Tésné, Normalni, Volné, Velmi volné a Viastni. Pro Viastni
rozestup zadame procentudlni hodnotu: 100 % je normalni rozestup znakd; mensi nez
100 % je tésné&jSi rozestup znakul; vétsi nez 100 % je volnéjsi rozestup znaku.

PFepnout plasti€nost
Prevede objekt Pismomalby na 3D tvar pridanim hloubky znakd. Vice informaci najdeme
v kapitole 7, 3D objekty.

Uprava pismomalby

S objektem Pismomalby se v aplikaci Draw zachazi jako s jakymkoli jinym objektem. Lze ménit
jeho velikost, otacet jej, seSikmit, zkosit, pfevratit atd. DalSi informace o Upravach objektu
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Pismomalby nalezneme v kapitole 3, Prace s objekty, kapitole 4, Zména atribut(l objektu a
kapitole 5, Kombinace vice objekt0.

» Pismo se sklada z textu, ale u textu Pismomalby Ize pouZit pouze minimalni moZnosti
formatovani textu, napfiklad typ pisma, velikost pisma, Tu€né nebo Kurziva.

» Nékteré tvary Pismomalby Ize upravit, coZ je indikovano teCkou na vybraném tvaru.
Zakladni tvary lichobéZniku nebo rovnobézniku miZzeme napftiklad ménit Ghly posunutim
teCky zobrazené pfi viditelnych uchytech vybéru.
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Uvod

Dialogova okna a postupy pro tisk, export a odesilani vykrest e-mailem z aplikace Draw jsou
pouze PRIKLADY. Obsah skute¢nych dialogovych oken a konkrétni postupy zavisi na:

» Typu pocitaCe a jeho nastaveni.
* Operacnim systému pocitaCe a pouzivané softwaroveé aplikaci.
* Typu tiskarny pripojené k pocitaci.

« Zplsobu pfipojeni tiskarny k pogitaci, napiiklad USB kabelem nebo wi-fi.

Vychozi nastaveni tiskarny

Pred tiskem vykres( z aplikace Draw doporu¢ujeme nastavit vychozi tiskarnu pripojenou
k pocitaci. Prfiklad postupu nastaveni tiskarny v aplikaci Draw je nasledujici:

7) Pfejdeme na Soubor > Nastaveni tiskarny v hlavni nabidce a otevieme dialogové okno
Nastaveni tiskarny. Pfiklad dialogového okna Nastaveni tiskarny je na obrazku 249 pod.

8) Vybereme pozadovanou tiskarnu z tiskaren uvedenych v rozeviracim seznamu Nazev.

9) V pripadé potfeby klikneme na Vlastnosti v dialogovém okné Nastaveni tiskarny, ¢imz
otevieme dialogové okno Vlastnosti vybraneé tiskarny a vybereme poZzadované moznosti
pro papir a tiskarnu.

10) Klepnutim na OK ulozime vybér tiskarny a zavieme dialogové okno Nastaveni tiskarny.

Tiskarna

MNazev: Vlastnosti...

Stav: = S eno

Typ:
Umisténi:

Komentar:

Napovéda oK Zrusit

Obréazek 249: Priklad dialogového okna Nastaveni tiskarny

Standardni

RGO 'EIGE

Obrazek 250: Standardni nastrojova lista s nainstalovanou funkci Vytisknout primo

Dokumentace pro LibreOffice je dostupna na https://cs.libreoffice.org/get-help/documentation/



Rychly tisk

Chceme-li rychle vytisknout dokument nebo kresbu, aniz bychom ménili nastaveni tisku,
klepneme na Vytisknout pfimo na Standardni nastrojové listé (obrazek 250 nad), dokument
odeSleme na vychozi tiskarnu pocitace. Vytisknout pfimo odeSle cely dokument na vychozi
tiskarnu definovanou pro dany pocitac.

Pokud ikona nastroje Vytisknout pfimo neni na Standardni nastrojové listé, pfidame ji na liStu
nasledujicim zplsobem:

1) Klepneme pravym tlaCitkem mySi do prazdné oblasti na Standardni nastrojové listé
a z mistni nabidky vybereme moznost Viditelna tlacitka.

2) Vybereme Vytisknout pfimo ze seznamu dostupnych nastrojli a nastroj Vytisknout
pfimo se pfida na Standardni nastrojovou liStu.

Tisk v systému Linux nebo Windows

Chceme-li detailné nastavit tisk v operacnim systému Linux nebo Windows, otevieme dialogové
okno Tisk jednim z nasledujicich zplsob.

* V nabidkové li5té pfejdeme do nabidky Soubor > Tisk.
» PouZijeme klavesovou zkratku Ctril + P.

« Stiskneme tlacitko Tisk na Standardni nastrojové listé.

/? Poznamky

Moznosti vybrané v dialogovém okné Tisk se vztahuji pouze na tisk aktualniho
dokumentu otevieného v aplikaci Draw. VSechny moZnosti tisku vybrané

v dialogovém okné Tisk v aplikaci Draw prepiSou vychozi nastaveni tiskarny
nastavené v nabidce Nastroje > MoZnosti > LibreOffice > Tisk (macOS
LibreOffice > MoZnosti > LibreOffice > Tisk) a Nastroje > MozZnosti > LibreOffice
Draw > Tisk (macOS LibreOffice > MozZnosti > LibreOffice Draw > Tisk).

Obecné moznosti

Na obrazku 251 pod je pfiklad moZnosti nastaveni tisku na strance Obecné dialogového okna
Tisk ve Windows nebo Linuxu.
Tiskarna
Vybereme tiskarnu, kterou chceme pouZit, z tiskaren dostupnych v rozeviracim seznamu.

Stav:
Oznacuje, zda je vybrand tiskarna vychozi tiskarnou.

Vlastnosti
Klepnutim na Vlastnosti otevieme dialogové okno vlastnosti pouzivané tiskarny.
MozZnosti dostupné v tomto dialogu zavisi na typu tiskarny pfipojené k pocitaci a na
pouzitém operacnim systému pocitace.

Rozsah a kopie

VSechny stranky
Vytiskne vSechny stranky dokumentu.

Vybér
Vytiskne stranky vybrané v aplikaci Draw.
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Stranky

Vybereme Cislo (Cisla) stranky, které chceme vytisknout. V pfipadé vice stranek
pouzijeme pro vybér Cisla stranky forméat 1, 3, 7 nebo 1 -5, 7, 9.

Obecné LibreOffice Draw

Tiskarna
[EPSON L800 Series v]

Stav: Vychozi tiskarna Vlastnosti...

210 mm (A4) Rozsah a kopie
® Viechny stranky O Vybér
) Stranky: 1

Zahrnout; |Liché a sudé stranky ~ |
= Dalsi

Strany papiru: |Tiskn0utjednostranné ~ |

e \ Pocet kopi: [ N S
Sefadit

Pofadi: L Viytvorit samostatné tiskové Ulohy pro sefazeny vystup
[ vytisknout v opacném pofadi

297 mm

Rozvrieni stranky

Velikost papiru: ‘A4 210mm x 297mm b ‘

Orientace: |Automaticky ~ |

=l Dalai

@ Stranek na list: |1 ~ | 1
Poradi: |Zleva doprava, potom doll v |

1 Nakreslit ohrani¢eni kolem kaZdé stranky
) Pirucka

Enahted W] € [1 [73 =]y

Napovéda Zrusit

Obrazek 251: Priklad dialogového okna Tisk — stranka Obecné — Windows/Linux

Pocet kopii
Zadame pocet poZadovanych tiSténych kopii dokumentu.

Razeni a strany papiru > Zahrnout
Z rozeviraciho seznamu vybereme Sudé a liché stranky, Liché stranky nebo Sudé
stranky.

Razeni a strany papiru > Strany papiru

V rozeviracim seznamu vybereme jednu z moZznosti: Tisknout jednostranné, Tisknout
oboustranné (dlouhy okraj) a Tisknout oboustranné (kratky okraj).

Razeni a strany papiru > Pofadi > Sefadit

Slouci vice vytisténych kopii do samostatnych dokumentd. Je k dispozici pouze
v pfipadé, Ze tiskneme vice kopii dokumentu.

Razeni a strany papiru > Pofadi > Viytvofit samostatné tiskové tlohy pro sefazeny vystup
Je k dispozici pouze v pfipadé, Ze tiskneme vice kopii dokumentu.
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Razeni a strany papiru > Pofadi > Viytisknout v opacném poradi.
Vytiskne stranky dokumentu v opacném poradi.
RozvrZeni stranek
Velikost papiru
Z rozeviraciho seznamu vybereme formét papiru, ktery chceme pouZit.

Orientace
Vybereme z rozeviraciho seznamu Automaticky, Na vysku nebo Na Sitku.

Pocet stran na list
V rozeviracim seznamu vybereme, kolik stranek se vytiskne na jeden list papiru.

Poradi
Z rozeviraciho seznamu vybereme poradi tisku vice stranek na jeden list papiru.

Nakreslit okraj kolem kaZdé stranky
Pokud je na jeden list papiru vytiSténo vice stranek, je kolem kazdé stranky nakreslen
ramecek.

Prirucka
Vytiskne dokument tak, aby bylo mozné stranky slozit do pfirucky nebo brozury.

Stranka LibreOffice Draw dialogu Tisk

Na obrazku 252 pod je pfiklad moznosti nastaveni tisku na strance LibreOffice Draw
dialogového okna Tisk ve Windows nebo Linuxu.

Obsah
Vybereme-li Nazev stranky a/nebo Datum a Cas, vytisknou se na vykres.

Barva
Viytiskne kresbu v Pdvodnich barvach, Stupnich Sedé nebo Cernobile.

Velikost
Kresbu vytiskneme pomoci jedné z nasledujicich moznosti:

Obecné

Obsah
[ Nazev stranky

[ Datum a éas

297 mm (A4) Barva
® Piavodni barvy
() Stupné 3edi
£ O Cerna a bila
E .
= - \ Velikost
o

® Pivodni velikost

(O Prizplsobit stranku rozsahu tisku

) Rozdélit na vice listd papiru

() Naskladat opakované stranky na papir

Obrazek 252: Priklad dialogového okna Tisk — stranka LibreOffice Draw —
Windows/Linux

Pdvodni velikost
Vytiskne kresbu v plvodni velikosti.
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Prizptsobit strance k tisku

Velikost kresby se zméni tak, aby odpovidala velikosti papiru pouzitého pro tisk.
Rozdélime na vice listl papiru

Pouziva se, pokud je kresba pfilis velka pro pouzity format papiru.
List papiru s opakujicimi se strankami

SlouZi k tisku vice kopii kresby na stranku.

Tisk v systému macOS

Detailni nastaveni tisku v systému macOS rovnéz provedeme otevienim dialogového okna Tisk
jednim z nasledujicich zplsob.

» V nabidkové listé pfejdeme do nabidky Soubor > Tisk.
* Pouzijeme klavesovou zkratku 38+P.

 Stiskneme tlacitko Tisk na Standardni nastrojové listé.

[ ) Print

Printer #» Canon TS6100 series &

Presets Default Settings

<>

i

Pages
© All 2 Pages
Range from 1 to 1

Selection
i " Select pages from the sidebar

@ Pagelof2 Print in Color [ @

Double-sided On

'3

LibreOffice

Media & Quality
Feed: Auto Select - Media Type: Auto Select - Quality: Normal

Layout
1 page per sheet

Paper Handling
Collate Sheets « All Sheets

Watermark
Off

® Page2of2

Printer Info

?  PDF ~ cancel | [EIED

Obrazek 253: Priklad dialogového okna Tisk — stranka Obecné — macOS
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Obecné moznosti

Na obrazku 253 nad je pfiklad moZnosti nastaveni tisku na strance Obecné dialogového okna
Tisk v systému macOS.
Tiskarna
Z rozeviraciho seznamu vybereme tiskarnu, ktera se ma pouzit. Pokud se pouziva
vychozi tiskarna, bude tato tiskarna jiz vybrana.
Predvolby

Z rozeviraciho seznamu vybereme pfedvolbu tisku. Dostupné predvolby zavisi na typu
tiskarny pfipojené k pocitaci. To se tyka i vSech vytvorenych vlastnich pfedvoleb.

Kopie
Zadame pocet kopii, které se maji vytisknout.
Stranky
Vse
Vytiskne vSechny stranky dokumentu.
Rozsah od
Vybereme rozsah Cisel stranek, které chceme vytisknout.
Vybér

V podokné Stranky vybereme stranky, které chceme vytisknout.
Barevny tisk
Tuto moznost vybereme, chceme-li kresbu vytisknout barevné, pokud vybrana tiskarna
umoziuje barevny tisk. ZruSenim vybéru této moznosti vytiskneme vykres €ernobile.
Oboustranny
Tuto mozZnost vybereme, chceme-li kresbu vytisknout oboustranné, pokud vybrana
tiskarna umoznuje oboustranny tisk.
Povoleno

Pokud je tato moZnost vybrana, vytisknou se stranky kresby oboustranné s pouzitim
vazby s dlouhymi okraiji.

Povoleno (kratky)

Pokud je tato moznost vybrana, vytisknou se stranky kresby oboustranné s pouZzitim
vazby s kratkym okrajem.

Moznosti LibreOffice

Stranka LibreOffice Draw dialogu Tisk
Klepnutim na LibreOffice Draw otevieme moZznosti tisku dostupné pro Draw (obrazek 254 pod).
Tisk pouze vybéru
Vytiskne stranky vybrané v podokné Stranky.

Obsah
Vytiskne na kresbu Nazev stranky a/nebo Datum a Cas.

Barva
Viytiskne kresbu v Pdvodnich barvach, Stupnich Sedé nebo Cernobile.

Velikost
Vytiskne kresbu pomoci jedné z nasledujicich moznosti:
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Pdvodni velikost
Vytiskne kresbu v plvodni velikosti.
Prizptsobit strance k tisku
Velikost kresby se zméni tak, aby odpovidala velikosti papiru pouZitého pro tisk.
L Print

Printar A Canon TSE100 series &

Presats Default Settings &

Copies 1
Pages

1 O &l 2 Pages

H Range from 1 to 1

. Selection

Salect pages Trom the sidebar

@ Pagelof 2 erint in Calor O

Dauble-sided an 2

LibreCffica

LibreQffice Draw | More

Print salection only
Contents
Page name
Date and time
Color
© original colars
Grayscale
Black & whita
Siza
D Original size
Fit te printable page
Distribiute on multiple sheets of paper
Tile shiet of pager with repeated pages

@ Page2of 2

Media & Quality
Fead: Autn Salect - Media Type: Auto Sebect « Quality: Marmsal

L eyt
1 page per sheat

Paper Handling
Collate Sheels « All Shaels

Watermark
O

2 por cance

Obrazek 254: Priklad dialogového okna Tisk — stranka LibreOffice Draw —
macOS

Rozdélime na vice list( papiru

Pouziva se, pokud je kresba pfili§ velka pro pouzity format papiru.
List papiru s opakujicimi se strankami

SlouZi k tisku vice kopii kresby na stranku.
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Vice mozZnosti

Pro zpfistupnéni dalSich moznosti tisku v LibreOffice Draw klepneme na DalSi a otevieme
stranku DalSi (obrazek 255 pod).
Pfirucka
Pokud je vybrana tato moznost, vytiskne se dokument tak, aby bylo mozné list\y slozit do
broZury.

Obrazek 255: Priklad dialogového okna Tisk — stranka DalSi moZnosti —
macOS
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Zahrnout
Z rozeviraciho seznamu vybereme, které stranky chceme tisknout: VSechny stranky;
Predni strany / pravé stranky; Zadni strany / levé stranky. K dispozici pouze pfi vybéru
Pfirucka.

Pouzije pouze zasobnik papiru z predvoleb tiskarny
Pokud je vybrana, zasobnik vybrany na tiskarné je nadfazen zasobniku vybranému ve
vlastnostech tiskarny v pocitaci.

VSechny stranky
VSechny stranky vykresu jsou vytiStény.

Stranky
Do textového pole zadame Cisla stranek, ktera se maji vytisknout. V pfipadé vice stranek
pouZzijeme pro vybér Cisla stranky format 1, 3, 7 nebo 1 -5, 7, 9.

Vybér
Vytiskne stranky vybrané v podokné Stranky.

Moznosti médii a kvalita

Kliknutim na Média & Kvalita otevieme rozeviraci seznam s t€mito moznostmi tisku
(obrazek 256 pod).

Zdroj papiru
Pokud ma tiskarna vice nez jeden zasobnik papiru, vybereme z rozeviraciho seznamu
zasobnik papiru, ktery chceme pouzit.

Typ média
Z rozeviraciho seznamu vybereme typ papiru, ktery byl vlioZzen do pouZzitého zasobniku
papiru, napfiklad Obélka, Fotografie, ObyCejny papir.

Kvalita
Vybereme pozadovanou Groven kvality tisku.
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Cancel Print

Obrazek 256: Priklad dialogového okna Tisk — stranka Média a kvalita LibreOffice
—macOS
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Printer & Canon TS6100 series

<>

<

Presets Default Settings

Pages
O All 2 Pages
Range from 1 to 1

Selection
Select pages from the sidebar

® Page10f2 Print in Color [ @

Double-sided On

<

LibreOffice

Media & Quality
Feed: Auto Select - Media Type: Auto Select - Quality: Normal

Layout
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Border None ¢
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Reverse Page Orientation
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Paper Handling
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off
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Obréazek 257: Priklad dialogového okna Tisk — strénka RozloZeni LibreOffice —
macOS

Moznosti rozvrzeni

Kliknutim na RozvrZzeni otevieme rozeviraci seznam s témito moznostmi rozvrzeni dokumentu
(obrazek 257 nad).
Pocet stran na list
V rozeviracim seznamu vybereme, kolik stranek se vytiskne na jeden list papiru.

Smér rozvrzeni
Vybereme pofadi tisku vice strAnek na jeden list papiru.

Ohraniceni

Pokud je na jeden list papiru vytisténo vice stranek, je kolem kazdé stranky nakreslen
ramecek.
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Obracena orientace stranky

Pokud LibreOffice vytiskne stranky v nespravném poradi, vybereme tuto moznost
a vytiskneme dokument znovu.

[ ] Print

Printer &» Canon TS6100 series ¢

Presets Default Settings ¢
- Z' §
UL it
i
1 il . ol Pages
O All 2 Pages
Range from 1[5t 1

Selection
Select pages from the sidebar

® Page 10f2 Print in Color [ @)

Double-sided On

<

LibreOffice

Media & Quality
Feed: Auto Select - Media Type: Auto Select - Quality: Normal

Layout
:E 1 page per sheet
.GJ ® i; ';’ &] . Paper Handling
Collate Sheets [ @)
@ Page 2 of 2 Sheets to Print All Sheets ¢
Sheet Order Automatic ¢

Scale to Fit Paper Size

Destination Paper Size A4 210 by 297 mm ¢

v

Scale Down Only

Watermark

off

Printer Info

? PDF v Cancel

Obrazek 258: Priklad dialogového okna Tisk — stranka Manipulace s papirem
LibreOffice — macOS

Preklopit vodorovné

Pokud LibreOffice vytiskne strdnky v nespravné orientaci, vybereme tuto moznost
a vytiskneme dokument znovu.

MozZnosti manipulace s papirem

Kliknutim na Manipulace s papirem otevieme rozeviraci seznam s nasledujicimi moznostmi
tisku dokumentu o vice stranach (obrazek 258 nad).

Sefradit listy
Po vybéru se vice vytisténych kopii spoji do samostatnych dokumentd.
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Stranky k tisku
Z rozeviraciho seznamu vybereme, které stranky v dokumentu chceme tisknout: VSechny
stranky; Liché stranky; Sudé stranky

Poradi stranek
V rozeviracim seznamu vybereme poradi tisku strdnek: Automaticky; Normalni,
Obraceny.

Skalovat podle velikosti papiru
Prizplsobi vytisténou stranku velikosti papiru.

Velikost cilového papiru
Z moznosti dostupnych v rozeviracim seznamu vybereme format papiru. K dispozici
pouze v pfipadé, Ze byla vybrana moznost Skalovat podle velikosti papiru.

Pouze zmenseni méfitka

Zmensi méfitko vykresu tak, aby se prizpUsobilo velikosti stranky. K dispozici pouze
v pfipadé, Ze vybrana velikost stranky je mensi nez velikost kresby.

Moznosti vodoznaku

Poskytuje moZznosti tisku textu vodoznaku na stranky kresby, napfiklad Divérné, pokud je
dokument citlivé povahy.

Moznosti informaci o tiskarné

Poskytuje informace o pouzivané tiskarné, napfiklad o hladinach inkoustu, ndzvu tiskarny a jejim
umisténi.

Priklady tisku

Nasledujici pokyny k tisku jsou POUZE pfiklady. Skute¢ny postup tisku se mizZe od téchto
prikladd lisit, protoZe tisk zavisi na operac¢nim systému pocitace, nastaveni pocitace a pfipojené
tiskarné. Vice informaci o tisku viz “Tisk v systému Linux nebo Windows” na strané 257 nebo
“Tisk v systému macOS” na strané 260, a také v PfiruCce aplikace Writer.

Jednotliva stranka
1) Otevieme dialogové okno Tisk a vybérem moznosti Obecné otevieme stranku Obecné.

2) Pokud je k pocitaCi pfipojeno vice tiskaren, vybereme v poli Tiskarna z rozeviraciho
seznamu tiskarnu, kterou chceme pouZit.

3) V Casti Rozsah a kopie vybereme moZnost Stranky a zadame Cislo stranky, kterd se ma
vytisknout.

4) V poli Rozsah a kopie zadame do pole Pocet kopii, kolik kopii se méa vytisknout.
5) Kliknutim na tlacitko Tisk vytiskneme jednotlivou stranku a zavifeme dialogové okno Tisk.

VSechny stranky
1) Otevieme dialogové okno Tisk a vybé&rem moZnosti Obecné otevieme strdnku Obecné.

2) Pokud je k pocitaci pripojeno vice tiskaren, vybereme v poli Tiskarna z rozeviraciho
seznamu tiskarnu, kterou chceme pouZit.

3) V okné Rozsahy a kopie vyberte moznost VSechny stranky.
4) V poli Rozsah a kopie zadame do pole Pocet kopii, kolik kopii se ma vytisknout.
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5) Kliknutim na Tisk vytiskneme vSechny stradnky dokumentu a zavieme dialogové okno
Tisk.

Rozsah stranek
1) Otevieme dialogové okno Tisk a vybérem moZnosti Obecné otevieme stranku Obecné.

2) Pokud je k pocitaci pfipojeno vice tiskaren, vybereme v poli Tiskarna z rozeviraciho
seznamu tiskarnu, kterou chceme pouzit.

3) V okné Rozsahy a kopie vybereme moznost Stranky a zadame Cisla stranek, které
chceme vytisknout, napfiklad 1,3,7 nebo 2-5,7,9.

4) V poli Rozsah a kopie zaddme do pole Pocet kopii, kolik kopii se ma vytisknout.

5) Kliknutim na Tisk vytiskneme vybrané stranky a zavieme dialogové okno Tisk.

Tisk vybéru
1) Vybereme stranky na panelu Stranky v LibreOffice Draw.
2) Otevieme dialogové okno Tisk a vybérem moZznosti Obecné otevieme stranku Obecné.

3) Pokud je k pocitaCi pfipojeno vice tiskaren, vybereme z rozeviraciho seznamu tiskarnu,
kterou chceme pouzit.

4) V sekci Rozsah a kopie vybereme mozZnost Vybér a poté v rozeviracim seznamu
Zahrnout vybereme jednu z moznosti: Liché a sudé stranky, Sudé stranky nebo Liché
stranky.

5) V poli Rozsah a kopie zaddme do pole Pocet kopii, kolik kopii se ma vytisknout.

6) Kliknutim na tlaCitko OK vytiskneme stranky a zavieme dialogové okno Tisk.

Vice stranek na jednom listu
1) Otevieme dialogové okno Tisk a vybérem moznosti Obecné otevieme stranku Obecné.

2) Pokud je k pocitaci pfipojeno vice tiskaren, vybereme v poli Tiskarna z rozeviraciho
seznamu tiskarnu, kterou chceme pouzit.

3) V sekci RozlozZeni stranky vybereme z rozeviraciho seznamu Stranek na list poCet
stranek, které se maji vytisknout na jeden list papiru. V nahledu vidime, jak budou stranky
vypadat po vytisténi na stranku.

4) V ¢asti Rozvrzeni stranky vybereme v rozeviracim seznamu Poradi fazeni stranek na
listu.

5) V pfipadé potfeby vybereme moZznost Kresleni ramecku kolem kaZdé stranky, abychom
odlisili jednotlivé stranky vytiSténé na listu papiru.

6) V poli Rozsah a kopie zadame do pole Pocet kopii, kolik kopii se ma vytisknout.
7) Kliknutim na Tisk vytiskneme dokument a zavieme dialogové okno Tisk.

Tisk pFirué¢ky

V aplikacich Writer, Impress a Draw |ze dokument vytisknout jako broZuru, resp. prirucku.

Stranky jsou pfi tisku uspofadany tak, aby po prelozeni vytisténych stranek na polovinu byly
stranky ve spravném poradi a tvofrily pfirucku resp. brozuru.
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Tip

1m

Dokument navrhujeme tak, aby pfi tisku jako broZura vypadal profesionalné.
PouZijeme vhodné okraje, vétsi velikost pisma apod., protoZe stranky se obvykle
tisknou v polovicni velikosti listu papiru. Experimentujme, abychom ziskali nejlepsi
format dokumentu odpovidajici moznostem pouzité tiskarny.

Tiskarna s jednostrannym tiskem
1) Otevieme dialogové okno Tisk a vybérem moznosti Obecné otevieme stranku Obecné.

2) Pokud je k pocitaCi pfipojeno vice tiskaren, vybereme v poli Tiskarna z rozeviraciho
seznamu tiskarnu, kterou chceme pouZzit.

3) V &asti Tiskarna klikneme na Vlastnosti, otevie se dialogové okno vlastnosti vybrané
tiskarny.

4) V Casti RozvrZeni, se ujistime, Ze je tiskarna nastavena na stejnou orientaci (na vysku
nebo na Sitku), jaka byla zadana v nastaveni stranky dokumentu. Obvykle na orientaci
nezalezi, ale u broZur je dllezita pro vytvoreni spravného rozvrzeni stranky.

5) V Casti Papir a kvalita vybereme z rozeviraciho seznamu Média typ papiru.
6) V sekci Barva vybereme moznost Cernobile nebo Barevné.

7) Kliknutim na tlaCitko OK zavieme dialogové okno Vlastnosti a vratime se do dialogového
okna Tisk.

8) V okné RozvrZeni stranky vybereme moznost Prirucka.
9) V poli Rozsah a kopie vybereme nasledujici polozky:
f) V Casti Zahrnout vybereme v rozeviracim seznamu Sudé stranky nebo Liché stranky.
0) V poli Strany papiru vybereme v rozeviracim seznamu Tisknout jednostranné.
10) Kliknutim na Tisk vytiskneme sudé nebo liché stranky.

11) VytiSténé stranky vyjmeme z tiskarny a viozime je zpét do tiskarny ve spravné orientaci
pro tisk na prazdnou stranu. To mdzZe vyZadovat uréité testovani, abychom zjistili, jaké je
spravné usporadani pro vybranou tiskarnu.

12) Pokud byly vytistény Sudé stranky, vybereme nyni v sekci Zahrnout moznost Liché
stranky. Pokud byly vytiStény Liché stranky, vybereme nyni v sekci Zahrnout moznost

Sudé stranky.

13) Kliknutim na tlagitko Tisk dokon€ime tisk dokumentu jako broZury a zavieme dialogové
okno Tisk.

14) Ujistime se, Ze vytiSténé stranky tvofi pfirucku, Ze jsou viechny jeji stranky ve spravném
poradi.

Oboustranna tiskarna
1) Otevieme dialogové okno Tisk a vybé&rem moZnosti Obecné otevieme strdnku Obecné.

2) Pokud je k pocitaCi pfipojeno vice tiskaren, vybereme v poli Tiskarna z rozeviraciho
seznamu tiskarnu, kterou chceme pouzit.

3) V sekci Tiskarna klepneme na Viastnosti a otevieme dialogové okno vlastnosti vybrané
tiskarny.

4) Zkontrolujeme, Ze je tiskarna nastavena na stejnou orientaci (na vysSku nebo na Sifku),
jaka je uvedena v nastaveni stranky dokumentu. Obvykle na orientaci nezalezi, ale
u broZur je dllezita pro vytvoreni spravného rozvrzeni stranky.
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5) V Casti Papir a kvalita vybereme v rozeviracim seznamu Média druh papiru.
6) V sekci Barva vybereme moznost Cernobile nebo Barevné.

7) Kliknutim na tlaCitko OK zavieme dialogové okno Vlastnosti a vratime se do dialogového
okna Tisk.

8) V sekci Rozsah a kopie vybereme moznost VSechny stranky.

9) V poli Rozsah a kopie vybereme z rozeviraciho seznamu Strany papiru jednu
z nasledujicich moznosti. Skutecné moznosti oboustranného tisku zavisi na modelu
tiskarny a pouzitém pocitatovém systému:

— Tisknout oboustranné (dlouhy okraj).
— Tisknout oboustranné (kratky okraj).
10) V Casti Rozvrzeni stranky vybereme moZznost Prirucka.
11) Kliknutim na Tisk vytiskneme dokument jako broZuru a zavieme dialogové okno Tisk.

Cernobily tisk nebo tisk ve stupnich Sedi

Nastaveni tiskarny

Nasledujici priklad postupu vysvétluje, jak tisknout dokumenty v €ernobilé nebo Sedé Skéle na
barevné tiskarné:

1) Otevieme dialogové okno Tisk a vybérem moZnosti Obecné otevieme stranku Obecné.

2) Pokud je k pocitai pfipojeno vice tiskaren, vyberte z rozeviraciho seznamu tiskarnu,
kterou chceme pouzit.

3) Kliknutim na LibreOffice Draw otevieme stranku moznosti tisku pro LibreOffice Draw.
4) V sekci Barva vybereme moznost Stupné sedi nebo Cernobile.

5) Kliknutim na Tisk vytiskneme dokument a zavieme dialogové okno Tisk.

. Tipy

Neékteré barevné tiskarny mohou umoznit pouze barevny tisk bez ohledu na zvolené
nastaveni. DalSi podrobnosti naleznete v pfirucce uZivatele k vybrané tiskarné.

Odstiny Sedé jsou nejlepSi moznosti pro tisk barevného textu nebo grafiky
v dokumentu na Cernobilé tiskarné. Barvy vytisténé v odstinech Sedé poskytuji vice
detailll. Pfi Cernobilém tisku barevné predlohy se ¢ast téchto detaill ztrati.

Nastaveni LibreOffice

V dialogovém okné MoZnosti LibreOffice Draw mUzZete po kliknuti na zalozku Tisk zménit
nastaveni LibreOffice tak, aby se veSkery barevny text a grafika tiskly ve stupnich Sedi nebo
cernobile.

1) Pfejdeme do nabidky Nastroje > MoZnosti > LibreOffice Draw > Tisk (macOS
LibreOffice > Pfedvolby > LibreOffice Draw > Tisk), otevieme dialogové okno
Moznosti tisku LibreOffice Draw (obrazek 259 pod).

2) V sekci Kvalita vybereme moznost Stupné Sedi nebo Cerna a bila.

3) Kliknutim na OK ulozime zménu a zavieme dialogové okno Moznosti tisku LibreOffice
Draw.

4) Vytiskneme dokument jednim z vySe uvedenych postupd a dokument se vytiskne ve
stupnich Sedi nebo Cernobile.
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LibreOffice Moznosti strinky Tisk
NaEl’ténlifuklédénl’ ’ ® Vyichozi [ Nézev strénky
Jézykove? nastavent () Prizplisobit rozméru stranky [ patum
= LibreOffice Draw ] ) -
Obecné () Stranky jako dlaZdice Ocas
Zobrazeni O Pfirucka Skryté stranky
Mfizka Predni
Zadni
LibreOffice Base Ll Zasobnik papiru z nastaveni tiskarny
arafy Kvalita
Internet
® Vychozi
) Stupné sedi

O Cerna a bila

Obrazek 259: MoZnosti v dialogu Tisk aplikace LibreOffice Draw

Obecne VWchozi zobrazeni UZivatelské rozhrani Odkazy Zabezpedenl Elektronické podpisy
Rozsah Obecné
® Vie [ Hybridni PDF (vloZit soubor ODF)
O Stranky: [ Archivni (PDF/A, 1SO 19005)
O Vyber Verze PDF/A:  |PDF/A-3b ~|
[] Zobrazit PDF po dokonéeni exportu 0] Univerzaing pfistupné (PDF/UA)
. Ul Tagované PDF (se strukturou dokumentu)
Obrazky Viytvofit PDF formulaf
) Bezztratova komprese _ Formét odeslant: ‘FDF v |
® Komprese JPEG Kvalita: 90 % = )
[ Povolit shodné nazvy pali
Zmensit rozlideni obrazkd na: |300 DPI| i
Struktura
Vodoznak Exportovat osnovu
[J Podepsat vodoznakem [ Komentafe jako poznamky PDF
Komentare na okrajich
Exportovat automaticky vioZené prazdneé stranky
[l Pouzit odkazy XObject
MNapovéda Exportovat Zrusit
Obréazek 260: Dialogové okno MoZnosti PDF — strénka Obecné
Exportovani

Format PDF

LibreOffice umi exportovat dokumenty ve formatu PDF (Portable Document Format). Tento
standardni format souboru je idealni pro odeslani souboru k prohlizeni na jiném pocitaci pomoci
softwaru pro prohlizeni PDF.

Pfimo ve formatu PDF
Cely dokument exportujeme ve vychozim nastaveni PDF takto:
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1) Na nastrojové listé Standardni klikneme na P¥imy export do PDF nebo jdeme do
nabidky Soubor > Exportovat jako > Pfimy export do PDF.

2) Zadame nazev a umisténi souboru PDF a kliknutim na UloZit soubor exportujeme jako
PDF.

ﬁ Poznamka

PFi vytvareni souboru PDF pfikazem PFfimo jako PDF nelze nastavit rozsah stranek,
kompresi obrazkl ani dal$i moZnosti tisku.

Nastaveni obsahu a kvality PDF

Chceme-li pfi vytvareni souboru PDF detailné nastavit obsah a kvalitu, pouzijeme moznosti
dostupné v dialogovém okné MoZznosti PDF (obrazek 260 nad). Dalsi informace o dostupnych
moZznostech nalezneme v pfiru€ce Zaciname s LibreOffice.

1) V hlavni nabidce zvolime Soubor > Exportovat jako > Exportovat jako PDF a otevie
se dialogové okno MoZnosti PDF.

2) Pozadované moznosti vybereme na rdiznych strankach dialogového okna Moznosti PDF.
3) Klikneme na tlagitko Exportovat a otevie se okno prohlize¢e soubord.
4) Prejdeme do poZzadovaného umisténi a zadame nazev vytvafeného souboru PDF.

5) Kliknutim na UloZit exportujeme soubor do formatu PDF. Okno prohlizece soubord
a dialogové okno Moznosti PDF se zaviou.

ﬁ Poznamky

Pfi exportu do Jinych formatl se mize otevfit dialogové okno s moznostmi, které
Ize vybrat pfi exportu souboru LibreOffice Draw.

Obsah exportovaného souboru zavisi na prvcich vybranych na vykrese. Pokud
nejsou vybrany zadné prvky, exportuje se do souboru cely vykres.

DalSi formaty

LibreOffice umi exportovat soubory v réiznych formatech, které jsou uvedeny v rozeviracim
seznamu okna prohlizece souborl. Dalsi informace o exportu grafiky nalezneme v kapitole 6,
Upravy obrazkd.

1) V nabidkové listé prejdeme na Soubor > Exportovat a otevieme okno spravce soubord.

2) Pfejdeme do adresare, do kterého bude kresba ulozena.

3) Do textového pole Nazev souboru zadame pro exportovany vykres ndzev souboru.

4) V rozeviracim seznamu Ulozit jako typ vybereme pozadovany format souboru.

5) Kliknutim na UloZit nebo Exportovat soubor uloZime a zavieme okno spravce soubord.

Odesilani dokumentui e-mailem

LibreOffice nabizi nékolik zplsobl, jak rychle a snadno odeslat dokumenty jako pfilohu e-mailu
ve forméatu ODF (vychozi format LibreOffice) nebo ve formatu PDF. DalSi informace o odesilani
dokumentl e-mailem nalezneme v pfiruéce Zaciname s LibreOffice.
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Open Document format

1) V hlavni nabidce zvolime Soubor > Odeslat > Odeslat dokument e-mailem. LibreOffice
otevie vychozi e-mailovy program s dokumentem pfipojenym k novému e-mailu.

2) V e-mailovém programu zadame pfijemce, pfedmét a zpravu a poté e-mail odeSleme.

Format PDF

1) V hlavni nabidce zvolime Soubor > Odeslat > E-mailem jako PDF, a otevie se
dialogové okno MoZnosti PDF.

2) Soubor PDF vytvofime z vykresu pomoci moznosti dostupnych v dialogovém okné
Moznosti PDF, dalsi informace nalezneme v ¢asti ,Format PDF“ na strané 272. Vychozi
e-mailova aplikace se otevie se souborem PDF pfipojenym k novému e-mailu.

3) V e-mailové aplikaci zadame pfijemce, pfedmét a zpravu a poté e-mail odeSleme.

Digitalni podpisy

Digitalni podpis je matematické schéma pro ovérovani pravosti digitalnich verzi kreseb nebo
dokumentd.

PTi digitalnim podepisovani vykresu je vyzadovan osobni kli€ nebo certifikat. Tento osobni kli¢ je
uloZen v pocitaci a je kombinaci soukromého a verejného kliCe. Tyto klice se pfidavaji k vykresu
pri pouziti digitalniho podpisu. Certifikat se ziskava od certifikacni autority, kterou mize byt
soukrom@ spole€nost nebo statni instituce.

P¥i digitalnim podpisu vykresu se z obsahu vykresu a pouZzitého osobniho kli€e vypocita kontrolni
soucet. Kontrolni soucet a vefejny Kli¢ jsou ulozeny spolecné s kresbou.

N Y4

PTi otevieni vykresu na jiném pocitaci s nejnovejsi verzi LibreOffice program znovu vypocita
kontrolni soucet a porovna jej s ulozenym kontrolnim souctem. Pokud jsou oba kontrolni soucty
stejné, program otevie plivodni, nezménénou kresbu.

Program také dokaze zobrazit informace o vefejném Kkli€i z certifikatu. Tyto informace se
porovnavaji s vefejnym klicem, ktery je zvefejnén na webu certifikacni autority. Pfi kazdé zméné
kresby dojde k poruSeni digitalniho podpisu.

Podrobnéjsi popis ziskani, pouzivani a spravy certifikatu a ovéfovani platnosti podpisu
nalezneme v pfiruéce Zaciname s LibreOffice a v “Poutiti digitalnich podpist“ v napovédé
LibreOffice (https://help.libreoffice.org/7.1/en-US/text/shared/guide/digitalsign_send.html?
&DbPAR=WRITER&System=UNIX).

Odstranéni osobnich udajt

Nékdy je nutné pred distribuci nebo vytvofenim verze PDF z vykresovych soubor( odstranit
osobni Udaje, verze, poznamky, skryté informace nebo zaznamenané zmény. K odstranéni
tohoto typu dat ze souboru vykresu slouZi nasledujici dva postupy.

Nastaveni moZnosti zabezpec€eni a upozoriiovani

1) Zvolime Nastroje > Moznosti > LibreOffice > Zabezpec€eni (macOS LibreOffice >
Predvolby > LibreOffice > Zabezpec€eni) a otevieme dialogové okno MoZnosti
zabezpeceni LibreOffice (obrazek 261 pod).

2) Klepnutim na MoZnosti otevieme dialogové okno MoZnosti zabezpeceni a upozoriiovani
(obrazek 262 pod).
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3) Vyberte poZzadované moznosti, aby LibreOffice upozorfioval na to, Ze soubory kresby
obsahuiji citlivé informace, a/nebo aby pfi ukladani osobni Gdaje automaticky odstranoval.

=l LibreOffice MozZnosti zabezpeéeni a upozoriiovani

—  Utivatelske adaje Upravte nastaveni zabezpeceni a upozorovani na skryty MozZnosti

—  Obecné obsah dokumentl. =

—  Zobrazeni L

C Tisk Hesla pro pripojeni k webu

-~ Cesty (I Trvale uloZit hesla pro webova spojeni Spojent...

— Pisma Chranit hlavnim heslem (doporu¢eno)

Zabezpecenl Hesla jsou chrénéna hlavnim heslem. Pokud LibreOffice pfistupuje k Hlavni heslo...
—  Pfizplsobeni heslu v chranéném seznamu hesel, budete jednou béhem relace -
I poZadani o zadani hlavniho hesla.
—  Barvy aplikaci
Zpfistupnéni Zabezpeceni maker
—  Pokrodile Nastavte Groven zabezpeceni pro spousténi maker a urcete -
L : ; Zabezpefeni maker...
—  OpenCL davéryhodne zdroje maker.
Nacitanifukladani Autority Easovych razitek
Jazykova nastaveni - . .
L'ij Office D Upravte seznam adres URL pro autority casovych razitek
1orevimee Lraw (TSA), které se pouZiji u elektronickych podpist pfi exportu Autority casovych razitek...

LibreOffice Base do PDEF.
Grafy
Internet

Napovéda Obnovit PouZit QK Zrusit

Obrazek 261: MozZnosti dialogu LibreOffice — stranka Zabezpeceni

Bezpecnostni upozornéni
Upozornit, pokud dokument obsahuje zaznamenané zmény, verze, skryté informace nebo poznamky:
[ Pfi ukladani nebo odesilani [ Pfi podepisovani
[ Pi tisku [ Pfi tvorb& PDF soubor(
MozZnosti zabezpeéeni
[J Odstranit pii ukladani osobni informace
[ Doporuéit pfi ukladani ochranu heslem
Pro otevieni hypertextowyjch odkazd vyZadovat Ctrl-kliknuti

[ Blokovat odkazy z dokumentl, které nejsou uloZeny v divéryhodnych umisténich (viz Zabezpeéeni maker)

Napovéda

Zrusit

Obréazek 262: Dialogové okno MoZnosti zabezpeceni a upozorriovani

4) Klepnutim na tlaitko OK zavifeme dialogové okno MoZnosti zabezpeceni a upozornovani
a uloZime vybrané moZznosti.

5) Kliknutim na OK zavieme dialogové okno Moznosti zabezpeceni LibreOffice.

Odstranéni osobnich Gidaji a informaci o souborech kresby

1) Otevieme soubor kresby a pfejdeme do nabidky Soubor > Vlastnosti, otevie se
dialogové okno Vlastnosti (obrazek 263 pod).

2) Na strance Obecné zruSime vybér moznosti PouZit uZivatelské udaje.
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3) Klepneme na Obnovit vlastnosti a zménime nésledujici vlastnosti souboru:

— Odstranime vSechny informace z poli Vytvofeno a Upraveno.

Odstranéni dat o Upravach a tisku.

Vynulujeme Cas Uprav.

Nastavime datum vytvoreni na aktuélni datum a Cas.

Nastavime c&islo verze na 1.

4) Kliknutim na tlacitko OK uloZzime zmény a zavieme dialogové okno Vlastnosti.

Odstranéni informaci o verzi
Chcete-li ze souboru vykresu odstranit informace o verzi, pouzijte jednu z nasledujicich metod:

1) Pfejdeme do nabidky Soubor > Verze, otevie se dialogové okno Vlastnosti vykresového
souboru.

2) V seznamu Existujici verze vybereme verzi, které chceme odstranit a klikneme na
Odstranit. Dialogové okno se automaticky zavre.

3) Pfejdeme do nabidky Soubor > Ulozit jako a soubor vykresu uloZzime pod jinym nazvem.

Obecné Popis Vlastni vlastnosti Zabezpeceni Pismo

@ Pomocna grafika.odg Zménit heslo
Typ: Kresba LibreOffice
Umisténi: D

Velikost: 15 kB (14 883 Bajtl)
Vytvofen: (07.05.2023, 11:10:02, Roman Toman
Zménén: 07.05.2023, 11:19:47, Roman Toman

Sablona:

Elektronicky podepsan: Elektronické podpisy...
Vytistén:
Celkovy ¢as dprav:  00:01:40

Cislo revize: 1

PouZit uZivatelske udaje Obnovit vlastnosti

Ulozit s timto dokumentem obrazek nahledu

] Upfednostiiované rozlizeni obrazkd: ppi

Napovéda Obnovit oK Zrusit

Obrazek 263: Dialogové okno Vlastnosti — stranka Obecné
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Redakéni tprava

Dokumenty jsou redigovany tak, aby byly odstranény nebo skryty veSkeré citlivé informace.
Redigovani umoziiuje selektivni zvefejnéni nékterych informaci v dokumentu, pficemz jiné ¢asti
dokumentu zUstavaji utajeny.

P¥i exportu redigovaného dokumentu jako nového dokumentu jsou v3echny redigované Casti
odstranény a nahrazeny redigovanymi bloky pixeld, které brani jakémukoli pokusu o obnoveni
nebo kopirovani plivodniho obsahu. Redigovany dokument se ¢asto exportuje do formatu PDF
za UCelem zvefejnéni nebo sdileni.

VSechny dokumenty, které jsou redigovany v aplikacich Writer, Calc nebo Impress, se
automaticky prenesou k redigovani jako kopie do aplikace Draw.

ﬁ Poznamka

PTi exportu redigovaného dokumentu jako nového souboru PDF jsou vSechny
informace v redigovanych oblastech odstranény a nahrazeny redigovanymi bloky
pixeld. Redigované oblasti brani jakémukoli pokusu o obnoveni nebo kopirovani
plvodniho obsahu.

Dokumenty, seSity nebo prezentace

1) Otevieme dokument, ktery byl redigovan, v aplikaci Writer, Calc nebo Impress, poté
prejdeme do nabidky Nastroje > Redigovat a stane se nasledujici:

— Dokument je zkopirovan, pfipraven a pfenesen do Draw jako nepojmenovany soubor.

Redakcni Uprava W X
R =l

Obrazek 264: Nastrojova lista

Redak¢ni uprava

— Dokument otevieny v aplikaci Draw je bez nazvu.

— Automaticky se otevie nastrojova liSta Redak¢ni Uprava (obradzek 264 nad). Pokud se
nastrojova lista Redak¢ni Uprava nezobrazuje, pfejdeme do nabidky Zobrazeni >

v s s

Nastrojové liSty a vybereme RedakEni Gprava.

2) Prejdeme do nabidky Nastroje > RedakEné upravit a vybereme bud Obdélnik nebo Od
ruky, nebo na nastrojove listé Redakcni Gprava klikneme na Uprava obdélnikem nebo
Uprava od ruky.

3) Nakreslime poZzadované tvary pro redigovani citlivych oblasti dokumentu. Tvar redigovani
je Sedy, takZe citlivé oblasti v dokumentu jsou pfed redigovanim viditelné.

4) Kliknutim na Exportovat PDF s nahledem vytvofime kopii dokumentu ve formatu PDF
a ulozime ji jako soubor PDF. Pfed dokoncenim redigovani zkontrolujte citlivé informace
v Sedé redigovanych oblastech.

5) Po zkontrolovani redigovanych oblasti odstranime nahledovou kopii PDF.

6) Pfejdeme do nabidky Nastroje > Redak&éné upravit nebo pouZijeme jednu
Z nasledujicich moznosti na nastrojové listé Redak&né upravit:

— Vyberte bud moznost Exportovat redakéné upravené PDF (bild) nebo Exportovat
redakéné upravené PDF (Eernd).
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— Klikneme na ikonu Exportovat redakéné upravené PDF (bild) nebo Exportovat
redakéné upravené PDF (Cerna).

7) V otevieném okné priizkumnika soubori prejdeme do slozky, kam ma byt redigovany
dokument uloZen, a zaddme jeho nazev.

8) Kliknutim na UloZzit vytvofime redigovany soubor PDF, zobrazi se nasledujici zprava:

— Sedé redigované oblasti se pfevedou na bilou nebo ¢ernou barvu a dokument se
exportuje do formatu PDF.

— V souboru PDF neni zadny volitelny text a zadny redigovany obsah neexistuje.

Kreshy

V aplikaci Draw otevieme soubor vykresu a podle krok({ 2) aZ 8) v ¢asti ,Dokumenty, seSity nebo
prezentace" na strané 277 vytvofime redigovanou kopii vykresu ve formatu PDF.
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Stranky kresby

Panel stranek

Kresby vytvofené v programu Draw se mohou skladat z vice stranek a mohou byt v pocitaci
uloZeny jako jeden soubor. Stranky kresby se zobrazuji jako miniatury v panelu Stranky. Pomoci
panelu Stranky Ize pfidavat, pfejmenovavat, odstrarniovat a fadit stranky kresby.

Ve vychozim nastaveni se panel Stranky (obrazek 265 pod) zobrazi ukotveny na levé strané
Pracovni plochy. Pokud panel Stranky neni viditelny, zvolime v hlavni nabidce moznost
Zobrazit > Panel stranek. Panel Stranky se miZe stat plovoucim oknem pomoci jedné

Z nasledujicich moznosti:

* Pouze pro systémy Windows a Linux — stiskneme a drzime klavesu Ctr1 a poté
dvojitym klepnutim na zahlavi Panelu stranky vytvofime plovouci okno.

* Pouze pro systém MacOS — stiskneme a podrzime klavesu 3 a poté dvojitym
klepnutim na zahlavi Panelu stranek vytvofime plovouci okno.

» V systémech Windows, Linux a macOS — klepnutim na zahlavi a pfetazenim Panelu
stranek vytvofime plovouci okno.

Pokud chceme zavfit Panel stranek, klepneme na X na pravé strané titulkového pruhu nebo
v hlavni nabidce zvolime Zobrazit > Panel stranek.
Vybér stranek

Chceme-li, aby se stranka zobrazila na Pracovni ploSe, vybereme stranku jednim
z nasledujicich zpUsob:

* Vybereme stranku v Panelu stranek.

* Pomoci klavesové zkratky F5 nebo volbou Zobrazit > Navigator v hlavni nabidce

otevieme dialogové okno Navigator (obrazek 266 pod) a vybereme stranku ze
zobrazeného seznamu.
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Obrazek 265: Hlavni okno Draw

Dokumentace pro LibreOffice je dostupna na https://cs.libreoffice.org/get-help/documentation/



(25) Panel stranek (27) Postranni lista (29) Stavovy fadek Vrstvy

(26) Pracovni plocha (28) Stavovy fadek
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Obrazek 266: Dialogové okno Navigator
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Obréazek 267:Karta navigator v postranni liSté

» Klepnutim na ikonu Navigator v postranni listé otevieme v postranni listé kartu Navigator
(obrazek 267) a vybereme stranku ze zobrazeného seznamu.

Navigace mezi strankami

Pokud chceme prochazet vicestrankovou kresbou a vybrat strdnku k Upravam, pouZzijeme jednu
z nasledujicich metod:

* Vybereme poZzadovanou stranku v Panelu stranek.

* Pozadovanou stranku vybereme v dialogovém okné Navigator (obrazek 266 nad) nebo
v karté Navigator v postranni li5té (obrazek 267 nad).

* V hlavni nabidce zvolime Stranka > Navigovat a vybereme jednu z nasledujicich
MOoZnosti:

— Na prvni stranku — piejde na prvni stranku vykresu.
— Na pFedchozi stranku — prejde zpét na predchozi stranku.

— Na nasleduijici stranku — pfejde na dalsi stranku.
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— Na posledni stranku — pfejde na posledni stranku kresby.

— Prejit na stranku — do textového pole zadame Cislo stranky a stisknutim klavesy
Enter se pfesuneme na vybranou stranku.

VloZit strénky x

=1 830 file:///C:/Users/petrk/M35C53AF % 20disk /5
[ Stranka 1
[ stranka 2
[ Stranka3
[ stranka 4
[ Stranka s
[ stranka 6
[ Stranka7
[ stranka 8
[ Stranka 9
[ stranka 10

] Odkaz

Smazat nepouZitd pozadi

Mapovéda Lrusit

Obréazek 268: Dialogové okno VioZit
stranky

Pridavani stranek
VloZeni nové stranky

Novou stranku vloZzime do kresby jednou z nasledujicich moznosti. Nova strdnka se pfida za
vybranou stranku v Panelu stranek nebo na konec, pokud neni vybrana zadna stranka.

* V hlavni nabidce zvolime Stranka > Nova.

* Klepneme pravym tlacitkem mysi v Panelu stranek a z mistni nabidky vybereme Nova
stranka.

» Klepneme pravym tlaCitkem mySi na stranku zobrazenou na Pracovni ploSe a z mistni
nabidky vybereme Stranka > Nova stranka.

* V hlavni nabidce zvolime Stranka > Vlozit stranku ze souboru a otevieme dialogové
okno Vlozit soubor. Pfejdeme do slozky, kde je soubor umistén. Vybereme soubor
a klepnutim na tlaCitko Otevfit otevieme dialogovém okno VloZit stranky
(obrazek 268 nad). Vybereme poZadované stranky a klepneme na OK.

Duplikovani stranek

Vybereme stranku v Panelu stranek a poté pomoci jedné z nasledujicich moznosti vlozime za
vybranou stranku duplicitni stranku:

* V hlavni nabidce zvolime Stranka > Duplikovat stranku.

* Klepneme pravym tlacitkem mysi na stranku v Panelu stranek a z mistni nabidky
vybereme moznost Kopirovat. Klepneme pravym tlacitkem mysSi do prazdné oblasti
Panelu stranek a z mistni nabidky vybereme moZznost VloZit.
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Pfejmenovani stranek

Kdyz jsou stranky vlozeny do kresby, jsou automaticky pojmenovany jako Stranka 1, Stranka 2
atd. v panelu Stranky, v dialogovém okné Navigator nebo na karté Navigator v postranni listé.
PTi zméné poradi strAnek se stranky automaticky precisluji, coz znesnadnuje jejich identifikaci.
Doporucujeme dat kazdé strance zapamatovatelny nazev, abychom mohli stranky identifikovat
takto:

9) V Panelu stranek vybereme stranku, kterou chceme prejmenovat.
10) PouZijeme jednu z nasledujicich moznosti a pfejmenujeme vybranou stranku:
— V hlavni nabidce zvolime Stranka a z podnabidky vybereme Pfejmenovat stranku.

— Klepneme pravym tlacitkem mySi na vybranou stranku v Panelu stranek a z mistni
nabidky zvolime Pfejmenovat stranku.

— Klepneme pravym tlacitkem mySi na stranku zobrazenou na Pracovni ploSe a z mistni
nabidky vybereme Stranka > Pfejmenovat stranku.

11) V otevieném dialogovém okné Pfejmenovat stranku zadame novy nazev stranky
a klepneme na OK.

Zmeéna poradi stranek
PouZijeme jednu z nasledujicich mozZnosti a zménime poradi stranek v kresbé:

* VVybereme miniaturu stranky v Panelu stranek a klepnutim a pfetazenim miniatury
stranky zménime poradi stranek.

* Vybereme miniaturu stranky v Panelu stranek, poté pfejdeme na Stranka > Pfesunout
v hlavni nabidce a vybereme jednu z nasledujicich moznosti:

— Stranka na zacatek — pfesune vybranou stranku na zacatek kresby.

— Stranka nahoru — posune vybranou stranku o jedno misto nahoru v poradi stranek
kreshy.

— Stranka dold — posune vybranou stranku o jedno misto doll v poradi stranek kresby.

— Stranka na konec — pfesune vybranou stranku na konec kresby.

Odstranéni stranek
1) V Panelu stranek vybereme stranku, kterou chceme odstranit.
2) K odstranéni vybrané stranky pouzijeme jednu z nasledujicich moznosti:
— V hlavni nabidce zvolime Stranka > Smazat stranku.

— Klepneme pravym tlacitkem mySi na vybranou stranku v Panelu stranek a z mistni
nabidky vybereme Smazat stranku.

— Klepneme pravym tlaCitkem mySi na stranku zobrazenou v pracovnim prostoru
a z mistni nabidky vybereme moZnost Stranka > Smazat stranku.

ﬁ Poznamka
Pfi mazani stranek v kresbé se u vybrané stranky nepotvrzuje jeji smazani.

Predlohy stranek

Predloha stranky je stranka, ktera se pouziva jako vychozi bod pro vSechny stranky kresby
a slouzi k fizeni zakladniho formatovani strdnek na zakladé predlohy stranek. Je to podobné jako
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styl stranky v aplikaci Writer nebo predloha snimku v aplikaci Impress. Kresba s vice strankami
mUze mit vice nez jednu predlohu stranek, coz umoziiuje prifadit jednotlivym strankam kresby
rlzny vzhled, napfiklad titulni strance, strance obsahu a strankam kresby.

Predlohy stranky maji definovanou sadu vlastnosti. Napfiklad objekty na pozadi (jako jsou loga,
ozdobné Cary), formatovani textu, bloky standardniho textu a pole, jako je Cislovani stranek,
datum nebo né&zev souboru.

Zobrazeni predlohy v

S0 E &

Obrazek 269: Nastrojova lista Zobrazeni
predlohy

Zobrazeni predlohy stranky

V hlavni nabidce zvolime Zobrazit > Pfedloha a otevieme zobrazeni predlohy stranky. Tim se
také otevfe nastrojova liSta Zobrazeni pfedlohy (obrazek 269 nad). Pokud se tato nastrojova lista
neotevie, zvolime v hlavni nabidce Zobrazit > Nastrojové liSty > Zobrazeni predlohy. Pokud
se chceme vratit do normalniho rezimu stranky, klepneme na Zavfit predlohu na nastrojové listé
Zobrazeni pfedlohy nebo v hlavni nabidce zvolime Zobrazit > Normalni.

Vytvoreni pfedlohy stranky

Kazda vytvorena kresba pouZziva vychozi predlohu stranky. Pokud mé kresba vice stranek, Ize
vytvorit pfedlohu a pfidat ji do kresby nasledujicim zptsobem:

1) Pomoci volby Zobrazit > Pfedloha v hlavni nabidce otevieme zobrazeni pfedlohy
a nastrojovou listu Zobrazeni pfedlohy.

2) Vytvofime novou predlohu jednou z nésledujicich moznosti: Po vytvoreni se automaticky
vybere nova predloha.

— Klepneme na ikonu Nova predloha na nastrojové listé Zobrazeni pfedlohy
(obrazek 269 nad).

— V hlavni nabidce zvolime Stranka > Nova predloha.

3) Do vybrané predlohy stranky pfidame poZzadované grafické objekty, loga, pole, text atd.
a poté kresbu uloZzime.

4) Novou predlohu pfifadime ke strdnce kresby. DalSi informace nalezneme v ¢éasti ,Zména
predlohy stranek” na strané 285.

5) Pfejmenujeme hlavni stranku, viz ,Pfejmenovani pfedlohy stranky“ na strané 284.

Pfejmenovani predlohy stranky

Kazda noveé vytvorena pfedloha ma vychozi ndzev Vychozi 1, Vychozi 2 atd. Doporucuje se
pfejmenovat nové predlohy stranek. Vychozi predlohu stranky, ktera byla vytvorena pfi vytvoreni
kresby, Ize také pfejmenovat.

1) Pomoci volby Zobrazit > Pfedloha v hlavni nabidce otevieme zobrazeni pfedlohy
a nastrojovou listu Zobrazeni pfedlohy.

2) PouZijeme jednu z nésledujicich metod a otevieme dialogové okno Pfejmenovat pfedlohu
snimku:

— Klepneme na ikonu Pfejmenovat pfedlohu na nastrojové listé Zobrazeni prfedlohy
(obrazek 269 nad).
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— Klepneme pravym tlacitkem mySi na pfedlohu v Panelu stranek a z mistni nabidky
vybereme Pfejmenovat prediohu.

3) Nazev predlohy stranky zaddme do textového pole Nazev v dialogovém okné
Pfejmenovat predlohu stranky.

4) Klepnutim na OK zmény uloZime a zavieme dialogové okno Pfejmenovat pfedlohu
snimku.

Zmeéna predlohy stranek

Pokud kresba pouziva nékolik predloh stranek, mlze kazda stranka kresby pouzivat jinou
predlohu stranky.

1) V hlavni nabidce zvolime Zobrazit > Normalni.
| Dostupné predlchy stranky x

Vyberte navrh stranky

Vychozl
(] Vymenit stranku pozadi

(L] Smazat nepouita pozadi

MNapovéda Madist... fruiit

Obréazek 270: Dialogové okno Dostupné predlohy stranek
2) V panelu Stranky vybereme stranku, na které chceme zménit predlohu stranky.

3) Klepneme pravym tlacitkem na stranku na pracovni ploSe a vybérem Zménit pfediohu
stranky z mistni nabidky otevifeme dialogové okno Dostupné predlohy stranky
(obrazek 270 nad).

4) V nahledovém poli Vyberte navrh stranky vybereme pfedlohu stranky pro vybranou
stranku.

5) V pfipadé potfeby vybereme moznost Vyménit stranku pozadi, abychom vybranou
predlohu pouZzili pro vSechny stranky kresby.
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6) V pfipadé potfeby vybereme Smazat nepouzita pozadi a odstranime vSechny predlohy
strdnek zobrazené v okné ndhledu Vyberte navrh stranky, které nebyly pfifazeny ke
strance.

7) Klepnutim na OK zménime vybranou pfedlohu stranky a zavieme dialogové okno
Dostupné predlohy stranky.

Smazani predlohy stranky

ﬁ Poznamka

Vychozi pfedlohu vytvofenou pfi prvnim vytvofeni kresby nelze odstranit. Pokud
kresba pouZziva pouze jednu pojmenovanou pfedlohu, nelze tuto pojmenovanou
predlohu odstranit.

Odstranéni pfedlohy stranky je k dispozici pouze v pfipadé, Ze kresba ma vice nez jednu
predlohu stranky.

1) V hlavni nabidce zvolime Zobrazit > Pfedloha a tim otevieme zobrazeni pfedlohy
stranky a nastrojovou liStu Zobrazeni pfedlohy (obrazek 269 na strance 284).

2) K odstranéni hlavni stranky pouZijeme jednu z nasledujicich moZnosti. Smazani pfedlohy
stranky je okamzité a neni tfeba potvrzeni.

— Vybereme a klepneme pravym tlacitkem mySi na predlohu stranky v Panelu stranek
a z mistni nabidky vybereme Smazat prediohu.

— Na nastrojové listé Zobrazeni predlohy klepneme na Smazat prediohu.

— V hlavni nabidce zvolime Stranka > Smazat pfedlohu.

Predlohy stranek ze Sablon

Pro kresleni Ize pouZit pfedlohy ze Sablon dostupnych v LibreOffice. Pokud predlohy stranky ze
Sablony pouZivaiji jinou velikost stranky, predlohy stranky naétené do kresby se pfizpsobi
velikosti stranky kresby. To mize zpUsobit, Ze nékteré objekty budou roztaZzené nebo nespravné
umisténé pri prizplsobeni velikosti stranky kresby.

1) Pomoci volby Zobrazit > Pfedloha v hlavni nabidce otevieme zobrazeni pfedlohy
a nastrojovou listu Zobrazeni pfedlohy.

2) Klepneme pravym tlaCitkem mysi na predlohu stranky zobrazenou v kresbé a volbou
Zmeénit predlohu snimku z mistni nabidky otevieme dialogové okno Dostupné predliohy
snimku (obrazek 270 nad).

3) Klepnutim na tlacitko Nacist... otevieme dialogové okno Nacist pfedlohu stranky
(obrazek 271 pod).

4) Vybereme kategorii Sablony ze seznamu zobrazeného v ¢asti Kategorie.
5) Vybereme Sablonu ze seznamu zobrazeného v ¢asti Sablony.
6) V pfipadé potfeby klepneme na Nahled a zobrazime nahled vybrané Sablony.
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Macist predlohu stranky et

Kategorie Sablo
Lokalizované
MediaWiki

Cbchodni korespondence
Oscbni kerespondence a dokum
Cstatni cbchodni dokumenty

MNapovéda Zrugit

Obrazek 271: Dialogové okno Nacist pfedlohu stranky

7) Klepnutim na OK zavieme dialogové okno Nacist pfedlohu snimku. Otevie se dialogové

okno Dostupné hlavni snimky, ve kterém se zobrazi vybrana Sablona v ¢asti Vyberte
navrh snimku.

8) Vybereme pozadovanou pfedlohu v ¢asti Vyberte navrh snimku.

9) V pfipadé potfeby vybereme moznost Vyménit stranku pozadi, abychom vybranou
predlohu pouZzili pro vSechny stranky kresby.

10) V pripadé potfeby vybereme moznost Smazat nepouzité predlohy stranek, abychom

odstranili vSechny predlohy zobrazené ve Vyberte navrh snimku, které nejsou pfirazeny
ke strance.

11) Klepnutim na OK pfifadime predlohu ke strance v kresbé a zavieme dialogové okno
Dostupné predlohy snimku.
Vkladani poli

1) Pomoci volby Zobrazit > Pfedloha v hlavni nabidce otevieme zobrazeni pfedlohy
a nastrojovou liStu Zobrazeni predlohy.

2) Pfejdeme na Vlozit > Pole v hlavni nabidce a vybereme typ pole z moznosti dostupnych
v podnabidce. Vybrané pole se zobrazi uprostfed stranky kresby.

3) VloZzené pole vybereme tak, aby se zobrazil ramecek.
4) Klepneme na okraj a pfetahneme pole na pozadované misto.

5) V pripadé potfeby naformatujeme text pouzity v poli podle pozadavk( kresby. Dalsi
informace nalezneme v kapitole 9, Pfidavani a formatovani textu.

Typy poli, které je mozné vlozit, jsou nasleduijici:
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Datum (neménné)
VloZzi aktualni datum do pfedlohy stranky jako neménné pole. Datum se automaticky
neaktualizuje.

Datum (proménna)
Vlozi aktualni datum jako proménnou pole. Datum se automaticky aktualizuje pfi kazdém
otevieni souboru.

Cas (neménny)
Vlozi aktualni ¢as jako neménné pole. Cas se automaticky neaktualizuje.

Cas (proménna)
Vlozi aktualni ¢as jako promé&nné pole. Cas se automaticky aktualizuje pfi otevieni
souboru.

Vlastnosti stranky *

Strénka  Pozadi  Prdhlednost

Format papiru

Sitka: 2970 cm =
Vyika: 21,00 cm =
Orientace: (O Na wyizku
© Na ik Zasobnik papiru: |[Z nastaveni tiskarny] |
Okraje MNastaveni rozvrZeni
Wlevo: 1,00cm Cisla stranek: |1_. 23 .. ~ |

Vpravo: 1,00cm [ Pfizphisobit objekt formatu papiru

Nahofe: 100 em | Pozadi pokryva okraje

Dole: 1,00 cm

Obrazek 272: Dialogové okno Vlastnosti stranky — stranka Stranka

Autor

Vlozi do aktivni stranky jméno a pfijmeni uvedené v udajich uzivatele LibreOffice.
Prejdeme do Nastroje > Moznosti > LibreOffice > Uzivatelské udaje (macOS
LibreOffice > Predvolby > LibreOffice > UZivatelské udaje) v hlavni nabidce
a zadame udaje o uzivateli.

Cislo stranky

~s o wr

Vlozi Cislo stranky do kazdé stranky kresby. Pokud chceme zménit forméat Cisla, volbou
Stranka > Vlastnosti stranky otevieme dialogové okno Vlastnosti stranky
(obrazek 272 nad). Klepneme na kartu Stranka a z rozeviraciho seznamu v Casti
Nastaveni rozvrzeni vybereme format Cisla.

Nazev stranky

Vlozi nazev stranky. Nazev stranky vytvofime v Normalnim zobrazeni tak, Ze v hlavni
nabidce zvolime Stranka > Pfejmenovat stranku a v otevieném dialogovém okné
Pfejmenovat stranku zadame nazev do pole Nazev. DalSi informace nalezneme v Casti
~Prejmenovani stranek” na strance 283.

Pocet stranek
Vlozi celkovy pocCet stranek kresby.

Nazev souboru
Vlozi ndzev aktivniho souboru. Nazev se zobrazi az po uloZzeni souboru.
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Sablony

Jako vychozi bod pro viechny nové kresby se pouziva $ablona kresby. Sablona mdze napriklad
obsahovat logo, nazev a informace o spole€nosti na prvni strané kresby, pfi€emz na zbyvajicich
stranéch kresby je uvedeno pouze logo a nazev spolenosti. Sablony mohou obsahovat cokoliv,
co mohou obsahovat bézné kresby, napfiklad text, grafiku, sadu styl( atd.

VSechny typy dokument( vytvofené pomoci LibreOffice jsou zaloZeny na $ablonach. Pokud neni
pfi spusténi nového dokumentu zadana Sablona, pouZije se vychozi Sablona pro dany typ
dokumentu. Tato vychozi Sablona pouZziva sadu vlastnosti, které jsou pevné zakodovany

v LibreOffice. V pfipadé potfeby Ize vychozi Sablonu pro kresby, ktera je v LibreOffice pevné
zakoédovana, zménit. DalSi informace nalezneme v €asti ,Vychozi Sablona“ na strance 291. DalSi
informace o Sablonach a ziskavani Sablon z jinych zdroji nalezneme v pfiru¢ce Za¢iname

s LibreOffice.

Jedinou Sablonou dostupnou v aplikaci Draw je vychozi Sablona a v LibreOffice nejsou
nainstalovany zadné preddefinované Sablony kreseb. Sablony v3ak Ize vytvafet pomoci
nasledujicich moznosti. Sablony kresby Ize nainstalovat i z jinych zdrojd, dal3i informace
nalezneme v ¢asti "Import Sablon" na strané 296.

Tvorba Sablon

PouZiti dialogového okna Ulozit jako Sablonu

1) Otevieme kresbu, kterou chceme pouZzit jako zaklad pro Sablonu, nebo otevieme
a upravime Sablonu, kterou chceme pouZit jako zaklad pro novou Sablonu.

2) Pridame dal$i obsah a styly nebo upravime obsah a styly podle poZzadavk( Sablony.

3) Dialogové okno UloZit jako $ablonu otevieme jednim z nasledujicich zplsobt (obrazek
273 pod):

— V hlavni nabidce zvolime Soubor > Sablony > Ulozit jako $ablonu.

— Klepneme na trojuhelnik v vpravo od Ulozit na Standardni nastrojové listé
a z rozeviraci nabidky vybereme Ulozit jako Sablonu.

4) Do textového pole Zadejte nazev Sablony zadame nazev Sablony.
5) Vybereme kategorii Sablony ze seznamu dostupného v poli Vybér kategorie Sablony.
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UloZit jako £ablonu >

fadejte nazev Zablony:
Vyberte kategorii fablony:
Moje sablony
Kresby
Lokalizowvané

MediaWiki

Obkchodni korespondence

Osobni korespondence a dokumenty
Cstatni cbchodni dokumenty

(] Mastavit jako vychozi

Mapovéda Ulozit frugit

Obrazek 273: Dialogové okno UloZit jako Sablonu

6) Pokud ma byt nova Sablona pouZita jako vychozi Sablona v LibreOffice Draw, vybereme
moZnost Nastavit jako vychozi.

7) Klepnutim na Ulozit ulozime Sablonu a zavieme dialogové okno Ulozit jako Sablonu.
PouZiti pFikazu UloZit jako
1) V hlavni nabidce zvolime Soubor > Ulozit jako nebo pouzijeme klavesovou zkratku
Ctrl + Shift + S(macOS 3 + Ctrl + S) a otevieme dialogové okno Ulozit jako.

2) Prejdeme do slozky Sablon LibreOffice. Skute€¢né umisténi slozky Sablony LibreOffice
zAavisi na systému a nastaveni pocitace.

3) Do pole Nazev zaddme nézev souboru s pfiponou OTG.
4) V rozeviracim seznamu vybereme jako typ souboru Sablona kresby ODF (.otg).

5) Klepnutim na Ulozit uloZime Sablonu a zavieme dialogové okno.

ﬁ Poznamka

PFi ukladani kresby jako Sablony musi byt Sablona uloZena ve sloZce Sablon
LibreOffice, aby ji Spravce Sablon LibreOffice rozpoznal a vyhledal. DalSi informace
nalezneme v ¢asti ,Umisténi slozky Sablon“ na strance 294.

Tvorba kresby ze Sablon

Uvodni obrazovka

Otevieme LibreOffice a vytvofime novou kresbu ze Sablony zobrazené v Uvodni obrazovce
pomoci jedné z nasledujicich metod:

+ Klepnutim na Sablony na Uvodni obrazovce zobrazime dostupné $ablony pro viechny
aplikace LibreOffice. Klepneme na pozadovanou Sablonu a otevie se novy dokument
s pouzitim pfislusného modulu LibreOffice pro danou Sablonu.
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Sablony *

Hledat... Filtrovat |Viechny aplikace V‘ Viechny kategorie e Spravovat ¥

Sy

Podnikové procesy (BPMN) Japanese normal Béiny pro zjednoduiencu mediawiki
cinstinu

Mederni cbchedni dopis Mederni obchedni dopis Zivotopis Struény Zivotopis
bezpatkovy patkovy

Lerem ipsm

Drkcr 5t Amat

Vizitky s logem Vel dl Modra kfivka Elueprint planu

Napovéda Zaviit Cteviit

Obréazek 274: Dialogové okno Sablony
* Klepnutim na trojuhelnik v vpravo vedle moznosti Sablony na Uvodni obrazovce
a naslednym vybérem moznosti Sablony kresby zobrazime Sablony aplikace Draw.
Klepneme na poZadovanou Sablonu a otevie se nova kresba pomoci LibreOffice Draw.
Dialogové okno Sablony
1) Dialogové okno Sablony otevieme jednim z nasledujicich zplsobd (obrazek 274 nad).
— V hlavni nabidce zvolime Soubor > Novy > Sablony.
— V hlavni nabidce zvolime Soubor > Sablony > Sprava Sablon.
— Pouzijeme klavesovou zkratku Ctrl + Shift + N (macOS ¥ + Shift + N).
2) V rozeviracim seznamu Filtr vybereme moZznost Kresby.
3) Vybereme kategorii z moznosti dostupnych v rozeviracim seznamu VSechny kategorie.
4) Z moznosti dostupnych v okné nahledu vybereme Sablonu.

5) Klepnutim na volbu Otevfit nebo dvojklikem na Sablonu vytvofime novou kresbu pomoci
vybrané Sablony a zavieme dialogové okno Sablona.

6) V hlavni nabidce zvolime Soubor > Ulozit jako a uloZzime novou kresbu jako soubor
s pfiponou ODG.

Vychozi Sablona

Pokud je vytvofena nova kresba bez vybéru Sablony, LibreOffice vytvori kresbu pomoci vlastnosti
pevné zakodovanych v LibreOffice. Jako vychozi Sablonu pro Draw vSak |ze pouzit libovolnou
Sablonu kresby. Vybrana Sablona musi byt ve slozkach Sablon pouzivanych pro aplikace

a kategorie LibreOffice. DalSi informace nalezneme v €asti ,Umisténi sloZky Sablon“ na strance
294,
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Nastaveni vychozi Sablony
1) Dialogové okno Sablony otevieme jednim z nasledujicich zplsobd:
— V hlavni nabidce zvolime Soubor > Novy > Sablony.
— V hlavni nabidce zvolime Soubor > Sablony > Sprava Sablon.
— Pouzijeme klavesovou zkratku Ctrl + Shift + N (macOS 3 + Shift + N).
2) V rozeviracim seznamu Filtr vybereme moznost Kresbhy.
3) Vybereme kategorii z moznosti dostupnych v rozeviracim seznamu VSechny kategorie.
4) Z moznosti dostupnych v okné nahledu vybereme Sablonu.

5) Klepneme pravym tlacitkem mySi na vybranou Sablonu a z mistni nabidky vybereme
moZznost Nastavit jako vychozi. Neexistuje Zadné potvrzeni, Ze vybrané Sablona je nyni
vychozi Sablonou pro nové kresby. Vychozi Sablona je oznaCena zaSkrtnutim v levém
hornim rohu ikony Sablony.

6) Klepnutim na Zavfit zavieme dialogové okno Sablony. P¥i pFistim vytvofeni nové kresby
se pouzije nova vychozi Sablona.

ﬁ Poznamka

Pokud je nova kresba vhodna k pouZziti jako vychozi Sablona, je potfeba ji nejprve
uloZit jako Sablonu a teprve poté ji pouZzit jako vychozi Sablonu. DalSi informace
nalezneme v Céasti , Tvorba Sablon“ na strance 289.

.- Tip
Pokud chceme obnovit vSechny vychozi Sablony pro vSechny moduly LibreOffice,
klepneme v dialogovém okné Sablony na Spravovat a z rozeviraciho seznamu

vyberte Obnovit vSechny vychozi Sablony.

Obnoveni vychozi sablony

1) Dialogové okno Sablony otevieme jednim z nasledujicich zplisob (obrazek 274 na
strané 291):

— V hlavni nabidce zvolime Soubor > Novy > Sablony.
— V hlavni nabidce zvolime Soubor > Sablony > Sprava Sablon.
— Pouzijeme klavesovou zkratku Ctrl + Shift + N (macOS ¥ + Shift + N).
2) V rozeviracim seznamu Filtr vybereme moznost Kresby.
3) Vybereme kategorii z moznosti dostupnych v rozeviracim seznamu VSechny kategorie.

4) Klepneme pravym tlacitkem mySi na vychozi Sablonu. Vychozi Sablona je oznacena
zaskrtnutim v levém hornim rohu ikony Sablony.

5) Z mistni nabidky vybereme Obnovit vychozi. Neexistuje Zadné potvrzeni, Ze LibreOffice
Draw byl obnoven na pouzivani vychozich vlastnosti LibreOffice. Z ikony Sablony se
odstrani zaSkrtnuti.

6) Klepnutim na Zavfit zavieme dialogové okno Sablony. P¥i pFistim vytvofeni nové kresby
se pouzije vychozi Sablona LibreOffice.

Upravy Sablon

Styly Sablon a obsah Sablon Ize upravovat a v pfipadé potfeby znovu pouzit na kresby, které byly
vytvofeny pomoci dané Sablony. Obsah kresby, ktery neni soucésti Sablony, nelze znovu pouZit.
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ﬁ Poznamka

Sablony dodané s LibreOffice nelze odstranit. Upravovat nebo odstrafiovat Ize pouze
Sablony vytvofené pomaoci LibreOffice nebo importované do LibreOffice.

Upravujeme

1) Dialogové okno Sablony otevieme jednim z nasledujicich zplsobi (obrazek 274 na
strané 291):

— V hlavni nabidce zvolime Soubor > Novy > Sablony.
— V hlavni nabidce zvolime Soubor > Sablony > Sprava Sablon.
— Pouzijeme klavesovou zkratku Ctrl + Shift + N (macOS 3 + Shift + N).
2) Vybereme Sablonu kresby, ktera byla vytvorena pomoci LibreOffice nebo importovana do
LibreOffice.

3) Klepneme pravym tlacitkem mysi na vybranou Sablonu a vybérem moZznosti Upravit
z mistni nabidky otevieme Sablonu v aplikaci Draw.

4) Sablonu upravime jako jakoukoliv jinou kresbu.

5) V hlavni nabidce zvolime Soubor > Ulozit nebo pouZijeme klavesovou zkratku Ctrl +
S (macOS ¥ +S) a tim uloZzime Sablonu.

6) Pfipadné miZeme upravenou $ablonu uloZit jako novou Sablonu. Dalsi informace
nalezneme v Casti ,Tvorba Sablon“ na strance 289.

Aktualizace kresby z upravené sablony

Pokud je kresba oteviena a Sablona byla upravena, otevie se potvrzovaci dialogové okno
s Zadosti o aktualizaci styl( v kresbé podle formatovani pouzitého v upravené Sabloné.

* Vybérem moznosti Aktualizovat styly aktualizujeme vSechny styly v kresbé, které byly
zmeéneény v Sabloné, a zavieme potvrzovaci dialogové okno.

 Vybereme Ponechat plvodni styly, aby se styly v kresbé&, které byly zménény
v Sabloné, neaktualizovaly. Potvrzovaci dialog se zavfe a pfi opétovném otevieni
dokumentu se nezobrazi. Kresba jiz také neni pfipojena k Sabloné.

}? Poznamka

Pokud je vybrana moznost Ponechat ptivodni styly, je Sablona stale uvedena
v poloZce Soubor > Vlastnosti > Obecné. Pro opétovné pfipojeni dokumentu
k Sabloné je tfeba Sablonu znovu pfifadit.

Zmeéna Sablon pfifazenych kresbam

V pripadé potieby Ize Sablonu plvodné pouzitou pro kresbu zménit na jinou Sablonu nebo
plvodni Sablonu pouZitou pro kresbu znovu pfiradit.

* Chceme-Ili ruéné zmeénit nebo znovu pfiradit Sablonu, vytvofime novou kresbu
z pozadované Sablony a zkopirujeme obsah staré kresby do nové kresby.

» Stdhneme si rozSifeni Template Changer z webu LibreOffice na adrese
https://extensions.libreoffice.org/extensions?ord=download_d&Tags%5B%5D=47
a nainstalujeme jej do LibreOffice. Restartujeme LibreOffice a aktivujeme rozSifeni.
Otevieme kresbu a pomoci Soubor > Sablony > Zménit Sablonu (aktualni dokument)
v hlavni nabidce zménime Sablonu. DalSi informace nalezneme v pfiru¢ce Za¢iname

s LibreOffice.
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MazZnosti - LibreDffice - Cesty X

Zadejte hledany text Cesty pougivané aplikaci LibreOffice
B LibreOffice Typ Cesty ufivatele Interni cesty

Udivatelské Odaje Automaticke opravy Ch\Users\petrk\AppData’\Roaming\LibreCffice\d\userautocorr  C\Program Fil
Obecné Automaticky text ChUsers\petrk\AppData\Roaming'\LibreOffice\d\user\autotext  C\Program Fil
Zobrazeni Doéasné soubory Ci\Users\petrk\AppData\Local\Temp
Tisk | Ciokumenty ChUsers\petrk\Documents

“ Galerie Ch\Users\petrk\AppData\Roaming\LibreOffice\fuser\gallery  C\Pragram Fil
Pisma Klasifikace C\Program Files\LibreCffice\program. \share\classification’.ex
Zabezpetens Motiv vzhledu dokumentu  Ch\Users\petrid AppData\Roaming'\LibreOffice\$\userthemes  C\Program Fil
Vzhled Chrazky Cih\Users\petrk\AppData\Roaming\LibreOffice\d\user\gallery
Zpfistupnéni Slovniky ChUsers\petrk\AppData\Roaming'\LibreOffice\d\user\werdboo  C\Pregram Fil
Pokrogile fsablon}f Ch\Users\petri\AppData’\Roaming\LibreCffice\d\useritemplate  C:\Program Fil
Basic IDE Zalohy Ci\Users\petrk\AppData’\Roaming\LibreCffice\d\user\backup

Online aktualizace
OpenCL
Maéitanifukladani

B E

Jazyky a ndrodn( prostiedi
LibreCffice Draw
LibreCffice Base

Grafy

Internet

BHEHEBEB

Vychozi Upravit

MNapowvéda Cbnovit Pouzit Zrugit

Obrazek 275: Dialogové okno Cesty pouZivané aplikaci LibreOffice

Sprava Sablon

LibreOffice dokaze vyhledat pouze Sablony, které jsou ve sloZce Sablon LibreOffice. Kategorie
Sablon Ize vytvaret a pouzivat k uspofadani Sablon, napfiklad k vytvoreni samostatnych kategorii
pro réizné projekty nebo klienty. Sablony Ize také importovat a exportovat.

Umisténi sloZky Sablon

Umisténi slozky Sablony v LibreOffice se liSi podle operacniho systému pocitace. Umisténi
sloZky Sablon v pocitaci je nasleduijici:

1) V hlavni nabidce Nastroje > MoZnosti > LibreOffice > Cesty (macOS LibreOffice >
Predvolby > LibreOffice > Cesty) a tim otevieme dialogové okno Cesty pouzivané
aplikaci LibreOffice(obrazek 275 nad).

2) Prejdeme dold na Sablony v Cesty pouzivané aplikaci LibreOffice a ur¢ime slozku
Sablon pouzivanou LibreOffice.

Vytvareni kategorii Sablon
1) Dialogové okno Sablony otevieme jednim z nésledujicich zplsobd:
— V hlavni nabidce zvolime Soubor > Novy > Sablony.
— V hlavni nabidce zvolime Soubor > Sablony > Sprava Sablon.
— Pouzijeme klavesovou zkratku Ctrl + Shift + N (macOS ¥ + Shift + N).
2) V rozeviracich seznamech Filtr vybereme jako aplikaci Kresby.
3) Klepneme na Spravovat a z mistni nabidky vybereme Novéa kategorie.

4) V otevieném dialogovém okné zadame nazev do textového pole Zadejte nazev nové
kategorie.

5) Klepnutim na OK uloZime novou kategorii v LibreOffice a zavifeme dialogové okno.
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ﬁ Poznamka

V kategoriich Sablon LibreOffice jsou vychozi moZnosti Pfejmenovat kategorii
a Smazat kategorii Sedé. To znamena, ze kategorie Sablon nelze pfejmenovat ani
odstranit.

Piejmenovani kategorii Sablon

Kategorie $Sablon plivodné nainstalované s LibreOffice nelze prejmenovat. Pfejmenovat Ize
pouze kategorie Sablon vytvofené po instalaci LibreOffice.

1) Dialogové okno Sablony otevieme jednim z nésledujicich zp(isobd:

— V hlavni nabidce zvolime Soubor > Novy > Sablony.

— V hlavni nabidce zvolime Soubor > Sablony > Sprava $ablon.

— Pouzijeme klavesovou zkratku Ctrl + Shift + N (macOS ¥ + Shift + N).
2) V rozeviracich seznamech Filtr vybereme jako aplikaci Kresby.

3) Z moznosti dostupnych v rozeviracim seznamu VSechny kategorie vyberte kategorii pro
prejmenovani.
4) Klepneme na Spravovat a z mistni nabidky vybereme Pfejmenovat kategorii.

5) V otevieném dialogovém okné zadame nazev do textového pole Zadejte nazev nové
kategorie.

6) Klepnutim na OK ulozime pfejmenovanou kategorii v LibreOffice a zavieme dialogové
okno.

Mazani kategorii Sablon

Kategorie Sablon nainstalované v LibreOffice nelze odstranit. Odstranit Ize pouze kategorie
Sablon vytvofené po instalaci LibreOffice.

1) Dialogové okno Sablony otevieme jednim z nasledujicich zp(isobd:

— V hlavni nabidce zvolime Soubor > Novy > Sablony.

— V hlavni nabidce zvolime Soubor > Sablony > Sprava $ablon.

— Pouzijeme klavesovou zkratku Ctrl + Shift + N (macOS & + Shift + N).
2) V rozeviracich seznamech Filtr vybereme jako aplikaci Kresby.

3) Z moznosti dostupnych v rozeviracim seznamu VSechny kategorie vybereme kategorii
Sablon, kterd ma byt odstranéna.

4) V poli Spravovat vybereme z rozeviraciho seznamu Smazat kategorii.

5) Klepnutim na Ano ve varovné zprave potvrdime odstranéni kategorie.

Prfesun Sablon
1) Dialogové okno Sablony otevieme jednim z nasledujicich zpdsobd:
— V hlavni nabidce zvolime Soubor > Novy > Sablony.
— V hlavni nabidce zvolime Soubor > Sablony > Sprava Sablon.
— Pouzijeme klavesovou zkratku Ctrl + Shift + N (macOS ¥ + Shift + N).
2) V rozeviracich seznamech Filtr vybereme jako aplikaci Kresby.

3) Z moznosti dostupnych v rozeviracim seznamu VSechny kategorie vybereme kategorii
Sablony pro presun.
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4) Klepneme pravym tlacitkem my3i na Sablonu, ktera mé byt pfesunuta, a vybérem
moznosti Pfesunout z mistni nabidky otevieme dialogové okno Vybrat kategorii (obrazek
276).

5) Vybereme kategorii z nabidky Vybrat z Existujici kategorie nebo zadame nazev nové
kategorie do Vytvofit novou kategorii.

6) Klepnutim na OK pfesuneme Sablonu do vybrané kategorie a zavieme dialogové okno
Vyberte kategorii.
Import Sablon

Pomoci Spravce rozsifeni Ize Sablony stahovat z mnoha zdrojd, véetné oficialniho UloZisté
Sablon LibreOffice. DalSi informace o pouzivani Spravce rozSifeni k importu Sablon nalezneme
v pfirucce Zac¢iname s LibreOffice.

UloZime Sablonu do pocitaCe a poté ji importujeme do slozky Sablon LibreOffice nasledujicim
zpUsobem:

1) Dialogové okno Sablony otevieme jednim z nésledujicich zplsobd:

— V hlavni nabidce zvolime Soubor > Novy > Sablony.

— V hlavni nabidce zvolime Soubor > Sablony > Sprava Sablon.

— Pouzijeme klavesovou zkratku Ctrl + Shift + N (macOS ¥ + Shift + N).
2) V rozeviracich seznamech Filtr vybereme jako aplikaci Kresby.

3) Klepneme na Spravovat a z kontextové nabidky vybereme Import. Tim otevieme
dialogové okno Vyberte kategorii (obrazek 276 pod).

4) Vybereme kategorii z Vyberte z existujici kategorie nebo zaddme nazev nové kategorie
do Vytvofit novou kategorii.

5) Klepneme na OK a otevieme okno prohlizece soubor(.

6) Pfejdeme do slozky obsahujici Sablonu, Sablonu vybereme a klepneme na Otevfit.
Prohlize¢ soubor(l se zavie a Sablona se zobrazi ve vybrané kategorii $ablon
v dialogovém okné Sablony.

Vyberte kategorii >

Wyberte z existujici kategorie

Maje 2ablony

Kresby

Lokalizované

MediaWiki

Chcheodni kerespendence

C=obni korespondence a dokumenty
Cstatni cbchodni dokumenty

nebo vytvofte novou kategorii

Mapowvéda OK Zrugit

Obrazek 276: Dialogové okno Vybér kategorie
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ﬁ Poznamka

Export Sablony ji neodstrani z dialogového okna Sablony ani ze slozky Sablon. PFi
exportu se kopie Sablony umisti do zadaného umisténi.

Export Sablon

Exportovat $ablonu z kategorie $ablon do jiného umisténi v pocitaci nebo v siti miizeme
nasledujicim zplsobem:

1) Dialogové okno Sablony otevieme jednim z nésledujicich zp(isobd:

— V hlavni nabidce zvolime Soubor > Novy > Sablony.

— V hlavni nabidce zvolime Soubor > Sablony > Sprava $ablon.

— Pouzijeme klavesovou zkratku Ctrl + Shift + N (macOS & + Shift + N).
2) V rozeviracich seznamech Filtr vybereme jako aplikaci Kresby.

3) Z moznosti dostupnych v rozeviracim seznamu VSechny kategorie vybereme
pozadovanou kategorii Sablony.

4) Klepneme pravym tlacitkem mySi na poZadovanou Sablonu a vybérem moZnosti
Exportovat z mistni nabidky otevieme okno prohlizece soubord.

5) Pfejdeme do cilové slozky, do které bude Sablona exportovana.
6) Klepneme na OK a exportovana Sablona se objevi ve vybrané slozce.

7) Klepnutim na Zavf¥it zavieme dialogové okno Sablony.

Mazani Sablon
1) Dialogové okno Sablony otevieme jednim z nésledujicich zp(isobd:
— V hlavni nabidce zvolime Soubor > Novy > Sablony.
— V hlavni nabidce zvolime Soubor > Sablony > Sprava $ablon.
— Pouzijeme klavesovou zkratku Ctrl + Shift + N (macOS ¥ + Shift + N).
2) V rozeviracich seznamech Filtr vybereme jako aplikaci Kresby.

3) Z moznosti dostupnych v rozeviracim seznamu VSechny kategorie vybereme
poZadovanou kategorii Sablony.

4) Klepneme pravym tlaCitkem mySi na odstranovanou Sablonu a z mistni nabidky
vybereme moznost Odstranit.

5) Klepnutim na Ano potvrdime odstranéni Sablony.

6) Klepnutim na Zavf¥it zavieme dialogové okno Sablony.

}? Poznamka

Sablony nainstalované v LibreOffice nelze odstranit. Odstranit Ize pouze Sablony,
které byly vytvofeny nebo importovany po instalaci LibreOffice.

Vice vrstev

Vrstvy v aplikaci Draw umoZiiuji sestaveni souvisejicich prvkl v kresbé. Vrstvy jsou jednotlivé
pracovni prostory v kresbé, které |ze skryt pfed zobrazenim, zabranit jejich tisku nebo je
uzamknout, aby v nich nebylo mozné provadét zmeny.
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Rozvrzeni Ovladaci prvky Kotovaci Cary

Stranka 1z 2 (Rozvrieni)  VWybrdno Obrdzek s prahlednost’
Obréazek 277: Priklad karty Vrstvy kresby

Vrstvy neurcuji pofadi skladani objektl v kresbé, s vyjimkou vrstvy Ovladaci prvky. Vrstva
Ovladaci prvky je v kresbé vzdy pred vSemi ostatnimi vrstvami. Poradi objektl v kresbé je
uréeno poradim, v jakém byly objekty pridany. Pofadi skladani objektli zmé&nime tak, Ze v hlavni
nabidce zvolime Tvar > Uspofadat.

Vrstvy v kresbé jsou oznaceny kartami umisténymi ve spodni ¢asti Pracovni plochy a nad
Stavovym fadkem, jak je zndzornéno na obrazku 277 nad. Ve vychozim nastaveni je pfi
otevieni kresby vzdy vybrana karta Rozvrzeni. Klepnutim na jinou kartu vybereme dalSi vrstvu
v kreshé.

ﬁ Poznamky

P¥i pfidani nové vrstvy se vrstva pfida na vSechny stranky kresby. Pokud je vSak
objekt pfidan do vrstvy na vybrané strance, je pfidan pouze na vybranou stranku
kreshy.

Pokud se ma objekt zobrazit na vSech strankach kresby, napriklad logo spole¢nosti,
pfidame objekt na hlavni stranku tak, Ze v hlavni nabidce zvolime Zobrazit >
Predloha. Vice informaci najdeme v €asti ,Pfedlohy stranek" na strané 283.

Vychozi vrstvy

Normalni pohled

V zobrazeni Normalni poskytuje LibreOffice Draw tfi vychozi vrstvy, které jsou pro uzivatele
viditelné. Tyto vychozi vrstvy neni mozné smazat ani pfejmenovat.

Rozvrzeni
Vychozi pracovni plocha, na kterou se obvykle umistuji objekty.

Ovladaci prvky
Pouziva se pro ovladaci prvky formulafe, kterym byla pfifazena akce. Objekty v této
vrstvé jsou vzdy pfed objekty v jinych vrstvach. Pokud chceme zabranit viditelnosti
ovladacich prvkl formulare v kresbé, zrusime zaskrtnuti moznosti Viditelna v dialogovém
okné Vlozit vrstvu nebo Upravit vrstvu. Pokud chceme zabranit tisku ovladacich prvku
formulare, zruSime zaskrtnuti moznosti Tisknutelna v dialogovém okné Vlozit vrstvu
nebo Upravit vrstvu.

s ¥z

Kétovaci Cary

Pri kresleni kotovacich Car se kotovaci Cary automaticky umisti do této vrstvy. Pokud
chceme zabranit viditelnosti kotovacich ¢ar v kresbé, zruSime zaskrtnuti moznosti
Viditelna v dialogovém okné Vlozit vrstvu nebo Upravit vrstvu. Pokud chceme zabranit
tisku kétovacich Car, zruSime zaSkrtnuti moznosti Tisknutelnd v dialogovém okné Vlozit
vrstvu nebo Upravit vrstvu.

Zobrazeni predlohy

V zobrazeni Pfedloha poskytuje LibreOffice jedinou vrstvu, Objekty pozadi. Tato vrstva se
pouziva k umisténi objektl, které se objevuji na kazdé strance kresby, napriklad logo
spolecnosti, datum, Cislo stranky, nazev kresby atd.

298 | Pfirucka aplikace Draw 25.8



VloFit vrstvu X
MNazev
|'u'rst‘ufa4

Nadpis

Popis

Viastnosti
Viditelna
Tisknutelna
[] Uzaméena

MNapovéda oK l Zruiit

Obréazek 278: Dialogové okno VloZit vrstvu

Vkladani vrstev

1) Dialogové okno Vlozit vrstvu otevieme jednim z nasledujicich zpUsobU (obrazek 278
nad):

— Klepneme pravym tlaCitkem mySi na oblast karty vrstvy v dolni ¢asti oblasti Pracovni
plochy a z mistni nabidky vybereme moznost Vlozit vrstvu.

— V hlavni nabidce zvolime Vlozit > Vrstva.
2) Do textovych poli Nazev a Nadpis viozime smysluplny nazev vrstvy.
3) V pripadé potfeby zaddme popis nové vrstvy do textového pole Popis.

4) Pokud chceme, aby byla vrstva v kresbé viditelna, vybereme moznost Viditelna. Pokud
neni volba Viditelné vybrana, vrstva je skryta a jeji jméno na zalozce zméni barvu na
modrou.

5) Pokud chceme, aby byla vrstva v kresbé tisknutelna, vyberme moznost Tisknutelna.
Pokud neni vybrana moznost Tisknutelna, je nazev vrstvy na pasu karet vrstev
podtrzeny. Napfiklad nevytisknout vrstvu je uzite€né, pokud je vrstva navrhovou vrstvou
pro voditka nebo poznadmky pouzivané pfi vytvafeni kresby, ale neni vyZadovana pro
konecny tistény vystup.

6) Vybérem volby Uzaméena zabranime mazani, Gpravam nebo presouvani objektl ve
vrstvé. Do uzamcené vrstvy neni mozné pfidavat dalSi objekty. Nazev uzamcené vrstvy
se na pasu karet vrstev zméni na text psany kurzivou. Uzamceni vrstvy je uzitecné
napriklad v pripadé, Ze je tfeba chranit zakladni plan a zaroven pfidat novou vrstvu
s dalSimi detaily.

7) Klepnutim na OK zavieme dialogoveé okno Vlozit vrstvu a nova vrstva se automaticky
stane aktivni.
Uprava vrstev
1) Vybereme vrstvu, kterd mé byt upravena.

2) Dialogové okno Upravit vrstvu otevieme jednou z téchto moznosti. Dialogové okno
Upravit vrstvu je podobné dialogovému oknu VloZit vrstvu (obrazek 278 nad):
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— Klepneme pravym tlacitkem mySi na oblast karty vrstvy v dolni ¢asti oblasti Pracovni
plochy a z mistni nabidky vybereme mozZnost Upravit vrstvu.

— V hlavni nabidce vybereme Format > Vrstva
— Klepneme dvakrat na kartu vrstvy.
3) Provedeme potiebné zmény atributd vrstvy.
4) Klepnutim na OK ulozime zmény a zavieme dialogové okno Upravit vrstvu.

Prace s vrstvami

Vybér vrstvy

Klepnutim na kartu s ndzvem vrstvy na li5té karet Vrstvy vybereme a aktivujeme vrstvu. Objekty
pfidané do kresby se pfidavaji pouze do aktivni vrstvy. Ovladaci prvky formulafe se automaticky

7 %7z

pridaji do vrstvy Ovladaci prvky a kétovaci ¢ary se automaticky pfidaji do vrstvy Kétovaci €ary.
Pokud je v kresbé nékolik vrstev, nemusi byt karta vrstvy na listé karet Vrstvy viditelna. Pomoci
navigacnich ikon na levé strané Listy karet vrstvy miZeme pfejit na pozadovanou vrstvu.
Skryti vrstvy

1) Vybereme vrstvu, kterd ma byt skryta, a otevieme dialogové okno Upravit vrstvu.

2) ZruSime vybér Viditelnost a klepneme na OK. Text s ndzvem vrstvy na karté zméni
barvu na modrou. Objekty umisténé ve skryté vrstvé jiz nejsou v ostatnich vrstvach
kresby viditelné.

3) Pfipadné podrzime stisknutou klavesu Shift a klepnutim na kartu s nazvem vrstvy
vrstvu skryjeme.
Zobrazeni skrytych vrstev

1) Vybereme skrytou vrstvu, kterd se ma stat viditelnou, a otevieme dialogové okno Upravit
vrstvu.

2) Vybereme Viditelné a klepneme na OK. Text s nazvem vrstvy na karté zméni barvu na
vychozi barvu textu. VSechny objekty umisténé ve skryté vrstvé jsou nyni viditelné
v ostatnich vrstvach kresby.

3) Pripadné podrzime klavesu Shift a klepneme na kartu s nazvem vrstvy, aby se vrstva
zobrazila.
Zamykani vrstev
1) Vybereme vrstvu, ktera ma byt uzamcena, a otevieme dialogové okno Upravit vrstvu.

2) Vybereme Uzaméena a klepneme na OK. Text s ndzvem vrstvy na karté bude podtrzeny.
Uzamceni vrstvy zabrafuje jakymkoliv Upravam vrstvy.

3) Pfipadné podrzime stisknutou klavesu Ctrl (macOS 38) a klepnutim na kartu s ndzvem
vrstvu uzamkneme.
Odemykani vrstev
1) Vybereme uzamcenou vrstvu a otevieme dialogové okno Upravit vrstvu.

2) ZruSime vybér Uzamé€ena a klepneme na OK. Text s nazvem vrstvy na karté jiz neni
podtrzeny.

3) Pfipadné podrzime stisknutou klavesu Ctrl (macOS ) a klepnutim na kartu s nazvem
uzamcené vrstvy ji odemkneme.
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ﬁ Poznamka

Pfejmenovat nebo odstranit Ize pouze vrstvy pfidané do kresby. Vychozi vrstvy
Rozvrzeni, Ovladaci prvky a Kétovaci €ary nelze pfejmenovat ani smazat.

Piejmenovavani vrstev
1) Vybereme vrstvu, ktera mé byt pfejmenovana, a otevieme dialogové okno Upravit vrstvu.
2) Do textového pole Nazev zadame novy nazev a klepnutim na OK zménu uloZzime.

3) Pripadné klepneme pravym tlagitkem mySi na kartu s nazvem vrstvy a z mistni nabidky
vybereme Pfejmenovat vrstvu. Text je mozné upravovat a ménit jeho nazev. Klepnutim
mimo oblast karet vrstev zmény uloZime.

4) Pripadné podrzime stisknutou klavesu Alt (macOS ~\2) a klepneme na kartu s nazvem.
Text je mozné upravovat a meénit jeho nazev. Klepnutim mimo oblast karet vrstev zmény
ulozime.

Smazani vrstev

1) Klepneme pravym tlaCitkem mySi na kartu s nazvem vrstvy, kterd ma byt odstranéna,
a z mistni nabidky vybereme Smazat vrstvu.

2) Potvrdime odstranéni vrstvy. Vrstva a vSechny objekty ve vrstvé jsou z kresby
odstranény.

Presouvani objekti mezi vrstvami

Pokud jsou ve vrstvé vybrany objekty, ve Stavovém fadku vidime, kolik objektd je vybrano.
Umisténi presunutych objekt( se v kresb& nezméni a vrstva, do které byly objekty umistény, se
zobrazi ve Stavovém fadku. Vybranych objekty pfesuneme z jedné vrstvy do jiné vrstvy pomoci
jedné z nasledujicich metod:

» Klepneme na vybrané objekty a pfetdhneme je na nazev karty cilové vrstvy.

+ V hlavni nabidce zvolime Upravy > Vyjmout nebo klepneme pravym tlagitkem mysi na
vybrané objekty a z mistni nabidky vybereme Vyjmout. Vybereme cilovou vrstvu
a v hlavni nabidce zvolime Upravy > VloZit nebo klepneme pravym tlacitkem mysi na
Pracovni plochu a z mistni nabidky vybereme VloZit.

Koétovani

Koétovani objektd v aplikaci Draw a nasledné zobrazeni kétovani vytvori kresbu podobnou

s vz

technickému vykresu. Kétovani se automaticky umisti do vrstvy Kétovaci €ary.

Koétované objekty

1) Kétovani objektu provedeme pomoci jedné z nasledujicich moznosti. Kurzor meéni tvar
v zavislosti na operacnim systému pocitaCe, napfiklad kfizek:

— Klepnutim na trojuhelnik v vedle ikony Cary a Sipky na nastrojové listé Kresba
otevieme dil€i nastrojovou liStu Cary a Sipky (obrazek 279 pod) a klepneme na
Kétovaci ¢ary.

— Klepneme na ikonu Kétovaci €ara” v panelu Cary a Sipky na karté Tvary v postranni
listé (obrazek 280 pod).

2) Umistime kurzor do jednoho z roht objektu a klepnutim a pretazenim kurzoru nakreslime
kotovaci Caru. Pokud chceme omezit kresleni kotovaci ¢ary ve vodorovném nebo svislém
smeéru, pfidrzime pfi tazeni kurzoru klavesu Shift.
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3) Po dosazeni konce kétovaci ¢ary uvolnime kurzor a kétovaci ¢ara se vykresli. Kétovani
se pfida automaticky (jak ukazuje pfiklad na obrazku 281 pod). Koétovaci ¢ary se
automaticky umisti do vrstvy Kétovaci €ary.

Obréazek 279: Diléi nastrojova lista Cary a Sipky

! Tvary T X =
= Wychozi E
Gr}ra Sipky
/ — -— - - - %
Krivky a mnohodhelniley
¢ A <& > | ©
a L 3

Obrazek 280: Panel Cary a Sipky na karté Tvary v postranni listé

10,75 cm

Obrazek 281: Priklad kotovacich car

4) Pokud chceme upravit text kéty, klepneme dvakrat na nevybranou kétovaci ¢aru, ¢imz
vstoupime do reZzimu Uprav textu a provedeme potfebné zmény. Klepnutim mimo

7 ¥z

koétovaci ¢aru zmeény ulozime.

5) Informace o konfiguraci kotovaci ¢ary najdeme v Casti ,Nastaveni kotovani” na strané
302.

)? Poznamka

Po Upravé textu kéty kresbu ulozime a zavieme. Znovu otevieme kresbu a povolime
automatické méreni kotovani.

Nastaveni kotovani

Styly objektu kresby

1) Otevieme dialogové okno Grafické styly (obradzek 282 pod) jednim z nésledujicich
zpUsobU:

302 | Prirucka aplikace Draw 25.8



— V hlavni nabidce zvolime Format > Styly > Upravit styl.

— Pomoci klavesové zkratky F11 (macOS 38+T) otevieme kartu Styly na postranni listé,
poté klepneme pravym tlacitkem mySi na styl a z mistni nabidky vybereme Upravit.

— Klepnutim na Styly v postranni listé otevieme kartu Styly, poté klepneme pravym
tlaCitkem mysi na styly a z mistni nabidky vybereme Upravit.

2) Klepnutim na Kétovani otevieme stranku Kétovani v dialogovém okné.

Graficke styly: Viyichozi styl kresby X

! | Obecne Céra Legenda '
Cira Wzdalenost ¢any: 0.80cm = Umisténi textu
- ——0O0—0 1
Oklast Previs voditka: 0,20ecm = i (L
Stinovani Vzdélenost voditka:  0,10cm = L)
Prihlednost Levé voditko: 0,00 cm = lgf“
Pismo Pravé vodtko: 0.00 crn D Autematicky svisle |
2 — 5 icky z
Efekty pro pismo [ M&it pod objektem /] Automaticky vodorovné
2 = Rovnobéiné s £arou
Odsazent a rozestupy Desetinna mista: 2 = —
—_— |_| Zobrazit mérné jednotky
Text
Automaticky
Animace textu
Kétovdni
Spojnice
Zarovnani
Tabulatory
Zwfraznéni
Napovéda Cbnovit Standardni oK Zrusit

Obréazek 282: Dialogové okno Grafické styly — stranka Koétovani

3) Pozadované zmény v kétovani provedeme pomoci réiznych moznosti v ¢asti Cara a ¢asti
Legenda na karté Kétovani.

4) Klepnutim na OK uloZime zmény a zavieme dialogové okno Grafické styly.
5) Chceme-li obnovit moZnosti kétovani na vychozi vlastnosti Sablony, otevieme dialogové
okno Grafické styly a klepneme na Standardni.
Dialogové okno Koétovaci ¢ara

1) Nakreslime kétovaci ¢aru. DalSi informace nalezneme v Casti ,Kétované objekty“ na
strance 301.

2) Klepneme pravym tlacitkem mySi na kétovaci ¢aru a z mistni nabidky vybereme
Kétovani. Tim otevieme dialogové okno Kotovaci ¢ara (obrazek 283 pod).

3) Pozadované zmény koétovani provedeme pomoci rliznych moznosti v dialogovém okné
Kétovaci Cara.

4) Klepnutim na OK zmény ulozime a zavieme dialogové okno Kotovaci Cara.

MoZzZnosti kétovani

Moznosti kétovani na strance Rozméry v dialogovém okné Grafické styly a v dialogovém okné

Kétovaci Cara jsou nasledujici. Nahled v dialogovych oknech se méni podle nésledujicich
moznosti, které ukazuiji, jak se kotovaci Cara zobrazi v kresbé.

Cara
Nastavuje vzdalenosti mezi kétovaci €arou, voditky a objektem.
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Vzdalenost Car

Ur€uje vzdalenost mezi kétovaci Carou a objektem nebo zékladni ¢arou. Do textového
pole je mozné zadat minimalni hodnotu —10 mm a maximalni hodnotu 10 mm. Cim

..... 7 w7 s x Ly

niz8i je hodnota, tim bliZe je kdtovaci Cara objektu nebo zakladni Care.

Kétovaci Edra >
Cara Legenda
Vzdalenost Cary: 0,80 cm = Umisténi textu
- (. O O
Previs voditka: 0.20cm = (L (L
Vzdalenost voditka: 0,10 cm = @® l
Levé voditko: 0,00 cm = (L C {

Prave voditko: 0.00cm Automaticky svisle

e . B Automaticky vodorovné
[_J M&fit pod objektem e i
Rovnobéiné s carou

Zobrazit mémé jednotky

Automaticky |~

143,51 mm

Desetinng mista: 2

OK Zruiit

Obréazek 283: Dialogové okno Koétovaci ¢ara

Previs voditka

Urcuje vzdalenost, ve které voditko prfesahuje nad nebo pod kétovaci ¢aru. Do
textového pole je mozné zadat minimalni hodnotu —10 mm a maximalni hodnotu 10
mm. Kladné hodnoty zpisobi, Ze previs voditka pfesahne kétovaci ¢aru. Zaporné
hodnoty zpUsobi, Ze pfevis voditka bude zakladni ¢arou.

Vzdalenost voditka

UrCuje délku pravého a levého voditka pod kétovaci ¢arou smérem k objektu. Do
textového pole je mozné zadat minimalni hodnotu —10 mm a maximalni hodnotu 10
mm. Kladné hodnoty prodluzuji voditka nad z&kladni Caru a dale od objektu. Zaporné

ey

Levé voditko

UrCuje délku levého voditka od kétovaci ¢ary. Do textového pole je mozné zadat
minimalni hodnotu —10 mm a maximalni hodnotu 10 mm. Kladné hodnoty prodluzuiji

voditko pro kétovaci ¢aru smérem k objektu. Zaporné hodnoty oddali voditko od
objektu.

Pravé voditko

Urcuje délku pravého voditka od kétovaci ¢ary. Do textového pole je mozné zadat
minimalni hodnotu —10 mm a maximalni hodnotu 10 mm. Kladné hodnoty prodluzuiji
voditko pro koétovaci ¢aru smérem k objektu. Zaporné hodnoty oddali voditko od
objektu.

MEérit pod objektem
Obrati polohy a délky kétovaci €ary a vodicich linii nastavené v moznostech Cara.
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Desetinna mista
UrCuje pocet desetinnych mist pouZzitych pro zobrazeni vlastnosti Cary.
Legenda
Nastavi vlastnosti textu koty.

Umisténi textu

Urcuje polohu textu kéty vici kotovaci ¢are a voditkdim. Automaticky svisle
a Automaticky vodorovné musi byt pfed vyb&rem pozice textu odznaceny.

Automaticky svisle
Ur€uje optimalni svislou polohu textu rozméru.
Automaticky vodorovné
Ur€uje optimalni vodorovnou polohu textu rozméru.
RovnobézZné s Carou
Pokud je vybrano, zobrazi text rovnobézné s kétovaci ¢arou nebo pokud je vybér
zruden, zobrazi text v Ghlu 90 stupid ke kétovaci Gare.
Zobrazit mérné jednotky

Zobrazi nebo skryje mérné jednotky kotovaci ¢ary. Z rozeviraciho seznamu vybereme
mérnou jednotku.

)? Poznamka

MozZnosti kétovani jsou spojeny s aktudlni kresbou a vSechny provedené zmény
kétovani se vztahuji pouze na aktualni kresbu. Nové kresby zacinaji se standardnimi
vlastnostmi aplikace Draw. Pokud maji byt moznosti kétovani pouzity pro budouci
kresby, ulozime kresbu jako Sablonu.

.- Tip
Pri kétovani objektl se doporucuje pouzivat funkce zvétSeni, vodici ¢ary a funkce
prichyceni, aby bylo mozné kétovaci Cary presné umistit na objekt. Vice informaci
nalezneme v kapitole 3, Prace s objekty a body objektd.

Kresba v méfritku

V aplikaci Draw ma kreslici plocha obvykle velikost stranky Letter nebo A4, v zavislosti na
nastaveni pocCitaCe a vychozi tiskarné pripojené k pocitaci. V zavislosti na skutecné velikosti
kreslenych objektl je viak ¢asto vhodné kresbu zmensit nebo zvétsi pomoci méfitka (napriklad
1:10 nebo 2:1).

ﬁ Poznamka

Pri kresleni v méfitku jsou hodnoty konfigurace rozmér( v dialogovych oknech Styl
grafiky a Kétovaci ¢ara rovnéz v meéfitku. Napfiklad hodnota 10 mm v dialogovém
okné znamen& hodnotu kéty 300 mm, pokud je méfitko nastaveno na 1:30.

Zadame hodnotu méfitka kresby tak, Zze vybereme Nastroje > Moznosti > LibreOffice Draw >
Obecné (macOS LibreOffice > Pfedvolby > LibreOffice Draw > Obecné) a tim otevieme
dialogové okno Moznosti (obrazek 284 pod). Potom vybereme hodnotu z rozeviraciho seznamu

Méfitko. Vychozi nastaveni této moznosti je 1:1. Pokud je provedena zména méfitka kresby,
projevi se ve vodorovnych a svislych pravitkach na pracovni ploSe.

Jakakoliv zména méfitka kresby nema zadny vliv na zakladni operace kresleni. Aplikace Draw
automaticky vypocita potfebné hodnoty (napfiklad kétovaci ¢ary). Vzdalenost bod( mfizky je
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nezavisla na méfitku kresby, protoze mrizka je pouze vizualni pomdcka pro kresleni nikoliv prvek

kresby.
Moznosti - LibreOffice Draw - Obecné

Zadejte hledany text

=]

LibreOffice
Maditanifukladani
lazyky a narodni prostied’
=]

LibreQOffice Draw

Zobrazeni
MFizka
- Tisk
LibreOffice Basze
Grafy
Internet

Obréazek 284: Dialogové okno MoZnosti LibreOffice Draw — strénka Obecné

5cm

Nastaveni
a Kopirovat pfi pfesunu
B Pousit mezipamét v pozadi
a Vidy pfesunutelné objekty
() Nedeformevat objekty na kiivce

Textové objekty
8 Povolit rychlou editaci
O Lze vybrat pouze textovou oblast

Méritko

Mérna jednotka: |Centimetr

Méfitko kresby:  1:1 |~

> |

Kroky tabuldtoru:  1,25cm

Kompatibilita

(1)

A

3.5cm

()

- 20 cm

1.25cm

e
‘-.
Y

.13.99¢cm .

i

©)

Obrazek 285: Priklad kresby v méritku

ZvétSeni meéfitka (napfiklad 1:4) umoziiuje kreslit velké objekty, které by se nevesly na kreslici
papir. Zmenseni méfitka kresby (napfiklad 4:1) umoziuje presné kresleni malych objekt( ve

w7,

=1

0.87 cm

I

vétSi velikosti, coZ usnadiiuje jejich pochopeni. Pfiklady kresleni v méfitku jsou uvedeny na
obrazku 285 nad, kde jsou v3echny tfi obdélniky v kresbé stejné velké.

1) Levy obdélnik — nakresleny ve vychozim méfitku 1:1 a s kétovanim.
2) Stiedni obdélnik — méfitko kresby zménéno na 1:4. Rozméry se automaticky zvetsi

v

pomoci funkce Draw, aby se zobrazilo zmenseni méfitka.

3) Pravy obdélnik — méfitko kresby zménéno na 4:1. Rozméry se automaticky zmensi
pomoci funkce Draw, aby se zobrazilo zvétSeni méfitka.

Vice pohledil na kresbu

V aplikaci Draw Ize oteviit a pouzivat nékolik pohled( na stejnou kresbu. Tyto pohledy se
zobrazuji v samostatnych oknech a jsou uzite¢né pro zobrazeni rliznych pohledd na kresbu,
napfiklad hlavni stranka a normalini strdnka otevien& soucasné. P¥i ukladani kresby se ujistime,
Ze je aktivni spravné zobrazeni.

Pokud chceme otevrit nové okno pro stejny soubor kresby, zvolime v hlavni nabidce Okno >
Nové okno. Jakakoli zména kresby v jednom okné se okamzité zobrazi ve vSech otevienych

oknech.

Néazev souboru kazdého otevieného okna je automaticky ocislovan, jak ukazuje priklad na
obrazku 286 pod, a aktivni okno je v seznamu oznaceno znackou u svého nazvu souboru. Pokud
jsou soucasné otevieny dalSi dokumenty LibreOffice, budou do seznamu zahrnuty i tyto

dokumenty. Mezi okny mizeme prepinat klepnutim na ndzev v seznamu nebo klepnutim na
samotné okno, pokud je viditelné.
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K zavfeni okna pouzijeme jednu z nasledujicich moznosti:
* V hlavni nabidce zvolime Okno > Zavfit okno.
* Pouzijeme klavesovou zkratku Ctr l+W (macQOS 38 +W).
» Zvolime Soubor > Zavf¥it v hlavni nabidce okna.

Okno  MNapovéda

% Nové okno
VT OKNOo Erl+
@ Zaviit ok Cirl+W

DG25811-AdvancedDrawTechniques_img.odt — LibreOffice Writer

*  pracovni dokument.odg — LibreOffice Draw

Obréazek 286: Priklad vice oken v aplikaci Draw
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Obrazek 287: Karta Galerie v postranni listé — Pohled

s ikonami
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Galerie

Bl backgrounds
Bl BPMN

Bl Bullets

Bl Diagrams
Bl Flowchart
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Obréazek 288: Karta Galerie v postranni liSté —
Detailni pohled

Galerie

Aplikace Draw obsahuje nékolik obrazk( v Galerii. Tyto obrazky jsou seskupeny do témat
uvedenych v abecednim poradi (napfiklad Sipky, BPMN, Odrazky, Diagramy atd.). Klepnutim
na téma zobrazime jeho obrazky jako ikony nebo v detailnim zobrazeni.

* Pro zobrazeni ikon obrazk( v karté Galerie (obrazek 287 nad), klepneme na ikonu
Pohled s ikonami v levém dolnim rohu postranni liSty.

* Pro podrobné zobrazeni obrazkd v karté Galerie (obrazek 288 nad), klepneme na ikonu
Detailni pohled v levém dolnim rohu postranni listy.

Pouzivani Galerie

1) Klepneme na ikonu Galerie v postranni listé nebo zvolime Vlozit > Multimédia > Galerie
v hlavni nabidce.

2) Z dostupnych moznosti vybereme téma.
3) K umisténi obrazku do kresby pouZijeme jednu z nasledujicich moZnosti:
— Klepneme na obrazek v karté Galerie a pfetdhneme jej do kresby.

— Klepneme pravym tlacitkem mySi na obrazek a z mistni nabidky zvolime Vlozit.
Obrazek je umistén uprostfed kresby.

— Klepneme pravym tlaCitkem mySi na obrazek a z mistni nabidky vybereme Kopirovat
a poté obrazek vloZime do kresby. Obrazek je umistén ve stfedu kresby.

4) Upravime obrazek galerie podle pqiadavkﬁ kresby. Vice informaci o Gpravé obrazk(
a snimkl nalezneme v kapitole 6, Upravy obrazkd.
Tvorba motivi a pridavani obrazk
1) V postranni li5té otevieme kartu Galerie.
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2) Klepnutim na tlacitko Novy vpravo dole na karté Galerie otevieme dialogové okno
Vlastnosti nového tématu (obrazek 289 pod).

3) Na strance Obecné zadame do textového pole ndzev motivu.
4) Klepnutim na Soubory otevieme stranku Soubory (obrazek 290 pod).
5) Klepnutim na tlacitko Najit soubory otevieme dialogové okno Vybrat sloZku.

6) Prejdeme do slozky, ktera obsahuje pozadované obrazky, a klepnutim na OK slozku
vybereme a dialogové okno Vybrat cestu se zavfie. Na strance Soubory se nyni zobrazi
seznam souborl obsazenych ve sloZce, jak ukazuje pfiklad na obrazku 290 pod.

Wlastnosti motivu Mowy metiv vzhledu bt

Obecné  Soubory

MNovy maotiv vzhledu

Typ: Galerie motivl vzhledu
Umisténi:  filey///C:/Users/petrk/AppData/Roaming/LibreOffice/4/user/gallery/novy motiv vzhledu.sdg
Cbsah: 0 Cbjekty

Zménéno:  21.11.2025 231812

Obréazek 289: Dialogové okno Vlastnosti motivu Novy motiv vzhledu —
stranka Obecné

Wlastnosti motivu Novy motiv vzhledu X

Obecné  Soubory

Typsouboru:  <VEechny soubory> (*.%) w ‘Najit soubory....
Ch\Users\petriiMaj diskisoukromé\Lib...\obr_01.png Pidat
ChUsers\petrid W) diskisoukromé\Lib.. \obr_02.png
ChUsershpetrkiMaj diskhsoukroméiLib..\obr_03.png Pidat vie

ChUsershpetrikMaj diskhsoukrométLib..\obr_04.png
ChUsershpetrkiMaj diskisoukromeéiLib..\obr_03.png
ChUsershpetrki\Maj diskhsoukrométLib..\obr_D6.png
ChUszersh\petrii MAj diskhsoukromé\Lib..\obr_07.png
ChUsershpetrkiMaj diskhsoukroméiLib..\obr_08.png
ChUsershpetrki\Mdj diskhsoukrométLib..\obr_09.png
ChUsers\petri W aj disksoukromé\Lib.. \obr_10.png
ChUsershpetrk\Mdj diskisoukroméiLib..\obr_11.png
ChUsershpetrkMaj diskisoukrométLib..\obr_12.png
ChUsershpetrkiMadj diskhsoukromeéiLib.\obr_13.png
ChUsershpetrkiMaj diskhsoukroméLib..\obr_14.png
ChUszers\petrii MAj diskhsoukromé\Lib..\obr_15.png

[ Mahled

Obréazek 290: Dialogové okno Vlastnosti motivu Novy motiv vzhledu — stranka Soubory

7) V pripadé potfeby vybereme poZadovany format souboru pro obrazky z moznosti
dostupnych v rozeviracim seznamu. Ve vychozim nastaveni jsou vybrany vSechny
formaty pro obrazoveé soubory.

8) V pripadé potfeby klepneme na Nahled a zobrazime kazdy vybrany soubor obrazku.
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9) Vybereme soubory poZadované pro nové téma. V pripadé potfeby stiskneme klavesu
Ctrl (macOS &) a vybereme vice soubor(.

10) Klepneme na PFidat. Vybrané soubory zmizi ze seznamu soubor(i a obrazky se objevi
v Galerii.

11) Pokud maji byt pridany vSechny soubory ze seznamu, klepneme na tlacitko PFidat vSe.
VSechny soubory zmizi ze seznamu a obrazky se objevi v Galerii.

12) Po dokond&eni pridavani soubor( klepneme na OK a zavieme dialogové okno Vlastnosti
motivu Novy motiv vzhledu. Nazev nového motivu se zobrazi v karté Galerie.

Odstranéni galerie motivli a obrazku

1) Klepneme pravym tlaCitkem mysi na motiv nebo obrazek v galerii a z mistni nabidky
vybereme moznost Odstranit.

2) Klepneme na Ano v potvrzovacim dialogu a motiv nebo obrazek se z Galerie odstrani.

ﬁ Poznamky

Pokud je objekt pfidan do motivu, ztrati své spojeni s grafickymi styly Draw a vSechny
vlastnosti jsou nastaveny jako pfimé formatovani.

Odstranit nebo pfejmenovat Ize pouze motivy a obrazky, které byly pfidany do
aplikace Draw. Motivy a obrazky, které jsou soucasti LibreOffice, nelze odstranit ani
pfejmenovat.

Obrazek je propojeny soubor a z Galerie se odstrani pouze odkaz. Plvodni soubor
s obrdzkem se neodstrani.

Aktualizace Galerie

VSechny obrazky v Galerii jsou odkazy na soubory. Ob¢as je vyhodné aktualizovat motiv, ktery
byl pfidan do aplikace Draw, abychom se ujistili, Ze jsou vSechny soubory stale pristupné.
Klepneme pravym tlacitkem mySi na motiv, ke kterému byl pfidan alespon jeden soubor,

a z mistni nabidky vybereme moZznost Aktualizovat.

Pfejmenovani motivl vzhledu

Pokud chceme prejmenovat motiv, ktery byl pfidan do aplikace Draw, klepneme pravym tlaCitkem
mySi na nazev motivu a z mistni nabidky vybereme moznost Pfejmenovat.

Barvy

Draw (stejné jako vSechny moduly LibreOffice) pouziva barvy seskupené do barevnych palet.
Barvy je mozné vytvaret podle pozadavkd kresby. VSechny vytvorené viastni barvy se umisti do
vlastni palety barev. V nasledujicim textu jsou vysvétleny modely barev, které se pouzivaji

k vytvofeni vlastni barvy.

Cervena, zelena, modra (RGB)

Barevny model RGB je zaloZen na aditivnim barevném modelu svételnych vin a je uréen
pro elektronické displeje a pocitace. To znamena, Ze se pfidava vice barev, blize k bilé
barvé. RGB se vytvari pomoci stupnic od 0 do 255. PFi pouziti ¢erné barvy jsou hodnoty
R=0, G=0 a B=0. Pfi pouZziti bilé barvy jsou hodnoty R=255, G=255 a B=255. LibreOffice
pouziva barevny model RGB pro tisk ve vSech modulech LibreOffice.
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Azurova, purpurova, Zluta, kli€ova (€erna) (CMYK)

Barevny model CMYK je subtraktivni barevny model, ve kterém se barvy odecitaji, aby se
zménila nebo vytvofila barva. Pouziva se hlavné pfi tisku, proto jsou inkoustové kazety do
tiskaren oznaceny CMYK. CMYK pracuje se stupnici od 0 do 100. Pfi pouZiti Cerné barvy

jsou hodnoty C=100, M=100, Y=100 a K=100. Pfi pouZiti bilé barvy jsou hodnoty C=0,
M=0, Y=0 a K=0.

Odstin, sytost, jas (HSB)
Barevny model HSB je alternativni reprezentaci barevného modelu RGB. Systém HSB
byl navrzen tak, aby Iépe odpovidal zplsobu, jakym lidsky zrak vnima atributy tvorby
barev. Pomoci hodnot HSB mizeme doladit vSechny vytvorené vlastni barvy.
_Tip

DalSi informace o barevnych modelech a hodnotach barev nalezneme na
https://en.wikipedia.org/wiki/Color_model.

Zména barev u objektl nebo car

PFi zméné barev v objektech se k vybéru barev pouzivaji palety barev. Tyto palety barev jsou
nainstalovany spolu s LibreOffice a pouzivaji se ve vSech modulech LibreOffice. Pouzivani
barevnych palet je podobné u vSech typl objektd, ale pristup k barevnym paletadm se lisi podle
typu vybraného objektu.

}? Poznamka

Barvy dostupné v Listé barev pochazeji ze standardni palety barev, kterd je soucasti
instalace LibreOffice.

LiSta barev

Prestoze LibreOffice obsahuje nastroje pro pfesné ur€eni barvy, obsahuje také LiStu barev
(obrazek 291 pod), ktera umoziuje ménit barvu vyplné plochy, okraje nebo ¢ary objektu. Lista
barev se také nazyvé Paleta barev.

1 1 1+ 1 1 1 1 1 1 |
N NN (NN N NN NN NN NN N NN N
%...........

Obrazek 291: Lista barev (Barevna paleta)
1) Vybereme objekt v kresbé.

2) Pomoci volby Zobrazit > LiSta barev otevieme LiStu barev. KdyZ se otevfe LiSta barev,
je oznaCen Barevna paleta.

3) Klepnutim levym tlaCitkem mySi na barvu zménime barvu vyplné oblasti nebo klepnutim
pravym tlaCitkem mysi na barvu zménime barvu okraje nebo ¢ary vybraného objektu.
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4) Klepnutim levym tlacitkem mySi na pole X v levém dolnim rohu LiSty barev odstranime
barvu z vyplné objektu nebo klepnutim pravym tla¢itkem mysi na pole X v levém dolnim
rohu LiSty barev odstranime barvu z ohranieni objektu.

5) Pokud chceme zavfit LiStu barev, zvolime v hlavni nabidce Zobrazit > LiSta barev
a zruSime oznaceni u polozky LiSta barev.

Dialogové okno Oblast
1) Vybereme objekt v kresbé.
2) Dialogové okno Oblast (obrazek 292 pod) otevieme jednim z nasledujicich zpUsobU:
3) V hlavni nabidce vybereme Format > Oblast.
4) Klepneme pravym tlacitkem na objekt a vybereme z mistni nabidky Oblast.
5) Klepneme na Oblast a poté klepnutim na Barvy otevieme stranku Barvy.
6) V okné Barva vybereme z rozeviraciho seznamu Paleta barevnou paletu.

7) Klepneme na barvu z téch, které jsou zobrazeny v paleté barev, nebo vybereme barvu,
ktera jiz byla pouzita v Poslednich barvach.

8) Klepnutim na tlacitko OK uloZime zmény a zavieme dialogové okno Oblast. Vybrana
barva vyplné se zobrazi ve vybraném objektu.
Panel oblasti na postranni listé
1) Vybereme objekt v kresbé.
2) Otevieme panel Oblast na karté Vlastnosti v postranni liSté (obrazek 293 pod).
3) V rozeviracim seznamu Vyplri vybereme moznost Barva.

4) Klepnutim na trojuhelnik v vpravo od Barvy vyplné otevieme naposledy pouZzitou
paletu.

5) V prfipadé potfeby vybereme paletu barev z dostupnych palet v rozeviracim seznamu.

6) Klepneme na barvu z barev zobrazenych v paleté barev nebo vybereme barvu, ktera byla
dfive pouZita, z barev zobrazenych v Posledni. Barevna paleta se zavie a na objekt se
pouzije vybrana barva vyplné.
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Obrazek 292: Dialogové okno Oblast — stranka Barva
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Obrazek 293: Sekce Oblast na karté Vlastnosti

v postranni listé

1) Vybereme objekt v kresbé.

Barva vypiné na ndstrojovych listach Céra a vyplrn nebo Kresba
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2) Klepnutim na trojahelnik v vpravo od Barvy vyplné na nastrojové list& Cara a vypli

nebo na nastrojové listé Kresba otevieme posledni pouZitou paletu barev.

3) Klepneme na barvu z barev zobrazenych v paleté barev nebo vybereme barvu, kterd byla
dfive pouZita, z barev zobrazenych v Posledni. Paleta barev se zavie a vybrana barva

vyplné se pouZzije na vybrany objekt.

Dialogové okno Céra.
1) Vybereme Caru nebo objekt v kresbé.

2) Dialogové okno Cara (obrazek 294 pod) otevieme jednim z nasledujicich zplsobd:

— V hlavni nabidce zvolime Format > Cara.

— Klepneme pravym tlacitkem na ¢aru nebo objekt a z mistni nabidky vybereme Cara.

3) Klepnutim na Céara otevieme stranku Cara.

4) Klepnutim na trojuhelnik ¥ vpravo od ikony Barva v ¢asti Vlastnosti €ary otevieme

posledni pouzitou paletu barev.

5) Z dostupnych palet v rozeviracim seznamu vybereme paletu barev, kterou chceme

pouzit.
| Céra

Cara Styly €ar  Styly Sipek

Vlastnosti cary
Styl: ————— Spojts v |
Barva: -Tmavé modra 1 S

-

Tlouitka: 0.00cm

Prihlednost: 0%
Styly Sipek

Styl zacathu: |

Sifka: 0,20 cm =

[ Na stfed

|_I Synchronizovat zakonéeni

Styly rohd a zakonéeni

Styl rohu: |Zaku|au:er1}'r

Styl zakonéent: |F'Ioché

Styl konce: — Sipka

Sifka: 0,20 cm

[ Ma stied

L J

[

MNapovéda

Obnowvit

Obréazek 294: Dialogové okno Réadek — stranka Radek
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Obrazek 295: Sekce Cara na karté Vlastnosti v postranni
listé
6) Klepneme na barvu z barev zobrazenych v paleté barev nebo vybereme barvu, kterd byla

drive pouZita, z barev zobrazenych v Posledni. Barevna paleta se zavie a vybrané barva
¢ary se pouzije na ¢aru nebo okraj objektu.

7) Klepnutim na OK uloZime zménu barvy a zavieme dialogové okno Cara.

Panel ¢ar v postranni listé

1) Vybereme &aru nebo objekt v kresbé.
2) Otevieme panel Cara na karté Vlastnosti v postranni listé (obrazek 295 nad).

3) V gasti Cara klepneme na trojuhelnik v vpravo vedle ikony Barva a otevieme posledni
pouzitou paletu barev.

4) Z dostupnych palet v rozeviracim seznamu vybereme paletu barev, kterou chceme
pouzit.

5) Klepneme na barvu z barev zobrazenych v paleté barev nebo vybereme barvu, ktera byla
drive pouzita, z barev zobrazenych v Posledni. Barevna paleta se zavie a vybrana barva
cary se pouzije na ¢aru nebo okraj objektu.

Barva &ary na ndstrojovych listach Céra a vyplfi nebo Kresba

1) Vybereme Caru nebo objekt v kresbé.

2) Klepnutim na trojahelnik ¥ vpravo od Barva &ary na nastrojové listé Cara a vypli nebo
na nastrojové listé Kresba otevieme posledni pouzitou paletu barev.

3) Z dostupnych palet v rozeviracim seznamu vybereme paletu barev, kterou chceme
pouzit.

4) Klepneme na barvu z barev zobrazenych v paleté barev nebo vybereme barvu, ktera byla
drive pouZzita, z barev zobrazenych v Posledni. Barevna paleta se zavie a vybrané barva
cary se pouzije na ¢aru nebo okraj objektu.
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Zmeéna barvy textu

Zmeéna barvy textu je podobna zméné barvy vyplné oblasti, okraje objektu nebo ary. Po vybéru
textu v kresbé se automaticky otevfe nastrojova liSta Formatovani textu, ktera nahradi
nastrojovou listu Cara a vyplii. Pokud se nastrojova lista Formatovani textu neotevie, zvolime
Zobrazit > Nastrojové liSty v hlavni nabidce a vybereme Formatovani textu.

1 Znak x|

Pismo  Efekty proplsmo  Umisténi  Zvyraznéni
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Obrazek 296: Dialogové okno Znaky — stranka Efekty pisma

Dialog Znak
1) Vybereme textové pole nebo zapneme textovy rezim pro objekt Kresby.
2) Zvyraznime textové znaky, u kterych se ma zménit barva textu.
3) Dialogové okno Znak (obrazek 296 nad) otevieme jednim z nasledujicich zplsobd:
— V hlavni nabidce zvolime Format > Znak.
— Klepneme pravym tlacitkem mySi na zvyraznény text a z mistni nabidky zvolime Znak.
4) Klepnutim na kartu Efekty pro pismo otevieme stranku Efekty pro pismo.

5) Klepnutim na trojuhelnik v vpravo od Barva pisma otevieme posledni pouzitou paletu
barev.

6) Z dostupnych palet v rozeviracim seznamu vybereme paletu barev, kterou chceme
pouzit.
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7) Klepneme na barvu z barev zobrazenych v paleté barev nebo vybereme barvu, ktera byla
drive pouZita, z barev zobrazenych v Posledni. Barevna paleta se zavie a vybrané barva
se pouzije na vybrany text.

8) Klepnutim na OK uloZzime zménu barvy a zavieme dialogové okno Znak.

Panel znak( v postranni listé

1) Vybereme textové pole nebo zapneme textovy rezim pro objekt Kresby.

! Viastnosti I
-I Znak M=
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BIU~SS AN =
& - ake - ﬂ - XX
+ Oblast M~ K:)'

Obrézek 297: Cast Znak na karté Vlastnosti v postranni listé
2) Zvyraznime textové znaky, u kterych se ma zménit barva textu.
3) Otevieme panel Znak na karté Vlastnosti v postranni liSté (obrazek 297 nad).

4) Klepnutim na trojuhelnik v vpravo vedle ikony Barva pisma oteviete naposledy pouzitou
paletu barev.

5) Z dostupnych palet v rozeviracim seznamu vybereme paletu barev, kterou chceme
pouzit.

6) Klepneme na barvu z barev zobrazenych v paleté barev nebo vybereme barvu, kterd byla
dfive pouZita, z barev zobrazenych v Posledni. Barevna paleta se zavie a vybrana barva
se pouZije na vybrany text.

Tvorba barev

ﬁ Poznamky

PFi pouZiti dialogového okna Céra nebo Znak pro otevieni dialogového okna Vybér
barvy nelze Zadnou vytvorenou vlastni barvu ulozit do Vlastni paleta nebo
prejmenovat na smysluplnéjSi nazev. Vytvorena vlastni barva je pojmenovana
pomoci hexadecimalni hodnoty, ktera se zobrazi v dialogovém okné Vyberte barvu.
Pouze dialogové okno Oblast ma moZnost pfejmenovat vlastni barvy a uloZit viastni
barvy do Vlastni palety.

LibreOffice pouziva pro barevny tisk barevny model RGB. Hodnoty RGB vybrané
barvy se zobrazi v ndhledovych polich.

PouZiti dialogového okna Vyberte barvu

1) Vybereme objekt nebo text a otevieme dialogové okno Vybér barvy (obrazek 298 pod)
pomoci jedné z nasledujicich moznosti:

— Otevieme dialogové okno Oblast, klepnutim na kartu Barva otevieme stranku Barva
a klepneme na Vybrat.
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— Otevieme panel Oblast na karté Vlastnosti na postranni listé, klepnutim na trojuhelnik
v vpravo vedle ikony Barva vyplné otevieme paletu barev a klepneme na Vlastni
barva ve spodni C4sti palety barev.

— Otevieme dialogové okno Céra, poté otevieme barevnou paletu u volby Barva
a klepneme na Vlastni barva ve spodni ¢asti barevné palety.

— V postranni li§t& na kart& Vlastnosti otevieme ¢ast Cara, klepnutim na trojahelnik v
vpravo vedle ikony Barva €ary otevieme barevnou paletu a klepneme na volbu Vlastni
barva ve spodni Casti barevné palety.

Vyberte barvu x
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Obréazek 298: Dialogové okno Vyberte barvu

— Otevieme dialogové okno Znak, poté otevieme paletu barev v Barva pisma
a klepneme na Vlastni barva ve spodni ¢asti palety barev.

— V postranni liSté na karté Vlastnosti otevieme ¢ast Znak, klepnutim na trojuhelnik v
vpravo vedle volby Barva pisma otevieme barevnou paletu a klepneme na Vlastni
barva ve spodni Casti barevné palety.

2) V dialogovém okné Vybér barvy vybereme na svislé barevné liSté rozsah barev, ktery
priblizné odpovida vytvafené vlastni barvé.

3) Klepneme a pfetahneme maly cilovy kruh v poli barvy, dokud barva nebude odpovidat
pozadované vlastni barvé. Hodnoty RGB, HSB a CMYK se méni pfi pfetahovani malého
cilového krouzku kolem barevného pole, coz pomaha vytvorit pfesnou barvu, pokud jsou
hodnoty barev znamy.

4) Pokud jsou hodnoty barev nebo hexadecimalni ¢islo znamy, zadame je do pfisluSného
textového pole. Hodnoty ve vSech textovych polich se zméni tak, aby odpovidaly novym
hodnotdm. Napfiklad po zadani hodnot HSB se zméni i hodnoty RGB, CMYK a Hex tak,
aby odpovidaly.

5) Klepnutim na OK ulozZzime zmény a zavieme dialogové okno Vyberte barvu.
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Pouziti dialogového okna Oblast

1) Otevieme dialogové okno Oblast a klepnutim na Barva otevieme stranku Barva
(obrazek 292 na strané 313).

2) V Céasti Nova zadame do textovych poli RGB hodnoty barvy nebo, pokud ji zname,
hexadecimalni hodnotu. Barva v nahledovém poli se zméni tak, aby odpovidala zadanym
hodnotam.

3) Pripadné v ¢asti Nova pouzijeme Sipky pro hodnoty RGB a tim sniZime nebo zvySime
hodnoty. Barva v nahledovém poli se zméni tak, aby odpovidala zadanym hodnotam.

4) Klepnutim na OK zménime barvu a zavieme dialogové okno Oblast.

Pridani vlastnich barev

1) Ujistime se, Ze dialogové okno Oblast je otevieno na strance Barva (obradzek 292 na
strané 313).

2) Vybereme vlastni barvu, kterd je zobrazena v poli Posledni barvy.
3) V okné Vlastni paleta klepneme na Pridat a otevieme dialogové okno Nazev.
4) Do textového pole zadame novy nazev barvy.

5) Klepnutim na OK zmény ulozime a zavieme dialogové okno Nazev. Vlastni barva se
zobrazi v poli Vlastni paleta.

6) Klepnutim na OK zavieme dialogové okno Oblast.

Prejmenovani vlastnich barev

Pomoci dialogového okna Oblast Ize pfejmenovat pouze vlastni barvu, a to nasledujicim
zpUsobem:

1) Ujistime se, Ze dialogové okno Oblast je otevieno na strance Barva (obrazek 292 na
strané 313).

2) Vybereme vlastni barvu, ktera se zobrazi ve Vlastni paleté.
3) Klepnutim na PFidat otevieme dialogové okno Nazev.
4) Do textového pole zadame novy nazev vlastni barvy,

5) Klepnutim na OK zmény uloZime a zavieme dialogové okno Nazev. V poli Vlastni paleta
se objevi nova vlastni barva.

6) Klepnutim na OK zavieme dialogové okno Oblast.

ﬁ Poznamky

Pfejmenovani vlastni barvy ve skutecnosti neznamena pfejmenovani vliastni barvy,
ale pfidani nové vlastni barvy do Vlastni palety. Pfed pfejmenovanim nebo
odstranénim vlastni barvy se ujistime, Ze tato barva NENI pouzita v jiném dokumentu
LibreOffice.

Pro vlastni barvy pouzivAme zapamatovatelné nazvy, aby byla vlastni barva snadno
rozpoznatelna ve Vlastni paleté. Ve vychozim nastaveni je vlastni barvé pfifazeno
hexadecimalni Cislo, coz stéZuje identifikaci barev, pokud existuje vice nez jedna
vlastni barva.

Mazani vilastnich barev

Pomoci dialogového okna Oblast Ize odstranit pouze vlastni barvu, a to nasledujicim zplsobem:
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1) Ujistime se, Ze dialogové okno Oblast je otevieno na strance Barva (obrazek 292 na
strané 313).

2) Vybereme vlastni barvu, ktera se zobrazi ve Vlastni paleté.

3) Klepneme na Smazat. Pfi odstrafovani vlastnich barev neni vyZadovano Zadné
potvrzeni odstranéni.

4) Klepnutim na OK zavieme dialogové okno Oblast.

Bézierovy krivky

Bézierovy? kiivky Ize pouZit v aplikaci Draw. Kfivka je definovana pomoci pocate¢niho bodu,
koncového bodu a pripadné fidicich bodl. Pro body na kfivce se ¢asto pouzivaji terminy Uzly
a Kotvy. DalSi informace a vysvétleni matematického pozadi Bézierovych kfivek nalezneme na
https://en.wikipedia.org/wiki/Bézier_curve.

Obrazek 299: Priklad Bézierovy krivky

Bézierovy kfivky jsou velmi uzite€né pfi experimentovani s tvarem a podobou kfivek. V bodovém
rezimu Ize zarovnani kiivky ménit tazenim bod0 kurzorem. Pfiklad na obrazku 299 nad zobrazuje
priklad Beziérovy kfivky s vybranym pocatecnim bodem a fidicim bodem pfipojenym

k poc¢ateénimu bodu preruSovanou ¢arou. Pohybem fidicich bod( se méni zakfiveni a tvar
Beziérovy kfivky.

Kresleni Bézierovych krivek

1) Klepneme na ikonu KFivka v ¢asti Kfivky a mnohouhelniky na karté Tvary v postranni
listé nebo KFivky a mnohouhelniky na nastrojové listé Kresba.

2) Klepneme na pocéatecni bod kfivky a pfetahneme kurzor do priblizné polohy koncového
bodu kfivky.

3) Uvolnime kurzor a pfetdhneme koncovy bod kfivky do jeji koncové polohy.

4) Po dosazeni koncové polohy kfivky dvakrat klepneme a kfivka se nakresli. Oblouk kfivky
je ur€en vzdalenosti pretazenou k vytvofeni koncového bodu.

5) Pfepneme se do rezimu editace bodl jednim z nasledujicich zplsobU:
— V hlavni nabidce zvolime Upravy > Pfepnout reZim tpravy bodd.

— Pokud je pfidan na néastrojovou listu, klepneme na Pfepnout rezim upravy bodu na
nastrojové listé Kresba.

2 Bézierovy kfivky vynalezl Pierre Bézier, inZenyr pracujici pro automobilku Renault, ktery tuto techniku
vyvinul v 60. letech 20. stoleti. Tato technologie méla usnadnit modelovani povrchu vozidel.
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— Pouzijeme klavesovou zkratku F8.

ﬁ Poznamka
Nastrojova liSta Upravit body se otevie az po vybéru bodu na kfivce.

6) Nastrojovou listu Upravy bod( (obrazek 300 pod) otevieme jednim z nasleduijicich
zpUsob.
— V hlavni nabidce pfejdeme do Zobrazit > Nastrojové liSty a zvolime Upravit body.
— Pouzijeme klavesovou zkratku F8.
— Pokud je pfidan na nastrojovou listu, klepneme na Body na nastrojové listé Kresba.

7) Jednim klepnutim na kfivku zobrazime pocatecni a koncovy bod. Poc¢atec¢ni bod kfivky je
vétsi nez koncovy bod.

8) Klepnutim na pocatecni nebo koncovy bod zobrazime Fidici body. Kontrolni body se
zobrazi na konci pferuSované Cary spojené s vybranym bodem, jak je zndzornéno
v nasledujicich pfikladech.

9) Klepnutim na fidici bod a jeho pfetazenim na novou pozici zménime tvar k¥ivky.

Upravit body v X
LA ANCH A A ka gl

Obrazek 300: Nastrojova lista Upravit body
10) Kdyz je tvar kfivky vyhovuijici, uvolnime kurzor a kfivku zafixujeme.

11) Klepnutim kdekoliv na pracovni plose zrusime vybér kiivky a ukoncime Gpravy bodd.

Nastroje pro Gpravu bod

Po prvni otevfieni nastrojové listy Upravit body se po vybéru objektu, ktery byl pfeveden na kfivku
nebo mnohouhelnik, tato nastrojova liSta zobrazi. Nastroje dostupné na nastrojové listé Upravit
body umoznuji upravovat Bézierovu kfivku a ménit jeji tvar. Aby byly k dispozici vSechny nastroje
na nastrojové listé Upravit body, musi byt vybran bod na Bézieroveé kfivce.

Pfesunout body
Klepnutim a pfetazenim na bod jej pfesuneme na jiné misto.

— Kfivka na obou stranach bodu sleduje pohyb tohoto bodu a méni tvar podle toho, jak
se méni poloha vybraného bodu.

— Klepnutim a taZzenim na kfivku mezi body mdzeme celou kfivku posunout, aniz by
doslo k naruseni tvaru kfivky.

Vlozit body
Po vybéru aktivuje reZzim vkladani a vloZi hladké body na kfivku. Rezim vkladani z(stava
aktivni i po vloZeni bodl. Vyb&rem moznosti Pfesunout body deaktivujeme rezim
vkladani.
— VlozZeny bod Ize pfi aktivovaném rezimu vkladani pfesouvat.

— Pokud je pozadovan uhlovy nebo soumérny bod, viozime nejprve hladky bod a ten
pfevedeme na uhlovy nebo soumérny bod.

Smazat body
Odstrani vybrané body. Pokud chceme odstranit vice bodd, podrzime pfi vybéru bodd,
a pfed klepnutim na Smazat body, stisknutou klavesu Shift.
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Prevést na kfivku
Pfrevede kfivku na pfimku nebo pfimku na kfivku (obrazek 301 pod).

— Vybereme jeden bod a zakfiven& UseCka za bodem se pfevede na pfimku nebo se Cast
pfimky (Usecka) za bodem pFevede na kfivku.

— P¥i pfevodu Usecky z kfivky na pfimku se kazdy bod na kazdém konci UseCky stane
fidicim bodem podobné jako pocCéatecni nebo koncovy bod.

— P¥i prfevodu Usecky z pfimky na kfivku se kazdy fidici bod na kazdém konci Usecky
stane hladkym bodem.

Uzaviit Beziérovu kfivku
Uzavfe volnou ¢aru nebo kfivku spojenim pocatecniho bodu s koncovym bodem a vytvofi
objekt s vyplni plochy.

Rozdélit kFivku
Rozdéli kfivku na dvé nebo vice kfivek. Vybere bod nebo body a klepnutim na Rozdélit
kfivku vytvofime samostatné useCky krivky. ZruSime vybér kfivky a poté vybereme
segment, ktery chceme pfesunout nebo upravit.

Uhlovy roh
Pfevede vybrany bod na tGhlovy bod (obrazek 302 pod). Uhlové body maji dva na sobé
nezavislé pohyblivé fidici body, které vytvareji uhel krivky.

Plynuly pfechod
Pfevede Uhlovy nebo symetricky bod na hladky bod (obrazek 303 pod). Oba Fidici body
jsou rovnobézné vyrovnané a mohou se pohybovat pouze soucasné. Ridici body se
mohou liSit délkou, coZ umoziuje meénit stupen zakfiveni.

Obréazek 301: Priklad pfevodu zakrivené useCky na primku

Obrazek 302: Priklad rohového bodu
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Obrazek 304: Priklad symetrického pfechodového bodu

Soumeérny prechod
Prevede fidici nebo hladky bod na symetricky bod (obrazek 304 nad). Oba fidici body
jsou rovnobézné a maji stejnou délku. Tyto Fidici body Ize posouvat pouze soucasné
a stupen zakfiveni je v obou smérech stejny.

Ubrat body
UmoZiuje vybér nékolika bod(l pred pouZitim nastroje Smazat body. To je uZiteCné pfi
odstrafiovani ¢asti pfimky (Usecky), aby se vytvofila uplna kfivka.

PFidavani komentaru

Komentare v modulu Draw jsou podobné komentarlim v modulech Writer, Calc a Impress. Dalsi
informace o pfidavani, navigaci a odpovidani na komentére najdeme v pfirucce Zac¢iname
s LibreOffice.

Komentare v aplikaci Draw nelze tisknout. Pokud chceme odpovédét na komentar v aplikaci
Draw, je tfeba pfidat novy komentar ke kresbé.

1) V hlavni nabidce zvolime Vlozit > Komentar a ramecek komentare (obrazek 305 pod) se
zobrazi nahofe na levé strané kresby. Aplikace Draw automaticky pfida na konec
komentéfe jméno uZivatele a datum a umisti znacku komentéfe na stranku kresby.

2) NapiSeme nebo vilozime komentar do textového pole pro komentar.

3) Pokud chceme na text pouzit zakladni formatovani, klepneme na text pravym tlaCitkem
mySi a z mistni nabidky vybereme moZnost formatovani.

4) Pokud chceme komentar smazat, pouzijeme jeden z nasledujicich zplsobu:

— Klepneme pravym tlacitkem mySi do pole komentarfe a z mistni nabidky vybereme
moznost Odstranit.

— Klepneme pravym tlacitkem mySi na znacku komentére a z mistni nabidky vybereme
moZznost Odstranit.

— Klepneme na trojuhelnik v v pravém dolnim rohu pole pro komentéar a z mistni
nabidky vybereme moZznost Odstranit.
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5) Pokud chceme komentar pfesunout, klepneme na znacku komentére a pretdhneme ji na
nové misto.

B Tuiné

I Kurziva

U Podtriens
S Pregkrtnuté
|.:_|=E“'| Kopirovat
I Vit

Smazat komentar

Smazat viechny komentare od (bez autora)

Smazat viechny komentare

Obréazek 305: Priklad komentére v aplikaci Draw
6) Pokud chceme skryt komentaf, pouzijeme jednu z nasledujicich moznosti:

— V hlavni nabidce pfejdeme do Zobrazit a zruSime vybér moznosti Komentare. Tim
skryjeme komentar a znaCku komentare.

— Klepneme na kresbu mimo komentér a tim ho skryjeme. Znacka komentéare zlistava
viditelna.

7) Pokud chceme komentéfe zobrazit, zvolime Zobrazit > Komentare v hlavni nabidce
a klepneme na znacku komentare.

ﬁ Poznamka

Aby se jméno a inicialy uzivatele objevily v komentafi, zadame Gdaje uZivatele
v dialogovém okné Nastroje > MoZnosti > LibreOffice > UZivatelské tdaje
(macOS LibreOffice > Pfedvolby > LibreOffice > UZivatelské udaje). Pokud

dokument upravuje vice osob, barva pozadi komentaru automaticky odliSuje jejich
autory.

Souradnicovy systém

Osy XayY

Osa x je vodorovna poloha objektu a osa y je svisla poloha objektu. Pravitka nezobrazuji
znaménko minus, pokud jsou souradnice zaporné. Znaménko minus pro zaporné soufadnice se
vSak zobrazuje v poli pozice ve Stavovém fadku a v dialogovém okné Pozice a velikost.

Pracovni plocha

Pracovni plocha Draw je vétSi nez stranka kresby. Plocha mimo stranku kresby je Siroka jednu
stranku vpravo a vlevo a pdl stranky nad a pod strankou kresby. Velikost stranky kresby je
znazornéna zvyraznénymi ¢astmi vodorovnych a svislych pravitek.
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Objekty v aplikaci Draw Ize kreslit Castec¢né nebo zcela mimo stranku kresby a tyto objekty se
ukladaji spolu s kresbou. P¥i tisku nebo exportu kresby vSak neni zahrnut Zadny objekt nebo ¢éast
objektu, ktery neni na strance kresby. To umoznuje, aby se oblast Pracovni plochy kolem
stranky kresby pouzivala pro navrhy pfi vytvareni objektd.

Poloha objektu

Souradnice objektll a voditek se zobrazuji relativné vzhledem k pocatku. Vychozim pocatkem
soufadnice (pozice (0.00/0.00) je levy horni roh stranky kresby bez okrajd nebo levy horni roh
stranky kresby, kde se protinaji okraje. Chceme-li zménit vychozi pocatek, klepneme na priisecik
pravitek v levém hornim rohu pracovni plochy a pfetdhneme jej na poZzadované misto. P¥i
pretahovani priiseciku z vychoziho poc¢atku do nové pozice se zobrazi vodici ¢ary. Toto
nastaveni pocatku se tyka pouze aktualniho zobrazeni a neni uloZzeno v dokumentu.

Oblast uvnitf vychoziho pocatku je oblast pouzita pro mfizku, pokud jsou vybrany moznosti

vy ~rv

Prichytit k mfiZzce a Zobrazovat mfizku.

Chceme-li obnovit vychozi poéatek do plivodniho nastaveni v levém hornim rohu stranky,
dvakrat klepneme do levého horniho rohu na pracovni plose, kde se setkavaji vodorovna
a svisla pravitka.

Pfesnost

Kresleni interné pouziva celoc¢iselné hodnoty v 1/100 mm. To znamena, Zze nemusi byt mozné
ziskat pfesnou polohu pro 1/8 palce. Mnoho poli v dialogovych oknech je také omezeno na dvé
desetinna mista.

Pokud chceme pracovat s maximalni moznou presnosti, pfejdeme do Nastroje > Moznosti >
LibreOffice Draw > Obecné (macOS LibreOffice > MoZnosti > LibreOffice Draw > Obecné)
a nastavime moznost Mérna jednotka na Milimetr. Po vybéru této moznosti se v pravitkach
zobrazi metrické jednotky, Pokud chceme pro pravitka pouzit jinou mérnou jednotku, klepneme
na pravitko pravym tlacitkem mySi a z mistni nabidky vybereme mérnou jednotku. Vodorovné
a svislé pravitko mohou mit rizné mérné jednotky.
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Uvod

Ve vychozim nastaveni jsou pfikazy a nastroje pouZzivané v aplikaci Draw seskupeny v
uzivatelském rozhrani, které se sklada z kaskadovych nabidek a nastrojovych list. Funkce a
pouZiti téchto kaskddovych nabidek a nastrojovych list jsou popsény v pfedchozich kapitolach
této uZivatelské prirucky.

Tato kapitola popisuje varianty uzivatelského rozhrani, které jsou k dispozici pro aplikaci Draw.
UZivatel ma moznost vybrat si uzivatelské rozhrani, které vyhovuje jeho pozadavkim a
zpUsoblm vytvareni kreseb v aplikaci Draw.

ﬁ Poznamka

Pfi zméné uzivatelského rozhrani Ize variantu pouzit pouze pro aplikaci Draw nebo
pro vSechny moduly LibreOffice.

Vybér variant uzivatelského rozhrani

8) V hlavni nabidce zvolime Zobrazit > UZivatelské rozhrani a tim otevieme dialogové
okno Vyberte upfednostiiované uzivatelské rozhrani (obrazek 306 pod).

9) Na karté Uzivatelské rozhrani vybereme pozadovanou variantu. Pfiklad vybraného
uZivatelského rozhrani je zobrazen v ¢asti Nahled s kratkym popisem.

10) Klepnutim na tlaCitko Pouzit v modulu Draw pouZijeme vybrané uZzivatelské rozhrani
pouze v LibreOffice Draw.

11) Pripadné klepnutim na Pouzit na vS§echny pouZijeme vybrané uZivatelské rozhrani na
vSechny moduly LibreOffice. Okno LibreOffice se zméni podle vybraného uZzivatelského
rozhrani.

12) Klepnutim na Zavfit zavieme dialogové okno.

)? Poznamka

Pokud byla vybrana moznost Povolit experimentalni funkce v Casti Nastroje >
MoZnosti > LibreOffice > Pokrocilé (macOS LibreOffice > MoZnosti > LibreOffice
> Upfesnit), zobrazi se v ¢asti UZivatelské rozhrani nékolik dalSich moznosti.
Vzhledem k tomu, Ze se jedna o experimentalni uzivatelska rozhrani, nejsou v této
kapitole popsana.

Dokumentace pro LibreOffice je dostupna na https://cs.libreoffice.org/get-help/documentation/
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listou. Uréeno pro ufivatele, kbefi jsou zwykli na klasické rozhrani.

Napovéda Pouit na viechny +/ Pou#it v modulu Draw Zavfit

Obrazek 306: Dialogové okno Vyberte uprednostriované uZivatelské rozhrani
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Obrazek 307: UZivatelské rozhrani standardni nastrojové listy

Standardni nastrojové listy

UZivatelské rozhrani Standardni nastrojové liSty je vychozim zobrazenim pfi instalaci
LibreOffice do pocitace a prvnim otevieni Draw. DalSi informace o pracovni ploSe Draw
nalezneme v kapitole 1, Pfedstaveni aplikace Draw. Obrazek 307 nad ukazuje pfiklad
uzivatelského rozhrani Standardni nastrojové listyv LibreOffice Draw, ktera se obvykle sklada z
nasledujicich polozek:

* Hlavni nabidka v horni ¢asti Pracovni plochy.

« Standardni nastrojova lista a nastrojova lista Cara a Vypli umisténé pod hlavni

nabidkou.

* Nastrojova lista pro kresleni umisténa svisle na levé strané pracovni plochy.
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» Postranni nastrojova liSta na pravé strané pracovni plochy.

Karty

/? Poznamka
PFi pouziti uzivatelského rozhrani Karty jiz nejsou viditeIné nastrojové liSty Draw. V
pfipadé potfeby je mozné otevrit nastrojové liSty volbou Zobrazit > Nastrojové listy
v hlavni nabidce nebo vybérem Nastrojové listy v rychlé nabidce.

UzZivatelské rozhrani Karty poskytuje uzivatelské rozhrani podobné jinym kancelarskym
aplikacim, napriklad Microsoft Office. Karty uzivatelského rozhrani se skladaji z nastrojli
seskupenych podle kontextu. Tento kontext se automaticky meéni v zavislosti na modulu
LibreOffice a vybraném objektu. Obrazek 308 pod ukazuje pfiklad vychoziho zobrazeni pracovni
plochy s vyuZitim uzivatelského rozhrani Karty v aplikaci LibreOffice Draw.

UZivatelské rozhrani Karty obsahuje panel nabidek, listu karet a ikony nastroji seskupené v
kontextu pro pouziti v aplikaci Draw. Pokud ikony néstrojd na strance s kartou presahuji Sitku
okna Draw, zobrazi se na pravém konci fadku karet dvojita Sipka >>. Klepnutim na tuto dvojitou

Sipku >> zobrazime zbyvajici moznosti uzivatelského rozhrani Karty.

X
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Obrazek 308: Uzivatelské rozhrani s kartami
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Obréazek 309: UZivatelské rozhrani s kartami — rychla
nabidka

Na levé strané od LiSty karet jsou k dispozici ikony, které umoznuji pfistup k nékterym bézné
pouzivanym nastrojiim — Hlavni nabidka; Otev¥it; UloZit; Zpét; Znovu. Klepnutim na Hlavni
nabidka na levém konci liSty karet se bud skryje, nebo otevie hlavni nabidka v horni ¢asti
Pracovni plochy.

V pravé horni ¢asti pracovniho prostoru klepneme na 3 vodorovné ¢éary (=), abychom ziskali
pfistup k ¢asto pouzivanym pfikazm a odkaz(m, jak ukazuje priklad na Obrazku 309 nad..
Nékteré prikazy maji mistni nabidky s dalSimi dostupnymi pfikazy. Ty se oznacuji trojuhelnikem
» nebo jednoduchou Sipkou >, vpravo od pfikazu.

UZivatelské rozhrani s kartami Ize prizplsobit pomoci stranky Lista karet dialogového okna
prizplsobit (obrazek 310 pod) a zobrazit nebo skryt jednotlivé nastroje na rliznych kartach. vV
hlavni nabidce zvolime Nastroje > Prizptlisobit a otevieme dialogové okno PfizpUsobit. DalSi
informace o pfizplsobeni nalezneme v pfiru¢ce Zac¢iname s LibreOffice a Prirucce aplikace
Writer.
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Obréazek 311: UzZivatelské rozhrani s kartami — karta Soubor

Neménné karty

Karta Soubor

Karta Soubor (obrazek 311 nad) obsahuje prikazy pro vytvareni novych dokumentt a spravu
existujicich dokument(. Na pravé strané karty Soubor jsou nasledujici dvé nabidky:

* Soubor — obsahuje stejné pfikazy jako nastroje dostupné na karté.
« Napovéda — obsahuje odkazy na rlizné zdroje.
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Karta Domu

Karta Domi (obrazek 312 pod) obsahuje nastroje a pfikazy pro vyjmuti, kopirovani, vioZzeni a
formatovani viech typl objektll jakou jsou obrazky, tabulky, grafy, text atd. Rovnéz Ize pouzit a
aktualizovat styly kreseb tak, aby odpovidaly poZadavkim na kresbu. Na pravém konci liSty karet
Domi klepneme na Domt a tim otevieme rozeviraci nabidku obsahujici dal$i nastroje.

Karta VlozZit

Karta VloZit (obrazek 313 pod) obsahuje nastroje a prikazy pro vkladani mnoha rliznych typ(
objektd jako jsou obrazky, tabulky, grafy atd. Na pravém konci listy karet VloZit klepneme na
Vlozit a tim otevieme rozeviraci nabidku s nékterymi stejnymi néstroji.

Karta Rozvrzeni

Karta Rozvrzeni (obrazek 314 pod) obsahuje nastroje a pfikazy pro vytvofeni rozvrzeni kresby.
Na pravém konci pasu karet Rozvrzeni kliknéte na Rozvrzeni, ¢imz oteviete rozbalovaci
nabidku s nékterymi stejnymi nastroji.
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Obrézek 312: UZivatelské rozhrani s kartami — karta Domd
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Obrazek 313: Uzivatelské rozhrani s kartami — karta VloZit
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Obréazek 314: UZivatelské rozhrani s kartami — karta RozvrZzeni
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Obrazek 315: UZivatelské rozhrani s kartami — karta Revize
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Obrazek 316: UZivatelské rozhrani s kartami — karta Zobrazit

Karta Revize

Karta Revize (obrazek 315 nad) obsahuje nastroje a pfikazy pro kontrolu pravopisu textu,
vkladani a mazani komentarl k revizim a redakénim Gpravam. Na pravém konci pasu karet
Revize klepneme na Revize a otevieme dal3i prikazy pro Upravu textu. Nékteré z t&chto prikazl
se zobrazi pouze v pfipadé, Ze je v nabidce Nastroje > MoZnosti> Nastaveni jazyka > Jazyky
(macOS LibreOffice > MoZnosti > Nastaveni jazyka > Jazyky) vybrana moznost Asijské
rozvrZzeni nebo Komplexni rozvrZeni textu.

Karta Zobrazit

Karta Zobrazit (obrazek 316 nad) obsahuje nastroje a prikazy pro zobrazeni kresby na
obrazovce. Na pravém konci liSty karet Zobrazit klepneme na Zobrazit a tim otevieme
rozeviraci nabidku s dalSimi nastroji pro zobrazeni kresby na obrazovce.

Karta RozsSireni

Karta RozSifeni je pevna karta obsahujici pouze Spravce rozsifeni. Po vybéru se otevie

dialogové okno Spravce rozSifeni, které umoZziuje instalovat a odstranovat rozsifeni kompatibilni
s LibreOffice.

Karta Nastroje

Karta Nastroje (obrazek 317 pod) obsahuje nastroje pro makra; nahrazeni barev; pfehravac
médii atd. Na pravém konci listy karet Nastroje klepnutim na Nastroje otevieme rozeviraci
nabidku s nékterymi stejnymi nastroji a dalSimi nastroji pro organizaci maker a dialogovych oken,

v v

mapu obrazku, zdroje dat, nastaveni filtr(i, spravce rozsifeni a moznosti.
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Obrazek 317: UZivatelské rozhrani s kartami — karta Nastroje
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Obrazek 318: UZivatelské rozhrani s kartami — karta Kresba

DalSi karty

Nasledujici dalSi karty se oteviou pouze tehdy, kdyZz je vybran urcity typ objektu v kresbé. Tyto
dalSi karty se zobrazuji mezi kartami Zobrazit a RozSifeni.

Karta Kresba

Karta Kresba (obrazek 318 nad) je k dispozici pouze tehdy, kdyZ je v kresbé vybran objekt
kreshby. Poskytuje nastroje a pfikazy pro Upravy, transformaci, seskupovani, zarovnavani a
rozmisténi objektl kresby. Na pravém konci listy karet Kresba klepnutim na volbu Kresba
otevieme rozeviraci nabidku s podobnou sadou néastrojl a pfikazd pro Gpravy, transformaci a
konverzi objektll kresby.

Karta Obrazek

Karta Obrazek (obrazek 319 pod) je k dispozici pouze tehdy, je v kresbé vybran obrazek,
napriklad fotografie, pismomalba, objekt OLE nebo QR kéd. Nabizi nastroje pro praci s obrazky,
jako je ofezavani, ohrani€eni, styly oblasti, barvy atd. Na pravém konci listy karet Obrazek
klepneme na Obrazek a tim otevieme rozeviraci nabidku s nékterymi stejnymi nastroji.

Karta Objekt

Karta Objekt (obrazek 320 pod) je k dispozici pouze tehdy, kdyZ je v kresbé vybran objekt média
Poskytuje nastroje pro umisténi, zmeénu velikosti, vybér barev atd. pro vybrany kompatibilni
objekt. Na pravém konci liSty karet Objekt klepneme na Objekt a tim otevieme nabidku s dalSimi
nastroji a pfikazy odpovidajicimi vybranému typu objektu.
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Obrazek 319: UzZivatelské rozhrani s kartami — karta Obrazek
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Obrazek 320: UZivatelské rozhrani s kartami — karta Objekt
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Obrazek 321: UZivatelské rozhrani s kartami — karta Tabulka
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Obrazek 322: UzZivatelské rozhrani s kartami — karta Média

Karta Tabulka

Karta Tabulka (obrazek 321 nad) je k dispozici pouze tehdy, kdyz je v kresbé vybrana
kompatibilni tabulka. Nabizi nastroje pro umisténi, zménu velikosti, vybér barev atd. pro
vybranou tabulku. Na pravém konci liSty karet Tabulka klepneme na Tabulka a tim otevieme
rozeviraci nabidku s dalSimi néstroji pro Upravy.
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Karta Multimédia

Karta Média (obrazek 322 nad) je k dispozici pouze tehdy, kdyZ je v kresbé vybran objekt média.
Poskytuje nastroje pro umisténi a spusténi zvukového nebo video souboru. Na pravém konci
listy karet Média klepneme na poloZku Média a tim otevieme rozeviraci nabidku s dalSimi
nastroji pro Upravy média.
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Obrazek 324: UZivatelské rozhrani postranni listy

Jednotna nastrojova liSta a postranni nastrojova lista

Pokud je vybrana moznost Jedina nastrojova lista a Postranni liSta (obrazek 323 nad a
324 nad) zobrazi se pouze hlavni nabidka bez nastrojovych list. Nastrojové liSty v3ak Ize do
uzivatelského rozhrani pfidat tak, Ze v hlavni nabidce zvolime Zobrazit > Nastrojové liSty a z
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dostupnych moznosti vybereme poZzadovanou nastrojovou liStu. DalSi informace o nastrojovych
listdch nalezneme v Dodatku B, Nastrojové liSty a v pfiru¢ce Za¢iname s LibreOffice.
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Obréazek 326: UZivatelské rozhrani Kompaktni skupiny

Kompaktni karty

Uzivatelské rozhrani Kompaktni karty pouziva stejné karty jako uzivatelské rozhrani Karty, ale
nastroje na kazdé karté jsou usporadany jako jedna fada nastrojli. Nékteré z t&chto nastroji maji
rozeviraci nabidky s dalSimi moznostmi. Obrazek 325 nad ukazuje pfiklad karty Soubor v
uzivatelském rozhrani Kompaktni karty. Po zobrazeni se klepnutim na dvojitou Sipku >> vpravo
na listé karet zobrazi dalSi nastroje a pfikazy pro dpravy objektu.
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Nabidka karet na pravé strané uzivatelského rozhrani Kompaktni karty obsahuje stejné
moznosti jako nabidky karet v uzZivatelském rozhrani Karty, dalSi informace nalezneme v Casti
“Karty” na strané 330.

Kompaktni skupiny

UZivatelské rozhrani Kompaktni skupiny poskytuje pristup k nastrojlim a pfikazim ve
skupinach pomaoci ikon pro €asto pouZivané nastroje a rozeviracich nabidek pro ostatni nastroje
a pfikazy. Obrazek 326 nad ukazuje priklad uZivatelského rozhrani Kompaktni skupiny s
vybranym textovym objektem v dokumentu LibreOffice Draw a je usporadan jako sady nastrojii a
nabidek. Dostupné nastroje a habidky se méni podle typu vybraného objektu. Klepnutim na
dvojitou Sipku >> zobrazime dalSi nastroje pro Upravu objektu.

Kontextova liSta

Uzivatelské rozhrani Kontextova liSta zobrazuje jednu nastrojovou liStu pro typ vybraného
objektu. Obrazek 327 pod ukazuje pfiklad uZivatelského rozhrani Kontextova lista pfi vybéru
objektu kresby. Klepnutim na dvojitou Sipku >> zobrazime dalSi moZnosti Uprav objektu.
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Obrazek 327: Uzivatelské rozhrani Kontextova lista
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Uvod

LibreOffice Ize pouZzivat bez pouziti ukazovaciho zafizeni, napfiklad mysi, trackpadu nebo
trackballu. Pomoci klavesovych zkratek Ize napfiklad provadét tak rozmanité a sloZzité ulohy, jako
je ukotveni a zruseni ukotveni nastrojovych list a oken nebo zména velikosti ¢i polohy objektd.
LibreOffice ma rozsahlou sadu klavesovych zkratek k dispozici pro pouZiti s kazdym modulem
LibreOffice, ktery ma klavesové zkratky specifické pro dany modul.

Napovédu ke klavesovym zkratkam LibreOffice nebo k pouzivani LibreOffice pouze pomoci
klavesnice nalezneme v napovédeé LibreOffice, kde jako klic¢ova slova pouZzijeme ,zkratky" a/nebo
~pristupnost”.

V LibreOffice Ize také vytvorit vlastni klavesové zkratky. MZzeme napfiklad vytvorit klavesové
zkratky pro standardni funkce nebo makra LibreOffice a uloZit je pro budouci pouziti. DalSi
informace o vytvareni vlastnich klavesovych zkratek nalezneme v pfiru¢ce Zac¢iname s
LibreOffice.

Nékteré klavesy a polozky nabidek se v systému macOS liSi od klaves pouzivanych v
operacnich systémech Windows nebo Linux. Je to dano zplsobem fungovani rdznych
operacnich systémU a rdznymi typy pouzivanych klavesnic. Oznaceni na klavesnicich se také
mUze liSit v zavislosti na stafi pocitace a stylu pouzité klavesnice.

/? Poznamka

Prazdna burika v nékteré z nasledujicich tabulek znamend, Ze klavesovéa zkratka
neni v pouzivaném operacnim systému pocitace k dispozici.

Obecné funkéni klavesy a klavesové zkratky

Otevirani nabidky a poloZzek nabidky

Akce nebo prikaz I/I{mdows/ macOS
Linux

Zavreni oteviené nabidky. Esc Esc

Opakovanym stisknutim klavesy F6 cyklicky aktivujeme

nasledujici objekty:

— Hlavni nabidka (pouze operacni systémy Windows a 6 £6

Linux).
— Kazda nastrojova lista shora doll a zleva doprava.
— Kazdé volné okno zleva doprava.

Opakovanym stisknutim kombinace klaves Shift+F6
aktivujeme cyklicky tyto objekty v opacném poradi.

Aktivuje zpét kresbu. Ctrl + F6 #+F6

Zapne nebo vypne pfistup k hlavni nabidce. F10

Shift + F6 Shift + F6

Pristup k pfikaziim hlavni nabidky
« Stisknutim tlaCitka F6 vybereme prvni polozku (Soubor) v hlavni nabidce.
« Stisknutim Sipky doprava vybereme dalSi nabidku vpravo.
* Stisknutim Sipky doleva vybereme pfedchozi nabidku vlevo.

« Stisknutim klaves Home a End vybereme prvni nebo posledni polozku hlavni nabidky.

Dokumentace pro LibreOffice je dostupna na https://cs.libreoffice.org/get-help/documentation/



« Stisknutim Sipky dol( otevieme vybranou nabidku. Kazdym stisknutim Sipky dold nebo
nahoru se vybér pfesune mezi prikazy nabidky.

« Stisknutim Sipky doprava otevieme vSechny podnabidky vybrané nabidky. Podnabidky
jsou oznaceny trojuhelnikem » nebo znakem vétsi > vedle poloZky nabidky.

 Stisknutim Enter se vybrany pfikaz provede.

Pfistup k pfikaziim nastrojové listy
* Opakované stiskneme klavesu F6, dokud neni vybran prvni nastroj na nastrojoveé listé.
* Pomoci Sipek doprava a doleva vybereme nastroj na vodorovné nastrojové listé.
« Pomoci Sipek nahoru a dolll vybereme nastroj na svislé nastrojové listé.
* Stisknutim klavesy Home vybereme prvni nastroj na nastrojové listé.
« Stisknutim klavesy End vybereme posledni nastroj na nastrojové listé.
« Stisknutim klavesy Enter aktivujeme vybrany nastroj.

« Stisknutim Sipky doprava otevieme libovolnou dil€i nastrojovou listu na vybrané
nastrojové listé. Dil¢i nastrojova lista je oznacena trojuhelnikem v vedle nastroje.

 Stisknutim Ctr l+Enter vlozime vybrany objekt kresby. Objekt kresby je umistén do
stfedu kresby s pfedem definovanou velikosti.

Ovladani dialogovych oken

KdyZ je dialogové okno oteviené, jeden prvek (napfiklad tlaCitko nebo pole s volbami) indikuje,
Ze je tento prvek vybran, a to bud' zvyraznénim, zaskrtnutim nebo te¢kovanym rameckem kolem
nazvu pole nebo tlacitka.

Vybrany prvek Akce nebo piikaz

Aktivuje vybranou moznost.

Enter Pokud neni vybrana Zadna moznost, je stisknuti Enter
ekvivalentni vybéru OK.

Zavfe dialogové okno bez uloZzeni zmén provedenych v
Esc dobé, kdy bylo dialogové okno oteviené.

Stisknuti klavesy Esc je také ekvivalentni vybéru Zrusit.

Pfesune zaméfeni v seznamu nahoru a dolU.
Zvysuje nebo sniZuje hodnotu proménné.

V ramci ¢asti dialogového okna se zaméreni pfesouva ve
svislém sméru.

Sipky nahoru/doli

Klavesy se Sipkami Aktivuje dalSi moznost v dialogovém okné ve vodorovném

vlevo/vpravo smeru.

Tabulator Aktivuje dalSi prvek v dialogovém okné.

Shift + tabulator Aktivuje pfedchozi prvek v dialogovém okné.

Alt + Sipka dold Zobrazi moznosti dostupné v rozeviracim seznamu.
Oznaci nebo vybere prazdné zaskrtavaci policko.

Mezernik Odzna&i nebo zrusi vybér zaskrtnutého zaskrtavaciho
pole.
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Klavesové zkratky v hlavni nabidce

» Hlavni nabidka je umisténa v horni ¢asti hlavniho okna LibreOffice a v kazdé z
uvedenych nabidek je k dispozici nékolik klavesovych zkratek.

* Nize uvedené nabidky nejsou fazeny abecedné, ale jsou uvedeny ve stejném poradi, v
jakém jsou zobrazeny v hlavni nabidce v hlavnim okné LibreOffice.

Nabidka LibreOffice

/? Poznamka

Nabidka LibreOffice je k dispozici pouze v pfipadé, Ze je LibreOffice nainstalovan v
pocitaCich se systémem macOS.

o PolozZzky
Akce nebo prikaz nabidky macOS
Ukoncit LibreOffice. .
. L ' - . Ukonci
Pfed zavienim LibreOffice se ujistime, Ze jsou soubory LibreOffice #8+Q

ulozeny.

Skryt LibreOffice.
Skryti nezavre LibreOffice.

Skryt LibreOffice | 3 +H

Otevieme dialogové okno Moznosti LibreOffice. Predvolby B+,
Nabidka Soubor
- Polozky Windows/
Akce nebo prikaz nabidky Linux macOS
Vytvoreni nového kresby.
Pouziva vychozi $ablonu LibreOffice pro | Novy > Kresba | Ctri + N BN
kresby.
Vytvofeni nové kresby pomoci Sablony.
Otevie dialogové okno Sablony pro . Shift+ .
pFistup k Sablonéam LibreOffice pfi Novy >Sablony | crrp 4 FASNIFL+N
vytvareni novych dokumentd.
Ukoncit LibreOffice. Pfed zavienim Ukon&eni
: ) L . . . 1+
L|b[eOff|ce se ujistime, Ze jsou soubory LibreOffice Ctr Q
uloZeny.
Sprava Sablon. Otevie dialogové okno Sablony >
Sablony pro pfistup k Sablonam Ctrl+ .
LibreOffice pfi vytvareni nebo tpravach | SPravovat Shift+N F+Shift+N
o 'y o Sablony
dokumentu, Sablon a kategorii Sablon.
Otevreni souboru. Otevfe prohlize¢
souborl umoZznujici navigaci do slozky | Otevfit Ctrl + 0 ¥k+0
a vybér souboru.
UloZzit soupor. U|0VZI v§echny zmény Uloit ctrl + S 84S
provedené v otevieném souboru.
Po provedeni zmén ulozime soubor jako i Ctri+ .
novy soubor. Ulozit jako Shift+S #+Shift+S
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- Polozky Windows/

Akce nebo prikaz nabidky Linux macOS

Zobrazeni nahledu. Otevre soubor a

zobrazi, jak bude soubor vypadat po |\ 4pi04 tisky 9 +Shift+P

vytisténi. K dispozici pouze pfi pouziti

systému macOS.

Tisk souboru. Otevfe dialogové okno

tisku, ve kterém mlzeme vybrat zplsob | Tisk Ctrl + P B+P
tisku souboru.

Nabidka Upravy
o Polozky Windows/

Akce nebo prikaz nabidky Linux macOS
Vratit predchozi akci zpét. Zpét Ctrl + Z ¥#+Z
ZruSeni pfedchozi akce nebo pfikazu. Znovu Ctrl +Y F#+Y
Od§tr§n§n| vybra’neho objektu a jeho Vyjmout ctrl + X 384+x
umisténi do schranky.

_Zkop|ru1err]e vybrany objekt a umistime Kopirovat ctrl + C 8+C
jej do schranky.

VlozZeni obsahu schranky na misto

kurzoru. Vlozeni také nahradi vSechny Viozit ctrl +V ¥+v
vybrané objekty.

VloZit obsah schranky v misté kurzoru

neforméatovany nebo s urcitym formatem - + .
vybranym v dialogovém okné Vlozit jinak. Vlog!t !!nak > Ctri + Shift ¥ +Shift+v

A - . Vlozit jinak +V

VloZeni také nahradi vSechny vybrané

objekty.

Duplikovat vybrané objekty. Kdyz je

objelv<,t vybrarj, dla,llo,gove okpo Dupllkovat Duplikovat Shift + F3 Shift + F3
slouzi k duplikovani vybraného objektu

pomoci jedné z dostupnych moznosti.
Vyber?me vSechny objekty a stranky v Vybrat vée Ctrl + A %+ A
kresbé.

Pri pvokusu vahledanl_§lova n?bo fraze Najit ctrl + F $8+F
otevieme nastrojovou listu Najit.
Otevieme dialogové okno Najit a

nahradit. Obvykle se pouziva k vyhledani
slova nebo slovniho spojenti, které Ize Nahradit Ctrl + H F+\+HF
nahradit jinym slovem nebo slovnim
spojenim.
Otevieme nastrojovou liStu Upravit body.

K dispozici je pouze v pfipadé, Ze objekt |Pfepnutirezimu | oo E8
pouZziva editovatelné body, napfiklad editace bodu
volnou caru.

Povoleni Upravy kresby pouze pro &teni,

kud ma uZivatel opravnani Rezim G cerit 98-+Shift+M

pokud ma uzivatel opravnéni ezim uprav Shift+M 1
zapisovatele.
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Nabidka Zobrazit

- Polozky Windows/
Akce nebo prikaz nabidky Linux macOS
Zobrazeni nebo skryti pravitek v hlavni . Ctri+ .
pracovni oblasti kreshy. Pravitka Shift+R F+Shift+R
Otevreni nebo zavfeni postranni listy. Postranni lita |Ctrl + F5 ¥+F5
Otevremg ero zavieme kartu Styly na Styly E11 W 4+ T
postranni listé.
Otevieme dialogové okno Navigator. Navigator F5 F5
Nabidka Vlozit
- PolozZky Windows/
Akce nebo prikaz nabidky Linux macOS
Vybereme rezim Uprav textu a otevieme .
A - . , P F2
nastrojovou listu Formatovani textu. Textove pole
zeni 5 Af - Ctrl + Alt
quzenl nového komentéfe na vybranou Komentar 84\ +C
stranku. +C
Otevieme dialogové okno Hypertextovy Hypertextovy ctrl + K 8 +K
odkaz. odkaz
Formatovaci
- o . ¢ Ctrl + .
Na pozici kurzoru vloZime nezlomitelnou znaEka g . F+Shift+
Viozit ShIft + Mezernik
mezeru. nezlomitelnou | mezernik
mezeru
Formétovaci
Na pozici kurzoru vlioZime Uzkou 6?3;':%;(0[] Alt+Shift+ |X+Shift+
nezlomitelnou mezeru. ; Mezernik Mezernik
nezlomitelnou
mezeru
Formatovaci
. ey L . znaCka >
\v/,Ivozenl uzke'h'o nepovinného zalomeni bez Nulova ctrl + / 84/
Sifky na pozici kurzoru.
mezera,
Zlomitelnd
Nabidka Format
- Polozky Windows/
Akce nebo prikaz nabidky Linux macOS
Navvy’brany text pouzije format pisma Text > TuEné ctrl + B 845
TucCne.
Na vybrany text pouzije format pisma Text > Kurziva | Ctrl + I 84T
Kurziva.
Zme,nvs,l velikost pisma V}/kv)r,aneho textu Text > Horni Ctrl + Shift %4+ShifE+pP
a zvySi text nad zakladni ¢aru. index + P
ZmenSi velikost pisma vybraného textu | Text > Dolni Ctri+ s8+Shi
o . Fp: . . Shift+B
a sniZi text pod zakladni Caru. index Shift+B
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objekt.

- Polozky Windows/
Akce nebo prikaz nabidky Linux macOS
ZvétSeni velikosti bodu vybraného Te>_(t> ZVetsit | ~pq 4 ] 4]
textu. velikost
Zmenseni velikosti bodu vybraného Te>§t > Zmensit ctri + [ [
textu. velikost
Nastaveni fégkovar!i v odstavci na Iv?gzestu,p){ > ctrl + 1 % + 7
jednoduché fadkova. Radkovani: 1
Nastaveni Féglkovénl' v odstavci na Fvac,)zestu,pyl, > ctrl + 5 % + 5
jeden a pul fadku. Réadkovani: 1,5
Nas_'Fa,vglnl Fadlfoyanl v odstavci na questu,py? ctrl + 2 % + 2
dvoijité fadkovani. Radkovani: 2
Nastaveni zarovnani odstavce na Zarovnani textu ctrl + L % + |
vlevo. > Vlevo
ij\stavime zarovnani odstavce na Zarovn:éml' textu | ~tr1 4+ E % + E
stfed. > Na stfed
Nastavime zarovnani odstavce Zarovnani textu ctrl + R % + R
doprava. > Vpravo
Nastavime zarovnani odstavce do Zarovnani textu ctri + J % + J
bloku. > Do bloku
Odstranévm pfimého tqr,matq’vam, které Vyme}zat pF[me ctri + M %€ + M
bylo pouzito bez pouziti stylu. formatovani
OtevvFe,d,ialogové okno/Grafické styly a | Styly > Upravit Alt + P ~C+P
umozni Upravu vybraného stylu. styl
Otevieme nebo zavieme kartu Styly na | Styly > E11 €+ T
postranni listé. Spravovat styly
Otevre dialogové okno Umisténi a Umisténi a
- .. . F4 F4
velikost pro vybrany objekt. velikost
Nabidka Tvar
v Polozky Windows/
Akce nebo prikaz nabidky Linux macOS
Presune vybrany objekt pred jiné Prenést do Ctri+ ® + Shift +
objekty. popredi Shift++ +
Pr(_asune vybrany objekt pfed prvni Prenést bliz ctrl + + St
objekt.
Presune vybrany objekt za dal3i objekt. |Odsunoutdal |Ctrl + - #®+-
Pfesune vybrany objekt za posledni Odsunout do Ctri+ %+Shi
; . , ift+-
objekt. pozadi Shift+-
Seskupi vybrané objekt Seskupit ceri #+Shift+G
eskupi vybrané objekty. eskupi Shift+G
o . . : " . Ctri + Alt + ®+\Z+Shift
ZruSeni seskupeni vybrané skupiny. ZrusSit skupinu +G
Shift+G
Umozni editovat objekty ve skupiné Upravit skupinu | F3 £3

Prirucka aplikace Draw 25.8 | 347




- Polozky Windows/
Akce nebo prikaz nabidky Linux macOS
Opusténi skupiny objektd. Zrusit skupinu | Ctrl + F3 #+F3
Spojime dva nebo vice vybranych . Ctri+ %+ShiFt+K
objektl do jednoho tvaru. Zkombinovat | gp; £r4k 1
Rozdéli kombinovany objekt na Rozdslit Ctr+Shift+A |®+\-+Shift
jednotlivé objekty. Lt+K +K
Otevre dialogové okno Duplikovat.
Kdyz je objekt vybran, otevfe se _ ) ]
dialogové okno Duplikovat, které Duplikovat Shift + F3  |Shift + F3
poskytuje moznosti duplikovani
vybraného objektu.
Nabidka Nastroje
- Polozky Windows/
Akce nebo prikaz nabidky Linux macOS
Spusti kontrolu pravopisu. K dispozici | Kontrola £7
pouze v rezimu Uprav textu. pravopisu
Zapnuti nebo vypnuti automatické Automaticka
kontroly pravopisu. K dispozici pouze v |kontrola Shift + F7 Shift + F7
rezimu Uprav textu. pravopisu
Otevre dialogové okno tezauru pro Slovnik
pouzity jazyk. K dispozici pouze v Ctrl + F7 #+F7
oy A synonym
rezimu Uprav textu.
Otevvje d,ialogové okno Spravce Spré\v/ce, Ctrl + Alt + BATHE
rozsSifeni. rozsifeni E
Qtevre d_|alogove okno Moznosti MoZnosti Alt + F12
LibreOffice.
Nabidka Okno
- Polozky Windows/
Akce nebo prikaz nabidky Linux macOS
Zavfeni aktivniho okna. Pokud je
otevieno pouze jedno okno, LibreOffice | Zavfit okno Ctrl + W B+
se zavfe.
Nabidka Napovéda
- PolozZky Windows/
Akce nebo prikaz nabidky Linux macOS
Otevfe vychozi aplikaci prohlizeCe na | Napovéda F1 F1
strankach napovédy LibreOffice. LibreOffice
Otevre okno pfikazu pro vyhledavani a Hledat pikazy | Shift+Esc

umozni vyhledani pfikazu.
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Funkéni klavesy a klavesové zkratky nastrojové listy

» Aplikace Draw nabizi nékolik nastrojovych list pro tvorbu a Upravu kreseb. Nékteré
nastroje na nastrojovych liStdch Draw Ize aktivovat pomoci funkéni klavesy nebo
klavesové zkratky.

» Nastrojové listy Draw jsou uvedeny ve stejném poradi, v jakém jsou zobrazeny v mistni
nabidce, ktera se otevie po vybéru moznosti Zobrazit > Nastrojové liSty v hlavni
nabidce.

* NiZe uvedené néstrojove listy aplikace Draw jsou vychozi sadou nastrojovych list po

instalaci LibreOffice do pocitace.

Nastrojova liSta Komentare

- Polozky Windows/
Akce nebo prikaz nabidky Linux macOS
VloZeni komentéfe do dokumentu. Komentéar gtrl tALL EXHC
Nastrojova lista Kresba
v Polozky Windows/
Akce nebo prikaz nabidky Linux macOS
VloZi textové pole, otevie rezim Uprav VioZit textové
textu a nastrojovou listu Formatovani ole F2 F2
textu. P
Nastrojova lisSta Upravit body
v Polozky Windows/
Akce nebo prikaz nabidky Linux macOS
Otevieme néstrojovou liStu Upravit
body. . .
. I e i s Prepnuti
K dispozici je pouze v pfipadé, Ze se V | osimy editace | F8 E8
kresbé nachazi objekt, ktery pouziva bodu
editovatelné body, napfiklad ¢ara od
ruky.
Nastrojova liSta Najit
- PolozZky Windows/
Akce nebo prikaz nabidky Linux macOS
Otevre dialogové okno Najit a nahradit
a
. . Najit a nahradit |Ctrl + H H+\+H
umozni vyhledat a nahradit vSechny
vyskyty textu v kresbé.
Nastrojova lista Navrh formulare
- Polozky Windows/
Akce nebo prikaz nabidky Linux macOS
Otevre dialogové okno Umisténi a Umisténi a E4 E4
velikost vybraného objektu. velikost
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- Polozky Windows/
Akce nebo prikaz nabidky Linux macOS
PFfesune vybrany objekt pfed vSechny | Pfenést do Ctri+ .
ostatni objekty. popredi Shift++ H+Shift++
Presune vybrany objekt za vSechny Odsunout do Ctri+ ¥ + Shift +
ostatnich objekty. pozadi Shift+- -
. o . Ctri+ .
Seskupi vybrané objekty. Seskupit Shift+G ®+Shift+G
o . . : " : Ctri + Alt + ¥+\Z+Shift
ZruSeni seskupeni vybrané skupiny. Zrusit skupinu +G
Shift+G
Umozrzl editovat objekty ve skupiné Upravit skupinu | F3 F3
objekta.
Opusténi skupiny objektd. Zrusit skupinu  |Ctrl + F3 ®+F3
Nastrojova lista Obrazek
o Polozky Windows/
Akce nebo prikaz nabidky Linux macOS
Otevre dialogové okno Umisténi a Umisténi a E4 E4
velikost pro vybrany objekt. velikost
Presune vybrany objekt pfed vSechny | Pfenést do Ctri+ ,
ostatni objekty. popredi Shift++ FH+Shift++
Pfesune vybrany objekt pfed objekt. Pfenést bliz Ctrl + + B++
Presune vybrany objekt za objekt. Odsunoutdal |Ctrl + - b +-
Pfesune vybrany objekt za vSechny Odsunout do Ctri+ & + Shift +
ostatnich objekty. pozadi Shift+- -
Nastrojova lista Vlozit
- Polozky Windows/
Akce nebo prikaz nabidky Linux macOS
. X i
Vlozi objekt vzorce do dokumentu. Objekt vzorce |Alt+Shift+E +;'__:Shlft
Nastrojova lista Cara a vypli
- PolozZky Windows/
Akce nebo prikaz nabidky Linux macOS
Otevfe dialogové okno Umisténi a Umisténi a F4 F4
velikost pro vybrany objekt. velikost
Pfesune vybrany objekt pfed vSechny | Pfenést do Ctri+ .
ostatni objekty. popredi Shift++ #+Shift++
PFfesune vybrany objekt pfed objekt. Pfenést bliz Ctrl + + $++
Pfesune vybrany objekt za objekt. Odsunoutdal |Ctrl + - 3 +-
Pfesune vybrany objekt za vSechny Odsunout do Ctri+ ¥ + Shift +
ostatnich objekty. pozadi Shift+- -
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- Polozky Windows/
Akce nebo prikaz nabidky Linux macOS
Otevie kartu Styly v postranni listé. Styly F11 ¥+ T
Nastrojova lista Standardni
- PoloZky Windows/
Akce nebo prikaz nabidky Linux macOS
Otevfe novou kresbu. Novy Ctrl + N F+N
Otevre dialogové okno Sablony, které 5 ctri+
umoznfuje vytvofit novou kresbu pomoci | Sablony Shift+N F+Shift+N
Sablony.
Otevre prohlize€ Otevfit soubor, ktery
umoznuje navigaci do slozky a vybér Otevrit Ctrl + 0 #+0
kresby.
Ulozi otevieny dokument. Ulozit Ctrl + S #+S
Otevre prohlize€ Ulozit jako soubor a ctri+
umozni uloZeni oteviené kresby jako Ulozit jako ; F+Shift+S
Shift+S
novou kresbu.
Zapnuti rezimu Uprav, kdyZ je kresba v . Ctril+ .
re3imu pouze pro &teni. Rezim Uprav Shift+M F+Shift+M
Otevrie dl?logoye okno Tisk a umozni Tisk ctrl + P 38.4p
vybrat zpusob tisku kresby.
Odstranéni vybraného objektu a .

PP p Ctrl + X +
umisténi objektu do schranky. Vyjmout #+X
Zkopyovam vybraného objektu do Kopirovat ctrl + C 8+C
schranky.

Umisténi objektu ze schranky do Viozit ctrl + v 38.4+)/
kreshy.
Odstranevr_u pfimého tqr,matq’vam, které Vymazat ctrl + M ~+M
bylo pouZito bez pouZziti stylu.
Vréti pfedchozi editacni akci. Zpét Ctrl + Z ®+ Z
ka,)now akci Qaposledy vracenou Znovu ctrl + Y 38+y
pfikazem Zpét.
Spusti kontrolu pravopisu. Kontrola E7 E7
K dispozici pouze v rezimu Gprav textu. |pravopisu
Zapnuti nebo vypnuti automatické Automaticka
kontroly pravopisu. kontrola Shift + F7 Shift + F7
K dispozici pouze v rezimu Gprav textu. |pravopisu
Pfepnt_e do rezimu Uprav textu a otevie | ..« pole E2
nastrojovou listu Formatovani textu.
Otevieme dialogové okno Hypertextovy Viozit .
hypertextovy Ctrl + K
odkaz.
odkaz
Otevre dialogové okno Umisténi a Umisténi a E4
velikost pro vybrany objekt. velikost
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- Polozky Windows/
Akce nebo prikaz nabidky Linux macOS
Pokud se v kresbé nachazi objekt s
lvjpravneln)v/ml pody,. napr|l_<1ad volna_ Upravit body F8
Céra, otevie nastrojovou listu Upravit
body.
Nastrojova lisSta Standardni (reZzim prohlizeni)
o Polozky Windows/
Akce nebo prikaz nabidky Linux macOS
Otevre prohlize¢ Ulozit jako soubor a ctri+
umozni ulozit otevieny dokument jako | Ulozit jako : F¥+Shift+S
v Shift+S
novy dokument.
Zapnuti reZimu Uprav, kdyz je . Ctri+ .
dokument pouze pro cteni. Rezim uprav. | gpjft+m FHSNIFL+M
Otevre dif\logov_é okno Tisk a umozni Tisk ctrl + P 84p
vybrat zpusob tisku dokumentu.
Zkopyovam vybraného objektu do Kopirovat ctrl + C 84C
schranky.
Otevieme dialogové okno Najit a
nahradit.
Pomoci dialogového okna Najit a Najit a nahradit |Ctrl + H B+ T+F
nahradit umozni najit a nahradit
vSechny vyskyty textu v kresbé.
Nastrojova lista Text
- Polozky Windows/
Akce nebo prikaz nabidky Linux macOS
Vlozi textové pole, otevie rezim Uprav VioZit textové
textu a nastrojovou liStu Formatovani ole F2 F2
textu, P
Nastrojova lista Formatovani textu
- Polozky Windows/
Akce nebo prikaz nabidky Linux macOS
ZvétSeni velikosti bodu vybraného ZVatsit ctri + J %+]
textu.
ZmensSeni velikosti bodu vybraného Zmensit ctri + [ %+[
textu.
Navvyprany text pouzije format pisma TuEné ctrl + B 848
Tuéné.
Na vybrany text pouzije format pisma Kurziva ctrl + I 84T
Kurziva.
Zmensi velikost pisma vybraného textu . Ctri+ %+Shif
. t+P
a posune text nad zakladni ¢aru. Homf index Shift+pP Shi
Zmensi velikost pisma vybraného textu . Ctri+ serChiFit
a posune text pod zakladni ¢aru. Dolni index Shift+B Shift+b
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- Polozky Windows/
Akce nebo prikaz nabidky Linux macOS
Odst(aneplrvesk?_rgho prlmehov_ ] . | Vymazat ctrl + M ~+M
formatovani pouzitého bez pouziti stylu.
Nastaveni zarovnani odstavce na Vievo ctri + L 384
vlevo.
szlstawme zarovnani odstavce na Na stied ctrl + E $84E
stfed.
Nastavime zarovnani odstavce Vpravo ctrl + R 384R
doprava.
Nastavime zarovnani odstavce do Do bloku ctrl + J 38+
bloku.
Vybereme cely text v textovém poli. Vybrat vse Ctrl + A F+A

Nastrojova lista Priblizeni

- Polozky Windows/

Akce nebo prikaz nabidky Linux macOS
. o . +Shifi+

Klepnutim zvétSime velikost kresby na Priblizit Ctrl+Shift+P %+ Shifts a
obrazovce. age Up
Klepnutim zmensime velikost kresby na Oddalit Ctrl+Shift+P %+Shift+y
obrazovce. age Down
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Uvod

Aplikace Draw nabizi nékolik nastrojovych list pro vytvareni kreseb. Kazda nastrojova lista ma po
instalaci LibreOffice v pocitaci vychozi sadu nastrojd. Pro zlepSeni pouzitelnosti nastrojovych list
Ize pfidat dalSi nastroje, vice informaci nalezneme v €asti ,Uprava nastrojovych list“ na strance
359.

ﬁ Poznamka

Ikony na nastrojové listé zobrazené v této uzivatelské pfirucce se mohou liSit od ikon
zobrazenych na obrazovce pocitaCe. Ikony na nastrojové listé zavisi na operacnim
systému pocitace a na nastaveni LibreOffice. Dal$i informace o pfizptisobeni
LibreOffice a nastrojovych list najdeme v pfiru¢ce Zaciname s LibreOffice.

Pouziti nastrojovych list

Zobrazeni nastrojovych list
V aplikaci Draw se pouZivaji dva zplsoby otevirani nastrojovych list, a to nasledujici:

1) Pfejdeme na Zobrazit > Nastrojové liSty v hlavni nabidce. Otevie se podnabidka s
abecednim seznamem nastrojovych list, které jsou k dispozici pro vytvareni kreseb v
aplikaci Draw.

2) Klepnutim na nazev néastrojové listy ji zobrazime a aktivujeme. Aktivni nastrojové listy
jsou v zavislosti na nastaveni pocitace oznaceny zvyraznénim nebo zaSkrtnutim vedle
nazvu nastrojové listy.

Zavreni nastrojovych list
Pokud chceme zavfit nastrojovou listu, pouZzijeme jednu z nasledujicich metod:

* Pfejdeme do Zobrazit > Nastrojové liSty v hlavni nabidce a nastrojovou listu
odznacime.

» Klepneme pravym tlacitkem mysi do prazdné oblasti na nastrojové listé a z mistni
nabidky vybereme moznost Zavfit listu.

» Klepneme na X v pravém rohu zahlavi plovouci nastrojové listy.

Pfesouvani nastrojovych list

Ukotveni nastrojovych list

Ve vychozim nastaveni jsou nékteré nastrojové listy v hlavnim okné aplikace Draw ukotveny.
Nastrojova lista Standardni je ukotvena vodorovné nahofe a nastrojova lista Kresba je ukotvena
svisle na levé strané. Ukotvené nastrojové listy Ize odpoijit a pfesunout do nové ukotvené pozice
v hlavnim okné nebo je ponechat jako plovouci néstrojove listy.

1) Pfesuneme kurzor na maly svisly Uchyt na levém konci nastrojové listy nebo na
vodorovny Uchyt v horni ¢asti nastrojové listy (zvyraznéno na obrazku 328 pod). Kurzor
zméni tvar na pohyblivy kurzor pouzivany pro systém pocitace a nastaveni.

2) Pripadné klepneme pravym tlacitkem mySi na ukotvenou nastrojovou liStu a z mistni
nabidky vybereme Uvolnit nastrojovou liStu.

3) Klepneme na nastrojovou listu a pfetdhneme ji do nové pozice ukotveni nebo ji
ponechame jako plovouci nastrojovou liStu. Kolem nastrojové liSty se pfi pfetahovani
zobrazi Srafovany ramecek oznacujici umisténi nastrojové listy.

Dokumentace pro LibreOffice je dostupna na https://cs.libreoffice.org/get-help/documentation/



4) Jakmile je nastrojova liSta na poZzadovaném misté, uvolnime ji.

= RN

—
Y & B C

Stranky

Obrazek 328: Priklad tchyt( pro presunuti nastrojové listy

01 4 {1}

Obrazek 329: Priklad vytvofeni plovoucich dil¢ich nastrojovych list

}? Poznamka

Pokud nejsou na ukotvené néastrojoveé listé viditelné achyty pro pfesun nastrojove
liSty, je nastrojova lista uzamcend. Pfed pfesunutim do nového umisténi v hlavnim
okné je nutné odemknout ukotvenou nastrojovou listu. Dal3i informace nalezneme v
¢asti ,Uzamceni nastrojovych list* na strance 358.

Plovouci nastrojové listy

Pokud chceme presunout plovouci nastrojovou listu, klepneme na jeji zahlavi a pretdhneme ji na
nové misto. Jakmile je nastrojova liSta na poZzadovaném misté, uvolnime ji. Plovouci nastrojova
liSta nemusi byt umisténa v hlavnim okné aplikace Draw, aby byla funkgni.

Plovouci dil¢i nastrojové listy

Nékteré nastroje na nastrojové listé maji vpravo od nastroje trojuhelnik v, ktery oznacuje, ze
dalsi nastroje jsou k dispozici na diléi nastrojové listé, napriklad Tvary symboll na nastrojové
listé Kresba. Dil€i nastrojové listy Ize zménit na plovouci nastrojové liSty a pfesunout je na nové
misto nasledujicim zplsobem:

1) Pfesuneme kurzor na vodorovny Uchyt v horni ¢asti dilci nastrojové listy (zvyraznény na
obrazku 329 nad). Kurzor se zméni na pohyblivy kurzor pouZivany systémem pocitace a
nastavenim.

2) Klepneme na dilCi nastrojovou liStu a pretahneme ji na nové misto, ¢imz vytvofime
plovouci dil¢i nastrojovou listu.
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3) Po dosazeni poZzadovaného umisténi uvolnime diléi nastrojovou liStu.

4) Chceme-li zavrit plovouci dil¢i nastrojovou listu, klepneme pravym tlacitkem mySi na
trojuhelnik v v zahlavi dil¢i nastrojové liSty a z mistni nabidky vybereme Zavfit listu.

5) Pfipadné klepneme na X v pravém rohu zahlavi plovouci dil€i nastrojové listy.

Ukotveni plovoucich nastrojovych list
Pokud chceme ukotvit plovouci nastrojovou liStu, pouzijeme jednu z nasledujicich moZnosti:

» Klepneme na zahlavi a pfetahneme jej do pozice ukotveni v horni, dolni, levé nebo pravé
¢asti hlavniho okna. Jakmile nastrojova lista dosahne své pozice ukotveni, objevi se na
pozici ukotveni Srafovany ramecek. Uvolnénim nastrojove listy ji ukotvime na
poZadovaném misté.

» Klepneme pravym tlaCitkem mysi na nastrojovou liStu a z mistni nabidky zvolime Ukotvit
liStu. Nastrojova liSta se pfesune na pozici ukotveni. Pokud nam pozice nevyhovuije,
presuneme nastrojovou listu do nové pozice ukotveni.

» Pokud chceme dokovat vSechny aktivni plovouci nastrojové listy, klepneme na
nastrojovou listu pravym tlacitkem mysSi a z mistni nabidky vybereme moznost Ukotvit
vSechny listy.

Uzamceni hastrojovych list

Ukotveni nastrojovych list

Pokud byla néstrojova liSta ukotvena na misto, Ize ji také uzamknout, ¢imz se zabrani tomu, aby
se z nastrojové listy stala plovouci nastrojova lista.

» Chceme-li nastrojovou listu uzamknout na ukotvené pozici, klepneme pravym tlaCitkem
mysSi do prazdné oblasti na nastrojové listé a v mistni nabidce vybereme moznost
Zamknout umisténi liSty. Maly svisly nebo vodorovny pruh na levém konci nebo v horni
¢asti nastrojové listy zmizi, coZ znamend, Ze je nastrojova liSta uzamcena.

* Pokud chceme néstrojovou listu odemknout, klepneme pravym tlaCitkem mysi do
prazdné oblasti na nastrojové listé a v mistni nabidce klepneme na Zamknout umisténi
liSty. Na levém konci nebo v horni ¢asti nastrojové listy se zobrazi maly svisly nebo
vodorovny pruh, ktery oznacuje, Ze je nastrojova liSta odemcena. Tento panel slouzi také
k pfesouvani nastrojoveé listy.

ﬁ Poznamky

Zamknout umisténi listy slouzi k uzamykani a odemykani nastrojové listy; jedna se
0 pfepina¢ zapnuto/vypnuto.

Nékteré néstrojoveé liSty nelze v jejich umisténi ukotvit ani uzamknout. To je
indikovano tim, Ze moznosti Ukotvit liStu a/nebo Zamknout umisténi liSty jsou
Sedé a obé moznosti nejsou k dispozici.

Pouziti volby Zamknout liSty ovliviiuje vSechny nastrojové liSty a dilci nastrojové listy
dostupné ve vSech modulech LibreOffice.

Uzamcéeni nastrojovych list a dil¢ich nastrojovych list

Pokud chceme zabranit tomu, aby se vSechny néstrojové listy a dilci nastrojové liSty staly
plovoucimi nastrojovymi listami nebo dil¢imi nastrojovymi listami, miZeme je uzamknout.
Uzamdcené nastrojové listy a dil¢i nastrojové listy Ize odemknout stejnym zpUsobem, ktery je
uveden niZe. Volba Zamknout liSty se pouZziva jako prepina¢ uzamceni/odemceni.

1) Ulozime kresbu otevienou v aplikaci Draw.
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2) Pfejdeme na Zobrazeni > Nastrojové liSty v hlavni nabidce a z mistni nabidky
vybereme Zamknout liSty.

3) V otevieném dialogovém okné Restartovat LibreOffice vybereme moznost Restartovat
nyni a aktivujeme moznost Zamknout listy.

4) Pokud chceme odemknout vSechny néstrojoveé listy a dilci nastrojové liSty, abychom je
mohli pfemistit, opakujeme kroky 1 az 3. Volba Zamknout liSty je pfepinac
zapnuto/vypnuto.

Uprava nastrojovych list

Kdyz je LibreOffice nainstalovan do pocitace, obsahuje sadu nastrojovych list vhodnych pro
jednotlivé moduly LibreOffice. Kazda nastrojova lista ma vychozi sadu viditelnych nastrojd.
Nastroje Ize pfidavat nebo odstrafovat a nastrojové listy Ize pfizplsobovat.

Pridani nastroji
1) Klepneme pravym tlaCitkem mySi do prazdné oblasti na nastrojové listé nebo klepneme
na trojuhelnik v vpravo vedle titulku nastrojové listy.

2) Pokud chceme zobrazit seznam dostupnych nastrojll, vybereme v mistni nabidce
moznost Viditelna tlacitka.

3) Klepneme na poZadovany néstroj a nastroj se zobrazi na nastrojové listé. Seznam
dostupnych nastrojll se automaticky zavie. Zaskrtnuti vedle nastroje nebo zvyraznéni

kolem nastroje znamena, Ze nastroj uvedeny v casti Viditelna tlacitka je jiz na nastrojové

liSté nainstalovan.

ﬁ Poznamka
P¥i pfidavani nastrojii pomoci volby Viditelna tlacitka je nastroj pfidan na
nastrojovou liStu na stejnou pozici, v jaké se objevi v seznamu Viditelna tla€itka. To

znamena4, Ze prvni nastroj v seznamu se zobrazi na levém konci néstrojoveé listy a
posledni nastroj v seznamu se zobrazi na pravém konci nastrojové listy.

Odstranéni nastrojti

1) Klepneme pravym tlacitkem mysi do prazdné oblasti na nastrojové listé nebo klepneme
na trojuhelnik v vpravo vedle titulku nastrojove listy.

2) Pokud chceme zobrazit seznam dostupnych nastrojl, vybereme v mistni nabidce
moznost Viditelna tlacitka.

3) Klepnutim na nastroj, ktery jiz neni potfeba, se tento nastroj odstrani z nastrojové listy.
Zvyraznéni nebo zaskrtnuti se rovnéz odstrani. Seznam dostupnych nastroji se
automaticky zavre.

Pfizplisobujeme si nastrojové listy

Dal3i nastroje a pfikazy, které nejsou k dispozici v ¢asti Viditelna tlacitka, Ize pfidat na
nastrojové listy pomoci prizplsobeni (Zobrazeni > Nastrojové listy > Pfizplsobit v hlavni
nabidce). Prizplisobeni také umoZiuje vytvaret nové nastrojové listy, pokud je pro urcity ukol
vyzadovana specifickd sada nastrojd. Informace o pfizplisobeni nastrojové listy nalezneme v
pfirucce Zaciname s LibreOffice.

Nastrojové listy

T

Draw, pfejdeme na zvolime v hlavni nabidce moznost Zobrazit > Nastrojové listy.

Prirucka aplikace Draw 25.8 | 359



Priklad vychoziho seznamu nastrojovych list v aplikaci Draw je uveden na obrazku 330
pod.

 Pocet nastrojl viditelnych na nastrojové listé zavisi na nastaveni pocitace a opera¢nim
systému, ktery se pouZziva k vytvoreni kresby.

» Nastroje zobrazené na nastrojovych liStach v této pfiloze jsou pouze pfiklady. Skutecné
nastroje zobrazené na nastrojové listé zavisi na nastaveni pocitaCe, operacnim systému
a preferencich uZivatele.

» Nastroje jiz nainstalované na nastrojové listé jsou v ¢asti Viditelna tla€itka oznaceny
bud zvyraznénim ikony nastroje nebo zaskrtnutim. Tento Udaj zavisi na nastaveni
pocitaCe a pouzitém operacnim systému.

« Na nékterych nastrojovych listdch mohou byt ikony nastroji oznaceny trojuhelnikem
napravo od ikony. Klepnutim na tento trojuhelnik v otevieme seznam moznosti, dalSi
nastrojovou listu nebo diléi nastrojovou listu.

+ Né&které nastroje maji také klavesovou zkratku pro vybér nastroje. Uplny seznam
klavesovych zkratek dostupnych v aplikaci Draw najdeme v dodatku A, Klavesové
zkratky.

» Kazda nastrojova lista a dil€i nastrojova liSta zobrazena v této pfiloze zobrazuje tplny
seznam dostupnych nastrojl pro danou nastrojovou listu nebo diléi nastrojovou listu.

v

Priblizeni
Redakéni aprava
Rozmistit wybér
3D nastaven( «  Standardni
3D objekty Standardni (refim prohlizent)
Caraa vyplf Tabulka
DrivéjEl kruhy a ovaly Text
DrivéjEl obdélniky Transformace
Formatovani textu Upravit body
Komentare VloZit
+  Kresba Zachytné body
MozZnosti Zarovnat objekty
Majit Zobrazeni pfedlchy
Mavigace ve formulaf Pfizplisobit...
MNavrh formulare Obnovit
Obrazek «  Zamknout listy
Ovladaci prvky formulafe
Pismomalba
Prehravani médii

T

Obrazek 330: Priklad vychoziho seznamu nastrojovych list v aplikaci Draw
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3D objekty

3D objekty > X
PO & HOC O

Obrézek 331: Nastrojova lista 3D objekty

Nastrojova lista 3D objekty (obrazek 331) poskytuje nastroje pro vytvareni 3D objektll v kresbhé. V
hlavni nabidce zvolime Zobrazit > Nastrojové liSty > 3D objekty. Klepnutim na trojuhelnik v
vedle ikony 3D Objekty na nastrojové listé Kresba se otevre dilCi nastrojova lista, ktera
umoZnuje pristup ke stejnym 3D néastrojim.

(1) Krychle (3) Valec (5) Jehlan (7) Plast
(2) Koule (4) Kuzel (6) Torus (8) Polokoule
3D nastaveni

30 nastaveni v X
AR D

Obrazek 332: Nastrojova lista 3D nastaveni

Nastroje na nastrojové listé 3D nastaveni (obrazek 332) jsou aktivni, pokud byl objekt pfeveden
do 3D pomoci funkce Prepnout plasti¢nost a pfevedeny objekt je vybrany. U nasledujicich
nastrojli na nastrojové listé 3D nastaveni klepneme na trojahelnik v vpravo od ikony pro pfistup
k dalsim moZnostem.

(1) Pfepnout (3) Naklonit nahoru (6) Hloubka (9) Povrch
plasti¢nost (4) Naklonit doleva (7) Smér (10) Barva 3D
(2) Naklonit dold (5) Naklonit doprava (8) Osvétleni

Zarovnat objekty
ZLarownat objekty v X
= =
£ & < 0 fer oll

Obrazek 333: Nastrojova lista Zarovnat objekty

Nastrojova lista Zarovnat objekty (obrazek 333) poskytuje nastroje pro vzajemné zarovnani
nékolika objektl v kresbé.

(1) Pfepnout (3) Naklonit nahoru (6) Hloubka (9) Povrch
plasti¢nost (4) Naklonit doleva (7) Smér (10) Barva 3D
(2) Naklonit dolti (5) Naklonit doprava (8) Osvétleni
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Komentare

Komentafe v X
L1 €1 | L oY

Obrazek 334: Nastrojova lista Komentare

Nastrojova lista Komentare (obrazek 334) poskytuje nastroje pro pfidavani, mazani, Gpravy a
navigaci po komentarich v kresbé. Pokud chceme pouzivat komentéafe, doporucujeme pfidat
jména a inicialy vSech uZivatell v ¢asti Nastroje > MoZnosti > LibreOffice > UZivatelské udaje
(macOS LibreOffice > Pfedvolby > LibreOffice > UZivatelské tdaje). Pfidani uzivatelskych
jmen identifikuje vloZzené komentére.

(1) Komentér (3) DalSi komentar (5) Smazat vSechny
(2) Pfedchozi komentar (4) Smazat komentéar komentéare

Rozmistit vybér
Rozmistit wbér v X

Obh 0o oh dd =f oI & oI

Obréazek 335: Nastrojova lista Rozmistit vybér

Nastrojova liSta Rozmistit vybér (obradzek 335) poskytuje nastroje pro rozdéleni tfi nebo vice
vybranych objektl podél vodorovné nebo svislé osy. Rovnéz rozestupy mezi objekty mohou byt
rovnomeérné rozlozeny vodorovné i svisle.

(1) Rozmistit vodorovné vlevo (3) Rozmistit vodorovné (5) Rozmistit svisle nahoru
(2) Rozmistit vodorovné na mezery (6) Rozmistit svisle na stfed
stfed (4) Rozmistit vodorovné (7) Rozmistit svisle mezery
vpravo (8) Rozmistit svisle dolll
Kresba
Kresba v X

3 EL-R2-\NOOI—-¥-1L-

Tllvf.:;‘-‘v - ‘r"—.”?v -
& in P

Obrazek 336: Nastrojova lista Kresba

Nastrojova lista Kresba (obrazek 336) obsahuje nastroje pouzivané k vytvareni grafickych
objektd v kresbach. Ve vychozim nastaveni je tato nastrojova lista ukotvena na levé strané
pracovni plochy. Nékteré tvary nastrojd na nastrojové listé Kresba se méni v zavislosti na
poslednim vybraném a pouzitém nastroji. V pfipadé potieby klepneme na trojahelnik v vpravo
od ikony nastroje a tim otevieme vyskakovaci panel s moZnostmi.

(1) Vybrat (8) Barva vypIné (15) Spojnice

(2) PFiblizeni a posun (9) Carovy (16) Z&kladni tvary

(3) Priblizeni (10) Obdélnik (17) Tvary symboll
(4) Textové pole (11) Elipsa (18) Blokové Sipky

(5) Svisly text (12) Cara kon¢i Sipkou (19) Vyvojovy diagram
(6) Vlozit text pismomalby (13) Céry a Sipky (20) Bubliny

(7) Barva cary (14) Kfivky a mnohouhelniky (21) Hvézdy a cedule
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(22) 3D objekty (28) Vybereme alespori tfi (34) Na kfivku

(23) Umisténi a velikost predméty, které chceme (35) Na mnohouhelnik
(24) Otocit rozmistit (36) Na 3D objekt
(25) Preklopit (29) Stin (37) Na 3D rotacni objekt
(26) Zarovnat objekty (30) Ofiznout obrazek (38) Pfepnout plasticnost
(27) Usporadat (32) Filtr (39) Viozit

(32) Body F8 (40) Ovladaci prvky

(33) Zobrazit Zachytné body

Upravit body

Upravit body v X
Al AA A C A ZIE M Y

Obréazek 337: Nastrojova lista Upravit body

Nastrojova lista Upravit body (obrazek 337) poskytuje nastroje pro Upravu bod( kfivky nebo
mnohouhelniku nebo objektu, ktery byl pfeveden na kfivku hebo mnohouhelnik. Nastrojova lista
je aktivni pouze tehdy, kdyZ je vybran objekt. Klepneme na ikonu Upravit body na nastrojové
listé Kresba nebo Standardni nebo pouzijeme klavesovou zkratku F8 pro otevfeni nastrojové
liSty.

(1) Upravit body (5) Prevést na krivku (9) Plynuly pfechod
(2) Pfesunout body (6) Uzavrit Beziérovu kfivku (10) Soumérny prechod
(3) VloZit body (7) Rozdelit kfivku (11) Ubrat body
(4) Smazat body (8) Uhlovy roh
Najit
Majit v X
'{.::' ajit ~ Jajit vie [_] Rozlitovat velikost (] Rozlisovat diakritiku ,G&

Obrazek 338: Nastrojova lista Nayjit

Ve vychozim nastaveni se otevie nastrojova liSta Najit (obrazek 338), ktery je umistén v levém
dolnim rohu hlavniho okna LibreOffice Draw nad stavovym fadkem. Tuto nastrojovou listu Ize z
vychozi pozice odpojit a vytvofit z ni plovouci nastrojovou liStu.

(1) Zavrit vyhledavaci liStu (4) Najit dalsi (7) Najit a nahradit
(2) Najit text (5) Najit vSe
(3) Najit pfedchozi (6) RozliSovat velikost
Pismomalba
Pismomalba v X

F >--Aa =& . 0%

Obrazek 339: Nastrojova lista Pismomalba

Nastrojova lista Pismomalba (obrazek 339) slouzi k vytvareni grafickych textovych objektll na
snimku a poskytuje nastroje pro Upravu grafického textového objektu. Tato nastrojova lista je
aktivni pouze tehdy, kdyz je v kresbé vybran graficky textovy objekt Pismomalby.

(1) Vlozeni textu Pismomalby (3) Stejna vySka pismen (5) Rozestup znaki
(2) Tvar pismomalby pismomalby pismomalby
(4) Zarovnani pismomalby (6) Pfepnout plasticnost
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Ovladaci prvky formulare

Ovladaci prvky formulare v X

P ECEAVOEEREQM
DA BMOmAaaBENLGR E B

Obrazek 340: Nastrojova lista Oviadaci prvky formulare

Nastrojova lista Ovladaci prvky formulare (obrazek 340) poskytuje nastroje potfebné k vytvoreni
interaktivniho formulare. To umoziuje pridavat ovladaci prvky do formulare v kresbé. Napfiklad
tlaCitko, které otevie dokument, kresbu, tabulku nebo prezentaci.

(1) Vybrat (10) Tlacitko volby (20) Ménove pole

(2) Rezim navrhu (11) Seznam (21) Pole vzorku

(3) Pfepnout privodce (12) Pole se seznamem (22) Ovladaci prvek tabulky
ovladacimi prvky (13) Tlacitko (23) Lista navigace

(4) Navrh formulare (14) Obréazkové tlatitko (24) Ovladaci pole obrazku

(5) Vlastnosti ovladaciho prvku (15) Formétované pole (25) Vybér souboru

(6) Vlastnosti formulare (16) Pole pro datum (26) Rolovaci tlacitko

(7) Popisek (17) Ciselné pole (27) Posuvnik

(8) Textové pole (18) Seskupeni

(9) Zaskrtavaci pole (19) Pole pro ¢as

Navrh formulare

Mavrh formulare v X
[s ) N mw ( Ed

Obrazek 341: Nastrojova lista Navrh formulare

Nastrojova lista Navrh formulafe (obrazek 341) otevie formulaf v Rezimu navrhu, aby jej bylo
mozné upravovat. Ovladaci prvky formulafe nelze aktivovat ani upravovat jeho obsah, pokud je
ve stavu Rezim navrhu. Ve stavu Rezim navrhu vSak Ize ménit polohu a velikost ovladacich
prvkdl, upravovat jejich vliastnosti a pfidavat nebo odstrafiovat ovladaci prvky.

(1) Vybrat (8) Automaticky zaméfit (14) Zrusit skupinu

(2) Vlastnosti ovladaciho prvku ovladaci prvek (15) Zarovnat objekty

(3) Vlastnosti formuléare (9) Prenést do popredi (16) Otevrit v rezimu navrhu
(4) Umisténi a velikost (10) Odsunout do pozadi (17) Zobrazovat mrizku

(5) Navigator formulafem (11) Seskupit (18) Prichytit k mrizce

(6) Poradi aktivace (12) Zrusit skupinu (19) Voditka pfi pfesouvani
(7) Pridat pole (13) Upravit skupinu

Navigace ve formulafi

Navigace ve formulari w X
;;:3' Zaznam |2 z 63* M <] [} [}| [>_|- Dx
O A LAYV =

Obrazek 342: Nastrojova lista Navigace ve formulari
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Nastrojova lisSta Navigace na formulafi (obrazek 342) poskytuje nastroje pro Upravu tabulky
databaze nebo ovladani zobrazeni dat. Nastrojova lista se obvykle zobrazuje v dolni ¢asti
dokumentu, ktery obsahuje pole spojend s databazi. Tato nastrojova liSta je aktivni pouze tehdy,
kdyZ jsou formuléFe pfipojeny k databazi, proto je na obradzku 342 zobrazena nastrojova lista pro

deaktivaci.

Nastrojova lista Navigace ve formulafi umoZzniuje pohyb v rdmci zaznam( a také vkladani a
mazani zaznamU. Pokud jsou data ve formulafi uloZena, pfenesou se zmény do databaze. Tato
nastrojova lista také poskytuje pro zdznamy dat nastroje zajistujici funkce fazeni, filtrovani a

vyhledavani.

(1) Najit zaznam

(2) Zdznam

(3) Absolutni zaznam
(4) Text -> Zaznam

(9) Posledni zaznam
(10) Novy zaznam
(11) Ulozit zaznam
(12) zpét: polozka
(13) Smazat zaznam

(17) Radit vzestupné
(18) Radit sestupné
(19) Automaticky filtr
(20) Pouzit filtr

(21) Formularové filtry

(5) Celkovy pocet zaznam
(6) Prvni zadznam

(7) Pfedchozi zaznam

(8) DalSi zaznam

(22) Odstranit filtr/fazeni
(23) Zdroj dat jako tabulka

(14) Obnovit
(15) Obnovit ovladaci prvky
(16) Razeni

Zachytné body

Zachytné body v X
< &1 K B9 [

Obrazek 343: Nastrojova lista Zachytné body

Nastrojova liSta Zachytné body (obrazek 343) poskytuje nastroje pro vloZzeni zachytného bodu
nebo Upravu jeho vlastnosti. PFi pfipojovani spojnice se pouziva zachytny bod. Ve vychozim
nastaveni LibreOffice automaticky umisti bod lepeni do stfedu kazdé strany ohraniCujiciho
obdélniku kazdého vytvofeného objektu.

(2) Vlozit zachytny bod (7) Zachytny bod horizontalné (10) Z&chytny bod vertikalné

(2) Vystup doleva vlevo nahofe
(3) Vystup nahoru (8) Zachytny bod horizontalné (11) Zachytny bod vertikalné
(4) Vystup doprava uprostred uprostfed
(5) Vystup doll (9) Zachytny bod horizontalné (12) Zachytny bod vertikalné
(6) Relativni zachytny bod vpravo dole

Obrazek

Obrazek > X
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Obrazek 344: Nastrojova lista Obrazek

|Rastr V| |

Nastrojova lista Obrazek (obrazek 344) poskytuje nastroje pro Upravu, Upravu, zarovnani, zménu
polohy a velikosti obrazkd. Nastrojova lista je aktivni a dostupna pouze tehdly, kdyz je v kresbé
vybran obrazek. Nastrojova liSta Obrazek automaticky nahradi nastrojovou listu Cara a vypln.

(1) Umisténi a (5) Vpravo (10) Prenést do (13) Odsunout do
velikost (6) Nahoru popredi pozadi

(2) zarovnat objekty (7) Na stfed (11) Pfenést bliz (14) Pfed objekt

(3) Vlevo (8) Dold (12) Odsunout dal (15) Za objekt

(4) Na stfed (9) Usporadat (16) Prohodit
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(17) Styl Cary (22) stin (27) Vodorovné (32) Oblast

(18) Sitka cary (23) Filtr (28) Transformace (33) Animace
(19) Barva céary (24) Rezim obrazku (29) Prihlednost (34) Interakce
(20) Styl / vypln oblasti (25) Ofiznout (30) Barva
(21) Barva vypIné (26) Svisle (31) Carovy
Viozit
VleZit v X

T EH ~| G L TT 1l

Obréazek 345: Néstrojova lista VioZit

Nastrojova lista Vlozit (obrazek 345) poskytuje nastroje pro vkladani objektd (tabulky, obrazky,
média, vzorce, grafy a objekty OLE) do kresby.

(1) Nova stranka (4) Tabulka (7) Objekt vzorce
(2) Plovouci ramec (5) Obréazek (8) Graf
(3) Vlozit stranku ze souboru (6) Vlozit zvuk nebo video (9) Objekt OLE

DrivéjSi kruhy a ovaly
DivéjEl kruhy a ovaly v X
Ii::l O |';17 I$ |C} I:-:__‘} |:_-.\>. |::'..,;::| ::-l—/. |:: /-IT-" |:\-} |:\‘ -_ |:f

vvvvvv

s wrn s

kruznic a ovald do kresby.

(1) Vlozit elipsu (6) Kruhové Usec (11) Elipticka usec, nevyplnéna
(2) Kruh (7) Elipsa, nevyplnéna (12) Kruhova Usec, nevyplnéna
(3) Elipticka vysec¢ (8) Kruh, nevyplnény (13) Oblouk
(4) Kruhova vysec (9) Elipticky kolac¢, nevyplnény (14) Kruhovy oblouk
(5) Elipticka usec¢ (10) Kruhovy kolag, nevypinény
DrivéjSi obdélniky
Diivéjsi obdélniky v X

D0 0 EFE &=

Obrazek 347: Nastrojova lista Drivéjsi obdélniky

s wriv s

obdélnikl a &tverct do snimku.

(1) Vlozit obdélnik (5) Obdélnik, nevypinény (8) Zakulaceny ctverec,
(2) Ctverec (6) Ctverec, nevyplnény nevypinény

(3) Zakulaceny obdélnik (7) Zakulaceny obdélnik,

(4) Zaobleny ctverec nevyplnény
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Cara a Vypli

Cara a wypl ¥ X
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Obrézek 348: Nastrojova lista Cara a vyplri

Nastrojova lista Céara a vypli (obrazek 348) obsahuje nastroje a rozeviraci seznamy pro GUpravu
Car, Sipek a okrajl objektl. Dostupné nastroje zavisi na typu objektu vybraného k Gpravam.

(1) Umisténi a velikost (13) Odsunout do pozadi (25) Vodorovné

(2) Zarovnat objekty (14) Pfed objekt (26) Transformace

(3) Vlevo (15) Za objekt (27) Cérovy

(4) Na stred (16) Prohodit (28) Oblast

(5) Vpravo (17) Styl cary (29) 3D efekty

(6) Nahoru (18) Sitka ¢ary (30) Obrazkova mapa

(7) Na stred (19) Barva cary (31) Animace

(8) Dolti (20) Styl / vypln oblasti (32) Interakce

(9) Usporadat (21) Barva vyplné (33) Zobrazit postranni listu
(10) Pfenést do popredi (22) stin Styly
(11) Pfenést bliz (23) Styl Sipky (34) Zobrazovat mfizku
(12) Odsunout dal (24) Svisle (35) Voditka pfi pfesouvani

Zobrazeni predlohy

fobrazeni predl|.. ¥
= E 5 E

Obrazek 349: Nastrojova lista
Zobrazeni predlohy

Nastrojova lista Zobrazeni predlohy (obrazek 349) obsahuje nastroje pro vytvareni,
pfejmenovani, odstrafiovani a zavirani zobrazeni pfedlohy. Tato nastrojova lista je aktivni pouze
v reZzimu zobrazeni pfedlohy.

(1) Nova predlioha (2) Pfejmenovat (3) Smazat predlohu
prediohu (4) Zavrit predlohu

Prehravani médii
Prehrévani medii > X
Ll oee @ I 00:00:00 / 00:30:56 ® I
I:I Cesta k multimédiu: file:///C:/Users/petrk/Desktop/sample_audio.mp3

Obrazek 350: Nastrojova lista Prehravani médii

Nastrojova lista Pfehravani médii (obrazek 350) poskytuje nastroje potfebné pro vkladani,
prohliZeni, pfehravani a poslech zvukovych a video soubord. Nastrojova lista je aktivni pouze
tehdy, kdyZ je vybran zvukovy nebo video soubor. LibreOffice Draw podporuje mnoho rdiznych
formatl médii v zavislosti na pouzitém opera¢nim systému pocitace.

(1) Vlozit zvuk nebo video (3) Pozastavit (5) Opakovat

(2) Prehrat (4) Zastavit (6) Umisténi
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(7) Ztlumit (8) Hlasitost (9) Zobrazeni

Moznosti

X

MoZnosti e

L3I B L+ 1 Ed La 0 T4 EX
(2 =] =) &

Obrazek 351: Nastrojova lista MoZnosti
Nastrojova lista MoZnosti (obrazek 351) poskytuje nastroje pro Gpravu rliznych nastaveni nové
vytvorenych prezentaci, napfiklad zplsobu pfichyceni objektll k mfiZce pfi pfesunu nebo zméné
velikosti.

(1) Kliknutim vstoupite do (6) Prichytit k voditkim (11) Vybrat pouze textovou
rezimu otaceni (7) Prichytit k okrajiim stranky oblast

(2) Zobrazovat mfizku (8) Prichytit k ohraniCeni (12) Dvojitym kliknutim upravite

(3) Zobrazit voditka objektu text

(4) Voditka pfi pfesouvani (9) Prichytit k boddim objektu (13) Upravit objekt s atributy

(5) Prichytit k mfizce (10) Povolit rychlou editaci (14) Opustit vSechny skupiny

Redak€ni uprava

Redakéni uprava v X
R =1 (A

Obrazek 352: Nastrojova lista
Redakcni dprava

Nastrojova liSta Redakeni Uprava (obrazek 352) slouZi k blokovéani ¢asti kresby pfi ochrané
citlivych informaci. Redakéni GUprava poméha podnikiim a organizacim dodrzovat predpisy
tykajici se divérnosti nebo ochrany osobnich Gdajd.

PTi exportu redigované kresby se z kresby odstrani vSechny redigované Casti a nahradi se
redigovanymi bloky pixeld. Tim se zabrani jakémukoli pokusu o obnoveni nebo kopirovani
plvodniho obsahu. Upraveny vykres se ¢asto exportuje do formatu PDF pro zvefejnéni nebo
sdileni.

(1) Obdélnik (3) Exportovat redakéné (4) Exportovat redakéné
(2) Od ruky upravené PDF (bila) upravené PDF (Cernd)
(5) PDF
Standardni
Standardni v X

~= B 3D & X E
D~ B = & F
[d~ - A & [

Obrazek 353: Standardni nastrojova lista
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Standardni nastrojova lista (obrazek 353) je spolecna pro vSechny soucasti LibreOffice a
poskytuje nejb&zné&jsi nastroje pouzivané pfi vytvareni a Gpravach dokumentd v LibreOffice.
Standardni nastrojova lista se v jednotlivych souc€astech LibreOffice liSi tak, aby umoZziiovala
pouziti sad nastrojii potiebnych pfi vytvareni riiznych typl dokumentd.

(1) Nacist URL

(2) Novy

(3) Sablony

(4) Otevrit

(5) Oteviit vzdaleny

(6) Ulozit

(7) Ulozit jako

(8) E-mall

(9) Rezim Uprav
(10) PFimy export do PDF
(11) Vvytisknout pfimo
(12) Tisk
(13) Vyjmout
(14) Kopirovat
(15) Vlozit
(16) St&tecek formatu

(17) Vymazat

(18) Zpeét

(19) Znovu

(20) Najit a nahradit

(21) Kontrola pravopisu

(22) Automatické kontrola
pravopisu

(23) Priblizeni a posun

(24) P¥iblizeni

(25) Zobrazovat mrizku

(26) Voditka pfi pfesouvani

(27) Zobrazit pohledy

(28) Lista karet se zobrazenimi

(29) Forméat snimku

(30) Predloha snimku

(31) Zacit od prvniho snimku

Standardni (reZim prohlizeni)

Standardni (reim prohliZeni)

B = D& B & Q

(32) zacit od aktualniho snimku
(33) Tabulka

(34) Vlozit obrazek

(35) Vlozit zvuk nebo video
(36) Vlozit graf

(37) Textové pole

(38) Vlozit specialni znaky

(39) Svisly text

(40) VloZeni textu Pismomalby
(41) Vlozit hypertextovy odkaz
(42) Zobrazit kreslici funkce
(43) Interakce

(44) Napoveda LibreOffice
(45) Co je to?

-

Obrézek 354: Nastrojova lista Standardni (reZim

prohliZeni)

Nastrojova lista Standardni (rezim prohliZeni) (obrazek 354) obsahuje nastroje pro ukladani,

Upravy a distribuci kresby.

(1) Ulozit jako

(2) Rezim uUprav

(3) Rezim pouze pro ¢teni
(4) E-mall

Tabulka

Tabulka

ET 5 v@v FH v|Barva

B-F 5 =

(1) Tabulka

(2) Styl ohrani¢eni

(3) Barva ohrani¢eni

(4) Ohraniceni (Shift pro
prepsani)

(5) Styl / vyplii oblasti

(6) Barva vyplné

(7) Sloucit bunky

(5) Pfimy export do PDF
(6) EPUB

(7) Vytisknout pfimo

(8) Tisk

(9) Kopirovat
(10) Najit a nahradit
(11) P¥iblizeni

v|£r*-!?:|:|-r

= EE S

Obrazek 355: Nastrojova lista Tabulka

Nastrojova liSta Tabulka (obrazek 355) poskytuje nastroje a moznosti pro Upravu a formatovani
tabulky vioZzené do kresby. Tato nastrojova lista je aktivni pouze v pfipadé, Ze je vybrana tabulka.

(8) Rozdélit buriky

(9) Optimalizovat
(10) Zarovnani nahoru
(11) Svisle na stfed
(12) Zarovnat spodni ¢ast
(13) Vlozit fadek nad
(14) Vlozit Fadek pod
(15) Vlozit sloupec pred

(16) Vlozit sloupec za
(17) Smazat radek
(18) Smazat sloupec
(19) Smazat tabulku
(20) Vybrat tabulku
(21) Vybrat sloupec
(22) Vybrat radek
(23) Navrh tabulky
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(24) Vlastnosti tabulky

Text
Text * K

A= A g (7 ] Y

Obrazek 356: Nastrojova lista Text

Nastrojova lista Text (obrazek 356) poskytuje nastroje pro vkladani textovych poli a bublin do
kresby.

(1) Vlozit textové pole (3) Bubliny (5) PrizpUsobit rozmér svislého
(2) PrizpUsobit text velikosti (4) Vlozit svisly text textu ramci
textového pole (6) Svislé bubliny

Formatovani textu

Formatovani textu v X

Liberation Sans ~| 18pt |~ AT A‘L B I U - '5'

X X, 8 A A2~

=7

-lle
Il
9,

T

Obrazek 357: Nastrojova lista Formatovani textu

Nastrojova liSta Formatovani textu (obrazek 357) obsahuje nastroje pro formatovani textu a
pfikazy pro zarovnani. Tato nastrojova lista se stane aktivni, pokud byl vybran text v textovém
poli nebo grafickém objektu, a automaticky nahradi nastrojovou listu Céra a vypln.

(1) Nazev pisma (15) Vymazat pfimé formatovani (29) Svisle na stfed
(2) Velikost pisma (16) mala pismena (30) Zarovnat spodni €ast
(3) Zv&tsit velikost pisma (17) VELKA PISMENA (31) Nastavit fadkovani
(4) Zmensit velikost pisma (18) KAPITALKY (32) Rozestupy znakU
(5) Tucné (19) Barva pisma (33) Zvétsit rozestupy mezi
(6) Kurziva (20) Barva zvyraznéni znakd odstavci
(7) Podtrzené (21) Pfepnout nesefazeny (34) ZmenSit rozestupy mezi
(8) Dvoijité podtrzeni seznam odstavci
(9) PreSkrtnuté (22) Pfepnout sefazeny seznam (35) Smér textu zleva doprava
(10) Nadtrzeni (23) Format osnovy (36) Smér textu shora dol(
(12) Horni index (24) Zarovnat vlevo (37) Zleva doprava
(12) Dolni index (25) Zarovnani na stfed (38) Zprava doleva
(13) Prepinani stinu (26) Zarovnat vpravo (39) Vybrat vse
(14) PouZzit atribut obrysu na (27) Do bloku (40) Znak
pismo (28) Zarovnani nahoru (41) Odstavec
Transformace
Transformace v X

[dA & 5810

Obrazek 358: Nastrojova lista Transformace
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Nastrojova lista Transformace (obrazek 358) poskytuje nastroje pro Upravu tvaru, orientace nebo
vyplné vybranych objektd.

(2) Otocit (4) Umistit na kruznici (7) Interaktivni nastroj
(2) Preklopit (perspektivné) prahlednosti
(3) V 3D rotacnim objektu (5) Umistit na kruznici (zkosit) (8) Interaktivni nastroj
(6) Deformovat prechodu
Priblizeni
Pfiblizeni * X

Qaladhapad

Obrazek 359: Nastrojova lista Priblizeni

Nastrojova lista Priblizeni (obrazek 359) poskytuje nastroje pro zmenseni nebo zvétseni
zobrazeni aktualni kresby.

(1) Priblizit (4) Pfedchozi (6) Cela stranka (9) Priblizit objekt
(2) Oddalit priblizeni (7) Sitka stranky (10) Priblizeni a posun
(3) 100 % (5) Nasledujici (8) Optimalni (11) Shift

priblizeni zobrazeni

Dil€i nastrojové listy

3D objekty

3D objekty v X
POC e&ILOCC®O®

Obrazek 360: Dil¢i nastrojova lisSta 3D objekty

Klepnutim na trojuhelnik ¥ vpravo od ikony 3D objekty na nastrojoveé listé Kresba otevieme dil&i
nastrojovou liStu 3D objekty (obrazek 360) a vybereme 3D objekt, ktery chceme pridat do kresby.
DilCi nastrojova lista 3D objekty je totozna s nastrojovou liStou 3D objekty, ktera je k dispozici v
hlavni nabidce pod moznosti Zobrazit > Nastrojové listy.

(1) Krychle (3) Vélec (5) Jehlan (7) Plast
(2) Koule (4) Kuzel (6) Torus (8) Polokoule

Zarovnat objekty

Zarovnat objekty v X
£ & 3 [T fer o

Obrazek 361: Dil¢i nastrojova lista
Zarovnat objekty

Aby kresba vypadala profesionalnéji, Ize objekty vzajemné zarovnat pomoci nékterého z nastrojd
na dil¢i nastrojové liSté Zarovnat objekty (obrazek 361).

(1) Vlevo (3) Vpravo (5) Na stfed (1) Vlevo
(2) Na stfed (4) Nahoru (6) Dol (2) Na stfed
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(3) Vpravo (4) Nahoru (5) Na stfed (6) Dold
Zakladni tvary
Zakladni tvary v X

J1hgyyo o6 O a
QBOJKOOW@D%‘@

Obréazek 362: Dil¢i nastrojova liSta Zakladni tvary

%

[
_\_.\_-c\-'

Klepnutim na trojuhelnik v vpravo od ikony Zakladni tvary na nastrojové listé Kresba otevieme
dil¢i nastrojovou listu Zakladni tvary (obrazek 362) a vybereme zakladni tvar, ktery chceme pfidat
do kresby.

(1) Obdélnik (9) Kruhova vysec (17) Sestithelnik
(2) Zakulaceny obdélnik (10) Kruhova tsec¢ (18) Osmiuhelnik
(3) Ctverec (11) Oblouk (19) Valec

(4) zakulaceny Ctverec (12) Oblouk (20) Krychle

(5) Rovnobéznik (13) Rovnoramenny trojuhelnik (21) Ohnuty roh
(6) Lichobéznik (14) Pravouhly trojahelnik (22) K¥iz

(7) Elipsa (15) Kosoctverec (23) Ramec

(8) Kruh (16) Pravidelny pétiahelnik (24) Prsten

Blokové Sipky
Blokové Sipky v X

== ] TellaryVYrehb
IR L S A P b (T R

Obrazek 363: Dilci nastrojova liSta Blokové Sipky

Klepnutim na trojuhelnik ¥ vpravo od ikony Blokové Sipky na nastrojové listé Kresba otevieme
dil¢i nastrojovou listu Blokové Sipky (obrazek 363) a vybereme Sipku bloku, ktery chceme pfidat
do kresby.

(1) Sipka doprava (12) Rohova Sipka doprava (22) Sipka nahoru s bublinou
(2) Sipka doleva (13) Tvar V (23) Sipka doleva a doprava s
(3) Sipka doldi (14) Pétithelnik bublinou
(4) Sipka nahoru (15) Pruhovana Sipka doprava (24) Sipka nahoru a dold s
(5) Sipka doleva a doprava (16) Sipka nahoru, doprava a bublinou
(6) Sipka nahoru a dold dolti (25) CtyFsmérova Sipka s
(7) Kruhova Sipka (17) Sipka doprava se zafezem bublinou
(8) VInita Sipka (18) Sipka nahoru a doprava (26) Sipka nahoru a doprava s
(9) Rozdélena Sipka (19) Sipka doprava s bublinou bublinou

(10) Sipka doprava nebo doleva  (20) Sipka doleva s bublinou

(11) Ctyfsmérova Sipka (21) Sipka dolC s bublinou

Bubliny
Bubliny ¥ X

LG e U U

Obrazek 364: Dil¢i nastrojova liSta Bubliny
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Klepnutim na trojuhelnik ¥ vpravo od ikony Bubliny na nastrojové listé Kresba otevieme dilCi
nastrojovou liStu Bubliny (obrdzek 364) a poté vybereme bublinu, kterou chceme pfidat do
kresby.

(1) Obdélnikova bublina (3) Kulata bublina (6) Bublina s linkou 2
(2) Zakulacena obdélnikova (4) Oblak (7) Bublina s linkou 3
bublina (5) Bublina s linkou 1
Barva
Barva v X

1
il

=

o

=IO o
0% o= >[4 100 =

Obrazek 365: Nastrojova lista Barva

DilCi nastrojova liSta Barva (obrazek 365) poskytuje nastroje pro Upravu vlastnosti barev
vybraného objektu. Po vybéru objektu otevieme nastrojovou listu Obrazek a klepneme na ikonu
Barva na nastrojové listé Obrazek.

(1) Cervena (3) Modra (5) Kontrast
(2) Zelena (4) Jas (6) Gama
Spojnice
Spojnice > X

LNa2LVLNa/LWLNa Y\

Obrazek 366: Dil¢i nastrojova liSta Spojnice

Klepnutim na trojuhelnik ¥ vpravo od ikony Spojnice na nastrojové listé Kresba otevieme dilCi
nastrojovou listu Spojnice (obrazek 366) a vybereme spojnici, kterou chceme pfidat do kresby.

(1) Spojnice konci Sipkou (13) Spojnice kon&i kruznici
(2) Pfima spojnice konci Sipkou (14) Pfima spojnice kon¢i kruznici
(3) Zakfivena spojnice zakoncena Sipkou (15) Zak¥ivena spojnice konci kruznici
(4) Carové spojnice koné&i Sipkou (16) Céarova spojnice konci kruznici
(5) Spojnice (17) Spojnice zacina kruznici
(6) Pfimé spojnice (18) Pfima spojnice zacina kruznici
(7) Zakrivena spojnice (19) Zakfivena spojnice zacina kruznici
(8) Carova spojnice (20) Carova spojnice zacina kruznici
(9) Spojnice zacina Sipkou (21) Spojnice s kruznicemi
(10) Pfima spojnice zacina Sipkou (22) Pfima spojnice s kruznici
(11) Zakfivena spojnice zacina Sipkou (23) Zakrivena spojnice s kruznici
(12) Cérova spojnice zagina Sipkou (24) Cérova spojnice s kruznici

KFivky a mnohouhelniky

Kfivky a mnohodhelnily * X
O ALBHYALY

Obréazek 367: Dil¢i nastrojova lista Krivky a
mnohouhelniky
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Klepnutim na trojuhelnik v vpravo od ikony Kfivky a mnohothelniky na nastrojoveé listé Kresba
otevieme dil€i nastrojovou listu Kfivky a mnohouhelniky (obrédzek 367) a vybereme kfivku nebo
mnohouhelnik, ktery chceme pfidat do kresby.

(1) Kfivka, vyplnéna

(2) Mnohouhelnik, vyplnény

(3) Mnohouhelnik (45°),
vyplnény

Rozmistit vybér

(4) Céra od ruky, vypInéna
(5) Kfivka

(6) Mnohouhelnik

(7) Mnohouhelnik (45°)

ih 0o @b dd = =2 & ot

Obrazek 368: Dil¢i nastrojova liSta Rozmistit vybér

(8) Cary od ruky

¥ X

Rozmisténi objektl umoziiuje rovhomérné rozmisténi tfi nebo vice objektl podél vodorovné
nebo svislé osy. Nejvzdalené&jsi objekty slouZi jako zaklad pro vypocet rozestupl. Dil¢i nastrojova
liSta Rozmistit je k dispozici také jako nastrojova lista. V hlavni nabidce zvolime Zobrazit >
Nastrojové lisSty > Rozmistit vybér.

(1) Rozmistit vodorovné vlevo
(2) Rozmistit vodorovné na
stfed

Vyvojovy diagram

Vivojovy diagram
10O <$ 4
O U

(3) Rozmistit vodorovné
mezery

(4) Rozmistit vodorovné
vpravo

Q8O O

Obrazek 369: Dilci nastrojova liSta Vyvojovy diagram

(5) Rozmistit svisle nahoru

(6) Rozmistit svisle na stfed
(7) Rozmistit svisle mezery
(8) Rozmistit svisle doll

* X

inlUNC N ORONERY
o XS AVUD

Klepnutim na trojuhelnik ¥ vpravo od ikony Vyvojovy diagram na nastrojové listé Kresba
otevieme dil€i nastrojovou liStu Vyvojovy diagram (obrazek 369) a vybereme tvar vyvojového
diagramu, ktery chceme pfidat do kresby.

(1) Vyvojovy diagram: Proces

(2) Vyvojovy diagram:
Alternativni proces

(3) Vyvojovy diagram:
Rozhodnuti

(4) Vyvojovy diagram: Data

(5) Vyvojovy diagram: Pfedem
definovany proces

(6) Vyvojovy diagram: Interni
ulozisté

(7) Vyvojovy diagram:
Dokument

(8) Vyvojovy diagram:
Multidokument

(9) Vyvojovy diagram:

Terminator

(10) Vyvojovy diagram: Prfiprava

(11) Vyvojovy diagram:
Manualni vstup

(12) Vyvojovy diagram:
Manualni operace

(13) Vyvojovy diagram:
Konektor

(14) Vyvojovy diagram: Vnéjsi
konektor

(15) Vyvojovy diagram: Karta

(16) Vyvojovy diagram: Dérna
paska

(17) Vyvojovy diagram:
Sjednoceni

(18) Vyvojovy diagram: Nebo

(19) Vyvojovy diagram: Sbér

(20) Vyvojovy diagram: Razeni

(21) Vyvojovy diagram:
Extrakce

(22) Vyvojovy diagram: Spojeni

(23) Vyvojovy diagram: UloZzena
data

(24) Vyvojovy diagram:
Zpozdéni

(25) Vyvojovy diagram:
Sekvencni pfistup
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(26) Vyvojovy diagram: (27) Vyvojovy diagram: Pfimy (28) Vyvojovy diagram:
Magneticky disk pristup Zobrazeni

Tvar pismomalby

Tuar pismomalby v X
D OO0OdoAVDAAY
OOPYQNUeow )3 e
A ¢ p O

Obrazek 370: Dil¢i nastrojova lista Tvar pismomalby

Klepnutim na trojuhelnik v vpravo od ikony Tvar pismomalby na nastrojové listé Pismomalba
se otevre dilCi nastrojova lista Tvar pismomalby (obrazek 370). Vybérem poZzadovaného tvaru
zmeénime zobrazeni textového tvaru Pismomalby v kresbé.

(1) Prosty text (11) Zkosit nahoru (21) Levy oblouk (kfivka)
(2) Vinka (12) Zkosit dolC (22) Pravy oblouk (kfivka)
(3) Roztazeni (13) Sklonit nahoru (23) Kruh (kfivka)
(4) Zastavit (14) Sklonit dol (24) Otevieny kruh (kfivka)
(5) Kfivka nahoru (15) ZKkosit doprava nahoru (25) Horni oblouk (dovnitr)
(6) Kfivka doll (16) ZKkosit doleva nahoru (26) Dolni oblouk (dovnitr)
(7) Trojuhelnik nahoru (17) V nahoru (27) Levy oblouk (dovnitf)
(8) Trojuhelnik doll (18) V doll (28) Pravy oblouk (dovnitF)
(9) Zkosit doprava (19) Horni oblouk (kfivka) (29) Kruh (dovnitr)

(10) Zkosit doleva (20) Dolni oblouk (kFivka) (30) Otevreny kruh (dovnitr)

Filtr obrazku

Filtr obrézku v X
Gl O A allkP® 7 T E

Obrazek 371: Dil¢i nastrojova lista Filtr obrazki

Klepnutim na trojuhelnik ¥ vpravo od ikony Filtr na nastrojové listé Obrazek otevieme dilCi
nastrojovou listu Filtr obrdzku (obrazek 371). Vybérem pozadovaného filtru zménime zobrazeni
obrazku na monitoru.

(1) Prevratit (4) Odstranit Sum (7) Posterizovat (10) Reliéf
(2) Vyhladit (5) Solarizace (8) Pop art (11) Mozaika
(3) Zaostfit (6) Ztmavnuti (9) Kresba uhlem
Cary a Sipky
Cary a tipky v X

Obréazek 372: Diléi nastrojova lista Cary a Sipky
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Klepnutim na trojuhelnik v vpravo od ikony Cary a Sipky na nastrojové listé Kresba otevieme
dil€i nastrojovou listu Cary a Sipky (obrazek 372) a vybereme €aru nebo Sipku, kterou chceme
pridat do kresby.

(1) Céra kon¢i Sipkou (5) Céra zagina Sipkou (9) Kétovaci cara
(2) Cara se Sipkou/kruznici (6) Cara se Sipkou/kruznici (10) Céara (45°)
(3) Cara se ctvercem/Sipkou (7) Céra se Sipkou/Ctvercem
(4) Céra se Sipkami (8) Vlozit Caru
Umisténi
Umisténi v X

= O
L O o | O
Obrazek 373: Dil¢i nastrojova lista Umisténi

Klepnutim na trojahelnik v vpravo od ikony Uspofadat na nastrojové list& Cara a vypli
otevieme dilCi nastrojovou listu Umisténi (obrazek 373) a vybereme umisténi vybraného objektu
v kresbé.

(1) Pfenést do (3) Odsunout dal (5) Pred objekt
popredi (4) Odsunout do (6) Za objekt
(2) Prenést bliz pozadi (7) Prohodit

Hvézdy a cedule

Hvézdy a cedule v X
Cr ORI 0%

Obréazek 374: Dilci nastrojova lisSta Hvézdy a cedule

Klepnutim na trojuhelnik ¥ vpravo od ikony Hvézdy a cedule na nastrojové listé Kresba
otevieme dil¢i nastrojovou listu Hvézdy a cedule (obrazek 374) a vybereme hvézdu nebo Sipku,
kterou chceme pfidat do kresby.

(1) Ctyfcipa hvézda (5) 12cipa hvézda (9) Vodorovna role (12) Sesticipa hvézda,
(2) Péticipa hvézda (6) 24cipa hvézda (10) Pecet konkavni

(3) Sesticipa hvézda (7) Vybuch (11) Jmenovka

(4) Osmicipa hvézda (8) Svislarole

Tvary symbolt

Tvary symbold * X

|::‘;‘f;l ':F/-' u:(:;_.‘:n ™ E_:'l L%’ -:::} [@j ':E:}' @ @ @
01 4 {}

Obréazek 375: Dil¢i nastrojova lista Tvary symbol

._h_.

Klepnutim na trojuhelnik v vpravo od ikony Tvary symbol(i na nastrojové listé Kresba otevieme
dil¢i nastrojovou listu Tvary symbolll (obrazek 375) a vybereme tvar symbolu, ktery chceme
pridat do kresby.

(1) Smajlik (3) Slunce (5) Oblak (7) Kvétina

(2) Srdce (4) Mésic (6) Blesk (8) Zakaz
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(9) Puzzle (12) Zkoseny (15) Pravéa zéavorka (17) Leva sloZzena

(10) Zkoseny &tverec kosoctverec (16) Dvojita sloZzena zavorka
(11) Zkoseny (13) Dvojita zavorka zavorka (18) Pravé slozena
osmithelnik (14) Leva zavorka zavorka
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Prace s vektorovou grafi kou

O této knize:

Tato kniha se zabyva hlavnimi funkcemi aplikace Draw, vektorové grafické
komponenty kancelarského baliku LibreOffice. Pomoci Draw Ize vytvaret
Sirokou skalu grafickych obrazkda.

Vektorova grafika uklada a zobrazuje obrazek jako jednoduché geometrické
prvky, jako jsou ¢ary, kruznice a mnohouhelniky, nikoli jako soubor pixell
(bodd na obrazovce). To umoznuje jednodussi ukladani a podporuje presné
Skalovani prvkd obrazku.

Aplikace Draw je plné integrovana do baliku LibreOffice. To zjednodusSuje
vymeénu grafiky s aplikacemi Writer, Calc a Impress. Obrazky Ize exportovat v
mnoha formatech pro pouziti v jinych programech.

O autorech:

Tuto knihu napsali dobrovolnici z komunity LibreOffice. Zisky z prodeje tisténé
verze budou pouzity ve prospéch komunity. Tuto knihu si mGzete zadarmo
stahnout ve formatu PDF ze stranky:
https://cs.libreoffice.org/get-help/documentation/

O LibreOffice:

LibreOffice je svobodny, bezplatny a otevreny kancelarsky balik od The
Document Foundation. Je urcen pro systémy Windows, macOS a GNU/Linux.
Podpora a dokumentace je k dispozici zdarma diky nasi velké komunité
uzivateld, prispévateld a vyvojara.

Uvitdme zapojeni dobrovolnik@ v mnoha oblastech: pri vyvoji, zajistovani
kvality, prekladani, podpore uzivateld apod.

LibreOffice Community mizete zdarma stahnout ze stranek:
https://cs.libreoffice.org/download/

Pro komerc¢ni pouziti:

Spolupracujte s certifikovanymi odborniky na LibreOffice v pripadé jakychkoli
podnikovych potfeb, od nasazeni nebo konverze z jinych kancelarskych sad,
pres Skoleni zaméstnancl az po potreby vlastniho vyvoje.

Skvéli lidé - Smysluplny projekt
Svobodny kancelarsky balik



https://cs.libreoffice.org/get-help/documentation/
https://cs.libreoffice.org/download/

	Autorská práva
	
	Pro koho je tato uživatelská příručka určena?
	Co je v této uživatelské příručce?
	Minimální požadavky na LibreOffice
	Jak získat LibreOffice
	Instalace LibreOffice
	Nastavení a přizpůsobení LibreOffice
	Rozšíření a doplňky
	Kde získat pomoc
	Možné vzhledové odchylky
	Používání LibreOffice na systému macOS
	Kdo napsal tuto uživatelskou příručku?
	Často kladené otázky
	Co je nového v LibreOffice 25.8?

	
	Úvod
	Hlavní okno
	Volba a definování barev
	Mřížka, vodítka a pomocné čáry

	
	Úvod
	Kreslení základních tvarů
	Záchytné body a spojnice
	Kreslení geometrických tvarů
	Přidávání, vkládání a formátování textu

	
	Úvod
	Výběr objektů
	Umístění a zarovnání objektů
	Použití mřížky a funkce přichycení
	Používání vodítek
	Změna tvaru objektu

	
	Formátování čar
	Výplně oblasti
	Práce s výplněmi oblasti
	Práce se stíny
	Práce s průhledností
	Styly kresby
	Speciální efekty

	
	Seskupování objektů
	Kombinování, rozdělování, rozdělování a spojování
	Slučování, odečítání nebo průnik objektů
	Duplikace a přechod tvarů
	Umísťování objektů

	
	Úvod
	Importování grafiky a obrázků
	Export obrázků
	Formátování obrázků
	Oříznutí obrázků
	Filtry obrázku
	Náhrada barev
	Převod

	
	Úvod
	Typy 3D objektů
	Vytváření prostorových (3D) objektů
	Úprava 3D objektů
	Skládání objektů
	Skládání 3D objektů

	
	Spojnice a záchytné body
	Vývojové diagramy
	Organizační schémata

	
	Úvod
	Textový režim
	Textová pole
	Text v objektech
	Formátování textu
	Neuspořádané nebo uspořádané seznamy
	Textové sloupce
	Animace textu
	Textové bubliny
	Tabulky v aplikaci Draw
	Používání polí
	Hypertextové odkazy
	Obrázkové mapy
	Písmomalba

	
	Úvod
	Výchozí nastavení tiskárny
	Rychlý tisk
	Tisk v systému Linux nebo Windows
	Tisk v systému macOS
	Příklady tisku
	Exportování
	Odesílání dokumentů e-mailem
	Digitální podpisy
	Odstranění osobních údajů
	Redakční úprava

	
	Stránky kresby
	Předlohy stránek
	Šablony
	Více vrstev
	Kótování
	Kresba v měřítku
	Více pohledů na kresbu
	Galerie
	Barvy
	Bézierovy křivky
	Přidávání komentářů
	Souřadnicový systém

	
	Úvod
	Výběr variant uživatelského rozhraní
	Standardní nástrojové lišty
	Karty
	Jednotná nástrojová lišta a postranní nástrojová lišta
	Kompaktní karty
	Kompaktní skupiny
	Kontextová lišta

	
	Úvod
	Obecné funkční klávesy a klávesové zkratky
	Klávesové zkratky v hlavní nabídce
	Funkční klávesy a klávesové zkratky nástrojové lišty

	
	Úvod
	Použití nástrojových lišt
	Nástrojové lišty
	Dílčí nástrojové lišty


